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PHẦN 1

KHÁI QUÁT CHƯƠNG TRÌNH

Chào mừng các bạn đến với chương trình Eagle phiên bản dành cho Windows, MAC, Linux
Đây là chương trình quan trọng và rất hữu ích đối với những người theo học chuyên nghành Điện-
Điện Tử, Tự động hoá và Cơ điện tử v.v.  

EAGLE có nghĩa là: Easily
Applicable
Graphical
Layout
Editor

Chương trình này được phát triển và phân phối bởi công ty CadSoft Computer, Inc (Germany)
Phone: +1 954-237-0932
Fax: +1 954-237-0968
E-mail: support@cadsoftusa.com
Web: http://www.cadsoftusa.com
Điều đặc biệt nữa đây là chương trình Freeware với đầy đủ các tính năng giống như bản 
shareware.

EAGLE được chia ra làm ba phiên bản cho mỗi người dùng khác nhau.

 Bản Professional Edition
Bản này thường được dùng cho thương mại

 Không giới hạn không gian thiết kế (lớn nhất là 64 x64 inches = khoảng 1m6 x 1m6)
 Sơ đồ mạch điện up lên tới 999 sheet
 Hỗ trợ toàn bộ linh kiện chíp dán SMD
 Xuất dữ liệu data nhiều định dạng
 Tạo thư viện linh kiện mới từ thư viện có sẵn bằng cách Kéo & Thả
 Hộ trợ thao tác xoay các góc độ

http://www.cadsoftusa.com/
mailto:support@cadsoftusa.com






Các bước cài đặt được minh họa như hình trên,,, bạn chỉ cần nhấp Next > và chọn thư mục cài 
đặt là xong….sau khi hoàn tất quá trình cài đặt thì chúng ta có thể bắt đầu sử dụng được chương 
trình ngay lập tức.



Tại cửa sổ này bạn có thể thao tác mở:
Schematic dùng cho việc thiết kế sơ đồ nguyên lý…
Board dùng cho việc thiết kế mạch in…và xuất ra in ấn 
Library dùng cho việc thiết kế mẫu linh kiện nếu trong cơ sở dữ liệu của Eagle chưa có…

PHẦN 4

VẼ SƠ ĐỒ NGUYÊN LÝ

Khởi động chương trình, tại giao diện chính của chương trình Control Panel.
Bước 1: Kích chuột phải vào Projects và chọn New Projects  xuất hiện thư mục tên 
New_Project (bạn có thể đặt tên cho thư mục Projects này)



Tiếp theo kích chuột phải vào New_Project sau đó di chuyển con trỏ đến mục New và kích 
chuột trái vào Schematic 

Hoặc bạn có thể mở 1 File mới trực tiếp từ cửa sổ chính Control Panel theo các bước như hình



Khi cửa sổ soạn thảo Schematic xuất hiện bạn phải thực hiện công việc đặt tên cho mạch điện 
sẽ được vẽ. Bạn có thể thực hiện việc này bằng cách kích chuột trái vào biểu tượng cất giữ như 
trên hình vẽ hoặc bạn có thể kích chuột vào Menu File rồi tiếp theo kích chuột vào mục Save 
As…

       

Cửa sổ thiết kế sơ đồ nguyên lý



Các lệnh cơ bản

Tên tập tin

Thanh Menu lệnhDòng lệnh

Thanh hiển 
thị tham số

Tọa độ 
con trỏ 
chuột

Gốc tọa độ

Chỉ dẫn hành động

Thanh công cụ lệnh chức năng



                                                                                                      

Thanh công cụ 
này nằm bên trái 
của màn hình Thanh công 

cụ này nằm 
bên phải của 
màn hình

Show Kiểm tra sự nối mạch hay 
chưa

I: Information Xem thông tin của linh 
kiện hoặc dây nối

Mark Chọn thêm toạ độ thứ 2 trên 
bản vẽ

Display
Lựa chọn hiển thị các lớp vẽ và cho phép 
tạo thêm lớp layer mới

Move Di chuyển linh kiện trên sơ đồ 
nguyên lý

Mirror Linh kiện sẽ được đổi chiều (đối 
xứng) Rotate Xoay linh kiện với các góc 90, 180 

và 270 độ

Copy Sao chép linh kiện

Group Nhóm 1 số linh kiện hay 1 phần mạch 
điện cần di chuyển hoặc cắt Change Thay đổi các thông số của mạch 

điện

Paste Dán linh kiện hoặc phần mạch điện 
đã được Copy hoặc đã cắt

Cut Cắt 1 linh kiện hay 1 mạch điện đã 
được đánh dấu



Hiển thị lưới tọa độ GRID
Đây là chức năng cho phép hiển thị lưới để định vị linh kiện một cách chính xác và thẩm 
mỹ….mặc định chức năng này không được hiển thị khi bạn mở chương trình thiết kế mạch….
Để gọi chức năng này ta có thể gõ lệnh Grid on hoặc nhấp vào biểu tượng Grid 

Name Thay đổi tên gọi của linh kiện 
trong mạch

Delete Lệnh xoá linh kiện hoặc dây nối 
mạch

Pinswap hoán đổi vị trí chân linh kiện Replace thay thế linh kiện trong mạch 
bằng linh kiện khác

Add Mở/thêm thư viện linh kiện để vẽ 
mạch

Value Lệnh thay đổi thông số (giá trị) 
của linh kiện trong mạch

Gateswap hoán đổi vị trí cổng của linh 
kiện

Smash Sắp xếp lại vị trí Name/Value 
trên linh kiện

Split Chia đường nối ra từng phần

Miter Bo tròn góc đường đi dây

Invoke Kích hoạt cổng khác từ một linh 
kiện

Wire Lệnh này thực hiện vẽ Dây nối 
mạch điện

Circle Lệnh này thực hiện vẽ 1 vòng 
tròn

Text Bạn có thể viết 1 dòng chữ trong 
mạch điện thông qua lệnh này

Arc Lệnh này thực hiện vẽ 1 cung tròn

Rect Lệnh vẽ hình chữ nhật

Bus Lệnh này giúp bạn có thể vẽ mạch 
điện 1 cách gọn gàng và dễ nhìn nhất

Polygon Thực hiện vẽ kín những phần 
mạch không cần dùng đến trong mạch in
Net
Lệnh này thực hiện nối mạng các linh 
kiện cần nối với nhau

Junction Lệnh tạo các điểm nối mạch 
điện

Attribute Đặt thuộc tính cho một linh 
kiện nào đó
Erc Lệnh này giúp bạn có thể kiểm tra 
những lỗi trong mạch (Sự nối mạch)

Label Thực hiện làm xuất hiện tên của 
các dây nối trong mạch (Net, Wire)

ERC Kiểm tra lỗi trên mạch



Thực hiện các thao tác tùy chọn chọn hiển thị Grid rùi nhấn OK

Chức năng phóng đại

         

Chọn độ lớn của 
mắt lưới

Chọn đơn 
vị hiển thị

Chọn dạng 
lưới hiển thị

FIT
Phóng 
đại vừa 
cửa sổ

ZOOM +
Phóng to

ZOOM –
Thu nhỏ

REDRAW
Thao tác lại 
phóng đại

Chọn vùng 
phóng đại



Để nhìn được các linh kiện trong bản vẽ theo ý muốn chúng ta sử dụng các lệnh sau:
FIT: Hiển thị toàn bộ mạch điện
ZOOM +: Phóng to hình ảnh
ZOOM -: Thu nhỏ hình ảnh
REDRAW: Làm rõ mạch điện
SELECT: Chọn phần cần phóng to

Các hình vẽ cơ bản

Vẽ đường thẳng (dây nối)

Bạn có thể gõ lệnh WIRE trên thanh command line hoặc chọn biểu tượng  để vẽ đường 

thẳng,,, khi muốn kết thúc bạn có thể nhấp vào biểu tượng Stop  hoặc nhấn phím tắt là 
ESC

Thông số của Wire

                                                                                                     

Polygon

Arc
Circle

Wire

Rect

Dạng gấp 
khúc của 
đường thẳng

Màu sắc của 
đường thẳng



                                                                                                        

Một số chức năng vẽ khác các bạn có thể tìm hiểu thêm…

Vẽ sơ đồ nguyên lý



Lấy linh kiện: để lấy linh kiện bạn sử dụng lệnh add hoặc nhấp chuột vào biểu tượng  để 
gọi thư viện linh kiện.
Một cửa sổ xuất hiện cho phép chúng ta lấy linh kiện

Tại cửa sổ này bạn sẽ được cung cấp một số thông tin chi tiết liên quan đến loại linh kiện mà bạn 
chọn trong đó bao gồm mô tả về loại linh kiện, hãng sản xuất, dạng chân, hình dạng…
Trong trường hợp bạn muốn tìm một loại linh kiện, bạn có thể sử dụng chức năng Search để tìm 
một cách dễ dàng.



Note: tính năng Search của EAGLE không được hay cho lắm vì nhiều khi các tìm không chuẩn xác 
(không cho ra kết quả dù trong thư viện có linh kiện đó) do vậy nếu bạn nên ghi chú những loại 
linh kiện mà bạn hay dùng ra một cuốn sổ riêng để dễ tra cứu vì thư viện này tuy được sắp xếp 
một cách hợp lý nhưng hơi rắc rối…

Khi lấy linh kiện cần chú ý:
Có 2 tiêu chuẩn ký hiệu linh kiện: Đó là tiêu chuẩn EU và tiêu chuẩn của US 
Những ký hiệu này chỉ khác nhau trên sơ đồ nguyên lý ngoài ra thì không có sự khác biệt nào 
khác cả
Để nhận biết người ta thường gắn kèm ký tự EU và US vào tên của linh kiện như hình vẽ bên 
dưới 

                          



Sau khi đã add xong linh kiện chúng ta tiến hành đặt Value và Name cho linh kiện bằng cách 

chọn   

Dùng NET  để thực hiện kết nối giữa các linh kiện sau khi đã sắp xếp và lấy được các linh 
kiện ra…..

Kiểm tra sự thông mạch (nối mạch) 
Chúng ta có thể dùng lệnh MOVE hoặc lệnh SHOW để kiểm tra, lệnh MOVE còn có chức năng 
chỉnh sửa đường mạch, dây nối, vị trí linh kiện (đây là lệnh được thao tác nhiều nhất trong quá 
trình thiết kế, vẽ một hệ thống mạch điện.)



 

Tạo điểm nối mạch 
(Chức năng hầu như ít được sử dụng trong EAGLE)

Nối mạch

Để kết nối các linh kiện lại với nhau, chúng ta sử dụng lệnh NET  

SHOW
Màu sắc tươi hơn

Move
Để di chuyển đối tượng



SƠ ĐỒ MẠCH IN (MẶT DƯỚI CỦA BOARD)

Tạo board mạch từ sơ đồ nguyên lý
Giới thiệu chút:
Để tạo được một board mạch in chúng ta có hai lựa chọn, có thể là tạo trực tiếp trên Layout (vẽ 
tay từ đầu tới cuối) và có thể tạo Board mạch từ sơ đồ nguyên lý, cách hai giúp chúng ta đỡ mất 
thời gian kết nối giữa các linh kiện hơn cách thứ nhất bởi vì chỉ cần một thao tác chuột chúng ta 
có thể chuyển từ sơ đồ nguyên lý sang dạng Board rất nhanh chóng. Đặc diểm để EAGLE được sử 
dụng rộng rãi là tính dễ dùng, không rườm rà các tính năng và việc kết nối giữa các linh kiện từ 
sơ đồ nguyên lý với sơ đồ mạch in vô cùng đơn giản…hầu hết người dùng đều thích tính năng 
này. Ngoài ra sau khi phác thảo xong Board, chúng ta có thể xuất ra định dạng 3D nhờ một tool 
được phát triển bởi cộng đồng người dùng yêu thích Eagle… (Eagle3D) nó sẽ xuất board sang 
dạng Script và một chương trình để render Script sang dạng 3D (Pov-ray), chính việc hỗ trợ 

http://www.povray.org/
http://www.matwei.de/doku.php?id=en:eagle3d


dạng 3D đã làm cho Eagle trở thành một trong những chương trình được sử dụng rộng rãi nhất 
cùng với các chương trình thiết kế mạch điện nổi tiếng khác, ưu điểm là vì có dung lượng cài đặt 
rất nhỏ (~25Mb) so với các chương trình khác (hầu hết là chứa trên 1 đến 2 DVD)…

Tính năng 3D

Chuyển từ sơ đồ nguyên lý sang sơ đồ mạch in
Từ sơ đồ nguyên lý Schematic chúng ta sử dụng biểu tượng Board hoặc vào   Switch to  

hoặc cũng có thể gõ lệnh board để chuyển sang layout 



  hoặc  

Xuất hiện một hộp thoại xác nhận việc chuyển từ nguyên lý sang Board….

   
Output.sch Output.brd



Bạn có thể điều chỉnh kích thước board bằng cách dùng lệnh Move để di chuyển/điều chỉnh khung 
bao quanh cho vừa với kích thước bạn mong muốn

Chuyển các linh kiện vào Board mạch, chúng ta sử dụng các lệnh cơ bản như Move và Rotate 

. Hoặc có thể chuyển toàn bộ linh kiện vào trong bằng lệnh Group , sau đó tiến hành 
sắp xếp linh kiện một cách hợp lý nhất để khi chạy Auto không bị lỗi 
Chúng ta phải đặt linh kiện tại các vị trí thích hợp sao cho các đường mạch là ít bị chồng chéo 
nhất,,,,làm được điều này thì sẽ làm cho Board xuất ra đẹp nhất.

Tất cả các linh kiện 
có trong sơ đồ 
nguyên lý

Vùng giới hạn cho việc thiết kế
Tùy thuộc vào phiên bản 
EAGLE (Free, Stand, Pro)



Sau khi làm xong công việc sắp xếp linh kiện thì tiến hành xác định vị trí các lỗ khoan để bắt ốc 
định vị cho Board mạch 

Bạn sử dụng lệnh Hole  để đặt lỗ bắt ốc cố định cho Board

    

Có hai cách để tiến hành vẽ đường mạch cho board…có thể sử dụng lệnh Auto  để chay một 
cách tự động,,,cách này có nhược điểm là nhìn đường mạch sắp xếp không được đẹp/hợp 
lý….nhưng được cái NHANH

Cách thứ hai là tự đi đường mạch bằng lệnh Route  việc làm này hơi mất thời gian đôi chút 
nhưng nếu làm được thì rất là đẹp.
Đầu tiên chúng ta thử cách thứ nhất:

Để chạy lệnh AutoRoute chúng ta có thể gõ lệnh Auto, nhấp vào biểu tượng Auto  hoặc vào 
Tools  Auto…
Một cửa sổ hiện ra cho phép ta thiết lập các tham số chạy Auto…

Định vị lỗ
Chọn kích 
thước lỗ 
khoan



Tại cửa sổ này bạn có thể lựa chọn chế độ làm mạch in: 
- Mặt trên (Top)
- Mặt dưới (Bottom)
- Cả mặt trên và mặt dưới 
Nếu chọn vẽ mặt dưới thì bạn chọn mặt trên ở chế độ N/A
và mặt dưới bạn có thể chọn dạng chủ yếu cho đường mạch:
|     Mạch sẽ chạy theo chiều dọc
-      Mạch se chạy theo chiều ngang 
N/A Không chọn 
/      Mạch sẽ chạy theo 1 góc 45 độ
 \     Mạch sẽ chạy theo 1 góc 135 độ
*      Mạch sẽ chạy một cách tuỳ ý

Còn một số tham số khác như là Buss, Route, Optimize… bạn tự tìm hiểu vì nó không mấy khó 
hiểu…tên của nó đã nói lên chức năng của nó.
Sau khi thiết lập các tham số cho nó, bạn nhấp vào OK để bắt đầu chạy Auto



Để vẽ lại bằng tay một đường mạch nào đó, bạn có thể chọn lệnh RIP  để rip đường đã được 
auto

Bạn có thể chọn Rip toàn bộ bản mạch bằng cách chọn Group và chọn Rip 

   

Cách thứ hai để vẽ đường mạch, bạn chọn lệnh Route  và nhấp vào đường mạch để chỉnh 
đường mạch.

Các thông số đường mạch

Tên Net mà mình 
đang thao tác



Kết thúc board bằng cách vẽ tay nè!!!

Để đổ mass (phủ đồng) như hình trên, chúng ta sử dụng lệnh Polygon 

Xác định phần mạnh cần được phủ đồng sau đó chọn Ratsnest  

Chọn lớp 
phủ mass

Chọn góc 
bo cạnh

Chọn độ rộng 
đường phủ

Chọn độ 
cách điện

Chọn loại 
phủ mass



Một cửa sổ xuất hiện cho phép bạn thiết lập các tham số trước khi in

Trong phần Options, có một vài tham số chúng ta cần quan tâm.
- Mirror : In dạng ảnh ngược
- Rotate: In xoay
- Black: In đậm
- Scale factor: Tỷ lệ in
- Page limit: Giới hạn bản in
- OK: Chấp nhận in.
- Printer: Chọn máy in
- Cancel: Huỷ bỏ lệnh in  
- Page: Giới hạn lề giấy và vị trí in mạch 
- Aligment: vị trí in

- Nếu chọn Center thì mạch sẽ được in ở giữa giấy.
- Nếu chọn Top - Center thì mạch sẽ được in ở trên đầu và giữa giấy



- Left : Bên trái
- Right : Bên phải
- Bottom: Phía cuối giấy 

…..
Với cách xuất thành PDF….
Mặc định từ phiên bản 5.0 Eagle đã tích hợp trình xuất PDF nên bạn có thể xuất trực tiếp thành 
file PDF mà ko cần dùng máy in ảo….nhưng một lời khuyên của tui là bạn nên dùng một trình in 
ảo nào đó sau đó chọn thuộc tính độ phân giải cao cao một chút…có thể lên tới 4000dpi để in ra 
với chất lượng tốt nhất.

Trong thiết kế mạch In (Layout…) thì trước khi xuất ra file PDF bạn phải chỉnh lại một vào tham 
số liên quan đến lớp thiết kế (layer), mục đích của việc làm này là chúng ta chỉ nên xuất những 
layer mà cần thiết cho mục đích in tránh nhắm rối mắt. Nếu trong Board bạn thiết kế hai lớp thì 
phải xuất riêng từng lớp một

Máy in ảo xuất 
ra file PDF

Xuất trực tiếp ra 
PDF (không có 
tùy chọn gì cả)



Trong chế độ Library Edit bạn có thể chọn cách chỉnh sửa Packages, Symbols, và Devices. 

Package: nhận dạng hình dạng chân thực tế của linh kiện khi in (dạng này ở vùng PCB). 

Symbol: Dạng hiển thị ký hiệu của linh kiện trên sơ đồ nguyên lý . 

Device: Nhận dạng toàn bộ linh kiện bao gồm ký hiệu sơ đồ nguyên lý và dạng chân PCB cho 
toàn mạch. Nó có thể chứa nhiều dạng chân PCB cho một ký hiệu linh kiện (như chip dán, chuẩn, 
kích thước…). 

Trong Library Edit bạn có thể nhấp vào nút Dev, Pac hoặc Sym để chọn Device, Packages 
hoặc Symbols.

Để tạo một linh kiện mới bạn mở chương trình soạn thảo Library Edit lên và làm theo hướng dẫn 
từng bước dưới đây.

File  New  Library

Một cửa sổ mới xuất hiện

   
Tại mục Edit bạn có thể chọn thiết kế tạo mới chân linh kiện (Pac), Ký hiệu linh kiện (Sym) hoặc 
là chạy kết nối giữa hai linh kiện Pac và Sym lại với nhau (Dev)



Trong phần này chúng ta sẽ tạo linh kiện AT91SAM7SEXXX (vì trong EAGLE không có con 
này…)

Đầu tiên chúng ta nhấp vào Symbol (Sym)

  và đặt tên cho linh kiện muốn tạo, một hộp thoại yêu cầu xác nhận

Bây giờ chúng ta đã ở trong cửa sổ thiết kế chính của thư viên. Việc tiếp theo là ta làm tạo một 

khung cho linh kiện, sử dụng lệnh Wire  để vẽ.

 và khung bao quanh này thuộc trong lớp layer 

 Bây giờ đến việc đặt chân (PIN) cho linh kiện, bạn gõ lệnh Pin hoặc nhấp vào biểu tượng  để 
thực hiện việc đặt chân cho linh kiện.

Một vài (6) tham số liên quan tới PIN mà chúng ta cần quan tâm:



Direction : Loại chân linh kiện, nguồn, xuất/nhập, chung, tín hiệu, dao động…
Function : Chức năng
Length : Cỡ chân, dài, ngắn
Orientation: Định hướng góc xoay, 45, 90, 180, 270 
Visible : Dạng hiển thị, hiển thị đầy đủ (gồm số chân và chức năng)và hiển thị giản lược 
Swaplevel : Hoán đổi PIN

Sau khi đã làm xong thì tiến hành đặt tên cho từng chân (Pin) và chức năng của chúng. Để đổi 
tên chúng ta có nhiều cách khác nhau để thực hiện việc này, có thể dùng lệnh Info, change, 
name để đổi. Ở đây chúng ta có thể chỉ cần chọn Info (có thể đổi thông tin của PIN đó với nhiều 
lựa chọn) hoặc chọn Name (chỉ đổi được tên của PIN).

Với Info  chúng ta di chuyển chuột vào chân cần đổi thông tin và nhấp vào nó, một hộp thoại 
chứa đựng thông tin của Pin đó giúp chúng ta có thể thay đổi tùy theo ý thích.

Name: tên của PIN

Position: Vị trí Pin trong cửa sổ làm việc

Angle: góc xoay của PIN

Những thông tin còn lại chúng ta đã biết ở mục

trên

Với Name  bạn chỉ cần click vào Pin và

nó sẽ hiển ra hộp thoại cho phép thay đổi 

nhanh chóng:



Sau khi đổi tên cho tất cả các PIN như trên ta được một linh kiện hoàn chỉnh như phía dưới

Việc tiếp theo cần làm là Save lại cho chắc ăn (công sức làm như vậy mà cúp điện là tiêu…)

Bây giờ đến phần tạo Package cho linh kiện mang mã số AT91SAM7SEXXX

Một công việc “bất di bất dịch” là nếu bạn tự tạo linh kiện cho sơ đồ mạch thì bạn phải thiết kế 
dựa vào datatsheet của linh kiện đó,,,có thể ký hiệu linh kiện trên sơ đồ nguyên lý (Sym) thì 
không quan trọng lắm,,,nhưng Package thì lại rất quan trọng vì nó liên quan đến dạng chân board 
khi bạn làm ra thành phẩm. Nếu bạn không cẩn thận, có thể kích thước package khi in ra sẽ rất 
khác so với kích thước chân thực tế của linh kiện bạn tạo vì vậy ở đây chúng ta thiết kế phải dựa 
theo chuẩn của datasheet mà nhà sản xuất đã cung cấp cho chúng ta…

Khi thiết kế package bạn cần chú ý đến khoảng cách giữa các chân linh kiện (chân 1,2,3,4...) vì 
mấu chốt thực sự nằm ở chỗ này, chỉ cần ta thiết kế đúng là ok…in ra sẽ rất chuẩn so với linh 
kiện thực tế.



Điều đầu tiên để bạn làm được những việc như trên và tiếp theo sau đây là bạn phải tải được 
Datasheet cho con IC này…tải datasheet ở đâu thì chắc không cần nói vì bạn cũng thừa biết 
Google nó mạnh như thế nào đúng không!

Chip này có 128 Pin được thiết kế package dựa theo chuẩn LQFP-128 có khoảng cách hai chân là 
0.5mm (0.02inch)
Nhìn vào bảng phía dưới ở datasheet chúng ta có thể thiết kế nó một cách dễ dàng các khoảng 
cách chân linh kiện cũng như kích thước WxH

http://www.google.com/
http://atmel.com/dyn/resources/prod_documents/doc6222.pdf
http://atmel.com/dyn/resources/prod_documents/doc6222.pdf


Sau khi đã thiết kế xong phần Sym và Pac, chúng ta tiến hành một công việc quan trọng là kết 
nối giữa hai linh kiện Sym<-->Pac lại với nhau để chúng có tương thích với nhau ở cả sơ đồ 
nguyên lý và sơ đồ mạch in



Để kết nối chúng ta sử dụng lệnh dev   để kết nối, với lệnh này, chúng ta có thể tùy biến 
kết nối rất đa dạng linh kiện (ví dụ Resistor, capacitor…) 



Tới đây sử dụng lệnh add  để thêm linh kiện cần kết nối với nhau. Màn hình kết nối xuất 
hiện: Trước tiên ta phải lấy biểu tượng Symbol trong Add đưa ra ngoài màn hình. Tại gốc tọc độ.

Sau đó chọn linh kiện như hình dưới:



Để kết nối chúng ta nhấn vào Connect và chọn kết nối chân cho phù hợp, tùy từng loại mà kết 
nối phù hợp, ở đây chúng ta ta kết nối cho con linh kiện đã tạo

Sau khi đã chọn cho chân kết nối phù hợp, chúng ta nhấp vào Connect, nếu muốn kết nối lại thì 
nhấn vào Disconnect và chọn chân khác,,,

Sau khi làm xong phần kết nối, chúng ta có thê thêm vài dòng mô tả về con linh kiện này bằng 
cách nhấn  vào Description



Một hộp thoại soạn thảo mini giúp chúng ta mô tả vài nét về linh kiện mà chúng ta đang tạo, hỗ 
trợ các định dạng HTML

Sau khi xong thì Save lần nữa và cuối cùng là xem thành quả chúng ta tạo ra



Sau khi cài Eagle3D trong thư mục của bạn có:

3d40.ulp ULP cho phiên bản Eagle 4.09r2 hoặc thấp hơn
3d41.ulp ULP cho phiên bản Eagle 4.1 hoặc cao hơn
3dfunc.ulp Một vài chức năng cho 3d.ulp 
3dpack.dat Tập tin cấu hình cho chương trình
3dconf.dat Tập tin cấu hình do người dùng định nghĩa (mặc định rỗng) 
3dlang(_x).dat Tập tin ngôn ngữ tiếng Đức, X là tên ngôn ngữ(hoặc là ngôn ngữ khác) 
3dcol(_x).dat Tập tin sơ đồ màu sắc (hoặc là ngôn ngữ khác) 
3d_cam.png Hộp thoại màu 
3d_ko.png Hộp thoại màu
Tập tin trái tim của chương trình POV-Ray (thư_mục_con/povray) 
cap.inc Macros tụ điện
capwima.inc Macros tụ Wima 
connector.inc Macros kết nối 
diode.inc Macros diodes 
ic.inc Macros IC 
qfp.inc Macros IC dạng xQFP 
resistor.inc Macros Điện trở
socket.inc Macros đế cắm cho ICs 
special.inc Macros đặc biệt
switch.inc Macros công tắc switches 
transistor.inc Macros transistors 
tools.inc Miscellaneous macros, declares etc. 
user.inc Thiết lập người dùng (mặc định rỗng) 
tex_elko.png Texture for electrolytic capacitors 
tex_elko_axial.png Texture for axial electrolytic capacitors 
Tập tin ví dụ mẫu (thư_mục_con/examples) 
MoDsMega.brd Board file for making the example 
MoDsMega.pov POV-Ray file, all options active (v1.01) 
MoDsMega.png Generated out of MoDsMega.pov 
MoDsMega.ini INI file for POV-Ray 



Để chạy Render 3D, đầu tiên trong Board Editor bạn chạy lệnh run  và duyệt tới thư mục 
Eagle3D/3d41.ulp và Ok. Nếu đây là lần đầu tiên bạn chạy ULP này thì nó sẽ hiện hộp thoại  yêu 
cầu bạn chọn ngôn ngữ giao diện, nếu bạn không biết chắc tiếng Đức thì chọn English, chờ một 
chút, một hộp thoại khác hiện ra cùng với một loại các tham số giúp chúng ta thiết lập Render 3D 
cho board của mình

     
Nếu bạn không biết cần phải chỉnh gì thì nên để mặc định. Chọn thư mục lưu đoạn Script và nhấn 
vào nút Create POV file

 Global:

   Thiết lập các tham số liên quan đến hình dạng linh kiện, vị trí lưu file, ngôn ngữ…

 Board:

  Thiết lập mặt phẳng 3D cho board, độ dày board, 

 Camera:

Thiết lập vị trí, độ chiếu của camera (dạng đổ bóng linh kiện

 Miscellaneous:

Khung hình , cỡ chữ, cỡ đi dây…

 Colors:

Màu sắc board

Sau khi đã có file script để chạy Render 3D thì tiến hành chạy chương trình POV-Ray lên.



Pov-ray là một chương trình mã nguồn mở phiên bản ổn định tính cho tới thời điểm 
(10/2009)này là 3.6, phiên bản Beta 3.7 đã có mặt cả năm nay nhưng chưa ổn định, vì vậy nếu 
có download về thì khuyên các bạn nên dùng bản 3.6 là Ok.

Pov-ray là một công cụ cho phép Render rất mạnh, được hầu hết mọi người yêu thích, có thể 
Render ra ảnh có độ phân giải rất cao và rất chi tiết (giống y chang ảnh thật), yêu cầu cài đặt 
cũng như sử dụng không cần cao quá, đối với cài đặt yêu cầu hệ thống không cao lắm (Windows 
95/98, Windows NT4/2000, hoặc cao hơn), nhưng với Card thì nên cao một chút cho hình ảnh được 
nét.

Giao diện chính của chương trình như hình dưới:

Tại giao diện chính của chương trình bạn vào File  Open file chọn file Script mới được 
tạo ra từ Eagle3D, hoặc có thể nhấp chuột vào button Open trên thanh menu của POV-Ray 
để chọn file Script



hoặc 

Lưu ý trước khi Render cần thực hiện việc kết nối tới thư viện macro cho Pov-ray trước đã.

Có một lỗi mọi người hay mắc phải do thiết lập Pov-RAY không đúng cách dẫn tới khi Render thì 
báo lỗi như hình dưới:

Lỗi này cho biết Pov-ray không tìm thấy macro chưa trong file vì không thể định dạng được macro 
là gì…

Các khắc phục lỗi này là bạn phải kết nối cho Pov-ray tới thư mục Macro của Eagle3D

Tại cửa sổ chính của Pov-ray, bạn duyệt tới Tools -> Edit master POVRAY.INI 

Sau đó một cửa sổ notepad hiện lên chứa nội dung của file mang tên POVRAY.INI, tại đây cho 
phép bạn chỉnh sửa các thông sô cho phép Pov-RAY truy cập tới thư viện thiết lập render cho linh 
kiện. Bạn hãy chỉnh sửa lại line cuối cùng để phù hợp với vị trí cài đặt thư viện povray. 

Ở đây của mình là:

Library_Path="C:\Program Files\EAGLE-5.6.0\ulp\Eagle3D\povray“

Làm xong tiến hành lưu lại như cũ

Sau khi đã nạp file Script bạn nhấn vào nút Run  hoặc phím tắt Alt+G và chờ Render 
xong. Trong quá trình Render bạn có thể chọn lại độ phân giải cho ảnh được render bằng cách 
chọn:



 
Hoặc có thể bạn nhấp vào biểu tượng INI trên thanh toolbar để chỉnh sửa lại kích thước ảnh.

Kích thước ảnh càng lớn thì việc xử lý càng lâu, khi tui render tui thường chọn độ phân giải thấp. 
Lần xuất cuối cùng mới chọn độ phân giải lớn nhất. Ờ đây chữ AA biểu thị cho độ phân giải

Bạn có thể chọn kích thước + độ phân giải mặc định bằng cách vào Browse và chọn file thiết lập 
sẵn cũng như dạng xuất ra….

Bạn cũng có thể chỉnh sửa nó bằng cách nhấp vào Edit …và chỉnh sửa theo ý muốn (cẩn thận đó)

Nhìn vào bảng dưới bạn sẽ thấy sự khác biệt giữa việc chọn độ phân giải cho Render:

Hoặc

Không chọn AA Chọn AA



Để tìm được PACKAGE_NAME của một linh kiện chúng va quay ngược lại với chương trình 
Eagle. 

Tại cửa sổ làm việc của Eagle PCB, muốn tìm Package của 1 linh kiện nào đó, chúng ta gõ lệnh 
Info hoặc nhấn vào icon hình chữ i để hiện thông tin chi tiết về linh kiện đó. Như hình trên ta tìm 
Package cho linh kiện IC10 là TO220H trong thư viện LINEAR

Chúng ta tiến hành thay thế PACKAGE_NAME bằng TO220H, như vậy ta được:

TO220H:0:1:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:MACRO_NAME(::

Bước tiếp theo tiến hành tìm MACRO_NAME cho linh kiện có PACKAGE_NAME là TO220H.

Tất cả các Macro cho các linh kiện đều nằm trong thư mục \Eagle3D\povray. Mỗi một loại linh 
kiện tương ứng với các file khác nhau.

Ví dụ: transistor thì nằm trong file transistor.inc, tụ nằm trong Cap.inc và capwima.inc, điện 
trở nằm trong resistor.inc…v.v…

Như vậy linh kiện có Package mang tên là TO220H sẽ nằm trong file transistor.inc

Một mẹo vặt là Eagle3D cung cấp cho ta một thư viện hình ảnh của các linh kiện rất hay… để xem 
trước một hình 3D của một linh kiện nào đó, bạn có thể tải file zip tại địa chỉ 
http://www.matwei.de 

http://www.matwei.de/


Để tìm tên macro bạn chọn linh kiện tương đương với dạng package và dùng notepad++ để mở 
file *.inc. tương ứng. 

ở đây mình tìm được macro cho TO220H là một hình như bên cạnh với tên gọi là TR_TO220_L. 

Bạn thay nó thành:

TO220H:0:1:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:0:TR_TO220_L(:: 

Bước tiếp theo bạn mở file transistor.inc và tìm dòng macro và thêm nó vào trong file user.inc.

Tìm trong file transistor.inc ta tìm được đoạn macro:

#macro TR_TO220_L2(value)

object{TR_TO220_L2_GRND(value)}

#end

Ta sửa thành:

#macro TR_TO220_L2(value)

Union{

object{TR_TO220_L2_GRND(value)}

}

#end

Và lưu lại là OK..mục đích việc làm này là để cho việc kết nối giữa các thư viện để render một 
cách hợp lý…ko lỗi



Sau khi làm xong tất cả các bước…tiến hành Save lại và Render lần nữa xem kết quả….

Nếu có lỗi xảy ra trong khi render hoặc render ko được như ý muốn,,,,bạn hãy tham khảo các bài 
viết nói về Eagle3D và Pov-ray trên mạng Internet thông qua bộ máy tìm kiếm Google 

Giáo trình đến đây là kết thúc. Mọi ý kiến đóng góp, xin

PM nick : coccon_den hoặc c0cc0nden

Mail : cocconden@gmail.com

Tài liệu này được viết dựa trên sự hiểu biết Eagle của các nhân cocconden, vì vậy không thể tránh 
khỏi những thiếu sót, cũng như những lỗi trong bài viết do vậy mong mọi người thông cảm, hình 
ảnh trong bài viết được lấy một phần rất ít trên mạng, còn lại là tự chụp bằng công cụ FSC

Công cụ hỗ trợ thực hiện giáo trình này là:

POV-RAY 3.6

Tiến trình xử lý cơ bản

Tiến trình xử lý phức 

mailto:cocconden@gmail.com
http://www.google.com/
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  Chương 1: MỞ ĐẦU 

Chương 1: MỞ ĐẦU 
 

Mục tiêu cần đạt được: 
Sinh viên biết cách setup được chương trình MultiSim 6.20 và OrCAD 9.2 

Kiến thức cơ bản: 
Nắm cơ bản về cách cài đặt các chương trình ứng dụng trên hệ điều hành Windows 

Tài liệu tham khảo: 
[1] Trần Hữu Danh –  Bài Giảng OrCAD 9.2 – Khoa Công Nghệ Thông Tin và Truyền 
Thông – Đại học Cần Thơ. 

[2] Trần Hữu Danh – Bài Giảng MultiSim 6.20 – Khoa Công Nghệ Thông Tin và Truyền 
Thông  – Đại học Cần Thơ. 

Nội dung chính: 

Cài đặt MultiSim 6.20 
Vấn đề này thật đơn giản, chúng ta chỉ cần 

đưa đĩa CD-ROM MultiSim-Workbench 6.20 vào 
ổ đĩa CD-ROM của máy tính của bạn, sau đó 
chọn file setup.exe trong đĩa CD này và nhấp 
double click chuột vào file setup.exe chúng ta sẽ 

thấy và lần lượt làm theo các bước sau đây: 
 
 Nếu muốn setup chúng ta click chuột vào 
Next để tiếp tục và chúng ta sẽ thấy: 
 
 Nếu muốn setup MultiSim thi chúng ta 
chọn Yes để tiếp tục 
 Chọn Next để tiếp tục update các file 
system cần thiết để cài đặt chương trình. Công 
đoạn này chỉ được thưc hiện với máy tính cài 
MultiSim lần đầu tiên. Các lần cài đặt tiếp theo 
công đoạn này sẽ được bỏ qua. Sau khi chọn Next 
để tiếp tục chúng ta sẽ thấy như sau: 

Chọn Next để cập nhật hệ thống  (điều này 

Trần Hữu Danh  Trang 1 



  Chương 1: MỞ ĐẦU 
chỉ xãy ra khi chúng ta setup MultiSim lần đầu tiên trên máy tính của bạn) 

Chúng ta đợi và sẽ thấy hộp thoại sau đây 
xuất hiện: 

Nếu ta check Yes, I want to restart ... thi 
máy tính sẽ khởi động trở lại để cập nhật lại hệ 
thống. Nếu check vào No, I will restart ... later, thì 
máy tính sẽ không khởi động lại và chúng ta sẽ 
khởi động lại khi setup xong MultiSim. Chúng ta 
nên check vào Yes để cho hệ thống cập nhật lại hệ 
thống. Sau khi máy tính tự khởi động lại xong, 
file setup.exe tự động kích hoạt trở lại và chúng ta 
tiếp tục cài đặt chương trình. (nễu file setup.exe 
không tự động kích hoạt – khi máy tính không có 
chế độ Auto Play – chúng ta phải chọn lại file 
setup.exe trong đĩa CD-ROM và nhấp double 
click lên nó). 

Chúng ta đợi một vài giây và chúng ta sẽ 

thấy hộp hội thoại xuất hiện như hình bên. 

 
Sau đó chúng ta chọn Next để tiếp tục. 

Chọn Yes để tiếp tục 
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 Chúng ta mở file readme.txt trong file seriel_number.zip để chép serial number vào, nhìn hình bên 
dưới. Sau đó Copy rồi Paste vào Serial trong hộp thoại 

User Information 

Sau khi nhập vào Serial xong, 
chọn Next để tiếp tục. 

Chúng ta chờ vài giây để kiểm tra 
xem Serial number for MultiSim 
c chúng ta chọn Next và sẽ thấy hộp 

thoại xuất hiện bên phải. 
Personal có đúng không. Sau khi kiểm tra đúng, để tiếp tụ

để 

 cài đặt 
chươn

 

Nếu chúng ta muốn setup theo mặc định của 
Multi

PE-5501-04510-

Tại đây chúng ta phải đánh vào Feature Code 
Crack chương trình nếu chúng ta biết CODE này, còn 
nếu không thì chúng ta chỉ cần chọn Next bỏ qua bước 
này để tiếp tục.(Dĩ nhiên, sau khi setup xong chương 
trình, chúng ta mới tiến hành crack để chạy chương 
trình). Sau khi nhấp chuột vào Next chúng ta thấy. 

Chọn đường dẫn tùy ý - thích hợp để
g trình, sau đó chọn Next để tiếp tục. 

Sim thì ta chọn Typical, còn nếu chúng ta muốn 
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setup chương trình tùy theo mục đích sử dụng của ngườI dùng thì chúng ta chọn Custom. Chúng ta 
nên chọn Typical rồI sau đó chọn Next để tiếp tục. 

Từ đây chúng ta có thể chọn Program 
Folder hay Existing Folder, có thể thay đổI Icon 
cho chương trình. Sau đó chọn Next để tiếp tục và 
chúng ta sẽ thấy như hình bên dưới 

 

Sau khi hoàn thành giai đoạn này, một 
hộp thoại mới xuất hiện để chúng ta setup các 

chương trình liên quan để có thể đọc được các 
hướng dẫn sử dụng và các tài liệu liên quan đến 
MultiSim sau khi setup, mà cụ thể là chương 
trình Adobe Acrobat version 4.0. Nếu máy chưa 
có chương trình Adobe Acrobat version 4.0 
hoặc đã setup chương trình này rồi nhưng với 

version thấp hơn thì chúng ta nên setup chúng để người sử dụng có thể đọc được các file Acrobat 
và dĩ nhiên chúng ta có thể không setup chương trình này nếu người dùng cảm thấy không cần 
thiết hoặc khi máy chúng ta đã setup Adobe Acrobat với version mới hơn. 

Nếu chúng ta không cần setup Adobe Acrobat thì chúng ta chon No và ngược lại. Giả sử, 
chúng ta chọn No thì sẽ có một cảnh báo xuất hiện như bên dưới 

 

 

Chọn OK để chấp nhận. Hộp thoại 
information xuất hiên, tiếp tục chọn OK. 
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Và chúng ta đã setup xong chương trình 
MultiSim 6.20. Tuy nhiên chương trình này chúng ta chưa sử dụng được, muốn sử dụng chúng ta 
còn phải trải qua một số bước bên dưới. 

 

 

 

 

 

 

Chúng ta thử mở MultiSim lên vào 
Start/programs/multisim 6/multisim  

Chưa làm gì 
được hết mà 
sao khó khăn 
quá vây ?!?! 
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Chúng ta thấy một giao diện xuất hiện bên dưới. Do chúng ta chưa Crack nên ta thấy “You 
have 0 days left”. Để sử dụng được, chúng ta nên làm theo các bước sau: 

Chúng ta ghi lại Serial Number và Signature trong hình trên vào giấy, sau đó chọn Skip để 
bỏ qua chương trình ứng dụng này. Tiếp theo 
chúng ta tiến hành chạy file crack trong dĩa CD-
ROM. 

 MultiSim KeyGen/ 
MultiSim KeyGenerator để tìm ra Release Code. 

Để Crack chương trình này chúng ta làm 
như sau: 
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1. Bước thứ nhất: Chọn file MultiSim KeyGen.exe  trên đĩa CD-ROM, sau đó cho chạy file 

này để lấy Code (code này chúng ta đã bỏ qua trong lúc setup chương trình - do chúng ta 
chưa biết code này là gì). 

 
PE-5501-04510-0045-25698 

 87464-95790 

 
 
 
 
 
 
 
 
 

Lấy serial number trong file readme.txt hoặc lấy serial number và Signature trong giao diện 
của MultiSim để ghi vào KeyGenerator, sau đó nhấp chuột Generate để tạo ra Replease Code. 

 

Ta sẽ lấy dược Replease Code 
là:313645180659. 

 

 

 
2. Bước thứ hai: 

Sau đó ta lấy Replease Code này để Crack MultiSim. Cách Crack được thực hiên như sau: 
Mở MultiSim từ menu Start của Window để chạy hay từ Icon trên desktop của màn hình, ta thấy 
một giao diện như sau xuất hiện 

 

 

 

 

 

 

 

 

 

 Sau đó nhấp chuột vào nút Getting a release code để tếin hành ghi Replease code 
là:313645180659  vào Release Code. 

Sau khi ta nhập code vào Release Code ta tiếp tục nhấp chuột vào Register release code để 
crack. 
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 Sau đó ta có thể vào MultiSim để vẽ mạch mô phỏng và ta sẽ thấy giao diện thiết kế của 
MultiSim như sau: 

Switch 
On/Off

Giao diện thiết kế 
mạch điện mô 

phỏng 

Thư viện 
kinh kiện 

Các dụng cụ đo - 
công cụ quan sát 

 
Good Luck ! 
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Cách cài đặt OrCAD 9.2 
Để setup OrCad 9.2 chúng ta hãy làm theo các bước sau đây: 
 
Chọn file setup.exe từ đĩa CD-ROM, 

double click vào và thấy như hình bên dưới.  
 
 
 
 
 
 

Đợi vài giây chúng ta sẽ thấy hộp 
thoại mới xuất hiện như hình bên dưới, đây 
chỉ là lời cảnh báo khuyên chúng ta nên exit 
các phần mềm diệt virus đang chạy hay 
đang ở chế độ Enable Auto – Protect, nếu 
chúng ta không thực hiện đúng như lời cảnh 
báo thì trong khi setup chương trình OrCad 
có thể xảy ra lỗi không mong muốn. Click 
vào OK để thực hiện tiếp tục công việc 
setup. 
 
 
 
 
 
 
 
 
 Chọn Next để tiếp tục Chọn Yes để tiếp tục  

 

Nếu sử dụng cho Personal Computer thì chọn là Stadalone Licensing và ngược lại. 
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 Chọn Next để tiếp tục  Đánh Key Code vào và chọn Next 

 Đánh Authorization Code và chọn Next Điền v

a 
b 
e 
f 
g 
h 
i 
j 
k 

111111111111111

17 con 
số 1 

Chọn Yes để tiếp tục Chọ
 

Nếu chúng ta chọn Typical thì chúng ta xem như setup các thành phần chung của OrCad, tuy 
nhiên chúng ta có thể chọn Custom để setup vừa đủ các ứng dụng cần dùng (điều này sẽ làm ít tốn 
kém dung lượng đĩa cũng như bộ nhớ), bên cạnh đó chúng ta cũng có thể thay đổi đường dẫn hoặc 
Destination Folder 
 
 Chọn Next để tiếp tục Chọn Next để tiếp tục  
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 Chọn Yes để tiếp tục 

 
Sau khi chọn Yes thì một thông báo yêu cầu setup Adobe Acrobat version 4.05 để có thể đọc 

được các file Acrobat sau khi setup OrCad sinh ra. Nếu máy chúng ta đã có setup Acrobat với 
version mới hơn hoặc chúng ta không qua tâm đến vấn đề này thì chúng ta không cần phải setup. 
Để bỏ qua không setup Acrobat, chúng ta đóng thông báo đó lại, nếu chọn OK có nghĩa là chọn 
setup Acrobat. Vf cuối cùng là chúng ta đã setup xong OrCad 9.2.  

Để sử dụng được phần mềm này chúng ta phải Crack, điều này thì rất đơn giản hơn nhiều so 
với OrCad 9.1, Chúng ta hãy tiến hành tuần tự theo các bước bên dưới 
 
 
  Chọn Finish để hoàn thành 

 
 Chọn file crack PDXOrcad.exe trong đĩa CD-ROM để crack chương trình  
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 Chọn  Directory chứa thư mục OrCad trong ổ đĩa cứng sau đó chọn Apply 

 

 
 

Khi chúng ta chọn Directory đúng 
với thư mục chúng ta đã cài đặt 
OrCad thì sau khi chúng ta chọn 
Apply xong sẽ xuất hiện câu thông 
báo “Fixed Patch Finish – Success: 
All patches applied” như hình bên 
là chúng ta đã setup thành công 
chương trình OrCad 9.2. 
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Chưa học mà 
cảm thấy rắc 
rối quá ?!?!
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Chương 2:    MULTISIM 6.20 VÀ ỨNG DỤNG 
VÀO MÔ PHỎNG MẠCH ĐIỆN 

 
 

 
Mục tiêu cần đạt được: 

MultiSim 6.20 và ứng dụng vào mô phỏng mạch điện. Giới thiệu tổng quan cho 
sinh viên về phần mềm MultiSim và hướng dẫn cho sinh viên vẽ các mạch điện ứng 
để mô phỏng và cách sử dụng các công cụ hổ trợ Instruments của MultiSim.

Kiến thức cơ bản: 

Sinh viên phái có kiến thức về các môn chuyên ngành như sau: 
                     -Kỹ Thuật xung 
                       -Kỹ thuật số 
                       -Lý thuyết mạch 
                       -Link kiện điện tử 
                       -Mạch điện tử (1 +2) 
                       -Kỹ thuật vi xử lý và điều khiển 

1. Có kiến thức cơ bản về tin học, đặc biệt là hệ điều hành Windows 

Tài liệu tham khảo: 

[1] Nguyễn Minh Luân, Nguyễn Trung Lập – Giáo trình Thực tập Kỹ Thuật Số – 
Khoa Công Nghệ Thông Tin  và Truyền Thông – Đại học Cần Thơ – 2003 
[2] Trần Hữu Danh –  Bài Giảng OrCAD 9.2 – Khoa Công Nghệ Thông Tin và 
Truyền Thông  – Đại học Cần Thơ – 2003 
[3] Trần Hữu Danh – Bài Giảng MultiSim 6.20 – Khoa Công Nghệ Thông Tin và 
Truyền Thông  – Đại học Cần Thơ – 2003 

Nội dung chính: 
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I) Giới thiệu giao diện MultiSim 
I.1. Các phần tử cơ bản 

Giao diện người sử dụng của MultiSim bao gồm các phần tử cơ bản sau: 

Cửa sổ làm 
việc của 

MultiSim 

Lựa chọn cơ 
sở dữ liệu 

Các 
linh 
kiện 
mẫu 

Switch Mô 
Phỏng

Thiết kế mô phỏng

Công cụ 
mô phỏng 

Menu 

Thanh công 
cụ hệ thống 

Thanh 
trạng thái

 
 Menu: gồm các cử sổ ứng dụng, ở đó bạn có thể tìm thấy các lệnh của tất cả các 
hàm 

 Thanh công cụ hệ thống  (System toolbar): có các nút thực hiện các chức năng 
chung như tạo một mạch điện mô phỏng mới, mở một mạch điện mô phỏng đã tạo 
trước đó có trên đĩa … 

Thanh thiết kê mô phỏng (MultiSim Design Bar): là một phần tích hợp của MultiSim, chi tiết được 
giải thích rõ hơn ở phần bên dưới. 

 “In Use” list liệt kê tất cả các linh kiện được sử dụng trong mạch hiện tại, điều này 
giúp chúng ta có thể dễ dàng sử dụng lại các linh kiện. 

 Các linh kiện mẫu (Component toolbar) gồm các mẫu linh kiện, ta có thể mở 
các nút để lấy các linh kiện cùng họ được liệt kê trong bảng. 
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 Cửa sổ  làm việc hay cửa sổ  thiết kế  (Circuit windows) nơi đặt các linh kiện 
của mạch thiết kế. 

 Thanh trạng thái (Status  line) hiển thị trạng thái hoạt động của mạch và mô tả 
linh kiện mà con trỏ chỉ đến. 

I.2. Thanh thiết kế (Multisim Design Bar) 
 Thanh thiết kế là phần trung tâm của Multisim, nó cho phép ta dễ dàng thâm nhập 

vào các hàm phức tạp được cung cấp bởi chương trình.  
 

  Nút Component Design Bar được chọn mặc nhiên, dùng để chọn các linh kiện 
đặt vào cửa sổ mạch thiết kế. 

  Nút Component Editing Design Bar cho phép chúng ta định nghĩa các linh 
kiện  trong Multisim hoặc thêm vào các phần tử. 

  Nút Instrument Design Bar dùng để đưa vào mạch mô phỏng các máy đo và ta 
có thể xem các kết quả mô phỏng trên chúng. 

  Nút Simulate Design Bar cho phép bắt đầu, kết thúc và tạm dừng việc mô 
phỏng. 

  Nút Analysis Design Bar chọn các công cụ phân tích mạch. 

  Nút Postprocessor Design Bar dùng thực hiện các tính tóan xa hơn dựa trên 
các kết quả của quá trình mô phỏng. 

  Nút VHDL/Verilog HDL Design Bar cho phép làm việc với mô hình VHDL 
(Không có trên tất cả các version). 

  Nút Reports Design Bar dùng để in các báo cáo về mạch điện đang mô phỏng 
(giá thành linh kiện, danh sách các phần tử, chi tiết về các linh kiện. 

 Nút Transfer Design Bar dùng để giao tiếp và xuất ra các chương trình khác, như 
Ultiboar, cũng như từ Electronics Workbench. Chúng ta cũng có thể xuất các kết quả 
mô phỏng đến các chương trình như MathCAD và Excel. 

 

II.  Điều chỉnh giao diện của MultiSim 
Chúng ta có thể điều chỉnh bất cứ các tùy chọn của giao diện Multisim bao gồm các 

thanh công cụ, màu trên mạch mô phỏng, kích thước giấy, hệ số phóng đại, thời gian ghi tự  
động, tập ký hiệu (dạng ANSI hoặc DIN) và cài đặt máy in. Ta có thể đặt tùy chọn và các 
tùy chọn này được ghi lại cho từng mạch riêng lẻ, chẳng hạn như màu của mạch này khác 
với mạch kia. Ta cũng có thể có quyền đặt các phần tử một cách riêng biệt ( ví dụ như thay 
đổi màu của linh kiện từ đỏ sang cam). 

Để thay đổi mạch hiện tại, ta click chuột phải trên của sổ mạch điện và chọn mục nào 
cần thay đổi từ  menu kéo xuống. 
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II.1. Điều khiển việc hiển thị mạch hiện hành 
Ta có thể điều khiển cách hiển thị mạch và các phần tử xuất hiện trên màn hình. 
Để điều khiển hiển thị mạch hiện hành click chuột phải trên cửa sổ mạch và chọn từ 

menu kéo xuống những chi tiết sau: 
 Grid Visible (click để tắt hoặc mở) 
 Show Title Block and Border (click để tắt hoặc mở). 
 Color  
 Show hiển thị các chi tiết của linh kiện, ví dụ như hiển thị nhãn, tên của nút, giá trị của 

linh kiện ... 

II.2. Cài đặt mặc nhiên cho người sử dụng 
Ta có thể đặt cấu hình mặc nhiên để hiển thị cửa sổ mạch mô phỏng theo ý muốn …. 
Để đặt cấu hình mặc nhiên của người sử dụng ta chọn Edit/User Preferences. Màn 

hình User Preference có dạng Hình II.1: 

Hình II.1 

Trong cửa sổ này, chọn phím mong muốn. 
Chẳng hạn, để đặt nhãn và màu được sử dụng 
click Circuit tab. Để định nghĩa lưới, viền giấy 
và tên khối được hiển thị click Workspace tab. 
Chú ý chúng ta sẽ không thấy kết quả của sự lựa 
chọn này cho đến khi bạn tạo một file mạch 
mới. 

II.3. Các tuỳ chọn khác 
Ta cũng có thể đặt giao diện bằng cách 

biểu diễn hoặc dấu, di chuyển đến một vị trí 
mới. 
System toolbar 
Zoom toolbar    
Design Bar 
“in use” list 
Database selector   

Những thay đổi này tác động lên tất cả các mạch ta đang làm việc. Sự di chuyển hay 
sửa đổi kích thước các phần tử sẽ trở lại vị trí và kích thước ban đầu khi ta mở một mạch 
mới. 

Cuối cùng, ta có thể sử dụng menu View để hiển thị hoặc dấu các phần tử khác nhau 
trên giao diện. 

III.  Thiết kế mạch mô phỏng 
Trong phần này mô tả cách đặt và nối các phần tử trong mạch mô phỏng. Bước đầu 

tiên là chọn các linh kiện mà ta sử dụng, đặt chúng vào cửa sổ mạch thiết kế ở những vị trí 
và hướng mong muốn, nối dây chúng lại với nhau, và chuẩn bị những thứ khác cho việc 
thiết kế. 
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Để đơn giản, ta sẽ thiết kế mạch Schmitt Trigger đơn giản. Sau khi thực hiện xong 

các bước ta sẽ có mạch điện như  Hình II.2 

III.1. Tạo tập tin mạch mô phỏng 
Để thiết kế một mạch điện mô phỏng, ta chạy chương trình Multisim (click double 

click chuột vào biểu tượng Multisim trên desktop của màn hình window hay vào Menu 

có màu, kích thước và các tuỳ chọn hiển thị dựa sự trên cài đặt user preference của lần 
trước đó. Ta có thể thay đổi các tuỳ chọn này cho thích hợp bằng cách vào menu kéo 
xuống như  được mô tả ở phần trước 

 

Start). Multisim sẽ tự động mở một file mạch trống để ta thiết kế. Cửa sổ mạch thiết kế sẽ 

Hình II.2 

III.2. Đặt các linh kiện vào mạch 

   Bây giờ ta đã sẵn sàng đặt các linh kiện vào mạch thiết kế. Multisim cung cấp 
cho ta 3 l

ng cụ linh kiện 

ớp cơ sở dữ liệu của các linh kiện (‘Multisim master’, ‘user’, và ở một vài version 
là ‘corporate libray’). Với mục đích hướng dẫn sử dụng, chúng ta chỉ quan tâm đến lớp 
‘multisim’ là lớp các linh kiện đi cùng với Multisim. Muốn rõ hơn ta có thể tham khảo 
Multisim User Guide. 

III.2.1. Thanh cô

    Mặc nhiên ta có thể thấy thanh công cụ (Component Design Bar) ở giao diện 
của Multisim. Nếu không thấy, click vào nút Component từ Design Bar. 
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Các linh kiện ta cần sử dụng để thiết kế được phân loại trong các nhóm logic đặc 

trưng cho tính chất của loại linh kiện, mỗi nhóm được ký hiệu bởi một nút trên thanh linh 
kiện. Khi ta click vào các nút này, họ các linh kiện sẽ xuất hiện để ta chọn như  Hình II.3. 

Hình II.3 

Chú ý: Nếu ta click chuột vào nút linh kiện, nhóm các linh kiện này sẽ hiển thị và giữ 
ở đó cho đến khi ta đóng lại. Trong khi nhóm các linh kiện được hiển thị ta có thể di 
chuyển nó đến bất nơi đẩu trên màn hình bằng cách click và giữ trên đầu thanh và kéo đến 
vị trí mới cho tiện sử dụng. 

III.2.2. Đặt linh kiện đầu tiên 
Phần này giải thích cách đặt linh kiện bằng thanh linh kiện. Mặc khác ta có thể sử 

dụng menu Edit/Place Component  khi chúng ta không chắc chắn nó nằm ở khay linh 
kiện nào.  

III.2.2.1. Đặt linh kiện đầu tiên 
Bước 1: đặt nguồn pin (nguồn pin 12Volt) 
 Click vào khay linh kiện chứa nguồn. Một nhóm các nguồn xuất hiện như Hình II.4 

 
Chú ý: Di chuyển con trỏ trên khay linh kiện để 
xem tên của nó. 

Hình II.4 

   Click chuột vào nút DC Voltage Source. Con trỏ sẽ 
thay đổi biểu tượng để chỉ ra phần tử vừa được chọn đã 
sẵn sàng để đặt vào trong cửa sổ vẽ mạch mô phỏng giống 
Hình II.5. 

                                             
                                            

Hình II.5
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 Di chuyển đến góc trên bên trái của cửa sổ mạch thiết kế, nơi ta muốn đặt nguồn. 

Click chuột vào nơi ta cần đặt bộ 

nguồn sẽ xuất hiện như Hình II.6. 
Hình II.7 

Hình II.6 

 
Chú ý: Các ký tự mô tả linh kiện 

xuất hiện kèm theo. Ta có thể dấu chúng 
bằng tuỳ chọn Show từ menu kéo xuống 
khi click phím phải chuột vào màn hình 
thiết kế. 

 
Bước 2: Thay đổi giá trị của nguồn pin 

Mặc nhiên, nguồn Pin là 12V, tùy theo mạch điện thiết kế cần các nguồn khác nhau, 
ta có thể dễ dàng thay đổi giá trị này. 

 Click double click vào pin. Màn hình hiển thị các tính chất của pin xuất hiện, với 
phím Value có dạng Hình II.7. 

Chú ý: Để biết thêm chi tiết về các phím này ta tham khảo ở Multisim User Guide. 
III.2.2.2. Đặt phần tử kế tiếp 
Bước 1: đặt điện trở đầu tiên 

   Click con trỏ vào nút khay linh kiện Basic, ta click điện trở (Resistor) khi nhóm các linh 
kiện xuất hiện. Màn hình hiển thị các 
loại điện trở xuất hiện như      Hình 
II.8 

 

Màn hình này hiển thị bởi vì 
nhóm các điện trở chọn có chứa 
nhiều các linh kiện thực, các linh 
kiện mà ta có thể mua được. Nó 
hiển thị tất cả các điện trở có thể có 
từ cấp cở sở dữ liệu “Multisim 
master”. 

Chú ý: Browser không xuất 
hiện như khi ta chọn pin ở bước 
trước, bởi vì nguồn thế DC là linh 
kiện ảo (ta có thể đặt một giá trị bất 
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kỳ), vì thế không cần phải chọn từ Browser. 

 Kéo chuột vào thanh cuộn của Component List để tìm điển trở 1.0 kohm. 
Chú ý: Để thực hiện nhanh hơn thay vì phải kéo rê chuột, ta có thể đánh vào tên của linh kiện. 

 Chọn điện trở 1.0 kohm và click OK hoặc click double click trên giá trị linh kiện. 
Con trỏ sẽ xuất hiện ở cửa sổ thiết kế với bóng của điện trở. 

Di chuyển điện trở đến nới cần đặt và click chuột. 
Chú ý rằng màu ký hiệu điện trở khác với nguồn pin giúp ta phân biệt linh kiện thực. 
Bước 2: Xoay điện trở 
Để thuận tiện trong việc nối dây ta cần xoay điện trở  với chiều 

thích hợp. 
Click nút phải chuột trên điện trở. Menu kéo lên xuất hiện. 

 Chọn 90 CounterCW từ menu. Ta có kết quả  như hình bên 
Nếu muốn ta có thể di chuyển nhãn bằng cách click giữ và kéo nó đến vị trí 
thích hợp, hoặc ta có thể sử dụng các phím mũi tên trên bàn phím để di chuyển nhãn trên từng ô 
lưới. 

R4 1.0kohm

Bước 3: Thêm vào các điện trở khác 
Thêm vào điện trở 30 kohm như cách trên, ta chú ý điện trở  này có ký hiệu nhận dạng là “R3” để 
chỉ ra điện trở thứ ba được đặt. 
Tiếp tục dặt điện trở và các tụ điện khác và quay nó. 

Bây giờ ta nhìn vào mục “In Use” nó sẽ liệt kê tất cả các linh kiện ta đã sử dụng. Vì 
vậy ta có thể sử dụng lại các linh kiện này bằng cách click chuột vào nó. 

Ta có mạch như  Hình II.9 
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Bước 4: Ghi lại sự thay đổi 
Để ghi lại sự thay đổi cũng như tập tin đang sử dụng, ta chọn File/Save As . 

 III.2.3. Đặt các phần tử khác 
Ta tiếp tục đặt các linh kiện khác 

Oscilloscope từ nhóm Instrument 
IC555  từ thư viện linh kiện trong nhóm MIXED. 
Các tụ 10nF, 2μF từ thư viện linh kiện trong nhóm Basic. 
Mass dùng cho các linh kiện như tụ, IC, …  
Một nguồn xoay chiều dạng hình Sin có biên độ 12 Volt/1Khz từ  thư viện linh kiện trong trong 
nhóm VCC. 

Chú ý: Ở mạch chứa linh kiện số phải có nguồn VCC và một mass số  đặt trong cửa 
sổ mạch thiết kế. Multisim sẽ sử dụng hai linh kiện này để tạo nguồn cung cấp cho các linh 
kiện số. 

Sau khi lấy các linh kiện ta có mạch như Hình II.10 
 
 

 

 

 

 

 

 

 

 

 

 Hình II.10 

Chú ý: Đừng quên save lại sự thay đổi bằng File/Save hay dùng tổ hợp phím Ctrl+S 

III.3. Thay đổi nhãn và màu của các linh kiện và các nút 
Để thay đổi nhãn của bất kỳ linh kiện cho riêng mình ta thực hiện như sau: 

Click double_click trên linh kiện. Màn hình đặc tính của linh kiện xuất hiện. 
Click chuột vào lớp Label và nhập vào hay định nghĩa 
nhãn (nhãn được nhập vào là các ký tự  và số, không có 
ký tự đặc biệt hay khoảng trống). 
Để xóa sự thay đổi này, click Cancel. 

Để đổi màu click phím phải chuột trên linh kiện 
muốn đổi và chọn Color từ menu Pop up như Hình 

Hình II.11 
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II.11. Chọn màu mong muốn từ màn hình hiện ra cho chúng ta lựa chọn tùy thích 

III.4. Nối dây các linh kiên 
Tất cả các chân linh kiện đều có nối đến chân các linh kiện khác. Trong Multisim, 

chúng ta có thể chọn cách nối dây tự động hay bằng tay. Nối dây tự động nghĩa là 
Multisim tự  động đi dây và nối bằng  đường dẫn tốt nhất giữa các chân mà ta đã chọn. Nối 
dây bằng tay có nghĩa là ta điều khiển đường dẫn dây nối trên mạch điện. Chúng ta có thể 
kết hợp cả hai phương pháp trong việc đi dây, ví dụ bắt đầu nối dây bằng tay và để cho 
Multisim tự nối nối phần còn lại. 

III.4.1. Nối dây tự động 
Chúng ta bắt đầu nối để liên kết các thành phần của linh kiện lại với nhau thành một 

mạch kín. Công việc này rất đơn giản, chúng ta chỉ cần Click chuột vào chân của linh kiện 
và giữ chuột rồi kéo rê chuột đi đến điểm chân linh kiện cần liên kiết và cứ thế chúng ta lần 
lượt nối các điểm lại với nhau cho hết và thành một mạch điện hoàn chỉnh cần mô phỏng. 

Và một điều đáng nói ở đây là chúng ta có thể thay đổi màu sắc của các đường dây 
nối vào các thành phần linh kiện khác nhau nhằm phân biệt các đường cắt giao nhau cũng 
như màu sắc của tín hiệu ngõ vào ngõ ra hiển thị lên các thiết bị quan sát như Oscilloscope,  
Multimeter, LogicAnalyzer… để cho chúng ta dễ quan sát và phân biệt chúng. 

Chú ý: Mặc nhiên dây nối có màu đỏ, ta cũng có thể đổi màu dây giống như đổi màu 
linh kiện. 

Để xóa một dây, ta click chuột phải vào nó và chọn Delete từ menu kéo lên, hoặc 
chọn nó rồi ấn phím DELETE. 

III.4.2. Nối dây bằng tay: 
Multisim không cho ta nối 2 dây vào một chân để tránh lỗi có thể xảy ra. Vì vậy 

chúng ta cần phải bắt đầu không phải từ chân 2 hoặc 6 của U1 nhưng từ dây nối giữa 
chúng. Để nối dây từ giữa dây này với dây kia, ta phải thêm vào một mối nối. 
Chọn Edit/Place Junction. 
Chuyển nối đến vị trí mong muốn và nối dây giữa ngõ vào của U1 và click chuột. 
Điểm nối xuất hiện có dạng sau:                        

 Trong quá trình đi dây, ta muốn dây dừng và cố định ở một điểm nào ta click chuột. 
Cứ như thế dây nối sẽ đi theo đường ta muốn. 
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Kết quả có mạch điện cần vẽ như Hình II.12 

Hình II.12 

III.5.  Thêm chữ cho mạch điện thiết kế 
Multisim cho phép ta thêm vào một khối nhãn và Text để chú thích cho mạch. 

 Để thêm vào nhãn, ta chọn View/Show Title Block and Border. Nhãn khối sẽ 
xuất hiện ở đầu trên bên phải của mạch. 

 Để soạn thảo nhãn, chọn Edit/Set Title Block. Nhập vào đoạn ký tự và click 
OK. 

Để thêm vào ký tự: 
• Chọn Edit/Place Text. 

Click chuột vào nơi cần đặt đoạn text. Hộp chứa đoạn text xuất hiện. 
Đánh vào đoạn text, ví dụ “My tutorial circuit” 
Click bất cứ nơi đâu trên mạch, đoạn text sẽ xuất hiện. 

 Để xoá đoạn text bằng cách chọn đoạn text cần xóa và ấn phím DELETE hoặc 
click phím phải chuột vào đoạn text cần xóa và chọn Delete từ menu kéo lên và 
click DELETE. Tương tự ta có thể chọn màu cho đoạn text. 

Để sửa đổi nội dung đoạn text, click double-click vào hộp text và thay đổi nội dung. Click bất kỳ 
nơi đâu trên mạch để ngưng soạn thảo. 
Để di chuyển ta click chuột vào hộp text và kéo nó đến vị trí mới. 

IV.  Các chức năng và cách sử dụng công cụ mô phỏng 

Multisim cung cấp một số các công cụ ảo. Chúng ta sử dụng các công cụ này để đo 
lường các thông số của mạch. Các công cụ này gần tương ứng với các công cụ trong phòng 
thí nghiệm. Chúng thật sự là một phương tiện tốt và dễ dàng nhất để ta có thể quan sát đo 
lường và xem kết quả mô phỏng. 
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    Các công cụ này nằm ở nút Instruments ở thanh Design Bar. Khi bạn click 
chuột vào nút này, thanh các công cụ này xuất hiện như Hình II.13. Mỗi một nút là một 
công cụ. 
        
 
 
 
 
 
 
 
 
 
 
 
 
                                                            
 
 

Các công cụ ảo này có hai chức năng: có thể xem như là một máy phát hoặc có thể 
xem như dụng cụ đo / quan sát / hiển thị. 

 

IV.1. Thêm các công cụ vào mạch 

  Click vào nút Instrument ở thanh Design Bar. Thanh các công cụ xuất  
hiện. 

 Click chọn một trong các công cụ mà bạn cần dùng. Con trỏ sẽ xuất hiện với 
bóng của công cụ tương ứng. 

 Di chuyển con trỏ đến nơi cần đặt và click chuột. 
 Biểu tượng của công cụ xuất hiện trên mạch. 
 Nối dây của công cụ vào mạch điện cần mô phỏng. 
 Nếu cần thiết, kéo biểu tượng và đặt lại cho đúng vị trí cần đặt. 
 Điều chỉnh lại các thông số trên các nút điều khiển của công cụ 
 Để loại bỏ một công cụ bất kỳ nào đó, ta chỉ cần chọn công cụ cần Delete tương 
ứng và ấn phím Delete, mọi đường kết nối giữa Instrument và mạch điện cần mô 
phỏng sẽ bị xóa. 

 Sau khi chỉnh sửa các thông số của các công cụ quan sát như  Oscilloscope, 
Voltmet …., các giá trị của linh kiện trong mạch điện  … bây giờ chúng ta tiến 
hành mô phỏng mạch điện chúng ta đã thiết kế. 

Giả sử chúng ta có một ví dụ mà trong đó chúng ta cần thêm một máy hiện sóng - 
Oscilloscope vào một mạch điện để quan sát dạng sóng ngõ ra của mạch. (chúng ta cũng 
làm tương tự với các công cụ khác). 

Function Generator Logic Converter

Logic Analyzer Bode Plotter Multimeter Wattmeter 

Oscilloscope Word Generator 

Hình II.15. 
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Bước 1: Thêm vào máy hiện sóng. 

  Click vào nút Instrument ở thanh Design Bar. Thanh các công cụ xuất  
hiện. 

  Click vào nút oscilloscope. Con trỏ sẽ xuất hiện với bóng của máy hiện sóng. 
Di chuyển con trỏ đến nơi cần đặt và click chuột. 
Biểu tượng của máy hiện sóng xuất hiện trên mạch. 
Bây giờ ta nối dây của máy hiện sóng vào mạch. 

Bước 2: Nối dây máy hiện sóng đến mạch 
Click chuột vào điểm A trên biểu tượng oscilloscope và kéo dây nối đến điểm mong muốn. 

 Click chuột vào điểm B trên biểu tượng oscilloscope và kéo dây nối đến điểm 
mong muốn.         

Giả sử chúng ta thiết kế để mô phỏng đèn LED on/off liên tục với mạch điện đơn 
giản như  Hình II.16.  Chúng ta hãy thử mô phỏng mạch điện trên để quan sát LED và xem 
dạng sóng ngõ vào ra thông qua Oscilloscope. 
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2
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2N2222A
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G
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0 0

0
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7
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Hình II.16. 

                  

IV.2.  Cài đặt cấu hình công cụ 
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Mỗi công cụ ảo của Multisim bao gồm một số tuỳ chọn của riêng nó dùng để điều 

khiển và hiển thị. 

Hình II.17 

 IV.2.1.  Oscilloscpoe (Dao động nghiệm) 
Để mở oscilloscope, double-click vào biểu tượng oscilloscope. Nó có dạng Hình II.17 
Phần time base trên màn hình điều khiển tỉ lệ của chiều ngang oscilloscope hay trục x 

khi so sánh biên độ đối với thời gian (Y/T) 
Ground terminal: Mass đầu cuối 
Trigger terminal: Trigger đầu cuối 
A channel terminal: Kênh A đầu cuối 
B channel terminal: Kênh B đầu cuối 
Graphic display: Hiển thị đồ họa 
Reverse: Đảo màu nền của màn hình hiển thị đồ họa 
Save:  Lưu kết quả dưới dạng file Ascii 

Để có thể xem được kết quả hiển thị, chúng ta nên chú ý một điều là chỉnh timebase tỉ 
lệ ngược với tần số, tần số càng cao thì timebase càng thấp. 

Để đặt timebase cho mạch đèn LED on/off liên tục ở mạch điện ví dụ ở Hình II.16. 
Chúng ta nên đặt các giá trị cho Oscilloscope như sau hay như trên Hình II.18 
Đặt scale là 20μs/Div để có thể hiển thị tần số tốt nhất. 

 Đặt scale kênh A là 5V/Div và click DC. 
 Đặt scale kênh B là 5mV/Div và click DC. 
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Bây giờ công cụ đã 
được đặt đúng cấu hình 
với mạch thí dụ, ta có thể 
mô phỏng và quan sát kết 
quả trên Oscilloscope. 

 

  Để mô phỏng 
mạch, click vào nút 
Simulate trong thanh 
Design Bar, từ menu kéo 
lên ta chọn Run/Stop. 

Hình II.18 

Để thấy kết quả từ 
oscilloscope, nếu cần thiết 
double-click vào biểu 
tượng của oscilloscope để 
mở công cụ hiển thị. 

Nếu ta thay đổi 
những cài đặt như đã được 
nói ở phần trước, ta có thể 
có kết quả như sau: 

    
Để dừng mô phỏng, click vào nút Simulate ở thanh Design Bar, và từ  menu kéo lên 

ta chọn Run/Stop một lần nữa. Hoặc chúng ta có thể click chuột 
vào biểu tượng hình bên để điều khiển việc mô phỏng  

 
 
Chú ý: Nếu kết quả không hiển thị giống như trên. Để sửa lại ta chọn Simulate/ 

Default Instrument Setting . Click Maximum Time Step (TMAX) và nhập vào 1e –4. 
chọn  Accept.  

IV.2.2.  Bode plotter (máy phân tích tần số cộng hưởng) 
 

Hình II.19 
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Bode plotter dùng để phân tích tần số cộng hưởng của mạch điện, tạo ra một đồ thị 
cho đáp ứng tần số của mạch điện và được dùng rất hiệu quả trong việc phân tích các mạch 
lọc. Máy có thể dùng để đo tỷ lệ biên độ tín hiệu (độ lợi tín hiệu tính bằng dB) hoặc độ 
dịch pha (tính theo độ). Khi sử dụng trong mạch điện thiết kế thì máy đo sẽ tự kích hoạt tần 
phổ, tạo ra một dãy tần số trên một phổ tần đặc biệt. Tấn số của bất kỳ nguồn AC trong 
mạch đều không ảnh hưởng đến Bode plotter, nhưng trong mạch vẫn phải có nguồn AC 
cung cấp ở một vài chổ. Tuy nhiên, các  tín hiệu AC được tạo ra thì có ảnh hưởng nhiều 
đến Bode plotter. 

 Magnitude or Phase (độ lớn hoặc pha) 
•    Dùng thiết lập để đo tỷ lệ biên độ giữa hai điểm đo thử (lợi suất điện áp theo 

dB) hoặc độ dịch pha (tính theo độ)   tương ứng với tần số ( tính theo Hz) 
•    Đo độ lớn là đo tỷ lệ độ lớn giữa hai điểm V+ và V-. Cả độ lớn và độ dịch pha 

sẽ được vẽ tương ứng với tần số. Nếu V+ và V- là những điểm riêng lẻ trên mạch 
thì: 

- Kết nối ngõ vào và ngõ ra dương của đường tín hiệu trên mạch vào V+ và 
V- của máy Bode plotter 

- Kết nối Mass của ngõ vào và ngõ ra của đường tín hiệu trên mạch điện vào 
Mass của máy Bode plotter. 

 Vertical and Horizontal Axis Setting ( thiết lập tục dọc và ngang) 
• Chọn Log và Lin để quan sát thang đo trên trục x và y theo Log10 hoặc 

tuyến tính. Khi giá trị được so sánh có khoảng quá lớn thì người ta sử dụng 
Log ( tổng quát khi nhân 2 tần số). Chẳng hạn, khi đo độ lợi điện thế của một 
tín hiệu thì giá tri dB được tính như sau: dB = 20*log(Vout/Vin). 

• Có thể chuyển từ Log sang Lin (tuyến tính) khi mạch không được kích hoạt 
độ lợi 

 Horizontal Axis Scale (tỷ lệ trục dọc). 
• Trục ngang (trục x) luôn luôn hiển thị tần số. Tỷ lệ của nó được xác định bởi 

việc thiết lập I (bắt đầu) và F (kết thúc). Khi phân tích kết quả tần số đòi hỏi 
một dãy tần số lớn, người ta thường sử dụng Log. 

• Chú ý: Khi thiết lập tỷ lệ trục ngang, tần số bắt đầu I phải lớn hơn tấn số kết 
thúc F. MultiSim sẽ không cho phép bạn đặt I nhỏ hơn F. 

 Vertical Axis Scale (tỷ lệ trục dọc) 
• Đơn vị và tỷ lệ trục dọc (trục y) tùy thuộc vào việc đo cái gì và Log hay Lin 

được sử dụng, ta có bảng như sau: 
Đo Sử dụng I nhỏ nhất F lớn nhất 

Độ lớn (độ lợi) Log -20dB 200dB 
Độ lớn (độ lợi) Lin 0 10e+09 

Pha Lin 7200 7200

• Khi đo độ lợi điện thế, trục dọc hiển thị độ lợi điện thế ngõ ra của mạch là 
mức điện thế. Khi dùng Log thì đơn vị là dB. Khi Lin được dùng thì trục dọc 
hiển thị tỷ lệ Vout/Vin. Khi đo Pha, trục dọc luôn hiển thị góc Pha theo độ. Bất 
chấp đơn vị, chúng ta có thể đặt giá trị của I và F cho trục ngang. 

 Readouts (quan sát giá trị đạt được) 
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• Di chuyển con trỏ dọc để quan sát giá trị về tần số và biên độ hoặc pha tại bất 
kỳ điểm nào trên đồ thị. Con trỏ dọc nằm ở cạnh bên trái màn hình hiển thị 
Bode plotter. 

• Để di chuyển con trỏ dọc: Click chuột vào các mũi tên gần phía dưới của 
Bode plotter hoặc click giữ chuột vào con trỏ dọc, sau đó di chuyển đến điểm 
trên đồ thị mà chúng ta muốn đo. Biên độ (hoặc pha) và tần số là điểm giao 
nhau giữa con trỏ dọc và đồ thị được hiển thị trong khung cạnh các mũi tên. 

IV.2.3. Distortion Analyzer (máy phân tích độ méo) 

Đặc trưng của máy này là cung cấp việc đo độ méo trong dãy tấn số từ 20 Hz đến 100 
KHz, bao gồm tín hiệu âm thanh (hạ tần). 

Hình II.20 

Các phương pháp thực hiện việc đo này là Total Harmonic Distortion (THD: hoàn toàn điều hòa 
độ méo) hoặc Signal Plus Noise and Distor tion (SINAD: cộng nhiễu và méo vào tín hiệu). Để 
thiết lập ta click vào Settings, xem Hình II.20 
Harmonic Distortion (điều hòa độ méo) 
Harmonic Distortion phát ra những tín hiệu điều hòa của tần số kiểm tra. Chẳng hạn, tín hiệu có 
tần số là 1Khz, Harmonic có thể là 2khz, 3Khz, 4Khz….. 
Một mức nhọn đột ngột có thể điều hòa, được yêu cầu điều hòa độ méo. Mạch lọc được điều chỉnh 
đến tần số kiểm tra như là 1Khz, nó sẽ loại bỏ tín hiệu có tần số 1 Khz, chỉ laọi bỏ tần số cần điều 
hòa hoặc độ méo. Việc điều hòa độ méo được đo và giá trị kết quả được so sánh với biên độ của 
tín hiệu kiểm tra. 
SINAD: Phương pháp đo này dùng để đo tỷ lệ của tín hiệu (tín hiệu thêm nhiễu và méo)/(mức 
nhiễu và méo) 

IV.2.4. Function generator (máy phát sóng) 
 

 
 
 
 
 
 
 
 
 
 

Hình II.21 
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Máy phát sóng dùng để tạo ra tín hiệu điện thế dạng sin, tam giác và vuông. Đó là một phương 
pháp thực tế và tiện lợi để cung cấp những tín hiệu kích thích cho một mạch điện. Chúng ta có thể 
thay đổi dạng sóng và điều chỉnh tấn số, biên độ và chu kỳ thao tác. Dãy tần số của máy phát sóng 
là đủ lớn để tạo tín hiệu tần số âm thanh và vô tuyến. Máy phát sóng có 3 nút +, common và – 
dùng để cung cấp dạng sóng cho mạch điện. 

 Để khảo sát một tín hiệu ta nối kết Common của máy phát với GND của mạch điện. 
Nút + cung cấp dạng sóng có biên độ dương, nút – cung cấp dạng sóng có biên độ 
âm. 

Waveform (dạng sóng): Bạn dùng chuột chọn 1 trong 3 dạng sóng Sin, tam giac và  vuông mà 
chúng ta muốn phát. 
Signal Options ( những tùy chọn của tín hiệu) 
Frequency (1 Hz đến 999 MHz): dùng để thiết lập tần số để phát. 
Duty cycle (1% đến 99%): chu kỳ thao tác, dùng đẻ thiết lập độ rộng xung trong một chu kỳ. Nó 
chỉ tác động lên dạng sóng tam giác và vuông, không thao tác động lên dạng sóng Sin. Với giá trị 
50%, biên độ trên và dưới của dạng sóng sẽ bằng nhau 
Amplitude (0 đến 999Kv): dùng để thiết lập biên độ điện thế của tín hiệu, chúng được tính từ giá 
trị DC đến đỉnh của tín hiệu. Nếu kết nối đến Commmon và + (hoặc -), giá trị đỉnh đối đỉnh của tín 
hiệu đo được sẽ bằng 2 lần biên độ của tín hiệu. Nếu kết nối đến + và -, giá trị đỉnh đối đỉnh sẽ gấp 
4 lần giá trị biên độ. 
Offset (-999 đến 999Kv): điều khiển tín hiệu DC theo giá trị thay đổi của tín hiệu AC. Giá trị 0 
(zero) đặt dạng sóng của tín hiệu theo trục x của máy hiện sóng. Một giá trị dương sẽ định mức 
DC lên, một giá trị âm sẽ dịch mức DC xuống. Những tham số thiết lập cho biên độ sẽ xác định 
đơn vị cho Offset. 
Rise time: thiết lập thời gian kết thúc, chỉ sẵn có ở dạng xung vuông. 
 
 

IV.2.5. Logic Converter (máy chuyển đổi logic) 

 

Hình II.22 

 
 
 
 
 
 
 

 Đây là một thiết bị dùng để thực hiện các việc chuyển đổi của mạch điện, nó có 8 
ngõ vào và 1 ngõ ra. Nó có thể chuyển đổi mạch điện sang bảng sự thật hoặc biểu 
thức Boolean và tạo ra một mạch điện từ bảng sự thật hoặc biểu thức Boolean: 

 Click vào các nút tròn hoặc các nhãn dưới chúng (A,B,…,H) để hiển thị các ngõ vào 
 Nhận bảng sự thật từ mạch nguyên lý: 
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• Kết nối các ngõ vào của mạch điện đến các ngõ vào của máy chuyển đổi Logic. 

• Kết nối ngõ ra của mạch điện với ngõ ra của may chuyển đổi Logic. 

• Click vào nút Circuit to Truth Table                               . Bảng sự thật của mạch 
điện sẽ xuất hiện ở màn hình hiển thị của máy chuyển đổi mức Logic. 

 Tạo và chuyển đổi bảng sự thật: Để tạo và chuyển đổi bảng sự thật ta làm như sau: 
• Click chọn số ngõ vào mà chúng ta cần (A H). vùng hiển thị dưới các ngõ vào 

sẽ hiển thị đầy đủ các trường hợp của các ngõ vào với 0 và 1 thích hợp. Giá trị 
ban đầu đặt là 0. 

• Thiết lập ngõ ra ứng với từng trường hợp các ngcx vào. Để thay đổi giá trị của 
ngoc ra, click lên nó để chọn lại giá trị cần thiết:0, 1, x. 

• Để chuyển đổi bảng sự thật thành biểu thức Boolean, click vào nút Truth Table 
to Boolean Expression                             . Biểu thức Boolean được hiển thị ở phía 
dưới của mayc huyển đổi Logic. 

• Để chuyển đổi bảng sự thật thành biểu thức Boolean đơn giản hoặc đơn giản một 
biểu thức Boolean đang tồn tại. Click vào nút Simplify                        . Việc đơn 
giản này chiếm nhiều dung lượng bộ nhớ, nếu bộ nhớ không đủ, MultiSim sẽ 
không kết thúc tác vụ và có thể bị treo máy. 

 Tạo và chuyển đổi một biểu thức Boolean: 

• Nhập biểu thức Boolean vào khung dưới của máy chuyển đổi Logic, sữ dụng các 
ký hiệu qui ước: A, B, …, H. Muốn lấy đảo các ký hiệu này ta thêm dấu nháy 
đơn sau mỗi ký hiệu, ví dụ A’ là đảo của A. 

• Để chuyển đổi Boolean thành bảng sự thật, click vào nút Boolean Expression to 
Truth Table.  

• Để chuyển đổi Boolean thành một mạch điện, click vào nút Boolean Expression 
to Circuit.  

• Những cổng logic minh hoạ cho biểu thức Boolean sẽ xuất hiện trong cửa sổ 
thiết kế mạch. Những thành phần đều được chọn nên bạn có thể di chuyển chúng 
đến những vị trí khác hoặc đặt chúng vào những mạch điện phụ. 

• Để tạo một mạch điện bao gồm mọi điều kiện của biểu thức Boolean bằng cách 
dùng toàn cổng NAND, click vào nút Boolean Expression to NAND.  
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IV.2.6. Logic Analyzer (máy phân tích mức logic) 

Logic Analyzer hiển thị các mức của 16 tín hiệu số trong mạch điện. Nó được dùng để nhận dữ 

liệu trạng thái logic và đưa ra thời gian phân tích giúp cho việc thiết kế các hệ thống lớn và chống 
xung đột. 

Hình II.23 

 16 nút tròn cạnh trái của biểu tượng ứng với những dòng ngang trên màn hiển thị 
của máy. Khi ngõ ra của mạch điện được kết nối với các nút này, nút tròn được kết 
nối sẽ hiễn thị với một chấm đen, tên và màu của nó cũng được hiển thị. 

 Khi một mạch điện được kích hoạt, máy logic Analyzer ghi những giá trị ngõ vào 
và hiển thị dữ liệu dưới dạng sóng vuông theo thời gian. Dòng trên cùng hiển thị giá 
trị cho kênh 0 (thông thường là bit đầu tiên trong một từ số), dòng kế tiếp hiển thị 
giá trị kênh 1, …. Giá trị nhị phân của mỗi bit trong một từ hiện tại được hiển thị ở 
cạnh trái của thiết bị, trục thời gian được hiển thị trên màn hình tín hiệu. Ngoài ra, 
màn hình còn hiển thị tín hiệu xung clock nội và xung clock ngoại, … 

Hai con trỏ T1 và T2 dùng để xác định tại thời điểm t1 và t2 (bằng cách di chuyển con trỏ T1 và 
T2). 

 T1-T2 là khoảng cách thời gian mô phỏng giữa t1 và t2. 
 Trong ô Clocks/Div tăng hoặc giảm giá trị để có dạng sóng dễ quan sát. 
IV.2.7. Word generator (máy phát từ) 

Trần Hữu Danh  Trang  33 



 Chương 2: MultiSim 6.20 và Ứng Dụng Vào Trong Mô Phỏng Mạch Điện 

 Sử dụng để gởi các từ số hoặc mẫu bit vào trong mạch điện để cung cấp sự kích 
thích đến mạch số. 

Hình II.24 

Nhập các từ số: 
Cạnh bên trái của máy phát từ hiển thị các dòng 8 bit các số hex, từ 00000000 đến FFFFFFFF. 
Mỗi hàng trình bày một từ nhị phân 32 bit. Khi máy phát từ được kích hoạt, một dòng các bít gởi 
song song đến các thiết bị đầu cuối tương ứng ở các nút của công cụ. 
Để thay đổi một giá trị bit trong máy phát từ, chọn số mà bạn muốn thay đổi và sau đó vào khung 
edit tại một trong các ô Hex, Ascii hoặc Binảy điều chỉnh lại số cần phát. 
Edit bắt đầu từ địa chỉ 0000 đến FFFF, địa chỉ của từ có vệt sáng. 
Current là địa chỉ của từ hiện tại. 
Initial dùng để đặt địa chỉ của từ đầu tiên được phát 
Final dùng để đặt địa chỉ của từ cuối cùng được phát. 
Frequency dùng để xác định tần số phát 

• Nếu chọn Internal thì máy phát sẽ tự phát với tần số đã đặt 
• Nếu chọn External thì bạn phải cung cấp xung clock ở bên ngoài cho máy. 
• Cycle dùng để phát tất cả các từ, sau khi phát xong nó sẽ tiếp tục phát lại 
• Burst dùng để phát tất cả các từ, sau khi phát xong thì dừng. 
• Step dùng để phát từng từ 
• Breakpoint dùng để tạm dừng và khởi động lại các dòng từ tại một từ đặt biệt. 

- Để chèn một điểm Breakpoint, trong danh sách chọn từ mà chúng ta muốn 
dừng, sau đó Click Breakpoint. 

Trần Hữu Danh  Trang  34 



 Chương 2: MultiSim 6.20 và Ứng Dụng Vào Trong Mô Phỏng Mạch Điện 
- Để loại bỏ một điểm Breakpoint, trong danh sách, chúng ta click vào điểm 

Breakpoint cần loại bỏ đang tồn tại (có dấu *), sau đó sau đó Click 
Breakpoint một lần nửa. 

- Việc sử dụng điểm Breakpoint sẽ có ảnh hưởng đến Cycle và Burst 
• Pattern dùng để ghi lại những từ mẫu hoặc phát ra những từ mẫu đã đặt trước. 

IV.2.8. Multimeter (đồng hồ vạn năng) 
 

Hình II.25 
 

 Multimeter dùng để đo điện áp, cường độ dòng điện hoặc cường độ suy hao âm 
thanh trở kháng giữa các điểm đo thử trong mạch điện (kết nối đến nut + và - của 
máy đo) 

 Bạn có thể hiệu chỉnh lại các nút điều khiẻn của máy để đo Ampere(A), Volt (V), 
Ohm, dB, tín hiệu AC hoặc DC. Điều chỉnh các giá trị cần thiết với nút lệnh Set như 
trở kháng nội vi của Volt kế và Ampere kế, riêng cường độ nội vi của Ohm kế và 
giá trị dB được áp dụng theo tiêu chuẩn. 

 Những giá trị thể hiện trên biểu tượng của máy đo trong chương trình đều đã được 
ấn định theo tiêu chuẩn của các máy đo thực tế, cho nên những giá trị đo được trong 
mạch điện không có ảnh hưởng nào đáng kể đối với mạch đang được đo thử. 

V. Các ví dụ về mô phỏng mạch điện 

V.1. Mạch mô phỏng thanh ghi dùng IC 74164 
V.1.1. Mạch ghi dịch các bit sáng dần lên và tắt hết 

Bước 1: Sinh viên hãy vẽ mạch như  Hình II.26 
Bước 2: Đóng công tắc S1 vào nguồn 5V, công tắc S5 sang vị trí phía dưới. 
Bước 3: Bậc công tắc nguồn (Simulate Switch) và quan sát các đèn hiển thị 

 
V.1.2. Mạch ghi dịch các bit sáng dần lên và tắt dần  

Bước 1: Sinh viên vẫn sử dụng Hình II.26 
Bước 2: đóng công tắc S1 sang vị trí bên dưới, công tắc S2 sang v ị trí phía dưới, công tắc S3 sang 
vị trí phía trên, công tắc S5 nối vào nguồn 5V. 

 Bước 3: Bật công tắc nguồn. quan sát ngõ ra. 
V.1.3. Mạch ghi dịch một điểm tối và một điểm sáng sang kẽ  

Bước 1: Sinh viên vẫn sử dụng Hình II.26 để thực hiện mô phỏng 
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Bước 2: Công tắc S1, S2 ở vị trí phía dưới, công tắc S3 sang vị trí phía trên, công tắc S5 nối vào 
nguồn 5V. 

 Bước 3: Bật công tắc nguồn và quan sát đèn hiển thị. 

Hình II.26 

V.1.4. M ạch ghi dịch hai điểm sáng và hai điểm tối xen kẽ nhau. 
Bước 1: Sinh viên vẫn sử dụng Hình II.26 để thực hiện mô phỏng 
Bước 2: Công tắc S1, S2 sang vị trí phía dưới, công tắc S3 sang vị trí phía trên, công tắc S4 sang 
vị trí phía dưới, công t ắc S5 nối vào nguồn 5V. 

 Bước 3: Bật công tắc nguồn và quan sát đèn hiển thị. 
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Hình II.27 

V.2. Mạch mô phỏng mạch đếm dùng IC 7493 
IC 7493 là IC đếm bốn bit nhị phân từ 0000 đến 1111, nghĩa là đếm 0 đến F đối với 

số Hex 
 
V.2.1. Mạch đếm từ 00 đến FF dùng IC 7493 

Bước 1: Hãy vẽ mạch điện  như  Hình II.27 
Bước 2: Đóng công tắc A, B sang vị trí phía dướI bằng cách click phím A, B trên bàn phím. 
Bước 3: Đóng các công tắc P, C, D ở vị trí hở mạch. 
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 Bước 4: Bật công tắc nguồn (Simulate Switch), quan sát trên đèn hiển thị xem 

mạch đếm từ 00 đến FF 
V.2.2. Mạch đếm từ 00 đến 99 dùng IC 7493 

Bước 1: Sinh viên vẫn sử dụng Hình II.27 để mô phỏng 
Bước 2: Đóng công tắc A, B sang vị trí phía trên. 
Bước 3: Đóng công tắc P và D sang vị trí đóng mạch. Công tắc C ở vị trí hở mạch. 

 Bước 4: Bật công tắc nguồn  (Simulate Switch) và quan sát các đèn. 
V.2.3. Mạch đếm từ 00 đến 59 dùng IC 7493 
Sinh viên hãy thử tìm cách thực hiện để mạch Hình II.27 để mạch có thể  hoạt động ở 

chế độ đếm từ 00 đến 59. 

V.3. Mô phỏng mạch mạch chọn kênh 
V.3.1. Mạch chọn kênh dữ liệu số 0 điều khiển bằng công tắc 

 Bước 1: Sinh viên vẽ mạch điện mô phỏng như Hình II.28 
 Bước 2: Đóng công tắc S1 vào nguồn 5V, các công tắc từ S2 đến S8 nối xuống 

mass, bằng cách click các phím A, B ..., H. 
 Bước 3: Đóng công tắc S9, S10, S11 sang vị trí phía dưới bằng cách click các 

phím I, J, K trên bàn phím. 
 Bước 4: Đóng công tắc S12, S13, S14 xuống mass. 
 Bước 5: Bật công tắc nguồn, quan sát trên đèn hiển thị xem kênh nào được 

chọn và quan sát dữ liệu ngõ ra ở mức logic nào ? 
Tương tự các kênh 1, 2, 3, 4, 5, 6 và 7 được chọn thì ta chỉ cần thay đổi trạng thái 

logic của các công tắc S12, S13 và S14 theo bảng sau: 
S12 S13 S14 Kênh được chọn 

1 0 0 1 
0 1 0 2 
1 1 0 3 
0 0 1 4 
1 0 1 5 
0 1 1 6 
1 1 1 7 

Để nhận biết dữ kiện ra của các kênh tương ứng với các trạng thái logic của công tắc 
S12, S13 và S14 khi chọn kênh nào thì sinh viên cho dữ liệu vào của kênh đó ở mức 1. 
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Chú ý: trong quá trình mô phỏng (đã bật nguồn) ta có thể đóng mở các công tắc để 

thấy được sự thay đổi. 

Hình II.28 

V.3.2. Mạch chọn kênh dữ liệu thứ tự từ 0 đến 7 một cách tự động. 
Sinh viên sử dụng IC đếm 74190 để chọn kênh dữ liệu tự động. Bằng cách thay đổi 

mạch điện trên Hình II.28 
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Để chọn kênh dữ liệu theo thứ tự  ngược lại từ 7 đến 0 ta phải làm gì ? Hãy thay đổi 

mạch điện nếu cần thiết để thực hiện được yêu cầu trên.  

V.4.  Mô phỏng mạch giải mã 
V.4.1. Mạch giải mã số nhị phân 000 được điều khiển bằng công tắc. 

 Bước 1: Sinh viên hãy vẽ mạch Hình II.29 
 Bước 2: Đóng các công tắc S8, S9, S10 sang vị trí phía dưới. 
 Bước 3: Đóng các công tắc S5, S6, S7 xuống mass. 
 Bước 4: Bật công tắc nguồn, quan sát trên đèn hiển thị xem số nhị phân nào 
ứng với số thập phân trên đèn hiển thị và quan sát ngõ ra dữ liệu từ Y0 đến Y7 
xem mức logic là bao nhiêu ? 

Sinh viên thực hiện tương tự cho các mạch giải mã từ 001 đến 111. 
V.4.1. Mạch giải mã số nhị phân từ 000 đến 111 một cách tự động. 

Hình II.29 
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Tương tự như mạch chọn kênh sinh viên thực hiện việc thay đổi mạch điện trên 

Hình II.29 để thực hiện được yêu cầu đặt ra. 

V.5.  Ứng dụng của MultiSim trong việc thiết kế các mạch số đơn giản 
V.5.1. Thiết kế mạch điện và chuyển đổi 

 Đây là mạch điện đơn giản hoàn toàn dùng cổng Logic và công cụ được dùng 
cho việc mô phỏng này là Logic Converter 

A : B
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1

2

U2A
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1

2

U3A

7405N

1
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7432N
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U6A

U5B

7432N

4

5

5V

VCC 1

3

4

7

5

2
8

13

12

14

15

16

Hình II.30 

Double click vào biểu tượng của máy Logic Converter. 
 Click nút                            và chờ cho đến khi cột có dấu ? hiển thị kết quả đầy 
đủ (0 hoặc 1) ta sẽ được bảng sự thật. 

 Click vào nút                             ta sẽ được biểu thức Boolean chưa đơn giản , 
hiển thị phía bên dưới máy Logic Converter ta có kết quả sau: 

 
 

Hình II.31 
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 Tiếp tục click vào nút                            ta sẽ được biểu thúc Boolean đơn giản 
hiển thị phía dưới máy Logic Converter là A'B+B'C'+B'D'. 

 Click nút                             ta sẽ được mạch điện của biểu thức Boolean đơn giản 
tương đương với mạch điện ban đầu.  

 
 
        
 
 
 
 
 
 
                            

 
 
 
 
 
 
 
 

 Click vào nút      ta sẽ được mạch điện dùng toàn cổng NAND hai 
ngõ vào tương úng với mạch điện trên. Các bạn hãy thử xem. Điều này rất hữu 
ích cho sinh viên khi học môn Kỹ thuật số và thiết kế các mạch điện dùng IC số. 

V.5.2. Tạo bảng sự thật và chuyển đổi 
Đây là một trong phần quan trong giúp sinh viên làm quen với việc thiết kế mạch số 

cũng như kiểm tra bảng sự thật của các mạch số. Bây giờ chúng ta hãy thử làm quen với 
cách làm mới này từ phần mềm mô phỏng MultiSim này. 

 Mở file mới (File/Open) 
 Từ menu Simulate/Instruments/Logic Converter đặt vào cửa sổ thiết kế mạch 
 Double click vào biểu tượng của Logic Converter vừa lấy ra. 
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 Click vào A, B, A để tạo 3 ngõ vào, các trường hợp có thể có của 3 ngõ vào sẽ 
được hiển thị phía dưới nó. Ở cột có dấu ? cho phép chúng ta tạo giá trị ngõ ra 
mà chúng ta muốn thiết kế, chúng ta chỉ cần click chuột vào để thay đổi thành 
giá trị 0 hoặc 1 hoặc x. Sau khi chúng ta tạo xong bảng sự thật cho mạch số mà 
chúng ta cần thiết kế. Bây giờ chúng ta sẽ thực hiện việc chuyển đổi. 

 Click chuột vào nút                            , ta sẽ được biểu thức Boolean hiển thị phía 
dưới máy Logic Converter là: A'B'C+A'BC'+ABC'+ABC 

 Tiếp tục Click vào nút      , ta sẽ được biểu thức Boolean đơn giản 
hiển thị phía dưới máy Logic Converter là: A'B'C+BC'+AB 

 Tiếp tục Click vào nút      , ta sẽ được mạch điện của biểu thức 
Boolean đơn giản như sau: 

A B C

 
 Click chuột vào nút                                ta sẽ được mạch điện dùng toàn cổng 
NAND hai ngõ vào tương đương với mạch điện trên. 

A B C
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 Tương tự, chúng ta có thể thiết kế các mạch đếm từ đơn giản đến phức tạp dùng 
cổng logic. Sinh viên hãy tự khảo sát cho các trường hợp còn lại. 

V.5.3. Mạch dùng máy phát từ 
 Mục đích của ứng dụng này là để biết cách vận dụng máy phát từ vào trong các 
mạch số. Máy phát từ trong trường hợp này được dùng như bộ nhớ và led 7 đoạn 
được nối kết như hình sau: 

 Chúng ta hãy vẽ mạch số như Hình II.33 
 
 

Hình II.33 

 Sau đó double 
click vào biểu 
tượng của 
máy phát từ 
để đặt các giá 
trị cần mô 
phỏng như 
hình bên dưới 
(dĩ nhiên 
chúng ta có 
thể đặt nhiều 
hơn và tùy ý 
theo riêng 
mình ) 

 
 
 

 Tiến hành mô phỏng click chuột 
vào RUN,  ta có kết quả như : Led 
tắt 0000, 1111, 2222, …., 9999, 
2004, good, bye (Xem hình 
V.5.3). Chúng ta có thể đặt các 
giá trị khác theo ý muốn để hiểu 
kỹ hơn về cách ứng dụng của 
Word Generator vào trong mô 
phỏng mạch số.  Hãy thử xem để 
thấy được sự hữu dụng của phần 
mềm này trong giảng dạy cho s
viên ngành Điện – Điện Tử. 

inh 
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V.5.4. Mạch biến đổi ADC và DAC 

 Sinh viên hãy thử vẽ một mạch điện cần mô phỏng như Hình II.35 
 Mạch này dùng máy Function Generator để phát sóng để phát sóng Sin chuẩn và 
được biến đổi thành tín hiệu số bởi bộ ADC với tần số lấy mẫu được xác định 
bởi nguồn phát xung vuông. Led dùng để hiển thị giá trị của tín hiệu số ở mỗi 
lần lấy mẫu và dạng sóng vuông của tín hiệu số được hiển thị ở máy phân tích 
Logic. Sau đó, tín hiệu số được bộ DAC phục hồi lại dạng tín hiệu ban đầu. Tín 
hiệu ban đầu và tín hiệu phục hồi được hiển thị trên Oscilloscope. 

 Sinh viên hãy đặt lại các thông số thích hợp và tiến hành mô phỏng và quan sát 
các trạng thái trên Oscilloscope, Logic Analyzer, trên Led 7 đoạn, sau đó hãy 
thử thay đổi lại dạng sóng trên  Function Generator thành dạng xung vuông và 
xung tam giác. Sinh viên hãy quan sát các trạng thái trên Oscilloscope, Logic 
Analyzer. 
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Chương 3:    OrCAD Capture9.2 
 

 Mục tiêu cần đạt được: 
Sinh viên có thể thiết kế một mạch điện từ đơn giản đến phức tạp thông qua các môn học 

chuyên ngành đã biết. Sinh viên có thể mô phỏng mạch điện vừa thiết kế để kiểm chứng. Vẽ được 
mạch điện nguyên lý Capture hoàn chỉnh, cách tạo ra một Netlist để chuyển từ mạch nguyên lý 
(capture) sang Layout. 

 Kiến thức cơ bản: 
Sinh viên  cần phải có kiến thức cơ bản về các môn học liên quan như: Kỹ Thuật Xung, 

Linh Kiện Điện Tử, Mạch Điện Tử, Kỹ Thuật Số, Kỹ Thuật Vi Xử Lý và phải sử dụng  máy vi 
tính mà cơ bản là hệ điều hành Window. 

 Tài liệu tham khảo: 
[1] Đặng Hoàng Tuấn – OrCAD Capture Vẽ mạch Điện và Điên Tử - NXB Thống kê –2002. 

[2] Nguyễn Khắc Nguyên – Bài giảng Chuyên Đề Thiết Kế Mạch In – Khoa Công Nghệ thông 
Tin – ĐH Cần Thơ - 2002 

[3] Nguyễn Chí Ngôn – Bài giảng OrCAD – Khoa Công Nghệ Thông Tin, Đại học Cần Thơ – 
2002. 

[4] Nguyễn Việt Hùng & Nhóm cộng tác – Vẽ và Thiết kế mạch in OrCAD – Nhà xuất bản Đà 
Nẵng – 2004. 

[5] Trần Hữu Danh –  Bài giảng OrCAD 9.2 – Khoa Công Nghệ Thông Tin, Đại học Cần Thơ – 
2003 
[6] Short Lectures on Internet (các bài giảng về OrCAD trên Internet)  

 Phần nội dung: 

Vẽ Schematic bằng Orcad Capture 

Khởi động Orcad Capture  

Tạo project mới 

Đặt linh kiện 

Đặt nguồn/mass 

Kết nối các linh kiện 

Chỉnh sửa 

Kiểm tra mạch, hoàn tất mạch và Tạo Netlist 

I.  Khởi động Orcad Capture 
Chạy file: Capture.exe hoặc nhấp double click chuột vào 

biểu tượng Capture trên Desktop của Window 
(Start →All Programs →Orcad Family Release 9.2 → 

Capture ) 
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Khi bắt đầu vẽ 
một Schematic chúng ta 
nên chọn menu  
Options/Preference  
đặc các thuộc tính  tuỳ 
chọn riêng cho người 
thiết kế về màu sắc hiển 
thị của Wire, Pin ... toạ 
độ lưới vẽ trong trang 
thiết kế mạch nguyên 
lý. Khi chúng ta chọn 
Options/Preference từ 
menu lệnh  chúng ta sẽ 
thấy hộp hội thoại như 
sau xuất hiện 

 Preperence với 
mục đích cài đặt các thành phần thiết yếu 
chương trình Capture. Những thành phần mà 
chúng ta cài đặt sẽ ảnh hưởng đến cách xử lý 
của những chương trình và được lưu trong tập 
tin CAPTURE.INI 

I.1. Chọn lớp Colors/Print: 
 Hiện những gam màu để gán cho các 

từng dối tượng trong trang sơ đồ mạch nguyên 
lý như: màu nền của background, pin linh kiện, 
tên linh kiện, Bus, đường kết nối các thành 
phần, lưới vẽ, DRC maker, giá trị linh kiện, 
wire, text ... 

I.2. Chọn lớp Grid Display:  
Cho hiện hoặc không cho hiện thị các ô lưới được thể hiện bằng những dấu chấm trong các 

trang thiết kế mạch nguyên lý hoặc sửa đổi linh kiện. Mục đích của lưới để cho chúng ta đặt linh 
kiện cũng như sắp xếp chúng sao cho hợp lý và chính xác nhất. 
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I.3. Chọn lớp Pan and Zoom: 
Hiện khung thoại chứa các giả 

trị để thay đổi tỷ lệ phóng to hay 
thu nhỏ các đối tượng nẳmtong 
trang thiết kế sơ đồ mạch. 

 
 
 
 
 
 
 
 
 
 

I.4. Chọn lớp Select: 
Hiện thị khung thoại liên quan 

đến việc lựa chọn các thành phần 
trong trang sơ đồ nguyên lý. 
 
 
 
 
 
 
 
 
 

I.5. Lớp Miscellaneuos: 
Chứa những thành phần hổ trợ 

cho việc gán các thuộc tính các đối 
tượng trong trang thiết kế. Ngoài ra 
nó còn có chức năng rất quan trọng 
là tự động hiển thị số thứ tự của loại 
linh kiện được lấy ra (Automation 
reference place parts) và bắt tay chéo 
với Layout (Intertool 
Communication) rất hữu dụng tron 
việc sắp đặt các các footprint linh 
kiện theo tuỳ thích của người thiết kế 
nhằm tránh trường hợp các kiện 
được sắp đặt không theo ý muốn. 
Chức năng này chỉ có tác dụng khi 
chúng ta cùng mở cả Capture và Layout  và dĩ nhiên là chúng phải đang cùng xử lý chung một 
thiết kế. 
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I.6. Design Template  
Gán các tham số mặc định cho những bản thiết kê và các trang sơ đồ mạch nguyên lý mới. 

Những giá trị được gán theo khung tham số này không ảnh hưởng đến những thiết kế của các 
mạch điện cũ. Từ Design Template cho phép ta chọn Fonts như kiểu hiển thị các ký tự, size các 
của các ký tự hiện thị tên, giá trị, pin ... của linh kiện. Ngoài ra, nó còn cho chúng ta đặt tên của 
thiết kế, size của thiết kế, đơn vị đo, hiển thị lưới vẽ cho thiết kế .... 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

I.7. Design Properties: 
Chứa các thước lệnh liên 

quan đến việc thiết kế các 
thuộc tính cho các đối trong 
trang sơ đồ thiết kế mạch. 
 
 
 
 
 
 
 

II. Tạo một New 
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Project: 
 File → New → Project 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Khi tạo 
một Project mới chúng ta bắt buột phải ghi tên của Project vào trong Name và phải chọn thư mục 
để lưu Project đó. Còn nếu muốn mở một Project đã thiết kế rổi chúng ta vào : File → Open → 
Project... chúng ta sẽ thấy một hộp hội thoại xuất hiện để cho chúng ta chọn file cần mở. 

Tên Project 

Thư mục để  
lưu Project 

Chọn Up để 
tìm file cần 

mở ở Capture 

 

III. Giao diện chính của Orcad Capture 

Sau khi chúng ta tạo một Project mới (hoặc mở một Project đã tồn tại) thì chúng ta sẽ thấy 
một giao diện của OrCad Capture như sau: 
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Các thanh 
cộng cụ vẽ 

Vùng vẽ mạch điện

Cửa sổ quản lý 
Project  

 

 

Chọn đối tượng 

đặt linh kiện 

vẽ đường nối kết 

đặt nhãn đường mạch

vẽ bus và đường nối từ bus 

Nguồn và GND

Các công cụ hổ trợ vẽ mạch

Thanh công cụ 

Do OrCad là phần mềm chạy trên hệ điều hành Window giống như các phần mềm ứng dụng 
khác. Để học nhanh chương trình ứng dụng này đòi hỏi sinh viên phải có kiến thức vể tin học mà 
đặc biệt là hệ điều hành Window. Sau đây chúng ta sẽ tìm hiểu về chương trình ứng dụng này. 

Cũng giống như các chương trình ứng dụng khác chạy trên hệ điều hành Window, nên chúng 
ta có thể nhấp chuột phải là chúng ta có thể thực hiện hầu hết các đặc tính cơ bản, các chức năng 
cơ bản của chúng và chúng ta đã thấy ở trên. 
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Schematic 
folder 

Schematic page 

Chỉ cần click chuột 
phải là sẽ thấy và làm 
được như bên dưới

Part  folder 

III.1. Design Manager: 
Quản lý các sơ đồ thiết kế mạch điện và các thư viện trong hung cửa sổ Design Manager. 

Chúng ta dùng các cửa sổ này để tạo các sơ đồ nguyên lý mạch điện, các trang sơ đồ mạch trong 
bản thiết kế mới, thiết kế các linh kiện và các ký hiệu trong thư viện và sao chép hoặc di chuyển 
các linh kiện, ký hiệu, mạch 
điện và các trang sơ đồ 
nguyên lý mạch giữa các bản 
thiết kế và thư viện. 

Hình III.1 

Trong khung cửa sổ 
Logical, Design Manager 
trình bài các sơ đồ mạch điện 
và các trang mạchnguyên lý 
mẫu. Tên của sơ đồ mạch và 
linh kiện được liệt kê theo 
thứ tự mẫu tự trong các thư 
viện, nhưng tên sơ đồ nguyên 
lý luôn luôn được đặt trước 
các tên linh kiện. Đối với ví 
dụ về mạch điện nguồn tuyến 
tính thì Design manager có 
như hình III.1 
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Chúng ta có thể mở các trang sơ đồ nguyên lý mạch và các linh kiện trong Design Manager 

bằng cách nhấp double click chuột lên chúng. Mặc khác chúng ta cũng có thể trích duyệt bản thiết 
kế bằng cách chọn các văn kiện và kích nút lệnh Browser từ menu Edit sau:  

Chúng ta có thể thay đổi giá trị linh kiện, tên của các thành phần linh kiên, Flat Netlist, DRC 
Markers, TitleBlocks .... 

III.2. Part Editor: 
Chức năng này dùng để sửa đổi linh kiện 

theo ý riêng của người thiết kế. Để thực hiện 
được chức năng này chúng ta làm như sau: 
 

Nhìn vào hình III.1 ở trang phía trên, chúng 
ta chọn thiết kế cần chỉnh sửa linh kiện, sau đó 
vào menu Edit → Browse → Parts để chọn linh 
kiện cần Edit. Sau khi xác định đựoc linh kiện 
cần chỉnh sửa chúng ta chỉ cần click chuột phải 
vào linh kiện đó và chúng ta sẽ thấy một menu 
xuất hiện, sau đó chọn Edit Part. Sau đó một 
giao diện xuất hiện như hình III.2 

 
Hay chúng ta có thể thực hiện điều này bằng cách 

khác, chúng ta chọn linh kiện cần sử chửa ta cần sửa đổi 
trên Page có chứa sơ đồ mạch điện và sau đó vào menu 
Edit→Part  hoặc chúng ta có thể click chuột phải rồi chọn 
Edit Part. Chúng ta quan sát hình bên dưới. 
 
 
 

Nhấp double click vào nơi cần 
edit

 
 
 
 
 
 

, sau đó thấy một hộp thoại xuất 
hiện và tiến hành thay đổi như hình III.3. 

Hình III.2 
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Chẳn hạn như chúng ta muốn cho chân số 2 của IC ổn áp 7805 xuất hiện, chúng ta chọn shape 

là line, click chuột vào Pin Visible và chọn OK, lúc này ta thấy hình dạng của IC ổn áp 7805 có 
dạnh như sau: 

 
Chúng ta sẽ thấy khung cửa sổ con xuất hiện. Nếu chúng ta muốn thay đổi 

chân linh kiện thì chúng ta chỉ cần chọn chân link kiên muốn thay đổi sau đó click chuột phải và 
chọn Edit Properties. Còn nếu muốn thay đổi độ rộng cũng như vị trí các chân thì chúng ta chỉ cần 
giữ chuột và kéo đến vị trí mong muốn. Và tương tự cho các chân và thuộc tính khác. 

Sau khi đã sửa chửa theo ý muốn của mình xong, chúng ta click chuột vào nút close để đóng 
giao diện edit linh kiện lại và một hộp thoại thông báo xuất hiện như hình bên dưới.  

 
 

Nếu chúng ta chọn Update Current thì linh kiện mà chúng ta đã sửa đổi sẽ chỉ cập nhật lại 
những gì đã thay đổi vào ngay chính linh kiện đó. Còn nếu chọn Update All thì những linh kiện 
cùng loại sẽ được thay dổi tất cả. Còn nếu chọn Discard thì chúng ta sẽ bỏ qua tất cả các công việc 
edit linh kiện mà chúng ta đã thực hiện và quay trở lại giao diện thiết kế và nếu chọn Cancel thì ta 
sẽ quay lại khung cửa sổ con của Part View (cửa sổ dùng để edit linh kiện) để tiếp tục edit linh 
kiện. 
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III.3. Session Frame 
Khung này chứa các thành 

phần của Capture như: session log, 
Design managers, schematic page 
editors, Part editors.  

Cũng như các trình ứng dụng 
khác hoạt động trong môi trường 
Window, bạn có thể giảm, tăng 
hoặc chỉnh các khung cửa sổ theo ý
muốn, có thể Cut, Copy, Past ...  

 

 

III.4. Session Log 
 
Khung cửa sổ Session Log chứa các thông tin về 

những sự kiện xảy ra trong quá trình thiết kế mạch điện 
như lỗi, cá cảnh báo, các thông tin về linh kiện .....Để 
xoá nội dung trong khung cửa sổ này vào bất kỳ thời 
điểm nào với lệnh Clear Session Log từ menu Edit hoặc 
dùng phím nóng Ctrl+Del. 

IV.  Tìm hiểu các thanh menu lệnh 
Thanh menu trong Capture thay đổi tuỳ theo cách thực hiện của chúng ta. 

Menu FILE 
Hiện menu xổ chứa các lệnh liên quan đến việc tạo mới 

bản thiết kế sơ đồ mạch nguyên lý, quản lý và in bản thiết kế. 

 New 
Mở bản thiết kế hoặc thu viện mới. Sau khi kích chọn. 

Lệnh hiện các lệnh con gồm có như hình bên 
 Design 

Mở trang sơ đồ nguyên lý mới trong khung cửa sổ Design 
Manager. Đây là môi trường mà chúng ta đang quản lý các sơ 
đồ mạch nguyên lý vá các trang thiết kế. Do bản thiết kế sơ 
đồ mạch nguyên lý mới kế thừa các đặc tính từ sơ đồ mạch 
mẫu, chúng ta nên kiểm tra lại kỹ trước khi thiết kế sơ đồ 
mạch. 
 Nếu như chúng ta lưu sơ đồ mạch nguyên lý lần đầu 
thì khung hội thoại Save As hiện ra cho phép cho chúng ta đặt đường dẫn và thay thế tên tập tin 
mà hệ thống đã kích hoạt.  
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 Library 

Dùng để mở linh kiện hoặc 
ký hiệu linh kiện mới trong 
khung cử sổ Part Editor. 
 

Để tạo một linh kiện chúng ta 
nên chọn một linh kiện sẳn có sau 
đó chúng ta edit lại chúng là 
nhanh nhất. Cách làm này được 
thực hiện như sau: menu File→ 
Open→ Library... để chọn một 
linh kiện (dĩ nhiên linh kiện này 
phải nằm trong thư viện của 
Capture). Ví dụ: ta muốn tạo một 
vi điều khiển họ AVR là 
AT90LS8535, trong OrCad 9.2 
không có AT90LS8535 mà chỉ có 
AT90S8515, do đó chúng ta phải tạo ra nó từ AT90S8515 có sẳn. 

Sau đó chúng ta thấy một hộp hội thoại xuất hiện. 

Chọn MicroController trong thư viện Library của Capture, chọn và 

 giống như đã trình bài ở phần đầu. Sau 
khi 

 

 
 
 
 
 
 
 
 
 
 

double click chuột vào loại 
MicroController AT90S8515 và chúng ta sẽ thấy giao diện như hình III.3. 

Bây giờ vấn đề còn lại là chúng ta sửa chửa linh kiện
tạo thành một linh kiện chúng ta phải Save As vào một thư viện riêng (thư viện riêng do người 

dùng tạo ra) để linh kiện này không bị thay đổi trong thư viện ban đầu của chúng.  
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Do trong thư viện của Capture chỉ có các linh kiện thông dụng, do đó đối với các linh kiện 

chuyên dụng đặc biệt thì hầu như ít thấy trong thư viện của Capture. Do đó, để vẽ được mạch 
nguyên lý đó chúng ta phải tạo 
một linh kiện mới hoàn toàn, 
chúng ta làm như hình bên dưới.  

Hình III.3 

 
 

 
Sau đó chúng ta sẽ thấy 

khung cửa sổ mới sẽ xuất hiện. 
Chọn library1.olb, click chuột phải chúng ta sẽ thấy hộp hội thoại xuất hiện bên dưới. 

 
Chọn New Part để tạo một linh kiện mới nằm trong thư viện library1.olb, một khung thoại như 

hình III.4 xuất hiện để cho phép chúng ta điền các thông tin như Name, Part Preference Prefix, 
PCB footprint ….và các tùy chọn khác. Sau khi điền đầy đủ vào Name, Part Preference Prefix, 
PCB footprint và chọn OK ta sẽ thấy một giao diện như hình III.5 để cho chúng ta tự thiết kế một 
linh kiện theo ý muốn như hình III.6. Sau khi làm xong chúng ta lưu linh kiện vừa tạo mới vào 
trong thư viện đã tạo lúc ban đầu bằng cách vào menu File chọn Save As / Save (hoặc củng có thể 
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click chuột phải để chọn Save hay save As) và chọn thư viện để lưu linh kiện vừa tạo với một tên 
mới và click OK là xong. 

 

Tên của linh 
kiện 

Số hiệu bắt 
đầu của linh 
kiện lấy ra 

Hình III.4 

Số chân của 
linh kiện tạo 

ra
Hình III.5 

Công cụ để tạo linh 
kiện 

 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 

Hình III.6 

 
 
 
 

Ngoài ra các menu lệnh như Save, Save As, Print, Print Preview, Print setup, Close, Exit cũng 
giống như các trình ứng dụng khác chạy trên hệ điều hành Window. 
Menu EDIT 

Chứa các lệnh con liên quan đến việc xử lý các đối tượng trong trang thiết kế mạch nguyên lý 
hiện hành. Các menu lệnh như Undo, Redo, Repeat, Cut, Copy, Paste, Delete, Edit Part, Mirror, 
Rotate ... nó có ý nghĩa giống như nghĩa tiếng anh của chúng. Chúng hoàn toàn giống như các 
trình ứng dụng khác chạy trên hệ điều hành Window khác như Office ... 

Trần Hữu Danh  Trang 58  



  Chương 3: OrCAD Capture 9.2 
Menu VIEW 

Menu View chứa các lệnh có chức năng hỗ trợ trong việc 
quan sát các đối tượng trong trang thiết kế mạch nguyên lý. Lệnh 
thay đổi tuỳ theo chế độ thực hiện với các khung màn hình thiết 
kế. 
 

Menu PLACE 
Đây chính thanh công cụ hỗ trợ trong việc thiết kế mạch 

nguyên lý. Nó chứa các lệnh liên quan đến việc đặt các link kiện 
trong trang thiết kế sơ đồ mạch điện cũng như nối nhiều trang sơ 
đồ mạch nguyên lý từ những trang rời nhau kết thành một bản 
thiết kế hoàn chỉnh. 
 Part 

Menu lệnh con Part hiện danh mục linh kiện muốn đặt trong 
trang thiết kế mạch nguyên lý hiện hành. Có thể kích công cụ Part 
từ thanh công cụ để hiện ra khung danh sách các linh kiện trong 
Place Part. Trong Place Part này chúng ta cũng có thể Add các 
thư viện linh kiện khác nhau nằm trong Capture, hoặc cũng có thể 
Remove chúng ra khỏi Place Part, và chúng ta cũng lưu ý rằng 
khi chúng ta Remove các thư viện không cần thiết ra khỏi Place 
Part thì chúng sẽ không bị Delete, do đó chúng ta hoàn toàn an 
tâm. Hoặc chúng ta có thể tìm kiêm bất kỳ một linh kiện nào mà 
chúng ta đã quên hay thậm chí không biết chúng có tồn tại trong 
thư viện của Capture hay không, chúng ta chỉ cần đánh từ khoá 
cần tìm (giống như tìm một file trong Window mà thôi) sau đó 
chúng ta chọn Part Seach... để tìm linh kiện đó. 

 

 

 

 

 

 

 

 

 

 

 

V. Đặt Linh liện 
 

Từ menu Place → Part (Shift+P) hay nhấp chuột vào biểu tượng  

Chúng ta sẽ thấy và lần lượt làm theo các bước sau đây: 

Danh sách các LK 
có trong các thư 
viện được Add 

Đánh từ khóa 
để tìm LK 

Hình dạng của 
LK được chọn 

Tên của LK cần 
tìm trong Part 
List của thư viện
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Khi chúng ta bắt đầu vẽ một schematic mới, sau khi click chuột vào biểu tượng Place Part trên 

thanh công cụ vẽ, chúng ta sẽ thấy khung thoại xuất hiệnnhư hình III.7, để lấy được thư viện các 
linh kiện cần thiết cho schematic cần vẽ, chúng ta click chuột vào Add Library để chọn các thư 
viện cần add vào cho bảng thiết kế, khung thoại mới sẽ xuất hiện như hình III.8. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Từ khung thoại như hình III.8 chúng ta có thể chọn tất cả các thư viện có trong Folder Library 
của OrCad Capture (lưu ý: chỉ các thư viện trong Capture) hay chúng ta có thể chọn vừa đủ các 
thư viện cần dùng (giữ phím Ctrl + click chuột vào các thư viện cần chọn). Sau đó click chuột vào 
Open để add vào và chúng ta thấy như hình III.9 

 
 

 

 

 

Hình III.8 Hình III.7 

Hình III.10 Hình III.9 
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Từ hình III.9 - Place Part, chúng ta chỉ cần đánh tên 

linh kiện cần lấy ra vào Part (chỉ cần đánh chử cái đầu 
tiên của từ viết tắt từ tiếng Anh, ví dụ như điện trở có 
tên tiếng Anh là resistor, chúng ta chỉ cần đánh là R/r 
vào Part, cũng tượng tự cho tụ điện là capacitor – chỉ 
cần đánh là C/c vào Part ….như hình III.10. Chú ý là 
các linh kiện này phải đảm bảo có trong các thư viện đã 
được add vào, nếu chúng ta chưa add hay chúng ta 
không biết chúng nằm trong thư viện nào, chúng ta có 
thể tìm nó bằng cách click chuột vào Part Search trong 
khung thoại Place Part. Ví dụ như tìm IC số họ 74, 
chúng ta chỉ cần đánh 74* vào Part Name như hình 
III.11 và sau đó click chuột vào Begin Search để tìm, 
nếu có chúng sẽ hiển thị tất cả các linh kiện họ 74 và 
cho biết chúng được nằm trong thư viện nào, ở đây là thư viện có tên là Gate.olb , cách tìm này 
hoàn toàn giống như tìm một file trong window. 

Sau đó lấy các linh kiện cần thiết cho sơ đồ nguyên lý và đặc chúng vào vị trí thích hợp, sửa 
chửa lại cho phù hợp với yêu cầu thực tế cần sử dụng như đổi tên, đổi giá trị, quay trái phải … linh 
kiện như hình III.12 

Trong menu Place của OrCad Capture, nó còn hỗ trợ các chức năng khác nửa như: Wire dùng 
để nối các chân linh kiện lại trong sơ đồ mạch nguyên lý, đặt Bus, đặt  Net Alias, Text, đặt Power, 
GND, ngắt trang khi sơ đồ mạch nguyên lý có kích thước lớn .... 

 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Hình III.12 
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-Xoay linh kiện: Chọn linh kiện, ấn phím R 
- Đổi giá trị linh kiện: Nhấp đúp vào tên 
linh kiện, đổi tên  trong bảng ‘Display 
Properties’ 
- Di chuyển linh kiện: Nhấp và giữ phím 
trái chuột trên linh kiện, di chuyển đến vị 
trí mong muốn và nhả  
 
 
 

V. Đặt nguồn/mass và kết nối các linh kiện 
V.1.  Đặt nguồn/mass 
- Nhấp chuột vào biểu tượng công cụ Place power và Place 

ground. 
- Lấy Vcc/GND đặt vào vị trí thích hợp. Khi chúng ta click chuột 

chọn Vcc/GND, một giao diện xuất hiện để cho chúng ta chọn 
kiểu nguồn/mass như hình sau. 

V.2. Kết nối các linh kiện 
- Nhấp chuột vào biểu tượng  

 con trỏ xuất hiện dấu ‘+’ 
- Di chuyển đến vị trí muốn nối, nhấp chuột, 1 

đường kẻ  sẽ xuất hiện theo hướng di chuyển của 
chuột, đến ví trí  kết nối khác, nhấp chuột lần nữa, 
một kết nối sẽ được thiết lập. 

- Chỉnh sửa kết nối dễ dàng bằng  cách nhấp chuột 
vào đường nối.  

 
 

- Tiến hành nối các 
đường wire với 
các chân còn lai 
trong sơ đồ 
nguyên lý mạch 
điện. Công việc 
này rất dễ để thực 
hiện. Tuy nhiên 
chúng ta nên chú 
ý đến tính thẩm 
mỹ của sơ đồ 
mạch.  
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V.3.  Hoàn tất sơ đồ mạch 
Bây giờ chúng ta có một sơ đồ nguyên lý đã được vẽ hoàn chỉnh như hình bên dưới. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

VI. Kiểm tra mạch 
- Orcad Capture cho phép kiểm tra nhiều yếu tố: Hở mạch, nối tắt, 

… 
- Vào ‘Window’ → ‘NguonTT’  (tức chọn tên Project), đến khi 

cửa sổ ‘Schematic1: Page1’ đóng lại và có dạng như hình III.13 
 
 
 

Hình III.13 

hay click 

- Chọn DRC check 
trên menu Tool hay click chuột vào biểu tượng DRC để kiểm tra lỗi trong quá trình vẽ mạch, 
một hộp thoại Design Rules Check xuất hiện như hình III.14 cho phép chúng ta chọn các chế 
độ kiểm tra lỗi bằng cách check vào các qui luật kiểm tra. 
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- Nếu chúng ta muốn kiểm tra lỗi trong quá trình vẽ mạch thì chúng ta check vào Report của 

Design Rules Check. Nếu 
muốn xuất thông tin về lỗi 
trong mạch điện ra một file, 
chúng ta checktiếp vào View 
output trong Report file của 
Design Rules Check. Tuy 
nhiên,  chúng ta có thể chọn 
một vài qui luật kiểm tra nào 
mà có áp dụng trong sơ đồ 
mạch chúng ta đang vẽ, còn 
các qui luật nào không có 
dùng trong thiết kế của mình 
thì không nên check vào nó 
nhằm tránh xuất hiện các cảnh 
báo ngoài ý muốn xuất hiện. 

VII.  Tạo Netlist 
(danh sách các kết 
nối) 

- Vào ‘Window’ → chọn Project:  ‘NguonTT’ 
 
 
 
 
 
 

Hình III.14 

Click chuột vào Menu Tool→
Create Netlist hay nhấp 
chuột vào biểu   tượng 
‘Create Netlist’:
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Chúng ta có thể check vào Run ECO to Layout, mục đích của việc chọn này là sau khi Load 

file.MNL ở Layout, nó sẽ cho phép load tự động các footprint trong Layout vào. Tuy nhiên, khi 
chúng ta mới vẽ OrCad lần đầu tiên 
trên máy thì tính năng này cũng chưa 
có tác dụng, chỉ từ mạch thứ hai về sau 
thì chúng ta mới thấy được tính năng 
này. Mặt khác, Run ECO to Layout nó 
sẽ load các footprint có thể có vào khi 
chạy ở Layout, điều này sẽ có và chắc 
chắn rằng có một vài  footprint không 
đúng với kích thước của linh kiên trong 
thực tế, do đó để tiết kiệm thời gian 
phải chọn lại các footprint không mong 
muốn đó, chúng ta không cần phải 
check vào Run ECO to Layout khi tạo 
ra file.MNL. Khi đó khi file.MNL 
được load ở Layout, các footprint sẽ 
được chọn bằng tay và chúng ta chọn 
các footprint phù hợp với kích cỡ của 
linh kiện thực tế. 

Chọn Tab 
Layout và 
User … inches

Như vậy chúng ta đã hoàn tất công việc vẽ một sơ đồ nguyên lý trong OrCad Capture. 
Chú ý là Create Netlist tạo filename.MNL chỉ khi sơ đồ mạch điện được vẽ không có bất kỳ lỗi 

nào.  
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X. Các mạch điện ví dụ 
Nguồn ổn áp dùng IC ổn áp LM7805 

Bây giờ chúng ta  tập làm quen với mạch điện đơn giản sau: 
 
 
 
 

 
 
 
 

 
 
 
Để vẽ sơ đồ nguyên lý này 

chúng ta làm như sau: 
 

C3
1000

C2
.1

C1

100

U2

TL780-05/TO

1 3
IN OUT

D1

1N4007

D2

1N4007J1

AC in

1
2

0

J2

DC out

1
2

D4

1N4007

D3

1N4007

 
Chúng ta chọn Start → Programs → OrCAD Family Release 9.2 →Capture Cis. 
Biểu tượng của chương trình OrCAD xuất hiện như hình bên dưới: 
 
Khi đó cửa sổ OrCAD Capture xuất hiện, trong cửa sổ này chúng ta chọn File→New→Project 

để tạo sơ đồ nguyên lý mới. (được minh họa bởi hình bên dưới) 

Sau đó hộp thoại New Project xuất hiện, tại mục Name nhập vào tên sơ đồ nguyên lý mới, tại 
mục Create a New Project Using  nhấp chọn Schematic. 

Nhấp vào nút Browse hoặc nhấp vào mục Location tên đường dẫn chứa tập tin mới sau đó 
nhấp chuột vào nút OK. 
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Sau đó cửa sổ OrCAD Capture dùng để vẽ sơ đồ nguyên lý xuất hiện, trong cửa sổ này chúng ta 
thấy thanh công cụ dùng để vẽ sơ đồ nguyên lý nằm dọc ở góc phải  màn hình làm việc, nhấp chuột 
vào chọn thanh công cụ, giữ và di chuyển chuột đến vị trí thích hợp để đặt thanh công cụ vào vị trí 
mà chúng ta thích nếu như chúng ta thích thao tác này, nếu không thích thì chúng ta để cho thanh 
công cụ nằm ở vị trí mặc nhiên của OrCAD Capture. 

 
Trong cửa sổ này chúng ta chọn Place → Part  hoặc nhấp chuột vào biểu tượng Place Part 

trên thanh công cụ để bắt đầu đặt linh kiện. 
 

Nhấp chuột 
vào đây 

Khi nhấp chuột vào Place part, hộp thoại Place Part xuất hiện, vì trong khung Libraries chưa 
có các mục chứa linh kiện cần nên hãy nhấp chuột vào nút Add Library để chọn các thư viện chứa 
linh kiện ta cần. Các thư viện chứa linh kiện ta cần là Discrete, Connector, Regulator vì các thư 
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viện này chứa các điện trở, biến trở, tụ có cực tính, diode thường SCR, Port, IC ổn áp …. Ta có hộp 
thoại như  sau: 

 
Nếu chúng ta click chuột vào 

Add Library, chúng ta sẽ thêm 
vào các thư viện linh kiện cần thiết 
cho việc thiết kế mạch. Chúng ta 
có thể Add tất cả các thư viện linh 
kiện có thể có trong OrCAD 
Capture (trường hợp này thường 
thấy đối với những người mới  sử 
dụng OrCAD. Tuy nhiên, nếu 
chúng ta đã quen với vẽ mạch thì 
chúng ta nên Add những thư viện 
cần thiết cho thiết kế mà thôi)  

Nếu chúng ta muốn bỏ một thư 
viện linh kiện nào đó, chúng ta chỉ 
cần chọn thư viện linh kiện cần bỏ 
trong Libraries sau đó click chuột 
vào Remove Library. 

Nếu chúng ta không biết linh 
kiện cần trong sơ đồ mạch nằm 
trong thư viện nào thì chúng ta làm 
như sau: Từ hộp thoại của Place Part  chúng ta click chuột vào Part Search, sau đó một hộp thoại 
xuất hiện. 

Trong Part Name, chúng ta đánh từ khóa (tên đại diện cho linh kiện) ví dụ như hình bên, chọn 
Browse  trong Library Path để chọn đường dẫn chứa thư viện linh kiện trong OrCAD Capture. 
Sau đó chúng ta click chuột vào Begin Search,  nếu có thì chúng sẽ liệt kê tất cả các linh kiện nằm 
trong các thư  viện khác nhau của OrCAD Capture như hình bên dưới. 

 
 
 
 
 
 
 
 
 
 
 

Sau khi chúng ta tìm nạp các thư  viện cần thiết cho cho thiết kế, bây giờ chúng ta tiến hành vẽ 
mạch điện. Từ hộp thoại Place Part  ta chọn thư  viện Regulator và kéo thanh trượt trong Part 
List và chọn LM78L05ACZ/TO92 và chọn OK 
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Tại màn hình vẽ mạch điện lúc 
này tại đầu con trỏ chuột xuất hiện 
hình dạng linh kiện IC ổn áp LM 
7805.  

Khi chúng ta nhấp chuột vào vị trí 
bất kỳ trên trang thiết kế sơ đồ mạch 
điện và chúng ta sẽ thấy linh kiện sẽ 
xuất hiện trên sơ đồ mạch. Muốn thoát 
khỏi công việc này, chúng ta nhấn 
phím ESC hoặc nhấp chuột phải rồi 
chọn End Mode từ menu dọc. 

Một vấn đề chúng ta cần lưu ý là 
khi các linh kiện cùng loại được lấy ra 
thì Part Reference sẽ tựu động tăng 
lên. Còn khi chúng ta copy linh kiện 
đó ra nhiều lần thì chỉ số này sẽ không 
thay đổi và sẽ không tụ động tăng lên. 
Do đó khi chúng ta chuyển qua Layout 
sẽ bi báo lỗi vì chúng không biết vẽ 
mạch in như thế nào do có nhiều linh 
kiện cùng tên. Do dó, vấn đề này 
chúng ta cần lưu ý, khi copy linh kiện 
thì chúng ta phải sửa Part Reference 
lại sao cho chúng không trùng tên 
nhau đối với bất kỳ linh kiện nào. Ví 
dụ như IC ổn áp LM 7805 khi lấy ra 
thì sẽ mang  Part Reference  là U1,  
nếu tiếp tục lấy chúng ra các IC lấy ra 
sẽ là U2, U3,… Còn nếu chúng ta 
Copy thì chúng vẫn là U1 cho một lần 
copy, muốn vậy chúng ta phải Edit U1 
vừa được copy ra thành U2 hay một 
tên nào khác. 

Bây giờ chúng ta tiếp tục vào 
Place Part,  chọn trong thư viện 
Discrete  và kéo thanh trượt trong 
Part List  để chọn  như  hình bên dưới 

 
Nhấp chuột vào 4 vị  trí khác nhau 

để lấy ra 4 diode và chúng ta thấy trên 
cửa sổ thiết kế mạch như sau: 
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D4

DIODE21

D3

DIODE21

D1

DIODE21

D2

DIODE21

U1

LM78L05ACZ/TO92

1 3
VIN VOUT

 
 
 
 
 
 
 
 

Cũng từ hộp thoại Place Part của thư viện 
này, chúng ta đánh ký tự “C” vào Part  và 
chúng ta sẽ như hình sau 

Nhấp chuột vào 3 vị trí khác nhau trên sơ 
đồ mạch để lấy ra 3 tụ điện, sau đó nhấn phím 
ESC để thoát khỏi công việc. 

Cũng nhấp chuột vào Place Part và chọn 
thư viện Connector, đánh từ “header” và kéo 
thanh trượt trong Part List để chọn ra 
HEADER 2 như hình vẽ bên dưới 

 
Nhấp chuột vào 2 vị trí khác nhau trên sơ 

đồ mạch để lấy 2 HEADER. Nhấn phím ESC 
để kết thúc. 

 
Sắp xếp các linh kiện theo ý muốn sao cho 

có một sơ đồ mạch dễ nhìn và dễ hiểu. 
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Bây giờ chúng ta có các linh kiện được sắp xếp trong mạch điện như sau: 

C2
C

D4

DIODE21
C1
C

D3

DIODE21

D1

DIODE21

J1

HEADER 2

1
2

J2

HEADER 2

1
2

D2

DIODE21

C3
C

U1

LM78L05ACZ/TO92

1 3
VIN VOUT

Chúng ta tiến hành nối dây theo đúng sơ đồ nguyên lý bằng cách chọn Place →Wire  hoặc 
nhấp vào biểu tượng Place Wire trên thanh công cụ 

 

Khi sắp xếp linh kiện, chỉnh sửa các linh kiện theo ý muốn, đặt nguồn, GND và nối dây xong, 
chúng ta có được sơ đồ nguyên lý như sau: 

Hay nhấp chuột vào 
biểu tượng Place Wire
trên thanh công cụ 

C2
100

C1
1000

 
 

 

 
 
 

D3

DIODE

D1

DIODE

D4

DIODE
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Muốn thay đổi giá trị của các linh kiện cũng như  tên của linh kiện cho đúng như sơ đồ nguyên 

lý, chúng ta nhấp double click chuột vào linh kiện hoặc chọn vào thành phần của linh kiện cần thay 
đổi rồi click chuột phải và chọn Edit Part từ menu dọc. Khi đó hộp thoại Edit Part xuất hiện, tại 
mục Value nhập vào giá trị cần thay đổi, sau đó nhấp chuột vào nút OK để chấp nhận các thiết đặt 
mới này. Chúng ta xem thử ví dụ trên hình sau: 

Cách làm này cũng tương tự cho các linh kiện khác. Tuy nhiên chúng ta nên lưu ý rằng, chúng 
ta có thể Delete giá trị của linh kiện nhưng Part Reference (Name) của linh kiện thì không thể xóa 
bỏ được hay khi chúng ta Edit tên của linh kiện thì cũng phải cẩn thận nếu không khéo sẽ bị trùng 
tên thì khi đó chúng ta không thể nào tạo ra được filename.MNL để chuyển qua Layout  
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Sau khi vẽ xong sơ đồ nguyên lý mạch thì chúng ta nên Save lại để lưu lại sơ đồ vừa vẽ. 

Nhấp chuột vào nút Restore trên thanh công cụ để thu nhỏ màn hình làm việc.  

Kích hoạt cửa sổ quản lý để chọn trang sơ đò vừa thiết kế sau đó nhấp chuột vào biểu tượng 
Design Rules Check trên thanh công cụ để kiểm tra sơ đồ mạch 

Hộp thoại Design Rules Check xuất hiện, check vào Scope, Action và Report như hình bên 
dưới và sau đó nhấp OK để tiến hành kiểm tra.  

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Sau khi kiểm tra thấy không lỗi xảy ra, thì chúng ta tiến hành tạo file.MNL để chuyển qua 

Layout.  
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Bài tập Orcad 
 

 Hãy vẽ sơ đồ nguyên lý và thiết kế mạch in cho các mạch điện sau 
 
1. Mạch điều chỉnh và ổn định tốc độ động cơ 

 
 
2. Mạch điều khiển đèn chạy dùng IC 4017 
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3. Mạch Relay bảo vệ dòng 3 pha 
 
 
 

 
 
 
4. Mạch relay bảo vệ dòng 1 pha 
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5. Mạch AVR của máy phát công suất nhỏ 
 

 
 
6. Mạch tạo hiệu ứng âm thanh 
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7. Mạch xả nước và xấy tay tự động trong các phòng vệ sinh  

 
8. Mạch quét Led 7 đoạn dùng AVR AT90S2313 dùng cho các ứng dụng dơn giản như: đồng 

hồ hẹn giờ, đếm sự kiện … và các ứng dụng cơ bản khác. 
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9. Mở rộng PORT ngõ ra 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

10. Mạch xử lý tín hiệu số (DSP) dùng AVR AT90S8535 
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11. Kit nạp đa năng các họ AVR 
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12.  Mạch điều khiển Đèn trang trí công suất vừa dùng ROM 
 

 
 
 

 
 
 
 
 
 
 
 

A3

U5A

7404

12

Q6

BTA13

U5B

7404

34

U8

MOC3020

1

2

6
4

VCC

VCC

R17R

C10
1000uF

J2

CSuat 1

12

R6R

R26

R

R25R

U1

74192

15
1

10
9

3
2
6
7

12
13

14
11

5
4

P0
P1
P2
P3

Q0
Q1
Q2
Q3

CO
BO

CLR
LOAD

CLKU
CLKD

J9

Vac =230V

1 2

U4

2732

8
7
6
5
4
3
2
1

23
22
19
21

18
20

9
10
11
13
14
15
16
17

A0
A1
A2
A3
A4
A5
A6
A7
A8
A9
A10
A11

CE
OE/VPP

O0
O1
O2
O3
O4
O5
O6
O7

U6

MOC3020

1

2

6
4

A1

R1R R2R

R29

R

R7

POT

C13

.1

R8

RA7

U7

74192

15
1

10
9

3
2
6
7

12
13

14
11

5
4

P0
P1
P2
P3

Q0
Q1
Q2
Q3

CO
BO

CLR
LOAD

CLKU
CLKD

A4

U12

MOC3020

1

2

6
4

C4
C

VCC

A0

R28R

VCC

U14

MOC3020

1

2

6
4

R21R

R11

R

R4

R

Q8

BTA13

J6

CSuat 5

12

A2

U10

MOC3020

1

2

6
4-+

D1

BRIDGE_1A

1

4

3

2

Q4

BTA13

A5

C12
2200uF

Q7

BTA13

A5

Q5

BTA13

VCC

R23

R

R22R

VCC

C5
C

R20
R

A3

R9R

R24R

R27R

R15

R

Q1

BTA13

C3

.1

A1

T1

TRAN_HM31

13

24

C11

.1

U3

LM555/TO

3
4

5
2

6

7
OUT

R
S

T

CV
TRG

THR

DSCHG

J8

CSuat 7

12

D2

LED

C8

.1

VCC

VCC

R12

R R13R

C14

.1

A6

C2
C

C7

.1R16

R

R14R

C6

.1

U11

LM7805C/TO

13
INOUT

VCC

R19

R

A4

J4

CSuat 3

12

A2

J3

CSuat 2

12

R5R

U13

MOC3020

1

2

6
4

U9

MOC3020

1

2

6
4

VCC

A7

A0

J5

CSuat 4

12

R18R

Q2

BTA13

R3
R

C1

.1

VCC

U2

MOC3020

1

2

6
4

R10R Q3

BTA13

J7

CSuat 6

12

C9

104

A6

J1

CSuat 0

12



  Chương 3: OrCAD Capture 9.2 

 
13. Mạch xả nước và xấy tay tự động trong các phòng vệ sinh 
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14.  Mạch vi điều khiển đa năng dùng Vi điều khiển AT89C51 
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 Chương 4:   OrCAD Layout 9.2 

 

 Mục tiêu cần đạt được: 
Layout 9.2 là một chương trình chuyên dùng để thiết kế mạch in dựa theo sơ đồ mạch điện 

nguyên lý được thiết kế từ OrCad Capture. Sinh viên dựa vào  filename.MNL để chuyển sang 
Layout và từ đây sinh viên có thể sắp xếp linh kiện theo ý muốn, có thể vẽ mạch in theo 
phương pháp Manual hay Auto, có thể vẽ mạch in 1 hoặc 2 lớp, cách kéo Copper Pour .... 
Trong chương này, sinh viên nắm được cách thiết kế mạch in và từ đây sinh viên có thể vận 
dụng mọi tính năng của chương trình Layout mà thiết kế các mạch in thích hợp theo nhu cầu.  

 Kiến thức cơ bản: 
Sinh viên  cần phải có kiến thức cơ bản về các môn học liên quan như: Kỹ Thuật Xung, 

Linh Kiện Điện Tử, Mạch Điện Tử, Kỹ Thuật Số, Kỹ Thuật Vi Xử Lý và phải sử dụng  máy vi 
tính mà cơ bản là hệ điều hành Window. 

 Tài liệu tham khảo: 
[1] Đặng Minh Hoàng – Thiết Kế Mạch In với Layout 9 - NXB Thống kê –2002. 

[2] Nguyễn Khắc Nguyên – Bài Giảng OrCAD – Khoa Công Nghệ thông Tin – ĐH Cần 
Thơ - 2003 

[3] Nguyễn Chí Ngôn – Bài Giảng OrCAD – Khoa Công Nghệ thông Tin – ĐH Cần 
Thơ – 2002 

[4] Nguyễn Việt Hùng & Nhóm cộng tác – Vẽ và Thiết kế mạch in OrCAD – NXB Đà 
Nẵng – 2004.

[5] Short Lectures on Internet (các bài giảng về OrCAD trên Internet)  

 Phần nội dung: 

Khởi động Orcad Layout 
Tạo project mới 
Liên kết đến footprint 
Đặt footprint lên board mạch 
Định dạng và ấn định kích thước board mạch 
Sắp xếp linh kiện trên board outline 
Xác định số lớp mạch in cần vẽ 
Vẽ kết nối (vẽ tự động/vẽ tay) 
Kiểm tra và in kết quả 
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Sơ đồ minh hoạ toàn bộ quá trình xử lý của Layout

 

4.1. Khởi động Orcad Layout  
Chạy file: Layout.exe 
 
 
 
 
 
 
 
 
 
 
(Start → All Programs → Orcad Family Release 9.2 → Layout ) hoặc double click vào 

biểu tượng  trên thì chúng ta sẽ thấy một giao diện xuất hiện 
 
Đây có thể xem là khung màn hình tiền chương trình Layout để chúng ta có thê rtạo mới, 

mở, add vào hay xuất ra các tập tin bản vẽ hoàn chỉnh. 

 Bây giờ chúng ta tìm hiểu một số menu lệnh cơ bản. 

4.1.1. File 
Chứa  các lệnh liên quan đến việc tạo mới, mở, add vào hay xuất ra các tập tin đối tượng 

vào Layout hay sang các thành phần khác (của phần mềm thiết kế mạch khác như Protel, 
PCAD PCB …) 

4.1.1.1. New 
Nếu chúng ta chọn New, chúng 

ta sẽ dễ dàng tạo bảng mạch in mới 
với File.MNL mà chúng ta đã tạo 
ra trong phần OrCAD Capture 9.2 
ở chương 3. ( chúng ta có thể có 
thể xem lại chương 3 để hiểu rõ 
hơn). 

Khi ta chọn lệnh New từ menu 
File, màn hình hiện khung thội 
Load Template File trong đó có 
chứa tập tin các board mạch kỹ 
thuật mẫu với board mạch trống 
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hoặc những board mạch có chứa sẵn các linh kiện cố định nếu như chúng ta đã tạo board mạch 
theo yêu cầu của sơ đồ chi tiết mạch điện. 

Sau đó, chương trình Layout sẽ yêu cầu bạn tạo hoặc mở tập tin .MNL. Tập tin .MNL đã 
được tạo ra trong chương trình OrCAD Capture (xem lại chương 3) 

 

4.1.1.2. Open 
Lệnh Open liệt kê tất cả các tập tin .MAX 

đang nằm trong thư mục hiện hành. Để mở 
file.MAX chúng ta chỉ cần chọn file cần mở sau 
đó chọn Open là xong hay chúng ta  có thể nhấp 
double click chuột vào file đã chọn. 

 

 

4.1.1.3. Import 
Cho phép chúng ta mở hay du nhập một file 

đã được tạo ra từ các phần mềm thiết kế mạch 
khác như Protel PCB, CadStar PCB … 

  

 

4.1.1.4. Export 
Cho phép chúng ta chúng ta xuất file.MAX 

đã được tạo ra từ OrCAD Layout sang các 
phần mềm thiết kế mạch in khác như CadStar 
PCB, Protel PCB … 

 

 

 
 

4.1.2. Tools 
Menu Tools co các chức năng sau: 

4.1.2.1. Quản lý thư viện (Library Manager) 
Cho phép chúng ta edit hay tạo mới một footprint của một linh 

kiện nào đó. Từ đây chúng ta có thể tạo hay sưu tập một thư  viện footprint linh kiện mà chúng 
ta hay sử dụng cho các thiết kế sau này của mình (khi chúng ta chuyên về vẽ thiết kế các board 
mạch) 
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4.1.2.2. OrCAD Capture 
Cho phép chúng ta mở chương trình thiết kế mạch nguyên lý OrCAD Capture từ chương 

trình vẽ board mạch OrCAD Layout. 
Ngoài ra còn các chức năng khác như SmartRout cho phép chúng ta vẽ mạch thông minh, 

Edit App Settings, Reload App Settings 

4.2. Tạo Project mới 
Chọn File → New chúng ta sẽ thấy một hộp thoại xuất hiện như hình bên dưới 

 

Nếu chúng ta thiết kế board mạch bình 
thường thì chúng ta load DEFAULT, còn nếu 
chúng ta muốn thiết kế board mạch riêng theo 
một hình dạng cụ thể như sound card LAN card 
cắm trên chuẩn PCI, hay một card nào đó cắm 
trên chuẩn ISA hay một SDRAM, DDRAM … 
thì chúng ta chọn các file template khác. 

Ta cuõng coù theå ñoåi maãu coâng ngheä 
(Technology template) sau khi  vaøo moâi 
tröôøng thieát keá baèng caùch  file\ load   (File 
Technology template coù daïng *.tch ).  
 

Sau khi chúng ta chọn file template cần load thì một hộp thoại khác lại xuất hiện yêu 
cầu chúng ta mở file.MNL mà chúng ta đã tạo ra trong phần OrCAD Capture (xem lại chương 
3).  

 
Cách làm như sau: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Chọn file kết xuất của quá trình 
ạo Netlist, trong trường hợp này t

là: ‘NguonTT.MNL’ 

Layout  yêu cầu đặt tên file 
layout .max, mặc nhiên có tên 
giống tên project đã đặt 
(NguonTT.max) 
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 Sau đó chọn đường dẫn thích hợp để lưu file.MAX.  Nếu các linh kiện trong mạch thiết kế 

là các linh kiện mới và chưa từng liên kết đến thư viện footprint của Layout lần nào thì nó yêu 
cầu chúng ta phải liên kết đến footprint. Đây là bước khó khăn đòi hỏi chúng ta phải cẩn thận, 
chúng ta sẽ tiến hành cách làm này ở phần bên dưới 

4.3. Liên kết đến footprint 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Đây là giai đoạn khó, đòi hỏi kinh 
nghiệm để liên kết các Footprint đến từng 
loại linh kiện đýợc sử dụng trong mạch. 

ấn vào Link… 
Linh 
kiện 
cần 
liên kết 

 Chọn tên footprint 
thích hợp 

Footprint 
tương ứng Lặp lại đến hết các linh 

kiện trong mạch 

Các thư viện 

Các footprint trong 
thư viện tương ứng 

Một số footprint thông dụng: 
- Thư viện TO:  TO92 (trans. C828, C1815, C535, … ) TO202 (trans. H1061, IC  ổn áp 

họ 78xxx, 79xxx …) 
- Thư viện DIP100T: /W.300 (các IC cắm từ 14-20 chân)  /W.600 (các IC cắm từ 24-40 

chân ) 
- Thư viện TM_CAP_P là footprint của các loại tụ điện 
- Thư viện  TM_CYLND là footprint của các loại tụ điện 
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- Thư viện TM_DIODE  là footprint của các loại diode hay Led. 

4.4. Đặt footprint trên board mạch 
Sau khi liên kết các footprint đến toàn bộ các loại linh kiện, Orcad tự động load các 

footprint như hình vẽ  

 

 

 

 

 

 

 

 

 

 

 

 

 

Laøm vieäc vôùi footprint ( layout cuûa linh kieän)  
Trong phần này chúng ta đề cập đến 2 vấn đề: 

• Tìm kiếm linh kiện và chỉnh sửa footprint linh kiện. 
Khi các footprint được load thông thường chúng không đúng như yêu cầu của người thiết 

kế. Do đó, chúng ta phải tìm đúng footprint cho phù hợp với từng loại linh kiện thực tế để khi 
tạo ra board mạch in sao cho tối ưu nhất. 
Cách thực hiện như sau: 

 
Chọn footprint linh kiện cần thay đổi 

trên board mạch vừa load, sau đó click 
chuột phải và chúng ta sẽ thấy menu dọc 
xuất hiện, tiếp theo chúng ta chọn Properties 

 
 
 
 
 
 
 
 
 
Sau khi chúng ta chọn Properties thì một hộp thoại xuất hiện để cho chúng ta chọn loại 

footprint thích hợp. Chúng ta sẽ thấy vấn đề này như hình minh họa bên dưới. 
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Click chuột vào 
đây để tìm 
footprint thay thế 
thích hợp và chúnh 
ta thấy hộp hội 
thoại xuất hiện 

 
 
 
 
 
 
 
 
 
 
Chúng ta click chuột vào Footprint, sau đó chúng ta sẽ thấy một hộp thoại cho chúng ta 

chọn footprint thích hợp. 
 
Từ hộp thoại Select Footprint, nó cho phép 

người thiết kế lựa chọn footprint thích hợp hay 
theo ý thích của mình. 

 
Tuy nhiên, nếu các footprint có trong Select 

Footprint đó không phù hợp thì chúng ta phải 
tạo mới footprint đó cho phù hợp về kích thước 
của linh kiện. 

 
 
 
 

• Tạo mới một linh kiện 
(footprint). 

 Mở thư viện linh kiện của layout : vào File \ library manager  hoặc Ctrl+I để mở 
 
 
 
 
 
 
 
 
 
 
 
 

Hay sử dụng công cụ trên thanh Tool Bar, sau khi chỉnh sửa linh kiện xong ta phải lưu lại 
(Save hay Save As) 
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để tạo footprint mới hoặc 
edit footprint trong Library 
manager 

 

 

 

 

 
 
 
Sau khi click chuột vào Library Manager hay công cụ trên thanh Tool Bar, chúng ta sẽ thấy 

hộp thoại xuất  hiện 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Nếu chúng ta muốn tạo một footprint mới hoàn toàn thì chúng ta click chuột vào Create 

New Footprint, còn nếu tạo một footprint mới thông qua việc Edit một footprint linh kiện có 
sẳn thì chúng ta chọn thư viện có chứa footprint mà chúng ta cần thay đổi để tạo thành một 
footprint mới, nếu trong Libraries không có thư viện ta cần tìm thì chúng ta Add thư viện 
footprint mới vào và chúng ta cần lưu ý chỉ chọn các thư viện footprint trong Layout mà thôi. 
Các thư viện này chúng ta có thể Remove chúng ra nếu thấy không cần thiết để lại sử dụng nữa 
và dĩ nhiên chúng sẽ không bị mất trong trường hợp này mà chúng vẫn còn nằm trong thư  viện 
footprint của Layout. Sau khi chúng ta chọn được footprint linh kiện sao cho chúng ta đỡ mất 
thời gian Edit nhất. Ví dụ chúng ta làm như hình trên, sau khi sửa chữa tạo ra một footprint 
mới chúng ta nên Save As vì nếu chúng ta chọn Save thì nó sẽ lưu footprint mới vào cùng tên 
footprint cũ và lúc đó tính chất của footprint cũ sẽ không còn đúng nguyên bản chất của chúng 
nửa. Chúng ta có thể lưu footprint mới đó nằm trong thư viện hiện hành hoặc chúng ta có thể 
tạo ra một thư 
viện mới cho 

riêng 

mình. 

chọn đường dẫn để lưu 
thư viện mới Đặt tên thư viện 

mới 

Để tạo thư viện 
mới 
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Trong khi thiết kế một footprint mới chúng ta có thể sử dụng các công cụ khác của OrCad 
Layout để tạo ra footprint theo ý muốn và kích thước tuỳ ý ....Chẳng hạn có thể dùng các công 
cụ đo dạt như: Dimension, Measurement trong menu Tool để có thể tạo chính xác kích thước 
linh kiện thực tế.  

Để xem thông tin về footprint của linh kiện ta 
vào:  

Spreadsheet\Footprint 
 
 
 

Sau khi click chuột vào và chúng ta sẽ thấy 
bảng liệt kê các footprint của các linh kiện có trong 
board mạch. Cụ thể đối với mạch nguồn trong thiết 
kế này được liệt kê trong bảng sau: 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

4.5. Định dạng và kích thước board mạch 

• Nhấp chuột vào biểu tượng ‘Obstacle Tool’ 
 Vẽ bao hình bên ngoài của board mạch 
 Khi vẽ xong đường bao khép kín, double click chuột vào đường bao hay click 

chuột vào đường bao khi thấy con trỏ có dấu + nhỏ xuất hiện rồi click phải chuột, 
cách làm như hình bên dưới. 

 Sau đó chọn Properties, xuất hiện cửa sổ cho đặt độ rộng đường bao như sau 
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• Thiết lập đơn vị đo và hiển thị, nó cũng là đơn vị thể hiện độ rộng của đường mạch in 
(net) trong board mạch. Mục đích của vấn đề này là giúp cho người thiết kế mạch in 
kiểm soát được độ rộng của 
các nets trong board mạch 
cũng như kích thước của 
board outline. Cách làm 
được minh họa như hình bên 
dưới 

 

 

 

 

 

 

 Sau khi click chuột vào Options\ System Setting (hay dùng phím nóng Ctrl+G). 
Chúng  ta sẽ thấy một hộp thoại xuất hiện, từ đây chúng ta có thể đặt các đơn vị 
thiết kế, đơn vị hiển thị như Mils, Inches, Microns, Millimeters hay Centimeter. 
Chúng cũng cho phép cho chúng ta thay đổi lưới hiển thị, lưới vẽ, đặt lưới nếu cần 
thiết. 
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• Đo kích thước board:  ‘Tool’ → ‘Dimension’  → ‘Select tool’, sau đó  đo độ dài và 
độ rộng đường bao. Mục đích của cách làm này là cho người thiết kế biết được kích 
thước của board mạch mình thiết kế có kích thước bao nhiêu, có lớn so với kích 
thước thực tế của board mạch in mà mình đang có để từ đó có cách điều chỉnh thích 
hợp, sắp xếp lại linh kiện trong đường bao hợp lý với một khoảng cách hợp lý 
nhât.Cách làm như sau: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Chúng ta 
lưu ý rằng đơn vị đo khoảng cách này có cùng đơn vị đo với đơn vị được đặt trong Menu 
Options\System\Settings  mà chúng ta vừa thực hiện ở phía trên. Muốn thay đổi đợn vị hiển thị 
và cũng như đơn vị đo, chúng ta cũng vào Menu Options\System\Settings để đặt lại. Tuy nhiên, 
đơn vị đó trên board outline sẽ không tự động thay đổi theo, để chúng có thể thay đổi chúng ta 
phải vào Tool\Dimension\Select Tool hay New, sau đó click chuột vào thước đo khi thấy con 
trỏ chuột chuyển sang dấu + (nhỏ) rồi chúng ta xê dịch thì lúc này đơn vị đo sẽ thay đổi theo 
đơn vị đo vừa đặt lại. 

 

 

 

Thiết lập đơn vị đo cho bảng thiết kế 
 

 

 

 

 

Veõ board outline  
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Chọn công cụ vẽ board outline và vẽ, sau đó double click  lên board outline để thiết lập các 
thông số , ta có hộp thoại như sau: 

 

 

 

 

 

 

 

 

 

 

 
Để định nghĩa Layer stack, ta chọn Spreadsheet từ Toolbar 
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  Sau đó chúng ta click chuột vào layer để chọn lớp vẽ. Ta thấy hộp hội thoại xuất hiện: 

 

 

 

 

 

 

 

 

 

 

 

 

 Để thiết lập lưới vẽ ta vào Options → System Setting và ta thấy hộp hội thoại sau đây 
xuất hiện. 

 

 

 

 

 

 

 

 

 

 Để thiết lập những luật về khoảng cách cho pads, tracks và vias. Ta chọn 
Spreadsheet từ Toolbar 

 

 

 

 

 

 

 

Click chuột vào Route Spacing, sau đó chọn kéo chuột ngang qua lớp mình cần thực 
hiện chức năng này( có thể chỉ một lớp TOP hay BOTTOM hoặc cả hai lớp TOP và 
BOTTOM) và click chuột phải sau đó từ menu pop up chọn Properties chúng ta sẽ thấy 
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Thay đổi các giá trị theo 
yêu cầu của người vẽ 
mạch và chú ý đến đơn vị 
đo đang sử dụng 

 

 

 

 

 

 

 

 
Để định nghĩa padsstack ta chọn padstack trong Spreadsheet 
Ta làm tương tự như hình bên dưới và sẽ thấy 

 

 

 

 

 

 

 

 

Giả sử ta chọn VIA1 sau đó double click chuột hay clcik chuột phải rồi chọn Properties 
từ menu pop upvà chúng ta sẽ thấy. 

 

 

 

 

 

 

 

 

 

 

 

Từ đây 
chúng ta có thể thay đổi hình dạng của các pin trong footprint và các đặc tính khác như Non-
Plated, Use For Test Point ... 

Đặt linh kiện 
Sau khi thiết lập các thông số cho bản vẽ, ta bắt đàu sắp xếp linh kiện. Trước khi đặt linh 

kiên trên bản vẽ chúng ta phải đảm bảo rằng trên bản vẽ đã có board outline trên tất cả các lớp 
vẽ. 
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Để kiểm tra Board outline và những vùng cấm ta chọn spreadsheet \ obstacles  như hình 
bên dưới. 

Lock linh kiện (dẽ dàng cho việc sắp xếp linh kiện trên bản vẽ) và thay thế linh kiện 
(trường hợp ta thiết kế sẵn footprint cho linh kiện) 
 
 
 

 

 

 

 

 

 

4.6. Sắp xếp linh kiện lên board mạch 

• Nhấp chuột vào biểu tượng ‘Component tool’ 
• Để di chuyển linh kiện nào, ta nhấp chuột vào linh kiệnđó, sau đó, khi nhả chuột ra và 

di chuyển thì linh kiện sẽ được di chuyển theo. 
• Đến vị trí muốn đặt linh kiện, thì nhấp chuột lần nữa 
• Việc bố trí linh kiện là 1 trong những yếu tố quan trọng  ảnh hưởng đến độ ổn định, dễ 

vẽ, thẩm mỹ, … 

 

 
Board 
outline 

 

 

 

 

 

 

 

4.7. Xác định số lớp mạch cần vẽ 

 Trong mục này chúng ta cần phải xác định mạch  in chúng ta cần vẽ là bao nhiêu lớp. 
Trong OrCad Layout chúng ta vẽ được rất nhiều lớp mạch in nhưng do trên thị trường trong 
nước chúng ta chỉ có bán mạch in tối đa là 2 lớp và một mặt do hạn chế về mặt công nghệ nên 
cho dù chúng ta có vẽ được mạch in nhiều lớp thì chúng ta cũng không thể nào rửa mạch được. 
Do đó chúng ta chỉ chọn số lớp mạch thích hợp với nhu cầu thực tế, tuỳ theo mức độ phức tạp 
của mạch mà chúng ta có thể chọn vẽ mạch in một lớp hoặc hai lớp 
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Vẽ bảng mạch in ( mạch đồng) 
Tröôùc  khi veõ nhöõng ñöôøng noái maïch ta phaûi thieát laäp nhöõng thuoäc tính 

cuûa ñöôøng veõ ( net properties), cho pheùp veõ treân lôùp naøo ( tröôøng hôïp veõ nhieàu 
lôùp),  vaø moät soá caùc thoâng soá khaùc.   Thieát laäp caùc thuoäc tính cho ñöôøng noái 
maïch (teân, ñoä roäng) 

 Löu yù : 
- Veõ ñöôøng Vcc vaø Gnd tröôùc,  phaûi coù ñoä roäng lôùn hôn taát caû caùc ñöôøng 

coøn laïi.  
- Trong quaù trình veõ ta coù theå click chuoät phaûi ñeå coù theå thay ñoåi ñoä roäng, 

add via, free via, lock ñöôøng veõ, thay ñoåi loaïi via… 

Vẽ mạch tự động (Autoroute) 
Layout söû duïng nhöõng kyõ thuaät veõ sweep, shove, interactive ñeå taêng cöôøng 

söùc maïnh töï ñoäng veõ vaø khaû naêng uyeån chuyeån ( flexibility) 
 Sau ñaây la nhöõng böôùc cô baûn ñeå veõ maïch töï 
ñoäng: 

- Thieát laäp nhöõng thuoäc tính cho ñöôøng veõ (nets). 
- Kieåm tra boardoutline, ñònh nghóa via vaø löôùi veõ. 
- Veõ ñöôøng Vcc vaø Gnd. 
- Veõ tröôùc nhöõng ñöôøng phöùc taïp. 
- Load file chieán thuaät veõ. 
- Chaïy autouter. 
- Optimize ñöôøng veõ( söû duïng nhöõng coâng cuï 

trong menu Auto). 
  Here’s detail : 

- Orcad có thể vẽ tự động trên số lớp đã đặt. Tuy nhiên, các mạch phức tạp đòi hỏi 
nhiều thao tác vẽ tay. 

- Để vẽ tự động: Chọn ‘Auto’ →  ‘Autoroute’ → ‘Board’ 
- Orcad cho phép đặt nhiều chiến lược vẽ khác nhau. Ngoài ra, trước khi vẽ tự động 

ta cần đặt các thông số như: Độ rộng đường vẽ, khoảng cách đường - đường, đường 
- chân linh kiện, … Sẽ được đề cập ở phần các kỹ thuật nâng cao. 
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Lớp BOTTOM 
Vẽ mạch 1 lớp 

 
 
 
 
 
 
 
 
 
 
 

Sau khi vẽ xong,ta cần kiểm tra lại sự đúng đắn của mạch điện và để thực hiện được chức 
năng này chúng ta click chuột vào DRC trên thanh công cụ. Nếu mạch chúng ta vẽ co lỗi hoặc 
cảnh báo thì sẽ có những vòng tròn màu đỏ thì chúng ta phải sửa hết tất cả các lỗi này thì mạch 
in chúng ta thiết kế ra mới đảm bảo không bị chạm nhau. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vẽ mạch bằng tay 
Việc vẽ bằng tay, tuỳ thuộc vào 3 chế độ vẽ: 

 

     AutoPath Route Mode          Add/Edit Route Mode 
                                 Edit Segment Mode 

 
 
 
 
 
 

Sau khi chọn chế độ vẽ thích hợp, ta nhấp chuột vào đường vẽ để sửa đổi hoặc vẽ đường 
mới từ chân này đến chân khác. Thông thường, vẽ tự động  xong, đòi hỏi phải có thao tác chỉnh 
sửa bằng tay. 
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4.8. In mạch Layout lên giấy trong/bóng mờ 

Để in PCB layout vừa vẽ, ta thực hiện các bước sau: 
- Chọn ‘Options’ → ‘Post Process Settings’ 
- Nhấp chuột phải vào lớp muốn in (ví dụ lớp BOTTOM),   chọn ‘Preview’ 
- Chọn ‘File’ → ‘Print/plot’ 
- Chọn options thích hợp, OK   

 

Click chuột phải chọn Preview từ menu popup 
và chúng ta vào File→Print/Plot hoặc Ctrl +P 
để in 

 
 
 
 
 
 
 
 
 
 
 
 
 

In để thấy tâm của 
pin linh kiện để dễ 

dàng khoan lỗ mạch 
in sau này 

Nếu không phải là 
máy in màu thì check 

vào đây 

Nếu bỏ check này nếu muốn in mạch in theo toạ độ góc X, 
Y Ngược lại thì in board mạch ở giữa trang giấy 
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Intertool communication 
Layout coù theå lieân laïc hoaëc keát noái vôùi Capture hoaëc moät soá coâng cuï thieát 

keá maïch ñieän khaùc ñeå coù theå kieåm tra tính chính xaùc cuûa maïch ñieän sau khi hoaøn 
taát.  
 
 
 
 
 
 
 
 
 
 
 
 

Moät  trong nhöõng khaû naêng noåi baät cuûa Layout laø khi ta choïn moät ñoái 
töôïng trong Capture thì ñoái töôïng töông öùng trong Layout seõ saùng leân vaø ngöôïc laïi. 
Chức năng này giúp cho người thiết kế biết được linh kiện mình sắp xếp xem chúng nằm ngay 
vị trí mong mong muốn hay chưa. 
  
 
 
 
 
 
 
 
 
 
 

Tröôùc khi söû duïng coâng cuï  Intercool communication trong Capture, ta phaûi baät 
cheá ñoä ITC trong Capture nhö sau : Options \ Preferences…  
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Qui trình tạo mạch đồng 

In PCB layout  
lên giấy trong/bóng mờ 

Tạo bảng lụa 
(mặt nạ) 

In lụa lên bảng đồng 

Rửa mạch bằng hoá chất 

Khoan lỗ, phủ xanh, … 

Hoàn tất mạch in 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tạo thư viện footprint trong Orcad layout 
- Khởi động Orcad layout 
- Chọn ‘Tools’ → ‘Library Manager’ → ‘Create New Footprint’ → Đặt tên cho 

footprint. 
- Để thêm Pin mới, nhấp chuột phải, chọn ‘New…’ 
- Sau khi đặt xong tất cả các chân, lưu lại footprint 
- Cần lưu ý đến tỉ lệ lưới vẽ 

 
 
 
 
 
 
 
 
 
 

Định dạng độ rộng đường mạch in 
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- Nhấp chuột vào ‘View Spreadsheet’, chọn ‘Nets’ 
- Chọn ‘Width’ tương ứng với ‘Net Name’ trong bảng Nets 
 

Độ rộng đường Min – Max 
(1 inche = 1000 mils) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Định dạng khoảng cách các đường vẽ 
- Nhấp chuột vào ‘Options’, chọn ‘Global Spacing…’ 
- Chọn và đặt khoảng cách thích hợp. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

- Việc đặt các khoảng cách này cộng với độ rộng đường sẽ ảnh hưởng lớn đến việc 
vẽ mạch. Ví dụ, đường mạch có thể không  xuyên qua 2 chân IC được, … 

- Phụ thuộc công nghệ làm mạch in, … 
Các chú ý quan trọng khi vẽ bảng mạch thiết kế: 
Trong phần Layout chúng ta chú ý đến 2 vấn đề chính là vẽ mạch in tự động và vẽ 

mạch in bằng tay (manual), nhưng cho dù là vẽ bằng cách nào đi chăng nữa chúng ta cũng có 
một số chú ý sau:  

1. Để biết được kích thước của bảng mạch in thì ta vào Tool/Dimension/New (hoặc select 
tool),rồi ra màn hình vẽ mạch ta chỉ cần nhấp chuột trái và khi thấy có hình 2 mũi tên 
hương ra và ta kéo chuột đi và muốn đo đến đoạn nào thì ta nhấp chuột trái thì thanh 
thước đo sẽ hiển thị ra giá trị đo được, nhưng giá trị này mặc nhiên là Mils do đó muốn 
đổi về dạng mm hoặc cm thì ta vào Options/systems setting và chọn đơn vị cần đo. Và 

Trần Hữu Danh  Trang 103 



 Chương 4: OrCAD Layout 9.2 

bây giờ giá trị này vẫn chưa thay đổi, muốn thay dổi thì ta chỉ cần nhấp chuột vào thước 
đo trên bản mạch in rồi nhấp chuột lại lần nữa để xác định.  

2. Phải vẽ đường viền bao quanh bản mạch in để kiểm soát đường vẽ, linh kiện để khi vẽ 
sẽ không bị vượt ra ngoài giới hạn cho phép. Để làm được điều này ta làm như sau: 

Vào Tool/Obstacle/new (hoặc select tool) hay nhấp chuột vào Obstacle Tool trên Menu 
lệnh, rồi chọn 0 Global layer (có màu vàng).Nhấp chuột trái và khi thấy con trỏ là dấu 
cộng nhỏ hơn. Sau đó kéo chuột cà muồn dừng tại điểm nào thì nhấp chuột trái. Khi 
điểm đầu và điểm cuối gặp nhau thì ta nhấp chuột phải để chọn End Command để kết 
thúc.  

3. Để đặt chiến lươc vẽ mạch in tự động ta vào trong menu Options/ Route 
Strategies/Route Sweep. Để chọn vẽ lớp trên bao nhiêu % và lớp dưới bao nhiêu %. 

4. Vào Options chọn Global Spacing để chọn khoảng cách giữa các track to track, via to 
via, track to via, track to pad, via to pad … 

5.   Tạo Copper pour cho bản mạch in khi đã thiết kế xong, mục đích của vấn đề này là để 
chống nhiễu cho mạch điện. Có thể kéo lớp phủ này đối với VCC hay với GND. Cách 
làm như sau: 

Từ menu Tool/Obstacle/properties ( nếu đã tạo đường viền bao quanh bản mạch rồi) hoặc 
là Tool/Obstacle/new đối với trường hợp chưa tạo đường viền cho bản mạch in và ta phải 
vẽ đường viền bao quanh bản mạch. Khi vẽ xong, nhấp chuột trái khi thấy con trỏ co 
hình dấu + nhỏ thì nhấp chuột trái chọn Properties. Sau khi trên màn hình xuất hiện hộp 
thoại Edit Obstacle. Kế tiếp chúng ta chọn Obstacle Type chọn Copper pour, chọn 
Obstacle layer chọn lớp cần phủ copper pour ( có thể là TOP hay BOTTOM…) còn Net 
Attachment thì chọn là GND hay VCC tùy theo chúng ta muốn phủ theo GND hay VCC 
… Còn Hatch Pattern thì ta chọn là Line hay Cross Hatching hay Soild rồi chọn OK. Sau 
đó chọn tiếp OK Sau đó chọn ESC hoặc nhấp chuột phải rồi chọn End Command hoặc 
Finish. Thi chúng ta sẽ có một bản mạch in đã phủ Copper pour. 

 

6. Kích hoạt kiểm tra lỗi khi vẽ mạch in vào menu Tool/erro chọn select tool để kích hoạt 
bẩy lỗi. Muốn xem lỗi thì chọn menu Tool/erro/select from spreadsheet hoặc cũng có 
thể chọn menu Auto/Design rule check để kiểm tra lỗi, hoặc kích chuột vào menu lệnh 
Design Rule Check. 

7. In các linh kiện trên board mạch ở mặt trên của board mạch để thuận tiện cho việc gắn 
linh kiện về sau thì ta làm như sau: 

Vào menu Options/Post Process Settings thì hộp hộithoại xuất hiện. Sau đó chọn Plot 
Output File name là *.AST nhấp chuột phải và chọn Preview để xem các linh kiện ở 
mặt trên của board mạch. Bây giờ chỉ cần ta in file này ra để thấy các linh kiện đã được 
sắp xếp ở mặt trêncủa board mạch. 

8. Sau khi vẽ xong board mạch  in, bây giờ Layout trong Orcad có hỗ trợ chức năng filter 
tối ưu hóa để làm cho mạch gọn và tối ưu nhất ( trong cả hai chế độ vẽ tự động và vẽ 
bằng tay đều sử dụng được tính năng này và chỉ co trong Layout và Layout Plus). Bằng 
cách chọn Menu Auto\ Cleanup Design hoặc có thể vào từ Menu 
Auto\Refresh/minimize conections . 

9. Để thay đổi độ rộng của đường mạch ta chọn đường mạch cần thay đổi độ rộng (lúc này 
ta có thể ở đang ở chế độ vẽ manual hay đã kết thúc việc vẽ tự đông, chỉ còn chỉnh độ 
rộng đường mạch cho phù hợp) tacó thể chọn  ở mode autopath Route hoặc Add/edit 
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route hoặc Edit segment và nhấn phím W thì có một hộp hội thoại hiện ra cho chúng ta 
chọn để có thể thay đổi có thể là cả segment, net hoặc conections.  

10. Ta có thể chọn một khối mạch riêng lẻ trên một board để vẽ. Nhằm kiểm tra các chiến 
thuật vẽ đã chọn và để tối ưu board mạch in vẽ sau này. Vào menu View\Zoom 
DRC/Route Box để rãi linh kiện ( ta có thể thay đổi kích thước của DRC/Route Box 
hiện hành, dời nó hoặc có thể đặt kích cỡ của DRC/Route box bằng mouse và phóng to 
và chuyển để ở một vị trí khác). Sau đó vào Menu Auto\Autoroute\DRC/Route Box để 
vẽ khối mạch đã chọn. Còn nếu muốn Unroute khối mạch đã vẽ trên thì ta làm ngược 
lại vào menu Auto\Unroute\DRC/Route Box để không vẽ.  
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Chương 1. Khái niệm cơ bản  Biên soạn: ThS. Phan Như Quân 

 Trang 1 

Chương 1 KHÁI NIỆM CƠ BẢN 
 

1.1 KHÁI NIỆM CƠ BẢN 
1.1.1. Mạch Điện (circuit):  mạch điện gồm có: nguồn, tải và dây dẫn điện 
1.1.2. Nhánh (branch): một đoạn mạch gồm những phần tử ghép nối tiếp nhau.  
1.1.3. Nút (node):    điểm giao nhau của 3 nhánh trở lên 
1.1.4. Vòng (ring):  một lối đi khép kín qua các nhánh 

Ví dụ 1 : 

 
1.1.5. Nguồn (power, supply, source): các thiết bị điện để biến đổi các năng lượng 

khác sang điện năng 
1.1.6. Tải (load): các thiết bị điện dùng để biến đổi điện năng ra các dạng năng 

lượng khác 
1.1.7. Dây dẫn (conductor): là dây kim loại dùng để truyền tải từ nguồn đến tải 

1.1.8. Điện thế (voltage): UA, UB, VA, VB, A, B,… 

1.1.9. Hiệu điện thế : UAB=UA-UB=VA-VB=A- B 
1.1.10. Dòng điện (current): dòng chuyển dời có hướng của các hạt mang điện 

(electron, lỗ trống) 
Biểu diễn hàm điều hòa của dòng điện như sau : 

    0 sini t I t A    
Trong đó : 

-  I0 : là biên độ, giá trị cực đại của dòng điện (A) 

- 0

2
II   : là giá trị hiệu dụng (A) 

-  22 /f rad s
T
    : Tần số góc 

- ( , )f Hetz Hz : tần số (số chu kỳ T trong 1 giây) 
- (sec , )T ond s  : Chu kỳ tín hiệu (thời gian lặp lại) 
- . ( , )t radiant rad  : góc pha  
- ( , )radiant rad : pha ban đầu 
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Lưu ý  Khi đầu bài cho giá trị điện áp, dòng điện ta phải hiểu đó là giá trị hiệu 
dụng.  Khi nào đầu bài cho giá trị biên độ thì phải đầu bài sẽ nêu giá trị biên độ. 

1.1.11. Chiều dòng điện : Tùy ý chọn. Khi giải ra thấy giá trị âm thì kết luận dòng 
điện có chiều  ngược với chiều đã chọn 
Vídụ 2 : 

R1I1 I2R3

R4
E

R2

 
Giả sử giai ra được : 2 5I A  , ta kết luận 2I  có chiều ngược với chiều đã chọn 
1.2 MÔ HÌNH MẠCH ĐIỆN 

1.2.1. Điện trở (Resistor: R (ohm, )) : Đặc trưng cho hiện tượng tiêu tán năng 
lượng biến điện năng thành nhiệt năng. 

 
u R i   

1.2.2. Điện cảm (Inductive L (Henry, H)): Đặc trưng cho hiện tượng tích/phóng 
năng lượng từ trường. 

 
 L

diu L
dt

  

 Năng lượng từ trường: 
2

2L
LIW   

1.2.3. Điện dung (Capacitor C (Fara, F)) : Đặc trưng cho hiện tượng tích/phóng 
năng lượng điện trường. 

 

 
   C

C
dui t C
dt

  

Hay     1
C Cu t i t dt

C
   

Năng lượng điện trường : 
2

2C
CUW      
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1.2.4. Nguồn độc lập. 
1.2.4.1. Nguồn áp, nguồn sức điện động độc lập : u(t), e(t) 

   Qui định chiều Đối với nguồn áp U : từ dương sang âm 
  Qui định chiều Đối với nguồn sức điện động  E: từ âm sang dương 

 
1.2.4.2. Nguồn dòng độc lập : Dòng điện của nó không phụ thuộc vào điện áp 

trên 2 cực nguồn. 

1.3. PHẦN TỬ 4 CỰC 
1.3.1. Nguồn phụ thuộc  

1.3.1.1. Nguồn dòng phụ thuộc dòng : 
 
 
  
 

1.3.1.2. Nguồn dòng phụ thuộc áp : 
 
 
 

 
1.3.1.3. Nguồn áp phụ thuộc áp : 

       
 
 
 

1.3.1.4. Nguồn áp phụ thuộc dòng : 
 
 

 
 
 
1.4. ĐỊNH LUẬT OHM 
 

1.4.1. Định luật ohm  

 
Nếu UA>UB dòng điện I chảy từ A sang B:  0A BU UI

R


   

 

i2 

i1  i1 i2 =  i1 

o 

o 

o 

o 
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Nếu UA<UB dòng điện I chảy từ B sang A:  0B AU UI
R


   

Nếu UA=UB (đẳng áp) không có dòng điện I:  0A BU UI
R


   

 
1.4.2. Ví dụ 
Cho mạch điện sau, tìm I 

 
 

Giải: 
12 10 2

1
V VI mA

k


   

1.5. ĐỊNH LUẬT KIRCHHOFF 

1.5.1. Định luật Kirchhoff 1: 0
Node

i    

 là dấu, có thể qui ước tùy ý: vào (+), ra (-) hoặc vào (-) ra (+) 

                     
i1+ i4 – i2 – i3 = 0 

 
Chú ý : Nếu mạch có d nút thì ta được d-1 phương trình K1 

1.5.2. Định luật Kirchhoff 2:  
Ring Ring Ring

E U R I           

Chú ý :   - Nếu mạch có d nút, n nhánh thì ta có n-d+1 phương trìng K2 

  - Lưu ý chiều của nguồn sức điện động từ (-) sang (+) và chiều nguồn áp 
từ (+) sang (-) 
  - Định luật Kirchhoff 2 không viết được cho vòng có nguồn dòng 
 
Ví dụ 3 : Viết phương trình K1, K2 cho mạch sau : 

 
K1  :                 I1 – I2 – I3 = 0       (1) 
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K2  :                5,43010   UU             
                       10 I1 + 30 I2 = 4,5                    (2) 
Tương tự :      60 I3 – 30 I2 = 0               (3)  
Ví dụ 4: Viết phương trình K1, K2 cho bởi mạch sau : 

 
K1A :  I6 - I1 - I2   =  0 
K1B :  I1 - I4 – I3  =  0 
K1C :  I2 + I3 + I5 =  0     
 
K2  :                    R1I1 –E1 +  R3I3 - R2I2  = 0 
                           R4I4 –E5 + R5I5 – R3I3  = 0 
                           R2I2 –R5I5 + E5 – E6 +R6I6  = 0 
 
Hoặc cách khác :               R1I1 + R3I3 -  R2I2  = E1 
                             R4I4 + R5I5 – R3I3  = E5 
                             R2I2 –R5I5 +  R6I6  = E6 – E5 
 
Ví dụ 5 : 

 
 
K1 :                  I4  + I3 – I1 – I2 = 0 
K2 :                  -3I1 + 6I2  = 0 
                      -12I3 – 6I2 = -24              
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1.6. PHÉP BIẾN ĐỔI TƯƠNG ĐƯƠNG 
Chú ý : Khi mạch điện chỉ có 1 nguồn thì dùng phương pháp biến đổi tương đương 

1.6.1. Phân dòng 

 
 

1.6.2. Phân áp 

 
 

1.6.3. Biến đổi nguồn áp sang nguồn dòng  

 
1.6.4. Biến đổi nguồn dòng sang nguồn áp 

 
1.6.5. Biến đổi Y→ và →Y: 

 

 
 

: 
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Ví dụ 6 :  Tính I, I1, I2 = ? 

 
                                 
                                           1 30 / /60 20R     

 
 
Ví dụ 7 : Tính dòng các nhánh, U ? 
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1 6 / /12 4R     
2 1 8 12R R nt    

3 16 8 24R nt     
4 2 3/ / 8R R R    

5 4 24 32R R nt    
6 5 32 16R R nt    

6 4 20tdR R nt    

3
td

UI A
R

   

3
5

32 1.5
32

I I A
R

 


 

3
2 3

3 2

1RI I A
R R

 


 

1 2
6 1

6 12 3
I I A 


 

4 3 2 0.5I I I A    
4 16 8U I V    

Ví dụ 8 : Tính dòng các nhánh ? Tính U ? 

 
 
 1 (2 1) / /6 2R nt    
 2 1 2 4R R nt    
 3 2 / /12 3R R    
 3 2 5tdR R nt    

 4
td

UI A
R

   

 2
2

2

1
12

RI I A
R
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 3 1 2 3I I I A     

 4 3
6 2

6 3
I I A 


 

 4 1 2U I V    
Ví dụ 9 :Tính dòng điện I trong mạch : 

R2

6 c

R3

6

R6

2

_ +

U=6V

R5

2

bR1

6

R4

2

I

a

 
Biến đổi abc  

R13

2

R6

2

I

R12

2

_ +

U=6V

R4

2

R23

2

R5

2

 

12 13 23
6 2
3

R R R      

  2 2 2 2
2

2 2 2 2 2
R

 
  

   
 

Rtđ = 2 + 2 + 2 = 6  

I = A1
6
6
  

Ví dụ 10: Tính I1, I2, I3 

R1

3

5A

I1

R3

12

_
+ U=6VR2

6

I2

I3
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Ia

_
+ U=6V

I3R3

12

5A R1//R2
3//6=2

 
 

I3R3

12

2

_
+10V

_
+ U=6V

 

3
24 10 1
2 12

I A
 


 

1 5 6aI A    

1
6 6 4
6 3

I A
 


 

2
6 3 2
6 3

I A
 


 

Ví dụ 11 : Tính u1, u2, u3 = ? 
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Ví dụ 12 :  

 

 
 
1.7. CÔNG SUẤT 
 1.7.1. Công suất tiêu thụ (có ích) P (power) (Watt, W) 

- Đối với điện 1 chiều:   
2

2. . ( )UP U I R I W
R

    
2 2

1 2 1 1 2 2... . . ...P P P R I R I       

- Đối với điện xoay chiều:  

. .cosP U I  ,  trong đó  ,U I 
 

 

+Nếu mạch chỉ có R (thuần trở): 

 
0   

Suy ra .P U I  
+Nếu mạch chỉ có L (thuần cảm): 

 
Cho i(t)=I0sint (A) 

0 0' cos sin
2L

diu L Li LI t LI t
di
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Góc lệch pha giữa i(t) và u(t) là 900. Và u(t) nhanh pha hơn 
i(i) 
Suy ra  P=0 

+Nếu mạch chỉ có C (thuần dung): 

 
Cho u(t)=U0sint (A) 

0 0' cos sin
2C

dui C Cu CU t CU t
di

         
 

 

Góc lệch pha giữa i(t) và u(t) là -900. Và u(t) chậm pha hơn 
i(i) 
Suy ra  P=0 

+Nếu mạch có R, L, C (giả sử UL > UC) 

 
. .cosP U I   

Trong đó: 
L C L C

R

U U Z Zarctg arctg
U R


 

   

cos RU R
U Z

    

 1.7.2. Công suất phản kháng (vô ích) Q (VAR) 
2. .sin . ( )Q U I X I VAR   

trong đó X có thể là XL=L, có thể là XC =1/C 
 1.7.3. Công suất biểu kiến (dự kiến, toàn phần) S (VA) 

  2 2 ( )S U I P Q VA      

cos P
S

   

sin Q
S
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Chương 2. MẠCH XÁC LẬP ĐIỀU HÒA 
 

2.1. QUÁ TRÌNH ĐIỀU HOÀ 
Biểu diễn hàm điều hòa của dòng điện như sau : 

    0 sini t I t A    
Trong đó : 

-  I0 : là biên độ, giá trị cực đại của dòng điện (A) 

- 0

2
II   : là giá trị hiệu dụng (A) 

-  22 /f rad s
T


    : Tần số góc 

- f  (Hertz, Hz): tần số (số chu kỳ T trong 1 giây) 
- T (s) : Chu kỳ tín hiệu (thời gian lặp lại) 
- t+  (rad) : góc pha  
-  (rad) : pha ban đầu 

Ví dụ: cho 2 hàm điều hoà cùng tần số góc ω: 
    0 sin ii t I t A    
    0 sin uu t U t V    

i u     : được gọi là góc lệch pha giữa i(t) và u(t). 
Nếu >0 : i(t) nhanh sớm pha hơn u(t) 
Nếu <0 : i(t) nhanh trễ pha hơn u(t) 
Nếu =0 : i(t) cùng pha u(t) 
Nếu =  : i(t) và u(t) ngược pha nhau 
Nếu =  /2  : i(t) và u(t) vuông pha nhau 

2.2 BIỂU DIỄN BẰNG SỐ PHỨC 
2.2.1. Khái niệm số phức (complex) 
 
 
 
 
 

 
 

c = a + jb 
Trong đó 

a: phần thực (real) 
b : phần ảo (image) 
j2 = -1 

2 2c a b   : độ lớn. 

 barctg
a

   : argument 

 
 

I (Image: ảo) 

Re (Real: thực) 
0 

c 

a 

b 
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2.2.2. Biểu diễn số phức 
2.2.2.1. hàm đại số 
 c = a + jb 
2.2.2.2. hàm mũ 

 jc c e   

2.2.2.3. hàm lượng giác (áp dụng định lý Euler) 

 cos sinc c j    

2.2.2.4. dạng góc 

 c c    

Một số biễu diễn cơ bản hàm điều hòa về dạng phức 

1.     
.

cosm mi t I t I I        

2.    
.

sinm mi t I t I I        

3. 
     2

.

cos 21cos
2 2

1 2
2 2

m m

m

t
i t I t I

II

 
 



 
    

 

   

 

4. 
     2

.

cos 21sin
2 2

1 2
2 2

m m

m

t
i t I t I

II

 
 



 
    

 

   

 

HƯỚNG DẪN SỬ DỤNG MÁY TÍNH FX-570MS VỚI SỐ PHỨC  
Bước 1: Chuyển sang chế độ số phức: ON – MODE – 2 
Bước 2 :  Nhập số liệu 
Ví dụ1:  Chuyển 3+4j sang dạng góc: 

3 + 4 ENG shift + = (dừng lại quan sát kết quả modul 5) shift = (dừng 
lại quan sát kết quả góc 53.13) 

Kết quả 553.13 
Ví dụ 2: chuyển 2-2j sang dạng góc : 

2 – 2 ENG shift + = (dừng lại quan sát kết quả modul 2.828) shift = 
(dừng lại quan sát kết quả góc -45) 

 Kết quả 2.828-45 
Ví dụ 3: Chuyển ngược lại ví dụ 1 

5 shift (-) 53.13 = (dừng lại quan sát kết quả số thực 3) shift = (dừng lại 
quan sát kết quả số ảo 3.99) 
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Kết quả 3+3.99i 
Ví dụ 4: Chuyển ngược lại ví dụ 1 

2.828 shift (-) - 45 = (dừng lại quan sát kết quả số thực 1.99) shift = 
(dừng lại quan sát kết quả số ảo -1.99) 

Kết quả 1.99-1.99i (≈2-2i) 
Ví dụ 5: Biểu diễn số phức sau sang 3 dạng còn lại: c = 1+j 
Giải 

2 21 1 2c     
01 45

1
arctg    

Suy ra:  452 jc e   
   2 cos 45 sin 45c j   
  2 45c    
Ví dụ 6: Biểu diễn số phức sau sang 3 dạng còn lại: c = 1-j 
Giải 

 221 1 2c      
  01

45
1

arctg


    

Suy ra:   452 jc e    
     2 cos 45 sin 45c j       

  2 45c    
Ví dụ 7: Biểu diễn số phức sau sang 3 dạng còn lại: c = 1 
Giải 
Ta có:  c = 1 + 0j 

2 21 0 1c     
00 0

1
arctg    

Suy ra:  01 1jc e    
   1 cos 0 sin 0c j   
  1 0 1c     
Ví dụ 8: Biểu diễn số phức sau sang 3 dạng còn lại: c = j 
Giải 
Ta có:  c = j = 0+1j 
 

2 20 1 1c     
01 90

0
arctg    

Suy ra:  901 jc e   
   1 cos90 sin 90c j   
  1 90c    
Ví dụ 9: Biểu diễn số phức sau sang 3 dạng còn lại: c = -j 
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Giải 
Ta có:  c = -j = 0-1j 
 

 220 1 1c      

01 90
0

arctg 
    

Suy ra:   901 jc e    
     1 cos 90 sin 90c j       
  1 90c    
 
Ví dụ 10: 

i = 5 sin( 2t + 300 ) (A) 

  
.
I  = 5e 030530 

oj  

     
.
I  = 5 (cos 30o + jsin30o ) = 4,33 + 2,5j 

Đổi ngược lại : 
 c = 55,233,4 22   

  = arctg
33,4
5,2 = 30o 

  i = 5 sin (2t + 30o ) 
Ví dụ 11 : 
u = 10 2 cos (2t – 60o ) 

  jojoU hd 66,85)60sin()60cos(10
.





   

2.2.3. Các phép toán số phức  

Ví dụ 12 :  
Cho  c1=2-3j 

c2=3+2j 
tìm  c = c1+c2 

c = c1-c2 
c = c1×c2 
c = c1/c2 

giải: 
c = (2-3j) + (3+2j) = 5-j 
c = (2-3j) - (3+2j) = -1-5j 
c = (2-3j) (3+2j) = 6+4j-9j+6 = 12-5j 

  
  
2 3 3 22 3 13

3 2 3 2 3 2 13
j jj jc j

j j j
  

    
  

 

 
Lưu ý: nhân, chia số phức với dạng góc:  

a a
b b


 




  


 

    a b a b           
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Ví dụ 13 :  
o

o

oj
j 1162,2

535

6318,11
43

105








  

(2+6j).18 oooooo 504,11321714,1132118.713,621   
ojo

o

oooo

o

o

e
jjjj

j 657657
2815,31
936,223

153,27
936,223

103,17510
3020.6318,11

3020510
3020).510(

















 
2.3 QUAN HỆ U,I TRÊN R-L-C TRỞ KHÁNG VÀ DẪN NẠP : 

1. Quan Hệ U, I Trên R : 

 
i = Io sinwt               0i  
uR = R..i = R .Io sinwt 
Uo = R . Io uR = Uo sinwt   0u  
Trong mạch thuần trở thì dòng và áp cùng pha 
Biểu diễn bằng số phức : 

o
jo

o

o
IeII   

o

ooR

o
IRRIUU   

2
2 ..

2
oR IP R I   

2. Quan Hệ U, I Trên L : 

 
i = Io sinwt               0i  

uL = L   )90sin(.cos. o
oo

t

wtILwtIL
d
di

   

đặt : ULO = LwIo 
        XL = Lw 
UL = ULO sin(wt + 900 ),   0u  

Trong mạch thuần cảm thì áp nhanh pha hơn dòng 1 góc 
2
  

biểu diễn bằng số phức : 
o

L

o
L

o
IjXIjLwU .                RL = 0 

Trong mạch thuần cảm không có hiện tượng tiêu tán năng lượng mà chỉ 
có hiện tượng tích phóng năng lượng từ trường. Đặc trưng bởi công suất 
phản kháng 
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C1

Uc

i 
QL = XL.I2 = 

2

2
Lo XI  (VAR) 

3. Quan Hệ U, I Trên C : 
 

i = Io sinwt               0i  

)90sin(11 oo
c wt

w
I

c
idt

c
u    

c
o

co X
cwcw

I
u 

1  

)90sin( o
coc wtUU                       o

o 90  
Trong mạch thuần dung thì áp chậm pha hơn dòng 1 góc 900 
Biểu diễn bằng số phức : 

o

o
II   

jcw
IIjX

cw
jI

eUU
o

o

c
oj

coc
o o




  90  

2.IXQ cc   
4. Trở Kháng  : 

Trở kháng Z là tỉ số giữa 
o

U  và 
o
I  

Z = o

o

I

U  

 
i = Io sinwt               0i  
u = uR + uL + uc 

c
o

L
o

R
oo

UUUU   

  cL

oo

c

o

L

o
XXjRIIjXIjXIRU 

0
 

đặt X = XL - Xc 

 jXRIU
oo

  

ZjXR
I

U
o

o

  

vậy Z = R + jX =   
2 2Z R X   : trở kháng 

R
Xarctgiu    

 
ký hiệu :  
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2.5 GIẢI MẠCH XOAY CHIỀU BẰNG SỐ PHỨC : 
Bước 1:chuyển sang sơ đồ phức: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Bước 2: Giải mạch bình thường với số phức 
Bước 3: Chuyển số phức về miền thời gian 
VD4 : 

 
 

Giải : 
 

R
i(t)

C

R

iL(t)

u(t)

+ 
- 

U+ 
- 

U

u(t)=U0 sin(t+)(V)

uL(t)

iC(t)

uC(t)

L 

I


 

U


 
LI


 

LU


 

jL  

CI


 

CU


 

1
jC

 

0 ( )U U V
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Giải ra tìm được 21 ,,
ooo
III  

B1 : chuyển sang phức : 

 
B2: tính toán trên sơ đồ phức : 

Cách 1: dng K1, K2 : 

K1 : 0
o
I  

K2 :  
oo
EU  

 
o

L

o

c

o

R

o
EUUU )(  

cách 2 : phương pháp biến đổi tương đương : 
 
Cách 1 : 

K1 : 021 
ooo
III  

K2 : o
oo
IjI 05)33( 1   

     0)33(3 12 
oo
IjIj  

 
Cách 2 : biến đổi tương đương : 
Z1 = 3 + 3j 

Z2 = j
jj
jj 33

333
)3)(33(



  

037534133  jjZ td  

)(371
375
05 0

0

0

AI
o





  

 
B3 : biến đổi sang giá trị tức thời : 

)373cos(1 0 ti  

0
1 531

333
)3.(







jj
jII

o
o

 

)533cos(1 0
1  ti  

o
o

jj
jI 822
333

33.371 0
2 




  

)823cos(2 0
2  ti  

00
0

1

0
3711.3711.  IU R  
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)373cos(1 0
1  tu R  

000
1

00
373531.903.3  IjU L  

)373cos(3 0 tuL  
000

2

0
823822.903.3  IjU c  

)83cos(23 0 tu c  

Pnguồn = wIU 2)37cos(.1.5cos. 0   

Ptt = wIRtd 2
2
1.4.

2
2   

Tổng công suất phát tại nguồn bằng tổng công suất thu  
Q = )(5,1)37sin(.1.5sin. 0 AVIU   
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Chương 3. CÁC PHƯƠNG PHÁP PHÂN TÍCH MẠCH ĐIỆN 
3.1. PHƯƠNG PHÁP ĐIỆN THẾ NÚT : 
 

Khi bắt đầu giải mạch ta sẽ chọn 1 nút trong mạch và gọi là nút gốc có điện thế 
bằng không (có thể chọn tuỳ ý, như thường chọn nút có nhiều nhánh nối tới nhất làm 
nút gốc). 
Nội dung phương pháp : 

- Chọn các nút , điện thế các nút 
- Viết  phương trình thế nút : điện thế tại một nút nhân với tổng các nghịch đảo R 

nối tới nút, trừ cho điện thế nút kia ( nối giữa hai nút ) nhân tổng các nghịch đảo 
R giữa hai nút = nguồn dòng đi vào mang dấu dương , đi ra mang dấu âm 

- Giải hệ phương trình tìm điện thế nút 
- Tìm dòng các nhánh theo định luật ohm 

 
Ví dụ 1 : 
 

 

 

 

 

 

 

 

 

 

 

- Chọn một nút trong mạch làm nút gốc ( thường nút có nhiều nhánh tới ) 
- Nút gốc Uo = 0 
- Điện thế nút a : Ua 
- Điện thế nút b : Ub 
- Điện thế của một nút là điện áp của nút đó so với nút gốc 

Uao = Ua – Uo = Ua 
Ubo = Ub – Uo = Ub 
Uab = Ua – Ub   

Uab là điện áp giữa hai nút a và b 
Khi mạch có d nút thì ta có d-1 phương trình thế nút 
K1a : J1 = I1 + I3 

      J1 = 
3131 R
UU

R
U

R
U

R
U baaaba 

  

Phương trình thế nút tại a : 

  1
331

)11( J
R
U

RR
U b

a    (1) 

K1b : 

  232 IIj    mà  
2

2 R
U

I b  
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53)
4
1()

2
1

4
1(

65)
4
1()

4
1

4
1(





ab

ba

UU

UU
 

ab

b

ba

UU
UU

UUU






2

1

  
3

3
3

3 R
UU

I
R

UU
I abba 




  

  
332

2 )11(
R
U

RR
UJ a

b   (2) 

Giải (1) và (2) tìm được Ua , Ub  I1, I2, I3 
 
Ví dụ 2  : Giải mạch sau dùng phương pháp thế nút : 
 
 
 
 
 
 
  
 
 
 
 
 
 
   
 
 

Giải hệ tìm được ,a bU U  
Ví dụ 3 : Giải mạch sau dùng phương pháp thế nút : 
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0
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2
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ab

ba
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j

U

U
j
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1)

4
1

2
1(

2
2
1)

2
1

4
1(

1
00

00

u
UU

UU

ab

ba




 

 
 
 
 
  
 
 
 
 
 
 

 
5

2
0

1
0

aU
I   

 
 
Ví dụ 4 : Tính P2 =? 
 
 
 
 
 
 
 
 
 
 
Giải : 
 
   
 
 
 
U1  =  Ua 
 
 
 
 
 

(2) => Ua = bU
4
3  

Thay vào (1)  2
216

9
 b

b
U

U  

3 2          (1)
4 2
3        (2)
4 2 2

b
a

a a
b

UU

U UU
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VU

U
U

a

a
b

3

6
6
20

2
)

2
1

4
1

6
1(



  

VUuVU bb 88   

)(3224
)(426

)(6
4
24

4

)(24
)(32

2
)2(

1

2

wP
AI

A
U

I

VU
VU

a

a

b













 

 
Ví dụ 5 :Áp dụng phương pháp thế nút giải tìm Ua,Ub ? 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Chú ý: 3V là nguồn lý tưởng, không có điện trở trong của nguồn. Khi áp dụng 
phương pháp thế nút thì nút gốc chọn ở cực âm của nguồn lý tưởng. 
 
3.2. PHƯƠNG PHÁP DÒNG MẮC LƯỚI 
 

 Theo phương pháp này, mỗi mắt lưới ta gán cho nó một biến (dòng điện khép 
mạch trong mắt lưới đó) gọi là dòng mắt lưới. 
 Chiều của dòng điện mắt lưới có thể cho tuỳ ý, nhưng thường ta chọn chúng cùng 
chiều với nhau (cùng chiều kim đồng hồ hoặc ngược lại) 

Nội dung phương pháp : 
 
 
 
 
 
 
 
 
 
Bước 1 : ẩn số là những dòng điện mắc lưới tức là những dòng điện tưởng tượng 
coi như chạy khép kín theo các lối đi của vòng độc lập : nếu mạch có d nút , n 
nhánh thì ( n- d + 1 ) vòng độc lập => số dòng mắt lưới tương ứng và giả thiết 
chiều. 

 Ia và Ib là dòng mắc lưới  
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ab

ba

IRRRIE
IRRRIE

3322

3311

)(
)(




 

b

a

II
II




2

1  ba III 3  

Bước 2 : viết định luật k2 cho dòng mắc lưới : một vế là tổng đại số các suất điện 
động có trong vòng đó. Vế kia là tổng đại số các điện áp rơi trên mỗi nhánh của lối 
đi vòng gây bởi tất cả các dòng điện mắc lưới chạy qua. 

 

 
Bước 3 : Giải hệ phương trình tìm dòng mắc lưới. 
Bước 4 : Tìm dòng điện nhánh bằng tổng đại số các dòng mắc lưới chạy qua. 

 
 
 
 
Ví dụ 6: Áp dụng phương pháp dòng mắt lưới tìm Ia, Ib, Ic ? 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Ví dụ 7: 
 
 
 
 
 
 
 
 
 
 
 

bac

cab

cba

IRIRRRRIEE

IRIRRRRIE

RIRIRRRIEE

4164116

535435

2332121

)(

)(

)(







 

 Tìm Ia, Ib, Ic =? 
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Cách 1 : 

 
 
 
 
  
 
 
 
 i = (8 + 6 + 16 ) =152 – 32 

 => i = )(4
3

12
30

120 A  

 
Cách 2 : 
 
 Ia =19A 
 Ic = 2A 
 i (6 + 8 +16 ) – 19.8 + 2.16 = 0 

 => Ai 4
30

120
  

 
Ví dụ 8 : Tìm Ia, Ib, Ic 
 
 
 
 
 
 
  
 
 
 
 

Ia = -2A 
 Ic = 5A 
 38 = Ib (4 + 1+ 3 ) -Ia (4 +1 ) + Ic (1 + 3 ) 

 38 = Ib .8 + 10 + 20     Ib = )(1
8
8 A  

 I = Ib + Ic = 1 + 5 = 6(A) 
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AI
8
38

1   

3.4. PHƯƠNG PHÁP XẾP CHỒNG 
 
 Nguyên lý : Trong mạch gồm nhiều nguồn, dòng điện qua một nhánh bằng tổng 
đại số các dòng điện qua nhánh đó do tác dụng riêng rẽ của từng nguồn, các nguồn 
khác xem như bằng 0. 
 
 
 
 
 
 
 E1 + E2 = I.R 
 
Cho từng nguồn tác động : 
 

E1 tác động : E2=0 
 
 
 
 
 
E2 tác động : E1 = 0 
 
 
 
 
 
 E1 + E2 = R.( I1 + I2 ) 

 
Ví dụ 9 : dùng phương pháp xếp chồng tìm dòng điện I ? 
 
 
 
 
 
 
 
 
 
 

Nguồn 38 V tác động ( các nguồn còn lại cho bằng 0 ) 
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AI
8
20

2   

Nguồn 5A tác động : 
 
 
 
 
 
 
 
 
 

Nguồn 2A tác động : 
 
 
 
 
 
 
 
 
 
3.4. ĐỊNH LÝ THE’VENIN - NORTON 
Ví dụ 10 : Tính dòng điện I dùng định lý Thevenin ? 
 

 
3.4.1. Định lý thevenin : nội dung định lý : 
Bước 1 : tách bỏ nhánh cần tính dòng áp ra khỏi mạch  

 
 

Bước 2 : Tính Uab = Uhở = Uth. 
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 42
66
36

tdR

VU

U

VU
UUU

a

a

b

baab

6
6

121)
3
1

6
1(

422









 

vậy : VU ab 2  
Bước 3 : triệt tiêu tất cả các nguồn độc lập tính Rtđ nhìn từ cửa ab : 

 
 
 
 
 
 
 
 
     
 

Bước 4 : thành lập sơ đồ tương đương thevenin 
 
 
 
 
 
 

Bước 5 :gắn nhánh cần tính vào mạch tương đương thevenin, tính dòng áp : 

)(4,0
14

2 AI 


  

 
3.4.2. Định Lý Norton: 
 
Bước 1 : Tách bỏ nhánh cần tính dòng nhánh ra khỏi mạch : 
 

Bước 2 : tính I ngắn mạch : a trùng với b. dùng K1 
 

 

)(5,2
3
5

)(5

21
6

12)
2
1

3
1

6
1(

AI

vU

U

b

b

b







 

Ingắn = 2,5 – 2 = 0,5(A) 
Bước 3 : giống bước 3 ở trên 

 4tdR  
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Bước 4 : thành lập sơ đồ tương đương Norton : 
 
 
 
 
 
 

Bước 5 : giống bước 5 ở trên 
 

)(4,0
14
45,0 AI 




  

Chú ý : Định lý Thevenin và Nortorn có thể biến đổi tương được 
Ví dụ 11 :  
 
 
 
 
  
 

Giải : 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

VUU
AIaIa

ab 632
26129

3 




 

 
 
 
 
  
 
 
 
 
 

Tính IR khi R= 6  
Tính R để Pmax =? 





 2
36
36

tdR  
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Để công suất lớn nhất thì  2tdRR  

WP

AI R

2
9)

4
6(2

)(
2
3

4
6

2
max 


 

3.5. ĐỊNH LÝ CHUYỂN VỊ NGUỒN 
Định lý chuyển vị nguồn áp 
Dòng điện trong các nhánh không thay đổi khi ta mắc nối tiếp thêm các nguồn áp bằng 
nhau vào các nhánh của 1 nút.  
Ví dụ 

I2

+
-

U

+
- U

I4

+
-

U

I3

+ -

UI1

I2

I4 +-

UI1

+
-

U

I3

 
 

I )(
4
3

8
6 AR   
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I2

I3

I4I1 +-

U

+ -

U

+
- U

 
Định lý chuyển vị nguồn dòng 
Điện áp trên các nhánh không thay đổi khi ta mắc song song thêm các nguồn dòng 
bằng nhau vào các nhánh của 1 vòng 
Ví dụ: 

J

Z2

J

JZ3 Z3

Z1

J JJ

Z2

Z1

 

J

J

Z2

J

Z3

Z1
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Chương 4. MẠCH ĐIỆN 3 PHA 
4.1. KHÁI NIỆM CHUNG 
 4.1.1. Máy phát điện 3 pha và vấn đề truyền tải điện năng đi xa 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Hình 4.1.1.2. Sơ đồ minh họa tai nạn điện xảy ra khi chân người chạm đất 
 
 
 
 
 
 
 
 
 
 
 
 
 

Hình 4.1.1.3. Sơ đồ minh họa an toàn điện khi chân người cách điện với đất 
 
  
 

Hình 4.1.1.1. Sơ đồ nguyên lý nhà máy phát điện và vấn đề truyền tải điện năng đi xa 
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UCA 
. UCN 

. 

UAB 
. 

UBC 
. 

UAN 
. 

UBN 
. 

30% 

Mạch điện ba pha bao gồm nguồn điện ba pha, đường dây truyền tải và các phụ 
tải ba pha. Để tạo ra nguồn điện ba pha, ta dùng máy phát điện đồng bộ ba pha 

Mỗi một pha trong mạch 3 pha được ký hiệu là A, B, C hay a, b, c. Điện áp 
tương ứng trên mỗi pha lệch nhau một góc 120o, được viết dưới dạng điều hòa và dạng 
số phức như sau :  

 0 sin .ae E t      → 0
j

aE E e 


  

0
2sin .
3be E t      

 
  → 

2 2
3 3

0
1 3
2 2

j j

b a aE E e E e E j
      

 
 

      
 

 

0
4sin .
3ce E t      

 
  → 

4 4
3 3

0
1 3
2 2

j j

c a aE E e E e E j
      

 
 

      
 

 

Nguồn điện gồm ba sức điện động sin cùng biên độ, cùng tần số, lệch nhau về 
pha 2π/3 gọi là nguồn ba pha đối xứng. 

4.2. CÁCH ĐẤU NỐI DÂY 
4.2.1. Nguồn đấu sao: Có 2 cách đấu sao:  3 dây và 4 dây  

 

 

 

 

 

 

 

 

(a) nối sao 3 đầu        (b) nối sao 4 đầu    

Hình Nguồn đấu hình sao 

UAB, UBC, UCA : điện áp dây và điện áp giữa 2 pha bất kỳ (Ud) 

UAN, UBN, UCN : điện áp pha (Up) là điện áp giữa 1 pha bất kỳ với điểm trung 
tính hay dây trung tính. 

 

 

 

 

 

A 
        

B 
        

C 
 

eb 

ec 

ea 

eb 

ec 

ea 

A 
       

B 
       

C 
       

N 
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Theo giản đồ vectơ  

Nếu chọn  = 0 cho pha A, ta có : 

UAN = Upm sin t 

UBN = Upm sin (t –120o) 

Vậy :  UAB =UAN-UNB= Upm [sin t – sin (t – 120o)] 

   = 2Upm cos (t – 60o) sin 60o 

UAB = 3 Upm sin (t – 30o)   (*) 

 (*) Chứng tỏ : 3  Upm = Udm   

Hay :  3d pU U   

4.2.2. Nguồn đấu tam giác  

Tính chất đặc biệt của hệ thống 3 đối xứng là tổng của 3 dòng hay áp đối 
xứng, dịch pha nhau một góc 120o, tại mỗi thời điểm bất kỳ đều bằng không : 

 

 

 

 

 

 

 

Hình nguồn đấu tam giác 

Vì vậy, có thể đưa ra khả năng nối đầu cuối của cuộn dây này với đầu vào cuộn 
dây kia như hình vẽ trên, để tạo thành đấu tam giác. 

Điện áp pha    UAB, UBC, UCA là giống như điện áp giữa 2 pha bất kỳ, nên : 

pd UU   

A 
        

B 
        

C 
        

CAU


 

BCU


 

ABU
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4.2.3. Tải đối xứng đấu tam giác  

 

 

 

 

 

 

 

AI


, BI


, CI


:  dòng điện dây. 

ABI


, BCI


, CAI


: dòng điện pha  

K1A :  A AB CAI I I
  

   

Tải đối xứng nên : 

  120j
CA ABI I e

 

  

Hay:   120 3 31
2 2

j
A AB ABI I e I j

    
     

 
 

90 120 301 33 3 3
2 2

j j j
A AB AB ABI I j j I e e I e

   
  

        
 

 

 3d pI I       

4.2.4. Tải đối xứng đấu sao 

 

 

 

 

 

 

 

 

 

(a) Tải đấu Y 3 dây   (b) Tải đấu Y  4 dây 

 

ZBC 

AI


 
        

ZCA ZAB 

B C BI


 
        

CI


 
        

A 
ABI



 
        

CAI


 
        

BCI


 
        

BI


 

AI


 

ZA 
ZB 

ZC 

C 
CI



 

B 

C 

A A 

O O 

BI


 

AI


 

CI


 

B 
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Trường hợp này ta thấy ngay: 

pd II   

4.2.5. Đồ thị vector nguồn đấu sao tải đấu tam giác 

 

 

 

 

 

 

 

 

Kirchoff tại A,B,C:  A AB CAI I I
  

   

   B BC ABI I I
  

   

   C CA BCI I I
  

   

Nguồn đối xứng lệch pha 120o ở mỗi pha nên: 0


CNBNAN UUU .Và  

ANCNCA

CNBNBC

BNANAB

UUU

UUU

UUU













 

Ta xây dựng được giản đồ vectơ như hình vẽ. 

 

 

 

 

 

 

 

 

 

 

 

ZBC 

ABI


       

BCI


       

ZCA ZAB 

B C 

B 
        C 

        

N 
        

A       
CAI


       

A 
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Nguồn đấu sao :    

UAB, UBC, UCA:  điện áp dây 

 UAN, UBN, UCN:  điện áp pha 

pd UU 3  

Tải đấu tam giác :  

AI


, BI


, CI


:  dòng điện dây. 

ABI


, BCI


, CAI


: dòng điện pha  

3
d

p
I

I   

 

 

 

 

UAB 
. 

UBC 
. 

UCA 
. 

CI


 

CAI


 

 

 

 CAI


 

AI


 

BCI


 

UAN 
. 

UBN 
. UCN 

. 

ABI


 

BI


 

ABI


 

BCI
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4.3. CÔNG SUẤT TÁC DỤNG CỦA HỆ THỐNG 3 PHA  

Xét hệ thống 3, 4 dây nguồn và tải đấu Y 

 

 

 

 

 

 

 

 

 

Xét pha A :    

uAN (t) = U0 sin t 

 iA (t) = I0 sin (t - )   

 : góc lệnh pha giữa uA(t) và iA(t) 

Công suất tức thời : 

pA (t)  = uAN (t) × iA (t) = U0 I0 [sin t . sin (t - )] 

pA(t)    =  ½ U0 I0 [cos  - cos (2t - )] 

Công suất tác dụng là công suất trung bình của pA(t) trong 1 chu kỳ T: 

 
0

1 T

A AP p t dt
T

    

Thành phần không theo thời gian: ½. U0.I0. cos 

Nguồn và tải đối xứng nên công suất ở cả 3 pha: 

P = 3PA = 
2
3  U0.I0.cos 

Với   U0 = 2 ×U  

  I0 = 2 ×I  

Vậy   p =  3 Up Ip cos   (*) 
 

Đấu sao : Up = Ud / 3  , Ip = Id 

Đấu tam giác : Up = Ud , Ip = Id / 3 . Nên  (*) được viết theo cả 2 cách đấu : 

Za 

Zb 

Zc 

0 N 
B 

C 

A IA 

IB 

IC 
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 Trang 41 

cos
3
3

dd IUP   

Tóm lại: 
 Công suất tác dụng P. 

  
AAAA

cBAp

IUP
PPPPP

cos
3




 A : góc lệch pha giữa dòng và áp pha 

2
AAA IRP   

Mạch 3 pha đối xứng :   
cos1 PPpCBA IUPPPP   

1

2

3 3 cos

3 cos 3
P P P

d d P P

P P U I

P U I R I





 

   

Công suất phản kháng  

2

sin
A B C

A A A A

A A A

Q Q Q Q
Q U I

Q X I


  





 

Mạch 3 pha đối xứng : 

2

sin

3 3 sin 3 sin 3
A B C P P P

P P P d d P P

Q Q Q Q U I

Q Q U I U I X I Ptg



  

   

      

Công suất biểu kiến 
 

2 2 3

cos

d dS P Q U I
P
S



  


 

 
4.4. PHƯƠNG PHÁP GIẢI MẠCH 3 PHA ĐỐI XỨNG 
 Phải tính dòng áp cả 3 pha nhưng do tính đối xứng ta chỉ cần tính dòng áp trên 
một pha rồi suy ra hai pha còn lại. 
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Ví dụ 1 : 
 
 
 
 
 
 
 
 
Giải : 
Mắc tam giác :  

pd

pd

UU
II



 3
 

AA

AI P

20

20
3
6,34

2 


 

2 2

20 11 220
220

3 3 11 20 13, 2

P

d P nguon

V I R V
U U U V

P R I Kw

    
  

      

 

 
Ví dụ 2 : 
Nguồn đối xứng Ud = 30 V. cung cấp cho tải hình sao đối xứng có P = 1200 Kw. 

8,0cos  . Tính dòng dây và trở kháng pha của tải. 
Giải : 
Ghi nhớ: Đối với hệ thống 3 pha đối xứng (đấu sao, hay tam giác): ta luôn có: 

3 cos 3 cosp p d dP U I U I    
3

2

1200.10
3 cos 3 300 0,8

2886,75( )

3

d P
d

d P

P P P

PI I
U

I I A
P I R R


  

 
 

  

 

 
 

A1 = 34,6 A 
Tải mắc đối xứng , R=11  
Tính chỉ số A2 = ? volkế = ? 

PU dnguon ?,  
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 Trang 1 

BÀI TẬP CHƯƠNG 1 
Bài 1 :  
Cho maïch ñieän nhö hình 1.4. Bieát I1 =1A, xaùc ñònh doøng ñieän trong caùc 
nhaùnh vaø coâng suaát cung caáp bôûi nguoàn doøng 2A.   

+
-

48V

2

6

+
-

40V

I2

6

+
-

10V

2A

14

I1

I4 I5

I3

 
Hình 1.4 

Giải 

C

I3

V2

+
-

10V

A

I1

4

2

2A

I4

I2

I5

+
-

48V

61

+
-

40V

6

V1

B

 
K1A:   1 42 0I I    

4 1 2 1 2 3I I A       
K2V1:  1 4 34 2 1 40 48I I I      
  3 1 44 2 8 4 6 8 2I I I A         
K1B:  4 3 5 0I I I    
  5 4 3 3 2 5I I I A       
K2V2:  3 5 21 6 6 10 40 50I I I      

  2 3 5

2

6 50 6 50 2 30 18
18 / 6 3

I I I
I A

       

  
 

Cách khác:  
K1C:  5 22 0I I    
  2 5 2 5 2 3I I A       
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 Trang 2 

Bài 2:  
Trong maïch ñieän hình 1.5. Xaùc ñònh E ñeå nguoàn aùp 16V cung caáp coâng 
suaát 32W.      

+
-

E

2

3 1

9

+
-

16V
1

4A

3

 
Hình 1.5 

Giải 

1

+
-

E

I2

3

I4

1

4A

2

9

I6

I1

3I3
B

I5

V2

A

+
-

16V

C

V1

V3

 

1
32 2

16 16
PI A
V

    

K1A:  1 2 4 0I I    
  2 1 4 2 4 6I I A       
K2V1:  1 2 52 16I I I      
  5 1 22 16 4 6 16 6I I I A           
K1B:  1 5 6 0I I I     
  6 1 5 2 6 4I I I A       , dòng I6 có chiều ngược lại với chiều đã chọn 
K2V2:  5 6 43 9 0I I I    

  5 6
4

3 6 12 2
9 9

I II A 
     

K1C:  3 2 5 4 0I I I I     
  3 2 5 4 6 6 2 2I I I I A           
K2V3:  3 43 9I I E   
  6 18 24E V     
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 Trang 3 

Bài 3 : Cho mạch điện như hình vẽ      

16

3

4I4

6

8

I2

4

I3
I1

2 12I

+
-30V

 
 
Hãy tính các dòng  điện I, I1, I2, I3, I4 ? 
Giải 
Biến đổi tương đương: 

16

4

I

8nt4=12

I3

2

+
-30V

I412

3//6=2

I2

I1

 

4nt2=6

I 12

16+
-30V

8nt4=12

I3

2 I2 I4

I1

 

+
-30V

12I2

16 6//12=4

2I

I1
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 Trang 4 

I1

2I I2

16+
-30V

4nt12=16

 
2

16//16=8

I

+
-30V

 
30 3( )

2 8
I A 


 

Phân dòng: 

1
16 163 1.5( )

16 16 16 16
I I A  

 
 

2 1 3 1.5 1.5( )I I I A      
Phân dòng: 

3 2
12 121.5 1( )

12 6 18
I I A  


 

4 2 3 1.5 1 0.5( )I I I A      
Bài 4 : Cho mạch điện như hình vẽ :  
 
 
 
 
 
 
 
 
 
 
a/ Tính dòng điện I, I2, I3 ?     
b/ Tính U1, U2, U3 ?   
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 Trang 5 

Bài 5 : Cho mạng điện như hình vẽ.   
 
 
 
 
 
 
 
 
                                 
 
 
a/ Tính dòng I1, I2, I3, I4 ?   
b/ Tính U ?  
Bài 6 : Cho mạng điện như hình vẽ.   
 
 
 

 
 
 
 
 
  
 
 
a/ Tính dòng I, I1, I2, I3, I4 ?     
b/ Tính U ?   
Bài 7 : cho mạch điện như hình vẽ :     

2 18 21

12 8 66

 
 
Tính dòng điện I ? 
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 Trang 6 

Bài 8 :Duøng pheùp bieán ñoåi töông ñöông, tìm i1 ôû maïch hình 1.16.   
 

 
 
Bài 9: cho mạch điện như hình vẽ    
 
Xaùc ñònh Ix treân maïch hình 1.3a vaø hình 1.3b. 

 
 
Bài 10 : Cho maïch ñieän hình 1.12. Xaùc ñònh R ñeå cho I = 5A.    
 

               
 
Bài 11 : Xaùc ñònh u vaø i1 treân maïch hình 1.13.    
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 Trang 7 

Bài 12 : Tìm aùp u treân maïch ñieän hình 1.14.      
 

 
Bài 13 :Xaùc ñònh uo ôû maïch hình 1.15.       
 

 
 
Bài 14 :  
Duøng pheùp bieán ñoåi töông ñöông tìm doøng caùc nhaùnh ôû maïch ñieän hình 1.17  

 
Bài 15:      
 Xaùc ñònh u1 vaø coâng suaát tieâu taùn treân ñieän trôû 8Ω ôû maïch ñieän hình 1.8.   
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+

-

a

b

Uab

I 1

6

5 3

2

10V

I

I

1

2

Bài 16:  

Tìm heä soá khueách ñaïi 0Uk
E

  ôû maïch ñieän hình 1.9.     

 
 
Bài 17: 
Tính i vaø uo ôû maïch ñieän hình 1.10 theo E vaøα.      

 
Bài 18 :Tìm uo ôû maïch ñieän hình 1.19.      
 

 
 
Bài 19 : Cho mạch điện như hình vẽ.   
 
 
 
 
 
 
 
 
 
 
 
 

Simpo PDF Merge and Split Unregistered Version - http://www.simpopdf.com



 Trang 9 

a/ Tìm Rtđ, I ?                
b/ Tính I1, I2, Uab ?  
 
BÀI TẬP CHƯƠNG 2 
Bài 20 : Một mạch điện mắc nối tiếp và mắc song song được minh họa như hình sau  
   

         

3 2 j

6 j 

8 j 10

90
1V =10 0




1I


2I


3I


U


 
a/ Tính dòng 1I


, 2I


, 3I



?    

b/ Tính điện áp U


?  
Giải 

1
1

10 0 2.78 33.7( ) 2.31 1.54 ( )
3 2 3.6 33.7

VI A j A
j


 
     

 
 

   2 1
9 6 9 62.78 33.7

9 6 10 8 19 2
j jI I

j j j

   
  

   

2
10.82 33.72.78 33.7 1.57 73.41( ) 0.45 1.5 ( )

19.1 6.01
I A j A
 
     


 

   3 1
10 8 12.8 38.662.78 33.7 1.68 1.04( )

9 6 10 8 19.1 6
jI I A

j j

   
    

   
  

Cách khác: 

   3 1 2 2.31 1.54 0.45 1.5 1.86 0.04 1.68 1.36( )I I I j j j A
  

           

     1 1 10 8 // 9 6 3 2U I Z I j j nt j
  

         

  
     10 8 9 6

2.78 33.7 3 2
10 8 9 6

j j
U j

j j

   
    

    
 

 138 122.78 33.7 3 2
19 2

jU j
j

  
     

 

138 12 53 44 191 562.78 33.7 2.78 33.7
19 2 19 2

j j jU
j j

       
          

 

199 16.342.78 33.7 28.96 23.37( )
19.1 6.01

U V
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Bài 21 : Cho mạch điện sau : với ( ) 10sinu t t   
4 j

4 j 

4 j

12
010 0U



 

4I


cu

 
a/ Tìm dòng ( )i t ?       
b/ Tìm điện áp ( )cu t ?      
c/ Tính công suất P toàn mạch?     
Giải 

        12 // 4 4 4 4 12 // 4 4 3 4Z j j nt j j j           

1
10 0 10 0 2 53.13( )
3 4 5 53.13

UI A
Z j


  
    

 
 

  ( ) 2sin 53.13i t t A   

 
12 122 53.13 1.5 53.13( )

12 4 4 4 16cI I A
j j

 

    
  

 

 

 4 1.5 53.13 4 90 6 143.13( )c cU I j V
 

         
   6sin 143.13 ( )cu t t V   

     1 10 2cos 53.13 0.6 3
2 2

UIP W
    

 
Bài 22 : Cho mạch điện như hình vẽ :  
 
 
 
 
 
 
 
 
 
            
 
 
 
 
 
 
 

Tính I1, I2, I3 ? 
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Bài 23 : Cho mạch điện như hình vẽ :  
 
 
 
 
 
 
 
 
 
 
 
a/ Tìm dòng điện I ?               
b/ Tính công suất 3P ?           
Bài 24 : Cho mạch điện như hình vẽ :  

1

+
-

12V 1A
2A

6
A

2

BI

3

 
 
Tính dòng điện I dùng định lý Thevenin ? 
Giải 
Bước 1: Hở mạch (cắt bỏ nhánh cần xét) 

3+
-

12V

6

2

B

2A

A

1A

 
Bước 2: Tính UTh=Uhở mạch = UAB 

2
2A

1A

B

3

A

12/6=2A
6

 
BA

2A
1+2=3A

6//3=2 2

 
3 2 2 2 10( )A A

Th AB A BU U U U V          
Bước 3: Tính RTh=RAB (ngắn mạch nguồn áp, hở mạch nguồn dòng độc lập) 

A 
B C 

D 

I1 
I2 
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10A 5

10

20

30

100V

I I1 2

A

23

B
6

 
 6 // 3 2 4( )ThR nt    

Bước 4: Vẽ mạch tương đương The’venil 

B

A

+
-

Uth=10V

Rth=4

 
Bước 5: Gắn nhánh cắt bỏ vào 

I

A
Rth=4

1

B

+
-

Uth=10V

 
 10 2

1 4 1
Th

Th

UI A
R

  
 

 

 
Bài 25 : Cho mạch điện như hình vẽ :       
 
 
 
 
 
 
 
 
Tính dòng điện I1, I2 ? 
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Bài 26 : Cho mạch điện như hình vẽ :       

10

3

4 j

5 j 

I


2I


1I


E


 
Biết E



= 50 V (hiệu dụng) 

a/ Tính I


, 1I


, 2I


?            
b/ Kiểm tra lại sự cân bằng công suất tác dụng?      
 
Bài 27 : Cho mạch điện như hình vẽ :       

2

5 j

1I


2I


3I


3

3 8 j 

050 0 050 0

 
 

a/ Tính 1I


, 2I


, 3I


?             
b/ Kiểm tra lại sự cân bằng công suất tác dụng ?     
Bài 28 : hãy xác định L trong mạch điện sau :  

1510

-15j
L

0220 0

011.81 7.12I


 

1I 2I

 
 

 2
220 0 220 0 10.37 45( ) 7.33 7.33 ( )

15 15 15 2 45
I A j A

j

  
     

 
 

 1 2 11.81 7.12 10.37 45 11.72 1.46 7.33 7.33 ( )I I I j j A
  

           

1 4.39 8.77 9.81 63.41( )I j A


     

   
1

220 0 22.43 63.41 10 20 10
9.81 63.41 L

UZ j X
I
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Ta có 

 20L
L

XX L L H
 

     

 
 
 
 
 
 
 
 
BÀI TẬP CHƯƠNG 3 
 
Bài 29 : Hãy tìm I1 và I2  cho bởi mạch sau:  

1I 2I

 
                         
Bài 30 : hãy tính công suất toàn phần cung cấp bởi mạch điện sau :  
 

20

40 20j

I

-40j

200

0200 0

 
 
Bài 31 : Cho mạch điện như hình vẽ.   

1

20

5 2

 
 
Tính dòng điện chạy qua các điện trở ? 

10 
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12mA 2k 6k

8V

12 ( )U mA

+

-
1U

Giải 

1
20 2
10

I A          

2
20 10 9 1

1
I A 
       

3
20 50 10 2

20
I A 
    

4
10 2
5

I A        

5
10 5
2

I A         

 
Bài 32 : Cho mạch điện như hình vẽ.   
 
 
 
 
 
 
 
 
Tính điện áp U1 ? 

8aU  V 

1

1

1 1( ) 2 12
2 6 2

(3 1) 3.8 12 72

a
b

b

UU U

U U

   

    
    

1

1

4 12 48b

a b

U U
U U U

 

 
 

4 12(8 ) 48
3

b b

b

U U
U V
   

 
     

1 8 5 3a bU U U V           
 
Bài 33 : Cho mạng điện sau:   

C

12 j

6

I


0100 0
(Hieäu duïng)

 
  
Tần số 50f hz         
a/ Tìm giá trị C để V và I cùng pha ?       
b/ Tính công suất P toàn mạch ứng với C vừa tìm được?    
 

b 

a 
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R12

I

8V

24A 12

Bài 34 : Cho mạng điện tác động bởi các dòng điện như hình vẽ.   
 
                  
          
        
 
 
 
 
 
 
 
 
a/ Tìm điện áp U1 ?     
b/ Tìm điện áp U2?     
c/ Tìm dòng I chạy qua điện trở 2   
giải 
a/       

1 1 1( ) 10 5
4 2 2
1 1 1 1( ) 5
2 8 8 2
3 1 5
4 2

1 6 5
2 8

a b

b a

a b

a b

U U

U U

U U

U U

     

     


   
  


  

 
3 2 20

4 6 40
a b

a b

U U
U U
 

   
   

 
bài 35 : Dùng định lý Thevenin giải bài toán sau :         
            
 
 
 
 
 
 
  
 

a/ Tính I khi 5
2

R           

b/ Tính R để PRmax ? Tìm PRmx  
 
 
 
 

20
20

a

b

U
U


  

      

   1 20aU U   (V),      2 20bU U   (V)   

c/ Dòng chạy qua điện trở 2  : 

20 20 0
2 2

a bU UI  
    (A)   

84

2

2U

I

8
1U

a 
b 
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25A 20A 20V

10

4 2

1

10

I1 I2

Bài 36 : Cho mạch điện như hình vẽ.   
 
 
 
 
 
 
 
 
 
 
a/ Tính i(t), i1(t), i2(t) ?       
b/ tính Pnguồn, P3 ?           
 
Bài 37 : Cho mạch điện như hình vẽ.   

 
a/ Tìm dòng điện I2 , I3 ?           
b/ Tìm điện áp U ?                    
Bài 38 : cho mạch điện như hình vẽ                
 
 
 
 
 
 
 
 
 
 Tìm dòng điện I1, I2 ? 
 
Bài 39 : Dùng định lý Thevenin tìm dòng điện I trong mạch:         
            

I

10 V

10

4 8

20 5
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 Trang 18 

Bài 40: Dùng định lý Thevenin giải bài toán sau :     
 

             

8

4 I

35 V

2

10 10 R

 
      
a/ Tính I khi 4R           
b/ Tính R để PRmax ? Tìm PRmx  
Câu 41 : Cho mạch điện như hình vẽ.   

 
 
a/ Tìm dòng điện I2 , I3 ?           
b/ Tìm điện áp U ?              
Giải : 
  

 
  

1 1 1 1 1 20( ) ( ) 6
6 4 2 2 6 6

3

b a

a

U U

U V

      


    

8 8b bU V u U V           
 

2
11

2 2
a bU UI A

   

3 2
4

bUI A
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 Trang 19 

 
 
BÀI TẬP CHƯƠNG 4 
 
Bài 41 : Máy phát điện 3 pha đối xứng, Cung cấp cho 2 tải đối xứng. Tải 1 mắc tam 
giác có trở kháng pha 1 2 3 ( )Z j   . Tải 2 mắc sao có 2 3 2 ( )Z j   . Biết 380dU  V.
       
 
a/ Tính dòng điện chạy trong các tải ? Tính dòng điện dây chính ?   
b/ Tính công suất toàn mạch ? 
        
Bài 42 : Máy phát điện 3 pha đối xứng, có điện áp dây 1000dU  V. Cung cấp cho 3 tải 
đối xứng. Tải 1 mắc tam giác có 1 50dI  A, 1cos 0.8  . Tải 2 mắc tam giác có 

2P  70kW, 2cos 0.866  . Tải 3 mắc sao có 3 6 ,X    3 1R   .        
 
a/ Tính dòng điện chạy trong các tải ? Tính dòng điện dây chính ?   
b/ Tính công suất của các tải ?        
 
Bài 43: Cho mạch điện như hình vẽ :    
 
 
 
 
 
 
 
 
 
 
 
a/ Tính I1, I2 ? 
b/ Tính 2P  ? 
 
 
 
Bài 44 : Cho mạch điện như hình vẽ :  
 
 
 
 
 
 
 
 
 
 
 

4 
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 Trang 20 

Tìm dòng điện I dùng phương pháp xếp chồng ? 
 
Bài 45 : cho mạch điện 3 pha đối xứng, tải mắc tam giác :    
 
 
 
 
 
 
 
 
Bài 46 : nguồn 3 pha đối xứng, Ud = 300V, cung cấp cho tải hình sao đối xứng có  
P = 1200KW. Có cos 0,8  . Tính dòng điện dây và trở kháng pha của tải ?  
Bài 47: Tính I1 và I2 ?      

2I1I

 
 
Bài 48: Tìm dòng điện I ?       
 

 
 
 
II. PHỤ LỤC II : PHẦN BÀI TẬP TỰ HỌC : 
 - Bài tự học môn mạch điện 1 nhằm giúp sinh viên, nâng cao tính tự giác học tập, 
rèn luyện tính độc lập xử lý công việc, ứng dụng kiến thức vào thực tế thông qua hình 
thức bài tự học như sau : 
 
 Sinh viên sẽ được chia nhóm để làm bài tự học. mỗi nhóm có thể từ 3 - 5 sinh 

viên tùy mức độ của bài tự học. 
 Sinh viên sẽ làm mạch thực tế, nghiên cứu tài liệu liên quan môn học, mô 

phỏng…(mạch có thể do giáo viên gợi ý hoặc sinh viên tự tìm kiếm ) 
 

Bài 1 : Nghiên cứu Mathlab mô phỏng phân tích một số bài tập mạch điện. 

A1 = 34,6 A 
Tải mắc đối xứng , R=11  
Tính chỉ số A2 = ? volkế = ? 

?,dnguonU  công suất P? 
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Bài 2 : Làm mạch đèn giáng sinh theo gợi ý như sau : 

 
 
Bài 3 : Mạch điện tạo xung 1khz 
 

 
 
Bài 4 : Làm mạch đèn ngủ mini 
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Bài 5 : Mạch dịch Led dùng IC 4017 
 
 

 
 
 
 
 
 
 
 
 
Bài 6 : Mạch quảng cáo sáng dần lên rồi tắt dần xuống : 
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Mở đầu 
ORCAD là một công cụ thiết kế mạch điện tử đơn giản và phổ biến. Cũng có rất nhiều phần mềm thiết kế 
mạch điện tử khác, tuy nhiên, tôi chọn sử dụng phần mềm này, vì bộ công cụ này được đánh giá là khá 
mạnh. 
Các thư viện linh kiện của ORCAD có thể coi là mạnh nhất cho đến nay, và hầu hết các nhà sản xuất linh 
kiện điện tử đều cung cấp các add-in thư viện linh kiện cho ORCAD. 
 
Đã có rất nhiều sách hướng dẫn sử dụng ORCAD bằng hình, tuy nhiên giá sách khá cao và thực chất 
ORCAD không có gì là phức tạp, vì vậy, tôi muốn thực hiện tài liệu hướng dẫn này một cách đơn giản, để 
cung cấp miễn phí cho sinh viên. Thành thực mà nói, các sách dù có hướng dẫn tỉ mỉ tới đâu, thì cũng 
không thể giúp các bạn sinh viên nắm bắt toàn bộ các chức năng của ORCAD, mà chủ yếu, các bạn thực 
hành nhiều, mày mò nhiều, và hỏi han nhiều, các bạn sẽ tìm hiểu và nắm bắt về ORCAD rất dễ dàng. 
 
Trong tài liệu hướng dẫn này, chúng tôi sẽ đi từng bước đơn giản, để các bạn có thể thực hiện một mạch 
nguyên lý bằng ORCAD, sau đó hướng dẫn các bạn từng bước để xuất ra thành mạch in, chạy mạch in, 
điều chỉnh mạch in, cuối cùng là việc làm một mạch in điện tử tại nhà như thế nào. 
  
Tài liệu này được chia làm 5 phần: 
 -Phần 1. Cài đặt OrCAD 9.2 

 -Phần 2. Một số thao tác để vẽ một mạch nguyên lý với ORCAD dùng CAPTURE 

 -Phần 3. Cách chuyển từ mạch nguyên lý sang mạch in và các thao tác trên LAYOUT PLUS 

 -Phần 4. Sử dung công cụ Pspice A/D tích hợp trong OrCAD để mô phỏng mạch điện  

-Phần5. Một số mạch điện tử lý thú để các bạn nâng cao khả năng vẽ mạch của mình 

 -Phần 5. Làm  mạch in 1 lớp thủ công 

Ở đây tôi chọn sử dụng OrCAD 9.2 vì tính phổ biến của nó, thư viện khá đây đủ, chiếm ít tài nguyên, ít 

lỗi, sử dụng rất ổn định. Hiện tại đã có bản 16.5 nhưng rất nặng (10G tất cả sau khi cài đặt ), với lại việc 

cài đặt cũng rất khó khăn. Kể từ bản 16.3 trở đi Cadene đã bỏ phần Layout mà thay vào đó là PCB Editor, 

vì vậy tài liệu của phần này rất ít chủ yếu là tài liệu tiếng anh. Nhưng nếu muốn trở thành nhà Design 

PCB chuyên nghiệp thì nên sử dụng cái này. 

Cũng phải nói thêm rằng đây là tài liệu tôi biện soạn dựa trên những kiến thức của mình và trích dẫn 

tham khảo thêm một số tài liệu trên mạng  nên có một số đoạn có thể trùng với tài liệu của các tác giả 

khác, tôi đã cố gắng hướng dẫn rất chi tiết và tổng hợp một số tài liệu để các bạn có thể tiếp cận với 

phần mềm OrCAD một cách nhanh chóng.  

Các bạn đọc tham khảo và cho ý kiến để cuốn ebook này được hoàn thiện hơn.Xin chân thành cám ơn! 
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Link dowload: 

OrCAD 9.2 part1: http://www.mediafire.com/download.php?cpp7hztxpquc094 

OrCAD 9.2 part2: http://www.mediafire.com/download.php?s5h0e49kv6orr87 

Dùng phần mềm FFSJ để nối file: http://www.mediafire.com/download.php?blnyug2582ebiqb 

OrCAD 9.2 Protable : http://www.mediafire.com/download.php?o0z6sxoj672e11b 

Hoặc có thể liên hệ với tôi để lấy tài liệu, link dowload các phần mềm và ebook về 

điện tử 
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Chương 1: Cài đặt phần mềm OrCAD 9.2 

Để cài đặt OrCAD 9.2 bạn thực hiện các bước sau: 

- Cho đĩa CD cài đặt OrCAD vào máy hoặc có thể chạy trực tiếp trên ổ cứng: 

- Nhấp chuột phải vào file setup.exe , chọn Run as administrator như hình dưới 

 



Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 1. Cà i đà  t OrCAD 

 

Nguyễn Ngọc Hà. Email: hanguyen92205@gmail.com 
Lớp D10CQDT01_N – Học viện Công nghệ Bưu chính Viễn thông Tp.HCM  11 

- Đợi vài giây chúng ta sẽ thấy hộp thoại xuất hiện như hình dưới và yêu cầu chúng ta nên tắt hết 

các chương trình diệt virut , nếu không thì trong quá trình cài đặt có thể xãy ra vài lỗi không 

mong muốn. Click vào OK để tiếp tục thực hiện công việc cài đặt. 

 

- Một hộp thoại mới hiện ra, chọn Next để tiếp tục: 
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- Chọn Yes trong hộp thoại Software License Agreement: 

 

- Chọn Next để tiếp tục trong hộp thoại tiếp theo: 

 

 

- ở hộp thoại tiếp theo yêu bạn nhập key codec là A B E F G H I J K ( Enter xuống dòng sau mỗi kí 

tự) chọn Next và nhập 17 chữ số 1 ở hộp thoại tiếp theo như hình dưới. Next để tiếp tục  
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- Nhập thông tin của bạn vào phần Name và Company.  Next để tiếp tục. Chọn Yes ở cửa sổ tiếp 

theo: 

 

- ở hộp thoại tiếp theo, có 2 tùy chọn: Typical nếu cài đặt các thành phần chung của OrCAD, 

Custom để setup các ứng dụng cần dùng. Chọn Next để tiếp tục 
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- Quá trình cài đặt bắt đầu, 

 

- Chọn Yes ở 2 hộp thoại tiếp theo 

 

- Và cuối cùng nhấn Finish để hoàn 

tất .  
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Quá trình cài đặt  phần mềm OrCAD 9.2 đã 

xong. Nhưng đừng vội mở phần mềm lên, nó 

vãn chưa chạy được, ta phải tiến hành Crack 

đã: 

- Tìm đến file PDXOrCAD.exe trong thư 

mục Crack của CD  

- Click chuột phải và chọn thẻ Properties, 

chuyển qua Tab Compatibility và chọn 

như hình dưới       ( nếu là win 7, còn 

win XP thì bỏ qua bước này ). Click 

Appy để hoàn xác nhận 

 

 

 

 

 

 

- Xuất hiện hộp thoại của phần mềm Crack PDXOrCAD  

- Chọn đường dẫn đến thư mục đã cài đặt OrCAD , ở đây tôi cài lên ổ C có đường dẫn là 

C:\Programm Files\Orcad\. Nhấp chọn Apply để thực hiện. Nếu xuất hiện dòng thông báo “ 

Fixed Patch – Success: All patches applied “ như hình thì quá trình cài Crack đã thành công, nếu 

xuất hiện thông báo lỗi thì hãy kiểm tra lại các bước trên xem đã đúng chưa. 
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Vậy là đã cài hoàn tất cài đặt phần mềm OrCAD 9.2 ( Lưu ý: Mỗi phiên bản có  một cách cài đặt và Crack 

khác nhau ). Khởi động chương trình OrCAD lên và khám phá. 
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Chương 2: Vẽ mạch nguyên lý bằng OrCAD Capture 

2.1 Tổng quan về OrCAD Capture 

OrCAD Capture là phần mềm vẽ mạch nguyên lý rất mạnh , với thư viện phong phú, thao tác đơn giản, 

dễ chỉnh sữa và tìm kiếm. 

Trong phần này tôi sẽ hướng dẫn khái quát để mọi người có thể tiếp cận và sử dụng phần mềm này. Từ 

khởi động , tạo một bản thiết kế, lấy linh kiện, thay đổi thông số linh kiện, đi dây, hoàn thành mạch 

nguyên lí đến việc tạo thư viện linh kiện cá nhân để tiện cho việc sử dụng về sau. 

2.2 Vẽ mạch nguyên lý bằng OrCAD Capture 

2.2.1 Khởi động OrCAD Capture 

Khởi động OrCAD với chương trình Capture( hoặc Capture Cis ): 

C1. Start -> AllPrograms-> Orcad Family Release 9.2 -> Capture ( Capture Cis ) 

C2. Click vào biểu tượng            trên màn hình Desktop 

Màn hình làm việc của Capture như sau: 
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2.2.2 Tạo một Project mới 

2.2.2.1 Tạo Project mới: 

Để tạo một project bạn có thể làm như sau: 

  Chọn menu File -> New -> Project. 

 

 Hoặc chọn nút lệnh Create document   

Hộp thoại New project hiện ra, nhập tên project trong phần Name ( Theo tôi mỗi 1 Project bạn nên lưu 

vào 1 thư mục riêng vì trong orcad 1 project có thể tạo ra rất nhiều file  )và đường dẫn đến vị trí lưu 

project trong phần Location 
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Click vào nút Browse để chọn đường dẫn cho project 

Nếu muốn tạo một thư mục con để chứa các file trong project của bạn, nhấp chuột vào Create Dir... 

 

 Nhập tên thư mục muốn tạo vào phần Name trong hộp thoại Create Directory. OK để xác nhận 

 

Màn hình của OrCAD Capture như sau: 
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2.2.2.2 Thiết lập kích thước và cài đặt ban đầu cho bản vẽ: 

Khi bắt đầu vẽ một Schematic chúng ta 

nên chọn menu Options -> Preference 

đặt các thuộc tính tùy chọn riêng chi 

người thiết kế về màu sắc hiển thị của 

Wire, Pin …tọa độ lưới vẽ trong trang 

thiết kế. Hộp thoại Preferences như 

sau: 

 

 -Chọn lớp Color/Print: hiện các gam 

màu để gán cho từng đối tượng trong 

trang sơ đồ mạch nguyên lí như: màu 

nền của background, pin linh kiện, tên 

linh kiện, bus, đường kết nối các thành 

phần, lưới vẽ, giá trị linh kiện, text, … 

mailto:hanguyen92205@gmail.com


Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 2. OrCAD Capture 
 
 

  21 Nguyễn Ngọc Hà. Email: hanguyen92205@gmail.com 
Lớp D10CQDT01_N – Học viện Công nghệ BCVT Tp.HCM 

 

 

 

 -Chọn lớp Grid Display: Hiện/ 

không hiện ô lưới được thể 

hiện bằng những dấu chấm 

trong các trang thiết kế hoặc 

sửa đổi linh kiện. Mục đích 

của lưới là giúp chúng ta đặt 

linh kiện & sắp xếp so cho hợp 

lí & chính xác nhất 

 

 

 

 

 -Chọn lớp Pan and Zoom: 

hiện khung thoại chứa các  giá 

trị để thay đổi tỉ lệ thu phóng 

hay thu nhỏ các đối tượng 

trong trang thiết kế sơ đồ 

mạch. 
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 -Chọn lớp Select: hiển thị khung 

thoại liên quan đến việc lựa chọn 

các thành  phần trong trang sơ đồ 

nguyên lý. 

 

 

 

 

 

 

 

 

 

-Lớp Miscellaneous: chứa những 

thành phần hỗ trợ cho việc gán các 

thuộc  tính các đối tượng trong trang 

thiết  kế. Ngoài ra nó còn có chức 

năng rất quan trọng là tự động hiển 

thị số thứ tự của loại linh kiện được 

lấy ra  ( Automatic reference placed 

part ) & bắt tay chéo với Layout ( thẻ 

Intertool Communication ) rất hữu 

dụng trong việc sắp đặt các footprint 

linh kiện tùy thích của người thiết kế 

nhằm tránh trường hợp các linh kiện 

sắp xếp không theo ý muốn. Chức 

năng này chỉ có tác dụng khi mở cả 

Capture & Layout và xử lý cùng chung 

thiết kế. 
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Chọn menu Options > Design Templace… để gán các tham số mặc định cho 

bản thiết kế & các trang sơ đồ nguyên lí mới. Những giá trị được gán theo 

khung tham số này không ảnh hưởng đến những thiết kế của mạch điện cũ. Tại 

hộp thoại Design Template ta có thể tùy chỉnh thiển thị kiểu kí tự, size của các 

kí tự hiển thị tên, giá trị , … của linh kiện. Ngoài ra chúng ta có thể đặt têncủa 

thiết kế, size của thiết kế, đơn vị đo,… 

Chọn font hiển thị kiểu ký tự                                                                    thiết lập kích thước bản vẽ 
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2.2.2.3 Các đối tượng làm việc 

Thanh công cụ    

 Chọn đối tượng 

 Thư viện linh kiện 

 Chạy dây 

 Đặt nhãn đường mạch 

 Vẽ đường nối bus 

 Đặt điểm nối 

 Nối với đường bus 

 Nguồn 

 Mass 

 Điểm không nối 

2.2.3 Các phím tắt và từ khóa trong OrCAD Capture 

2.2.3.1 Phím tắt:  

Việc sử dụng các phím tắt sẽ giúp cho thao tác của chúng ta được nhanh hơn, và trong tài liệu này tôi 

chủ yếu hướng dẫn bằng các phím tắt 

Phím Chức năng Phím Chức năng 

R Xoay linh kiện W Nối các đương mạch 

I Phóng to màn hình O Thu nhỏ màn hình 

P Lấy linh kiện N Đánh nhãn 

J Tạo điểm nối B Vẽ đường bus 

T Thêm văn bản cho bản vẽ X Đánh dấu chân linh kiện ko sử dụng 

F Lấy các khối nguồn G Lấy các khối mass, nối đất 

Y Vẽ khối chữ nhật ESC Thoát chế độ đang chọn 
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2.2.3.2 Từ khóa tìm kiếm nhanh linh kiện 

Để thao tác được nhanh và lấy linh kiện chính xác thì bạn phải nhớ tên của các linh kiện,  ở đây tôi chỉ 

nêu một số từ khóa được sử dụng nhiều 

Kí hiệu Tên gọi Kí hiệu Tên gọi Kí hiệu Tên gọi 

R Điện trở RESISTOR VAR Biến trở CAP Tụ điện 

CAP NP Tụ không phân cực RELAY Rơ le LED Đèn led 

FUSE Cầu chì DIODE  Đi ốt DIODE ZENER Đi ốt ổn áp 

NPN Transistor ngược PNP Transistor thuận CRYSTAL Thạch anh 

BRIDGE Cầu diode SW Nút nhấn HEADR Chân cắm 

Khi làm việc với OrCAD các bạn chú ý là phải tắt các trình gõ tiếng việt đi thì mới sử dụng được các phím 

tắt , và tránh lỗi khi sử dụng các phím tắt, đơn giản là phần mềm nó không biết tiếng Việt.  

2.2.4 Vẽ sơ đồ nguyên lý 

Muốn vẽ được mạch nguyên lý thì các bạn phải có sơ đồ nguyên l{ đó ở 1 tờ giấy hay ở trong đầu bạn 

rồi. Bạn phải biết là sử dụng những linh kiện nào. 

2.2.4.1 Tìm kiếm và chọn linh kiện 

 Để lấy linh kiện ra bạn nhấn phím P ( hoặc Shift + P hoặc chọn Place Part ). 1 cửa sổ hiện ra như sau : 
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Ở khung Part cho phép chúng ta gọi ra các linh kiện, vậy linh kiện được lấy ở đâu? linh kiện được lấy ở 

Libraries. Nhưng chúng ta đang thấy Libraries trống trơn thế kia thì lấy làm sao được linh kiện? Vậy ta 

phải Add library sẽ hiện ra 1 cửa sổ như sau : 

Theo tôi thì nên Add tất cả các thư viện vào. Vì mỗi 1 thư viện chứa các linh kiện khác nhau mà ta không 

thể nhớ được linh kiện nào nằm trong thư viện nào. Thế là Add thư viện xong 
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 Từ hộp thoại Libraries, các bạn chỉ chuột vào bất kz một trong các thư viện được add ( hoặc Ctrl + A để 

chọn tất cả thư viện ) thì danh sách các linh kiện trên cửa sổ Part List sẽ xuất hiện 

 Bạn đánh tên linh kiện vào khung Part để chọn linh kiện phù hợp với mạch nguyên lý 

Nhấp OK để chọn linh kiện, lúc đó cửa sổ này sẽ mất đi và linh kiện dính vào chuột của bạn 

Chọn vị trí thích hợp và nhấp chuột trái để đặt linh kiện 
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Nhấp chuột trái để tiếp tục đặt linh kiện vào các vị trí khác, nhấn ESC trên bàn phím để ngưng việc đặt 

linh kiện 

 Chọn và đặt đầy đủ linh kiện vào trang vẽ trước rồi tiến hành đi dây nối mạch 

Để nối dây bạn nhấp vào  bên thanh công cụ phải hoặc sử dụng phím W 

Nhấp chuột vào linh kiện và kéo đến vị trí khác nếu muốn di chuyên chúng 

Các thao tác Rotate ( R ) để xoay linh kiện, Vertical ( V ) để lật linh kiện theo chiều dọc hoặc Horizontal ( 

H ) để lật theo chiều ngang 

2.2.4.2 Vẽ mạch cụ thể 

Để các bạn dễ hiểu thí chúng ta sẽ đi vào vẽ mạch cụ thể, ở đây tôi chọn mạch điều chỉnh và ổn định tốc 

độ động cơ. Mach nguyên l{ như hình dưới: 

 
Nguyên lý hoạt động của mạch: Khi động cơ được nối đến J1 quay sẽ cho ra điện áp cảm ứng đặt vào chân số 

1 của Triac. Nếu động cở bị giảm tốc độ ( có thể do tải tăng lên) làm V1 giảm, D2 sẽ dẫn điện tạo dòng kích 

cho Triac. Dòng điện qua triac tăng lên sẽ làm tăng tốc độ động cơ tăng lên như cũ. Nếu động cơ bị tăng tốc 

độ ( có thể do tải giảm xuống ) làm V1 tăng, D2 bị phân cực ngược sẽ ngưng dẫn, giảm dòng điện cấp  cho 

động cơ, tốc độ động cơ giảm xuông như cũ. 
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 Các linh kiện trong mạch: 5 điện trở, 1 biến trở, 2 tụ không phân cực, 3 diode chỉnh lưu, 2 transistor 

ngược , 1 triac, 2 chân cắm, công tắc 3 cực 1 

 Enter để lấy R. sau đó R sẽ đi theo chuột của ta, nhấp chuột vào 5 vị trí để lấy 5 điện trở. Muốn thoát để 

lấy linh kiện khác thì ấn ESC,hoặc nhấp chuột vào biểu tượng  Select  trên thanh công cụ để kết thúc. 

Để chọn chân cắm cho linh kiện ta 

cũng làm tương tự, ở khung Part các 

bạn gõ CON2, sau đó nhấp OK để trở 

về màn hình làm việc.  

Bây giờ quay trở lại cửa sổ Place Part ( 

Shift + P hoặc P ). Lấy ra 1 con trở nào 

ở khung Part ta gõ vào R sẽ có hình 

ảnh như sau 
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Gõ RESISTOR VAR ở khung 

Part để lấy biến trở: 

 

 

 

 

 

 

 

 

 

 

 

 

Để lấy tụ điện không phân 

cực chọn CAP NP tại 

khung Part của thư viện 

sau đó OK để trở về màn 

hình làm việc 
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Tiếp theo, bạn chọn DIODE 

tại khung Part để lấy đi ốt, 

nhấp OK để trở về màn 

hình làm việc. Nhấp chuột 

trái vào 3 vị trí khác nhau 

để lấy 3 diode 

 

 

 

 

 

 

 

 

 

Chọn công tắc 3 chấu bằng 

cách gõ SW MAG-SPDT  

trong khung Part, sau đó 

nhấp OK để trở về màn 

hình làm việc. Tại trang vẽ 

nhấp chuột trái vào một vị 

trí bất kì để chọn công tắc 
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Để lấy Triac, tại khung Part 

của hộp thoại Place Part 

gõ TRIAC, sau đó nhấp OK 

và nhấp chuột trái vào vị 

trí bâts kì để chọn Triac 

 

 

 

 

 

 

 

 

 

Chọn cuộn dây bằng cách 

tại khung Part gõ 

INDUCTOR FERITE. OK để 

trở về màn hình làm việc 
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Tiếp theo chọn transistor 

NPN bằng cách gõ NPN 

vào khung Part. OK 

 

 

 

 

 

 

 

 

 

 

 

Cuối cùng, chọn chân 

Mass bằng cách nhấp vào 

biểu tượng Place Ground 

 bên thanh công cụ. Tại 

khung Libraries chon 

SOURCE, tại khung Symbol 

chọn 0, sau đó nhấp OK để 

trở về màn hình làm việc 
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Kết thúc việc lấy linh kiện,  ta có hình sau : 

 

 

2.2.4.3 Sắp xếp linh kiện 
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Các linh kiện vẫn nằm ngổn ngang thế, để có thể xoay được các linh kiện dọc, ngang, quay ngược xuôi 

các bạn chọn vào linh kiện cần xoay rồi ấn phím R, hoặc phím H, hoặc V( có thể chọn vào linh kiện kích 

phải chuột chọn Rotate = R, Mirror Horizontally = H, Mirror Vertically = V )… và sắp xếp linh kiện sao 

cho gọn để chuẩn bị nối dây. 

 

Để nối dây các bạn ấn phím W ( Place Wire ), con trỏ chuột sẽ thành dấu cộng và chúng ta bắt đầu nối 

dây. Xong ta được hình sau: 
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Muốn thay đổi giá trị cho linh kiện, hãy nhấp đúp chuột 

vào linh kiện, khi đó hộp thoại Display Properties xuất 

hiện. Tại khung Value của hộp thoại nhập vào giá trị của 

linh kiện muốn thay đổi, sau đó nhấn OK để hoàn tất thay 

đổi. 
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Đây là mạch hoàn chỉnh 

 

2.2.5 Kiểm tra lỗi sơ đồ nguyên lý 

Nhấp vào biểu tượng minimize trên góc phải hoặc biểu tượng  , xuất hiện màn hình như sau. Chọn 

page 1  
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Nhấp vào biểu tượng design rules 

check  

 Hộp thoại Design Rules Check xuất 

hiện, check vào Scope, Action & 

Report như hình bên và nhấp Ok để 

kiểm tra. 

Nếu có thông báo lỗi bạn hãy kiểm 

tra vị trí có khoanh tròn nhỏ màu 

xanh và tiến hành sửa lỗi rồi tiếp 

tục. 
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2.2.6 Tạo file netlist 

Sau khi kiểm tra không thấy lỗi , chúng ta tiến hành tạo file .mnl để chuyển 

sang Layout , chọn  trên thanh công cụ, hoặc chọn Tool=> Create 

Netlist  

 

 

 

 

Cửa sổ Create Netlist xuất hiện, chọn Layout, trong thẻ Options chọn User Properties are in inchers để 

tự chọn chân linh kiện footprint, Browse để duyệt đến nơi chứa file, nhấp chọn OK  

 

Chon OK trong hộp thoại xuất hiện tiếp theo để hoàn tất quá trình tạo file netlist 
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Vậy là đã hoàn tất quá trình vẽ mạch bằng Capture, bạn hãy dùng file .MNL vừa tạo để vẽ mạch in bằng 

OrCAD Layout Plus 

2.3 Tạo thư viện linh kiện mới trong OrCAD Capture 

2.3.1 Giới thiệu  

Việc tạo ra linh kiện mới trrong Capture rất quan trọng, các linh kiện điện tử đều được sản xuất theo 

một số tiêu chuẩn nhất định. Trong Layout thì một số chân linh kiện nếu không biết thì có thể tìm một 

linh kiện khác có chân tương tự, còn trong Capture thì công việc đó không thể thực hiện được. Hơn nữa 

việc tạo ra một thư viện mới của riêng bạn sẽ giúp bạn quản l{, cũng như thao tác nhanh hơn trong việc 

tìm kiếm linh kiện 

2.3.2 Các bước tạo linh kiện mới 

Một project bao gồm việc tạo ra linh kiện mới , tạo ra bản vẽ nguyên lý hoặc xuất ra mạch in,...Khi đó 

việc tạo ra linh kiện mới là việc làm để phục vụ cho schematic nào đó. 

Để tạo thêm linh kiện mới, các bạn phải nhận diện được linh kiên đó là gì, hoạt động như thế nào. Phải 

tra datasheet của linh kiện đó. Sau khi đã biết rõ về linh kiện, hãy hình dung trong đầu sơ đồ bố trí các 

chân linh kiện sao cho việc vẽ mạch nguyên lí được dễ dàng và đẹp nhất. 

 Tiếp theo là tạo ra một thư viện linh kiện để chứa linh kiện mà các bạn sẽ tạo ra. Vì đặc tính các đề tài là 

khác nhau và những người làm việc với mạch điện tử cũng khác nhau nên việc đặt tên cũng có những 

đạc thù khác nhau. Cuối cùng là việc tạo ra linh kiện bạn, đặt vào các thư viện phù hợp. Cụ thể tôi sẽ 

hướng dẫn các bạn tạo ra con MAX232. 

2.3.2.1 Tìm datasheet 

Việc đầu tiên là phải tra cứu datasheet của con MAX232. Để tra datasheet bạn có thể search trên mạng 

http://google.com hoặc tìm trực tiếp từ các trang web về datasheet: 

www.alldatasheet.com  

 www.datasheetcatalog.com 
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Đây là hình ảnh của con MAX232 trong datasheet 

 

 

 

 

2.3.2.2 Tiến hành tạo linh kiện 

Trong màn hình làm việc của Capture.  

Chọn  File > New > Library  

 

T rong cửa sổ quản lí, nhấp chuột phải 

vào library.olb tại thư mục Library, chọn 

New Part để tạo linh kiện mới 

 

 

 

 

Nhập tên linh kiện vào 

khung Name ( tên này sẽ 

được hiển thị khi bạn chọn 

linh kiện). Chọn kiểu linh 

kiện trong ô Part 

Reference Prefix. 

Ở đây chọn là U 

Nhấp OK để vào trang 

thiết kế 
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Cửa sổ làm việc như sau: 

 

Trước hết chúng ta cần tạo ra nhóm chân, sau đó sửa chữa thông số, những nhóm chân có cùng chức 

năng ta ta thiết kế chung.  

Chọn Place Pin Array   trên 

thanh công cụ để tạo nhóm chân cho 

linh kiện 

Ô Starting Name ( tên chân) :         1 

Starting Number ( Chân bắt đầu):  1 

Number of Pins ( số chân được tạo ra 

trong cùng nhóm chân):                   8  

Increment ( số đơn vị tăng lên) :    1 

OrCAD hỗ trợ việc tạo ra các nhóm 

chân bằng cách tự động tăng thứ tự 

tên chân Starting Name, Starting 

Number lên Incrment đơn vị, nếu như 

chân đó tận cùng là 1 số. 
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Khi nhấn OK, con chuột sẽ tạo thành 1 dãy 8 chân linh kiện. Trên khối U 

vuông, các bạn đặt nó cạnh nào, nó sẽ nằm ở cạnh đó.Nhấp chuột để hoàn 

tất.  

 

 

T iếp tục tạo các chân còn lại. Chọn Place pin array   

Ô Starting Name : 16  

Starting Number: 16 

Number of Pins : 8 

Increment: -1 

OK và chọn vị trí đặt chân 

 

Nhấp đúp chuột vào chân linh kiện để sửa đổi các thông số: tên, 

số chân linh kiện  

 

 

 

Tiếp tục cho các chân còn lại. Nhấp chuột trái và kéo giữ chuột để sắp xếp 

lại vị trí các chân linh kiện cho hợp lí & thẩm mỹ. 

 

2.3.3 Vẽ đường bao và lưu linh kiện 

Chọn  Place rectangle  trên thanh công cụ để tạo đường 

bao, vẽ hình vuông vừa khít trên hình.Chọn Place Text để nhập tên 

cho linh kiện.Như vậy là đã làm xong 1 linh kiện mới, nhấn Save để 

lưu lại linh kiện.  

2.4 Chỉnh sửa linh kiện 

2.4.1 Đặt vấn đề 
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Khi lấy linh kiện trong thư viện, có một vấn đề là đa số với con IC thì bị ẩn chân VCC và GND, nhưng các 

bạn yên tâm khi xuất ra mạch in chân VCC mặc nhiên nối với Power và chân GND thì nối đất. Tôi sẽ chỉ 

cho cách làm cho nó hiện lên 

2.4.2 Tiến hành chỉnh sửa 

Ở đây tôi chọn con IC định thời 555 

Bạn nhấp phải chuột vào linh kiện, chọn Edit Part  

 

 

 

 

Xuất hiện cửa sổ làm việc  mới giúp bạn chỉnh sửa các thông số của linh kiện: 

Phần 2 dấu cộng trong vòng tròn màu đỏ là 2 chân VCC và GND, bạn nhấp đúp chuột vào nó để chỉnh 

kiểu chân 
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Hình dạng chân của nó trong cửa sổ Shape, trong cửa sổ này chân được lựa chọn là zero length chính vì 

vậy mà bạn không nhìn thấy nó, bạn có thể chọn Line hoặc Short để hiển thị chân. Tick vào Pin Visible 

để hiển thị tên của chân linh kiện 

Tương tự như trên để hiển thị chân GND. Bố trí lại sơ đồ chân cho 

hợp lý và thẩm mỹ, Sau khi chỉnh sửa ta được hình bên 

 

 

 

 

Trong cửa sổ này bạn cũng có thể thực hiện chỉnh sửa, thêm bớt chân, thay đổi kích thước hình dáng 

của linh kiện. 

2.4.3 Lưu linh kiện vừa chỉnh sửa 

Nhấp chuột vào nút Close  trong cửa sổ làm việc hoặc nhấn Ctrl + W, xuất hiện hộp thoại 

 

 

 

Chọn Update 

Current để lưu 

thay đổi, Update All để thay đổi tất cả linh kiện đó có trong Project, Discard để hủy bỏ thay đổi, Cancel 

để quay lại hủy bỏ thao tác, Help để được trợ giúp. 
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Vậy là đã hoàn tất cơ bản phần Capture, tiếp theo ta chuyển sang phần Layout để thiết kế mạch in. 

( luôn Ctrl + S để lưu bản project , phòng  sự cố xảy ra ngoài ý muốn ) 

 

mailto:hanguyen92205@gmail.com


Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 3. OrCAD Layout 
 

Nguyễn Ngọc Hà. Email: hanguyen92202@gmail.com 
Lớp D10CQDT01_N – Học viện Công nghệ Bưu chính Viễn thông Tp. HCm  47 

Chương 3: Vẽ mạch in với OrCAD Layout 

3.1 Tổng quan về phần mêm vẽ mạch in OrCAD Layout 

Để thi công board mạch thực tế cần phải xuất mạch nguyên lý trong Capture sang file mạch in được hỗ 

trợ bởi Layout. Phần này sẽ hướng dẫn các bạn xuất file .mnl trong mạch nguyên lý sang Layout để vẽ 

mạch in hoàn chỉnh, cách chọn chân linh kiện footprint, tạo thư viện chân linh kiện mới,... 

3.2 Vẽ mạch in với OrCAD Layout 

3.2.1 Khởi động OrCAD Layout 

Khởi động OrCAD với chương trình Layout Plus 

- Start -> AllPrograms-> Orcad Family Release 9.2 -> Layout 

- Click vào biểu tượng              trên màn hình Desktop 

Màn hình làm việc của Layout Plus như sau 
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3.2.2 Một số lệnh cơ bản 

3.2.2.1 File 

Chứa các lệnh liên quan đến việc tạo mới, mở, nhập và xuất ra các tập tin đối tượng vòa Layout hay sang 

các thành phần khác ( để sử dụng trong một số phần mềm thiết kế mạch khác như Protel, PCAD PCB, ...) 

3.2.2.1.1 Open 

Liệt kê tất cả các tập tin .MAX đang nằm trong thư mục hiện hành. 

3.2.2.1.2 Import 

Cho phép mở hay nhận một file đã được tạo từ các phần mềm khác như Protel PCB, CadStar PCB,... 

3.2.2.1.3 Export 

Cho phép xuất file .MAX đã được tạo từ OrCAD Layout sang các phần mềm thiết kế mạch in khác như 

Protel PCB, CadStar PCB,... 

3.2.2.2 Tools 

3.2.2.2.1 Library Manager 

Cho phép bạn chỉnh sữa hay tạo mới một footprint của linh kiện nào đó. Từ đây bạn có thể tạo hay sưu 

tập một thư viện footprint linh kiện mà bạn hay sử dụng cho các thiết kế về sau. 

3.2.2.2.2 OrCAD Capture 

Cho phép mở chương trình thiết kế mạch nguyên lý OrCAD Capture từ chương trình vẽ board mạch 

OrCAD Layout 

Ngoài ra trong Tools còn các chức năng khác như SmartRout cho phép bạn vẽ mạch thông minh, Edit 

App Settings, Reload App Settings,... 

3.2.3 Tạo bản thiết kế mới  

Để tạo một bản thiết kế mới, vào menu File -> New hoặc từ biểu tượng  trên thanh công cụ. Xuất 

hiện hộp thoại Load Template File, ta nhập vào file Template theo đường dẫn mặc định: 

C:\Program Files\Orcad\Layout_Plus\Data 

File template là file định dạng một số thông số mặc định cho board mạch, như số lớp board mạch, 

khoảng cách đi dây, kích thước đường mạch, quy định thiết kế,... được sử dụng xuyên suốt trong quá 

trình vữ mạch với Layout. Nếu là một board bình thường thì bạn chọn file default.tch ( hoặc 

jump6238.tch sẽ giúp quá trình chạy mạch hiệu quả hơn , các jumper sẽ không cắt ngang IC,…). Còn nếu 
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bạn muốn thiết kế board mạch riêng theo hình dạng cụ thể, như Sound Card, Lan card,... thì load các file 

template khác. Nhấn Open để thực hiện load file .TCH 

 

Xuất hiện hộp thoại Load Netlist Source yêu cầu bạn chọn file netlist có đuôi .MNL đã được tạo trong 

OrCAD Capture. Nhấp Open để chọn mở file Netlist 
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Tại hộp thoại Save File As bạn nhập vào đường dẫn và tên file mà bạn muốn lưu  thiết kế của mình. Mặc 

định Layout Plus sẽ đặt tên file mặc định trùng với file netlist và lưu trong thư mục chứa project đó. 

 

Nhấp Save để tiến hành lưu. 
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Nếu các linh kiện trong mạch thiết kế là các linh kiện mới và chưa từng có liên kết đến thư viện footprint 

của Layout Plus lần nào thì sẽ xuất hiện hộp thoại yêu cầu bạn phải liên kết đến footprint. Đây là bước 

khó khăn đòi hỏi bạn phải cẩn thận, nếu như chọn sai chân thì mạch coi như bỏ đi, ttos nhất bạn hãy 

xem kỹ hình ảnh thực tế của linh kiện để việc chọn hình dạng và kích thước của footprint được chính 

xác. Kinh nghiệm cho thấy sẽ tốt hơn nếu bạn tực hiện việc gắn footprint cho tất cả các linh kiện trong 

suốt quá trinh vẽ mạch bằng Capture. 

3.2.3.1 Liên kết Footprint 

Để làm tốt phần này bạn phải thường xuyên làm mạch, có kinh nghiệm thì việc tìm kiếm các footprint 

được nhanh hơn. 

3.2.3.1.1 Một số footprint thông dụng 

- Thư viện TO : TO92 ( transistor: C828, C1815, C535,...), TO202 ( Transistor: H1061, IC ổn áp họ 78xxx, 

79xxx,... ) 

- Thư viện DIP100T: /W.300 ( các IC cắm từ 14-20 chân ) /W.600 ( các IC cắm từ 24-40 chân ) 

- Thư viện TM_CAP_P là footprint của các loại tụ điện 

- Thư viện JUMPER là footprint của các loại điện trở, quang trở, biến trở,.. 

- Thư viện TM_DIODE là footprint của các loại diode hay led 

3.2.3.1.2 Liên kết đến footprint 

Quay lại màn hình làm việc của Layout sẽ xuất hiện hộp thoại  sau: 

 

Trong hộp thoại Link Footprint to Component có thông báo là không tìm thấy chân của D1 có tên là 

DIODE. Vì thế nên tìm chân cho linh kiện này bằng cách nhấp chuột vào liên kết Link existing fooprint to 

component... 
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Hộp thoại Footprint for DIODE xuất hiện , nếu là lần đầu tiên sử dụng thì bạn phải add thư viện vào 

bằng cách nhấp chuột trái vào nút Add... 

 

Bạn chọn đường dẫn đến thư viện Layout mặc định là C:\Program Files\Orcad\Layout_Plus\Library. 

Bạn nên add tất cả vào để tiện cho quá trình sử dụng 
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Tại khung Libraries nhấp chọn mục JUMPER. Tại khung Footprints nhấp chọn mục JUMPER200 ( khoảng 

cách giữa 2 chân là 200 mils = 5 mm ) để chọn chân diode. OK để thực hiện 

Tiếp theo trong hộp thoại Link Footprint to Component có thông báo là không thể tìm thấy chân của 

chân cắm J1 có tên CON2. Nhấp chuột vào Link existing fooprint to component... 

 

Trong hộp thoại Footprint for CON2, tại khung Libraries chọn JUMPER, tại khung Footprints chọn 

JUMPER100. Xong nhấp chọn OK. 

Trong hộp thoại Link Footprint to Component có thông báo là không thể tìm thấy chân linh kiện Q3 có 

tên T2801  
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Nhấp vào Link existing fooprint to component...Trong hộp thoại Footprint for T2801, tại khung 

Libraries chọn TO, khung Footprints chọn TO202AB để chọn chân cho Triac 

Tiếp tục chọn liên kết chân linh kiện cho các chân còn lại ( transistor Q1, Q2 tương ướng là TO - > TO126, 

cuộn dây L1 là thư viện JUMPER chọn JUMPER100, công tắc 3 chấu và biến trở chọn lần lượt là TO-> 

TO202AB và TO-> T126, tụ điện chọn JUMPER - > JUMPER100,...) cho đến khi nào không còn xuất hiện 

hộp thoại Link Footprint to Component nữa. Khi hoàn thành liên kết đến các footprint với linh kiện, 

OrCAD Layout tự động load các footprint như hình vẽ: 

 

3.2.4  Footprint trên board mạch 

Khi các fooprint được load, nếu không đúng với yêu cầu thiết kế thì phải chỉnh sửa hoặc tạo mới chân 

linh kiện cho phù hợp 

3.2.4.1 Chỉnh sửa fooprint 

Chọn linh kiện cần thay đổi trên board mạch vừa load, sau đó nhấp chuột phải  chọn Properties hoặc 

nhấp đôi chuột vào linh kiện 

Hộp thoại Edit Component xuất hiện, ở đây bạn có thể sửa lại tên và giá trị linh kiện, Nhấp chuột vào 

Footprint... để thay đổi footprint 
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Từ hộp thoại Select Footprint ta có thể lựa chọn các footprint thích hợp. Tuy nhiên nếu không tìm thấy 

footprint phù hợp thì ta phải tạo mới fooprint cho phù giợp với linh kiện 
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3.2.4.2 Tạo mới chân linh kiện 

Ta có thể tạo mới chân linh kiện bằng cách trong chương trình Layout Plus, vào menu Tools -> Library 

menager 

  

 

 

 

 

 

 

 

Để tạo một footprint mới hoàn toàn bạn bấm Create New Footprint … 

Ví dụ:   

Tạo footprint cho một pushbutton (Panasonic part EVQ-PAG04M) bạn cần một số thông tin về kích 

thước của nó: 
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Ở hộp thoại Create New Footprint   

Nhập tên linh kiện mới ở mục Name of 
footprint, ví dụ là PB 
Bấm chọn English. Mặc dù kích cỡ các bộ 
phận của linh kiện được cho ở hệ mét nhưng 
hầu hết kích thước chế tạo PCB vẫn bằng đơn 
vị inches ( hay mils = 1/1000 inch).  
 

 

 
Để dùng theo hệ mét bạn phải thay đổi systems settings. (vào Options -> System  Settings) xuất hiện 
hộp thoại bên. 
Nhấp OK. Bây giờ bạn đang làm việc theo hệ mét. 

 

Switch có tất cả 4 chân nhưng ta chỉ cần định dạng cho 1 padstack vì các chân dều có đặc điểm giống 

nhau. 

Đầu tiên vào View ->  Spreadsheet ->Padstacks. Ta thấy xuất hiện hộp thoại padstacks, ta double click 
vào padstack có tên T1 sẽ xuất hiện hộp thoại Edit Padstack cho tất cả các lớp của T1. 
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Bạn thay đổi tên của padstack này, thường thì 

đặt tên theo tên footprint. Điều này làm cho 

việc tìm kiếm nó dễ dàng hơn trong Layout khi 

có nhiều padstack. Tiếp đó nhấp chọn 

Undefined trong mục Pad Shape 

Nhấp OK. Xuất hiện hộp thoại padstacks. Bạn 
thấy padstack tên PB với tất cả các lớp của nó 
không được định dạng      
 
 
 
 
 
 
 
 
 
 
 
 
 
                    

 

 

Dựa vào Datasheet bạn định dạng cho các lớp của padstack PB. Nếu chọn nhiều lớp cùng một lúc thì 

nhấn chọn tên các lớp đồng thời giữ phím Ctrl. Bạn chỉ cần định dạng cho những lớp cần thiết . 

Đầu tiên bạn cần định dạng kích thước cho chân lỗ khoan, theo datasheet đường kính chân lỗ khoan là 1 
mm. 
Ta chọn 2 lớp DRLDWG, DRILL.  
Click phải chuột chọn Properties , xuất hiện hộp thoại Edit Padstack Layer , nhấp chọn Round, sau đó 
nhập giá trị 1(=40 mils) vào Height và Width. 
Nhấp OK 
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Bạn thấy trong hộp thoại padstacks lớp DRLDWG, DRILL đã được định dạng: 

 

Tương tự bạn định dạng cho các lớp TOP, BOTTOM, INNER. Thường thì kích thước của vòng xuyến bao 

quanh lỗ chân khoan lớn hơn lỗ khoan khoảng 20 mils(=0.5 mm). Do đó nhập giá trị 1.5mm vào Height 

và Width. 

Vì lớp giữa của mạch là miếng đồng dành cho power và ground, để tránh hiện tượng ngắn mạch người 

ta thường tạo ra xung quanh các lỗ khoan một khoảng trống, lớn hơn kích thước lỗ khoan là 35 

mils(=1.75 mm). Bạn nhập giá trị 2 mm vào Height và Width và chọn pad dạng round cho lớp PLANE. 

Cuối cùng bạn cần định dạng cho mặt để hàn chân linh kiện, thường thì nó lớn hơn vòng xuyến bao 

quanh chân lỗ khoan khoảng 5 mils(=0.125 mm). Do đó bạn chọn pad hình round và nhập giá trị 

1.625mm vào Height và Width cho lớp SMTOP and SMBOT. 
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Sau khi định dạng xong cho các lớp của padstack này, ta sẽ lưu tên của footprint mới tạo vào thư viện, ta 

nên tạo thư viện mới để dễ dàng tìm kiếm sau này.  

Bằng cách click Save As trong hộp thoại Library manager.  
Điền tên footprint mới tạo, sau đó click vào Create New Library để tạo thư viện mới.  

 

Nhấp OK thì footprint mới tạo sẽ được lưu vào thư viện. 

 



Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 3. OrCAD Layout 
 

Nguyễn Ngọc Hà. Email: hanguyen92202@gmail.com 
Lớp D10CQDT01_N – Học viện Công nghệ Bưu chính Viễn thông Tp. HCm  61 

 

Sau đó chọn Text tool  để xóa bớt 

các chữ không cần thiết đi, chỉ để lại 

&Comp và &Value. Nhấp vào text cần 

xóa và bấm phím Delete (trên bàn 

phím).  

Thêm các chân linh kiện vào bằng cách 

chọn công cụ Pin Tool .  

Click chuột phải vào nền đen, chọn 

New…   

Đặt chân mới ở vị trí thích hợp  
 

Chọn thuộc tính cho 2 text còn lại bằng kéo chuột để bôi nó, xong click chuột phải, chọn Properties 

(phím tắt Ctrl+E). 

Chọn Layer là SSTOP. 
Chọn OK. 
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Sau đó bạn sắp xếp lại vị trí cho các chân, bạn luôn luôn đặt vị trí của pad1 tại  

(x,y) = (0, 0) > double click vào pad1 xuất hiện hộp thoại EDIT PAD. 

 

Bạn dựa vào Datasheet biết khoảng cách giữa các chân để xác định vị trí cho các chân còn lại. Pad2 = (0, 
6.5) 
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Các chân khác tương tự: Pad4 = (4.5, 0), Pad3 = (6.5, 4.5)  

 
 
Bạn có thể dùng các công cụ đo đạc như: Dimension, Measurement trong menu Tool để có thể tạo 
khoảng cách chính xác giữa các chân. 
Ngoài ra bạn còn có thể vẽ thêm các đường bao (Obstacle) cho linh kiện, đây là đường ranh giới giữa các 
footprint để khi sắp xếp chúng không bị chồng chéo nhau.  

Để vẽ đường bao bạn click vào biểu tượng Obstacle Tool  , sau đó click phải chuột chọn New, giữ 
chuột trái đồng thời kéo đến các góc chân pad, đường bao bao quanh các chân pad. 
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Đầu tiên bạn đặt tên cho đường bao, sau đó chọn  Place Outline tại ô Obstacle Type. Độ dày width tùy 
ý. 

 

Thường bạn chọn đường bao này nằm ở lớp Global Layer, tức thuộc tính Obstacle Layer là Global Layer.   

Cuối cùng click OK để lưu lại các định dạng cho footprint mới tạo. 

Bạn đã hoàn thành việc tạo 1 footprint mới không có sẵn trong thư viện của layout. 

Để nhanh hơn bạn có thể lướt qua thư viện của layout tìm những footprint tương tự footprint mà bạn 

cần tạo để sửa chữa cho phù hợp với thực tế rồi Save As nó lại, lưu lại trong thư viện mới mà bạn tạo 

cho dễ tìm kiếm. 

3.2.4.3 Những chú ý khi tạo mới chân linh kiện 

Khi thiết kế footprint, ngoài việc bạn cần biết chính xác kích thước thực giữa các chân linh kiện để thiết 

kế kế đúng, còn phải biết kích thước của cả linh kiện để có thể bố trí khoảng cách giữa các linh kiện cho 

hợp lý. 

Một số kinh nghiệm chọn kích thước cho chân linh kiện: 
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- Với các linh kiện thường như điện trở, tụ, diode … bạn chọn chân hình tròn (Round), đường kính 

là 1.8 đến 2.1, tùy loại linh kiện 

- Chân 1 của IC hay các linh kiện có cực tính như tụ hoặc diode bạn nên chọn kiểu chân là hình 

vuông hoặc hình chữ nhật 

- Với IC ta nên chọn chân hình Oval (với các chân 2 trở lên) và hình chữ nhật (đối với chân 1). Kích 
thước thường là 1.7mm Width và 2.2 mm Height. 

- Với các chân linh kiện to như chân của các JACK cắm, chân của đế IC có cần thì nên chọn bề 
Width(bề ngang) to ra một tí, cỡ 1.8mm. 

Thực tế việc tạo ra linh kiện trong Capture quan trọng hơn rất nhiều lần so 

với việc tạo ra linh kiện trong Layout (hay Layout Plus). bạn chỉ cần sử dụng các chân layout có định 

dạng giống vậy đểsử dụng, không nhất thiết phải tạo ra các định dạng chân cho từng linh kiện riêng biệt. 

3.2.5 Một số thao tác cần thiết trước khi vẽ Layout 

Đầu tiên, bạn sẽ tắt DRC (Design Rule Check), bạn sẽ cần dùng chúng sau, nhưng không phải bây giờ. 
Sau khi tắt, khung chữ nhật nét đứt sẽ biến mất. 
Những ký hiệu xuất hiện bên cạnh các linh kiện có thể không cần thiết nhưng chúng sẽ làm cho màn 
hình của chúng ta rối hơn. Có 2 cách để xóa chúng đi: 

- Chọn Text Tool  trên thanh công cụ, click chuột vào đoạn ký hiệu mà bạn muốn xóa đi, sau 
đó click chuột phải và chọn delete. 

- Hoặc nếu bạn muốn xóa hoàn toàn các ký hiệu đi kèm, bạn làm như sau: Chọn lớp 23 AST như 
hình vẽ, sau đó tắt nó đi.(sử dụng phím “-”) 

3.2.6 Thiết lập môi trường thiết kế 
3.2.6.1 Thiết lập đơn vị đo và hiển 

thị. Đây cũng là đơn vị thể hiện độ 

rộng của đường mạch in trong board 

mạch. Mục đích của vấn đề này là giúp 

cho người thiết kế quản lý được kích 

thước của các nets trong board mạch 

cũng như kích thước của board 

outline. Cách làm như sau: Vào 

Options -> System settings. Bạn sẽ 

thấy hộp thoại sau xuất hiện: Ở đây 

bạn nên chọn đơn vị là 

Millimeters(mm). Ngoài ra ta còn có 

thể thiết lập lưới vẽ, đặt lưới nếu cần 

thiết ở khung Grids. 



Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 3. OrCAD Layout 
 

Nguyễn Ngọc Hà. Email: hanguyen92202@gmail.com 
Lớp D10CQDT01_N – Học viện Công nghệ Bưu chính Viễn thông Tp. HCm  66 

3.2.6.2. Đo kích thước board mạch 

Vào Tool -> Dimension -> Select Tool.  

Sau đó đo độ dài và độ rộng của đường bao. Mục đích của cách làm này là cho người thiết kế biết được 

board mạch mình thiết kế có kích thước thật bao nhiêu, để từ đó có những điều chỉnh hợp lý trong việc 

sắp xếp các linh kiện trong đường bao cho phù hợp với board mạch in mà  mình đang có. 

 

3.2.6.3 Layer Stack 

Để định nghĩa Layer Stack, bạn chọn View Spreedsheet từ Toolbar 
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Nhấp Layers để chọn lớp vẽ, ở đây bạn chọn lớp BOTTOM, click chuột phải chọn Properties. 

 

Chọn như sau và OK 

 

3.2.6.4. Thiết lập khoảng cách giữa các đường mạch 

Để thiết lập những luật về khoảng cách cho pads, tracks và vias. Bạn chọn View Spreedsheet từ Toolbar. 

Chọn Strategy -> Route Spacing. 
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Từ menu pop up chọn Properties: 

 

Xuất hiện hộp thoại: Edit Spacing 

 

Ở đây bạn có thể điều chỉnh các thông số cho phù 

hợp. Cần chú ý đơn vị đo mà bạn đã thiết lập ở trên. 

Chọn OK. 

 

 

 

 

 

 

 

3.2.6.5 Thiết lập độ rộng đường mạch in 

Bạn làm điều này để điều chỉnh độ rộng của các nets trong mạch khác nhau tùy theo chức năng của 

chúng. Thường thì: các đường nguồn, mass phải lớn hơn các nguồn tín hiệu, hay các đường ứng với 

mạch công suất thì bề rộng cũng phải lớn hơn bình thường…Muốn điều chỉnh các thông số này bạn có 

thể làm như sau: Vào View Spreedsheet → Nets. Bôi đen tất cả, chọn Properties 
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Hộp thoại Edit Net cho phép ta chỉnh các thông số của Nets 

 

Min Width, Conn Width, Max Width là độ rộng của nets mạch in. Không nên để 3 giá trị này bằng nhau, 

vì khi đi mạch máy sẽ tự động điều chỉnh độ rộng của nets. Khi ít đất thì nó chọn Min, khi nhiều sẽ chọn 

Max, như vậy sẽ linh hoạt hơn. 

3.2.6.6 Vẽ đường bao 

là đường bao ngoài cho tất cả các linh kiện và các đường mạch trong mạch in. Để vẽ bạn tiến hành như 

sau: 

Click chuột vào Obstacle Tool, sau đó click vào một góc mà bạn muốn vẽ Outline, con chuột chuyển 
thành dấu cộng nhỏ, click phải, chọn Properties sẽ hiện ra hộp thoại sau: 
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Bạn chọn như hình vẽ. Sau đó chọn OK. 
Click vào 4 góc của khung mà bạn muốn vẽ, sau đó nhấn ESC. 

3.2.7. Sắp xếp  linh kiện lên board mạch 

Việc bố trí linh kiện lên board mạch là một trong những yếu tố quan trọng quyết định 

đến độ ổn định, dễ vẽ và thẩm mĩ,v.v…của board mạch.  

Bạn có thể sắp xếp linh kiện bằng tay hoặc sử dụng chức năng tự động sắp xếp của 

Layout Plus. 

3.2.7.1. Sắp xếp linh kiện bằng tay 

Nhấp chuột vào biểu tượng Component Tool trên thanh công cụ.Để di chuyển linh kiện nào ta nhấp 

chuột vào linh kiện đó, sau đó, khi nhả chuột ra và di chuyển thì linh kiện cũng sẽ di chuyển theo. Đến vị 

trí cần đặt linh kiện thì nhấp chuột một lần nữa, và linh kiện sẽ được cố đinh. 
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Sau khi sắp xếp một lúc ta được như sau: nhấp chuột vào Reconnect Mode  để ẩn /hiện dây nối 

 

 
3.2.7.2. Sắp xếp linh kiện tự động 

Đầu tiên bạn cần phải cố định một số linh kiện mà bạn muốn nó được đặt ở một vị trí xác định, tránh bị 

thay đổi vị trí trong quá trình auto. Di chuyển linh kiện đến vị trí xác định, nhấp chuột phải chọn Lock. 

Sau khi đã cố định được các linh kiện theo yêu cầu, chọn Auto  -> Place -> Board. 

3.2.8 Vẽ mạch 

Layout Plus hỗ trợ cả 2 chức năng vẽ tự động và vẽ bằng tay. Thông thường nên kết hợp cả 2 chức năng 

này, vì khi vẽ tự động đôi khi sẽ có những đường mạch rất phức tạp, lúc đó ta nên điều chỉnh lại bằng 

tay. 



Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 3. OrCAD Layout 
 

Nguyễn Ngọc Hà. Email: hanguyen92202@gmail.com 
Lớp D10CQDT01_N – Học viện Công nghệ Bưu chính Viễn thông Tp. HCm  72 

3.2.8.1. Vẽ tự động 

Vào Auto -> Auto Route -> Board, Layout Plus sẽ tự động vẽ mạch. 

3.2.8.2. Vẽ bằng tay 

Chọn Edit Segment Mode . Kích vào dây muốn vẽ, lúc đó dây sẽ gắn với con trỏ, rê 

chuột để tạo đường mạch, kích trái chuột để cố định đường mạch. 

Để đổi hướng đường đi của mạch: kích vào cuối đoạn dây, sau đó đổi theo hướng mà bạn muốn vẽ. 

Sau khi vẽ xong, nhấn ESC để kết thúc. 

Nhấp F5 để refresh bản mạch. 

Sau khi vẽ, bạn sẽ được như sau: 
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3.2.9. Hoàn thiện bản mạch 

Về cơ bản, chúng ta đã hoàn thành việc vẽ mạch in. Trong phần này bạn sẽ tiến hành một số thao tác 

cuối cùng trước khi xuất mạch in 

3.2.9.1. Chèn một đoạn text vào mạch in 

Chọn Text Tool từ thanh công cụ. Click phải vào màn hình chọn 

New. 

Hộp thoại Text Edit hiện ra, trong khung Text String gõ nội dung cần chèn. 

 Lưu ý: nếu bạn làm mạch in thủ công thì click chọn Mirrored để khi ủi không bị ngược. Chọn lớp hiển thị 

trong khung Layer ( thường thị chọnTOP và BOTTOM ), và kích thước chữ . chọn OK để hoàn tất 

 

Di chuyển đoạn text đến vị trí cần chèn, click chuột. 
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3.2.9.2. Phủ mass cho mạch in 

Mục đích của vấn đề này là để chống nhiễu cho mạch điện.  

Cách làm như sau: 

Chọn Obstacle Tool. Nhấp chuột vào khung mạch, con chuột co 
thành dấu cộng nhỏ thì click phải, chọn Property.  
Màn hình sẽ xuất hiện hộp thoại Edit Obstacle. 
 

 

- Trong khung Obstacle Type chọn: Copper Pour. 
- Trong khung Obstacle Layer chọn lớp cần phủ Copper Pour: có thể là TOP hay BOTTOM. 
- Trong khung Net Attachment thì chọn là GND hoặc POWER, tùy theo bạn muốn phủ theo GND 

hay POWER. Nếu không thì ta để dấu “ – “ 
- Nhấn OK. 
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Bản mạch hoàn chỉnh: 

 

Nếu vẽ mạch nhiều lớp thì trong lúc vẽ, nhấn phím Backspace và các phím số để hiển thị  một số lớp 

nhất định,1: TOP, 2: 

BOTTOM, ... 

3.2.10. In mạch Layout 

Để in mạch vừa vẽ, bạn 

thực hiện các bước sau: 

- Chọn Option -> 
Post Process 
Settings 

- Nhấp chuột phải 
vào lớp muốn in 
(vd: lớp 
BOTTOM), chọn 
Preview 
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- Vào menu File, chọn Print/Plot ( Ctrl + P ) 
- Chọn như hình dưới rồi nhấp OK 

 
 

Kết quả:  

 

Vậy là đã hoàn chỉnh 1 board PCB , tôi sẽ hướng dẫn các bạn làm mạch in thủ công tại nhà ở phần sau. 
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Chương 4: Mô phỏng bằng PSPICE 

4.1 Tổng quan về phần mêm mô phỏng Pspice  

4.1.1 Giới thiệu về Pspice 

Kỹ thuật điện là ngành khoa học nghiên cứu những ứng dụng của các hiện tượng điện, từ nhằm biến đổi 

năng lượng và tín hiệu, bao gồm việc thu hập , gia công, xử lý, truyền tải tín hiệu 

Để thuận tiện cho việc tính toán, thiết kế các thiết bị điện tử, người ta thường thay thế các mạch điện 

thực tế bằng các mô hình thay thế và các sơ đồ mạch điện tương đương. Việc phân tích các mạch điện 

nhằm dự đoán và kiểm tra khả năng làm việc của các thiết bị điện  tử hoặc nhằm đưa ra các sản phẩm 

phù hợp với yêu cầu đặt ra. 

Phương pháp thực tế để kiểm tra một mạch điện là xây dựng chúng. Tuy nhiên hiện nay, khi mà các 

thành phần của một mạch tích hợp có kích thước ngày càng nhỏ bé thì việc xây dựng các vi mạch này trở 

nên rất khó khăn, Bên cạnh đó, những tác động vật lý, âm thanh, ánh sáng,...không ảnh hưởng đến 

mạch điện thông thường nhưng lại gây nhiễu rất lớn đối với các vi mạch. Vì vậy, việc lắp ráp các vi mạch 

từ các thành phần trong phòng thí nghiệm đòi hỏi nhiều thời gian, công sức và tiền bạc 

Sự phát triển của công nghệ thông tin cho phép xây dựng các phần mềm mô phỏng và phân tích quá 

trình làm việc của mạch điện tử. Khi đó ta có thể xây dựng, thử nghiệm, khảo sát hoạt động của mạch 

ứng với các trường hợp cũng như việc thay đổi các thông số kỹ thuaaj cũng như khảo sát ảnh hưởng của 

chúng đến quá trình làm việc của mạch. Do đó tăng tính mềm dẻo và khả năng khảo sát nhiều trường 

hợp, tình huống khác nhau 

Vấn đề khó khăn khi sử dụng các phần mềm là tính chính xác của mô hình. Nếu các mô hình không có 

các đặc tính giống như các phần tử thực thì việc mô phỏng là vô nghĩa 

Spice ( Simulation Program with Integrated Circuit Emphasis ) là một chương trình tính toán mô phỏng 

và mô hình hóa các mạch điện tử tương tự được phát triển từ những năm 1970 tại đại học California ở 

Berkeley 

Pspice ( Power Simulation Program with Integrated Circuit Emphasis ) được phát triển bởi hãng 

MicroSim, là một trong những phiên bản thương mại được phát triển từ Spicevaf trở thành phần mềm 

mô phỏng phổ biến nhất trên thế giới. Pspice cho hép chúng ta mô phỏng các thiết kế trước khi di vào 

xây dựng phần cứng. CHương trình mô phỏng cho phép chúng ta quan sát họa động của mạch cũng như 

những thay đổi của các tín hiệu đầu vào hoặc các giá trị của các thành phần trong mạch điện. Do đó có 

thể kiểm tra lại các thiết kế để xem chúng có chạy đúng trong thực tế hay không. Pspice chỉ mô phỏng và 

tiền hành các phép đo kiểm tra chứ không phải là phần thiết kế của mạch điện 

4.1.2 Các tính năng của Pspice 

Pspice được đưa ra thị trường nhiều phiên bản khác nhau, mỗi phiên bản cung cấp các tính năng khác 

nhau tùy thuộc vào yêu cầu khách hàng. 
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Trong phần này, tôi sẽ hướng dẫn dùng phần mềm Pspice A/D đi kèm trong bộ phần mềm OrCAD  

Pspice A/D là chương trình dùng để  mô phỏng các mạch điện tương tự và số. Các tính năng chính của 

Pspice A/D: 

- Phân tích xoay chiều, một chiều, quá độ : Tính năng này cho phép chúng ta kiểm tra các đáp 

ứng cảu mạch điện khi được cung cấp đầu vào khác nhau. Cụ thể :  

+ Phân tích một chiều ( DC Analysis ): Cho phép xác định điện áp định mức và trị số dòng điện 

cho tất cả các nút của mạch bằng cách quét toàn bộ giá trị của điện áp trong một khoảng do 

người dùng định nghĩa. Điều này có ý nghĩa khi muốn xác định đường đặc tính của các mạch 

điện có chứa các phần tử phi tuyến như: diode, transistor,.. hoặc muốn xác định điện thế định 

mức của các mạch khuếch đại 

+ Phân tích quá độ ( Transient Analysis ) : nhằm dự đoán các trạng thái của mạch khi có các sự 

kiện quá độ xảy ra 

+ Phân tích xoay chiều ( AC Analysis ) : mô phỏng hồi đáp tần số của mạch điện, tức là ta có thể 

quan sát được các trạng thái của mạch điện khi tần số của nguồn điện thay đổi trong một dãy 

cho trước. Dựa vào đó đó ta có thể tìm thấy tần số cộng hưởng của mạch 

- Phân tích tham số, độ nhạy, giá trị giới hạn : với những tính năng này chúng ta có thể quan sát 

những biến đổi của mạch điện khi thay đổi các giá trị của các thành phần của nó 

- Phân tích thời gian của các mạch số cho phép tìm ra sự cố về thời gian xuất hiện khi kết nối các 

tín hiệu có tần số thấp trong quá trình truyền dẫn tín hiệu 

Pspice A/D cũng cung cấp các mô hình hóa về các ứng xử của các thiết bị tương tự và số, vì vậy chúng ta 

có thể mô tả các hàm chức năng của mạch điện sử dụng các biểu thức và hàm toán học. Do đó có thể 

xây dựng và phân tích các đặc tính phức tạp của thiết bị thông qua mô hình toán học. Các mô hình hóa 

được xây dựng trong Pspice A/D không chỉ là các điện trở, điện cảm, điện dung mà còn có các mô hình 

sau : 

- Mô hình dây dẫn, bao gồm độ trễ, độ dội, tổn hao, tán xạ và tạp âm 

- Mô hình của cuộn dây từ phi tuyến, bao gồm độ bão hòa và từ trễ 

- Mô hình của MOSFET 

- Mô hình của transisitor trường có cực điều khiển cách ly IGBT MOSFET 

- Mô hình của các phần số với vào ra tương tự 

4.2 Các bước tiến hành mô phỏng và phân tích mạch điện 

Để khảo sát một mạch điện nói chung cũng như một mạch điện tử công suất nói riêng ta tiến hành theo 

các bước sau: 

- Xác định mô hình các phần tử cần thiết để xây dựng mạch điện. Đa số các phần tử này đều có 

trong thư viện mô hình của chương trình, tuy nhiên trong một số trường hợp ta phải xây dựng 

thư viện mới. Việc xây dựng mô hình mới đòi hỏi am hiểu sâu sắc về kỹ thuật điện- điện tử bởi vì 

mô hình phải phản ánh đúng đặc điểm và tính chất vật lý của thiết bị thực. Mô hình càng gần với 

thực tế thì kết quả phân tích càng đáng tin cậy. Mặc dù vậy, trong một số trường hợp, khi khảo 
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sát một số đặc tính nào đó thì ta chỉ cần mô hình hóa các tham số, thông số liên quan đến đặc 

tính đó, tránh gây ra những phức tạp không cần thiết 

- Thiết lập sơ đồ nguyên lý của mạch điện cần nghiên cứu. Cần phải đảm bảo chắc chắn rằng sơ 

dồ nguyên lý được xây dựng là đúng đắn 

- Chuyển đổi từ chương trình nguyên lý sang chương trình mô hình hóa theo ngôn ngữ chuyên 

dụng của phần mềm ( đối với phiên bản hiện tại của Pspice thì việc này là hoàn toàn tự động ). 

- Thiết lập các thông số của sơ đồ và các tham số khảo sát 

- Tiến hành khảo sát: 

+ Chạy thử chương trình với chế độ quen thuộc mà kết quả đã biết trước để kiểm tra độ chính 

xác của mô hình 

+ Khi mô hình hoạt động đạt độ tin cậy thì ta tiến hành nghiên cứu vói các chế độ cần khảo sát 

theo yêu cầu đặt ra 

Cụ thể với Pspice A/D trong OrCAD ta tiến hành theo 3 bước: 

- B1: Thiết kế mạch bằng CAPTURE 

+  Tạo một dự án Analog Or Mixed A/D 

+ Đưa vào các phần tử 

+ Nối dây và hoàn chỉnh sơ đồ mạch 

- B2: Xác định kiểu mô phỏng 

+ Tạo tệp tin mô tả 

+ Xác định kiểu phân tích: 1 chiều, xoay chiều, quá độ, thời gian, tần số 

+ Chạy PSPICE 

- B3: Quan sát kết quả: 

+ Thêm các đường đồ thị 

+ Phân tích dạng sóng 

Kiểm tra tệp tin đầu ra nếu cần 

+ Lưu và in kết quả 

4.3 Thiết kế mạch bằng CAPTURE 

Về phần Capture tôi đã hướng dẫn cụ thể cho các bạn ở phần trên, nên phần này tôi chỉ hướng dẫn 

những gì liên quan tới Pspice. 

4.3.1 Tạo 1 project mới 

Khởi động cửa sổ làm việc của Capture. Chọn File -> New -> Project để tạo project mới 

Cửa sổ New project xuất hiện 
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Trong cửa sổ này, bạn gõ vào tên tập tin trong phần Name, chọn thư mục để lưu trữ tập tin trong phần 

Location. Trong thẻ Create a New Project Using bạn đánh dấu vào ô tròn thứ nhất : Analog or Mixed 

A/D. Nhấn Ok để đồng ý tạo Project mới 

 Lúc này trình Capture mở ra một cửa sổ Create Pspice Project, bạn hãy chọn mục Create a blank 

Project để trình Capture mở ra trang vẽ trắng 

 

OK để hoàn tất và vào vùng làm việc chính của Capture 
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Với việc liên thông với trình Pspice A/D thì thanh Capture có thêm thanh công cụ để hỗ trợ cho việc liên 

thông với Pspice 

 

Ở đây tôi sẽ mô phỏng mạch dao động sử dung IC định thời 555, loại IC này được dùng rộng rãi trong 

mạch điện tử tương tự. Sơ đồ nguyên lý của 1 mạch tạo xung dùng 555 như sau: 

 

Các bạn thực hiện việc lấy linh kiện và đi dây để hoàn thiện mạch như hình trên 

 Lưu ý: 

- Thư viện để sử dụng cho trình mô phỏng  Pspice được lấy trong thư viện pspice theo đường dẫn 

mặc định là: \capture\library\pspice 

Một số thư viện thông dụng dùng trong mô phỏng Pspice bao gồm: 

Các linh kiện có trong mạch: 

IC 555/ ANL-MISC.OLB 

 R/analog 

 C/analog 

 VDC/source 

 GND 
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 Analog: chứa các phần  tử thụ động ( R,L,C ), hỗ cảm, đường truyền và các nguồn dòng, nguồn áp phụ 

thuộc( nguồn áp phụ thuộc điện áp E, nguồn dòng phụ thuộc dòng điện F, nguồn dòng phụ thuộc dòng 

điện G và nguồn áp phụ thuộc dòng điện H ) 

 Source: bao gồm các loại nguồn dòng và nguồn áp độc lập như  VDC, IDC, VAC , IAC , VSIN ,VEXP, xung,... 

Và nhiều thư viện khác chứa các thành phần của mạch điện như các linh kiện điện tử công suất: diode, 

transistor, thyristor, mosfet, các cổng logic, các thiết bị giao tiếp 

- Các điểm nối của mạch được đánh dấu bằng các số nguyên dương, trong đó bắt buộc phải có 

nút số 0 và luôn được hiểu là điểm đất ( Ground ). Điểm 0 này rất quan trọng vì khi chạy chương 

trình máy sẽ tính toán điện áp giữa mỗi nút trong mạch điện với điểm đất này trong từng bước 

tính 

Để lấy điểm 0 ta kích chuột vào biểu tượng  bên thanh công cụ hoặc nhấn phím G. Hộp thoại Place 

Groud hiện ra, ta chọn thư viện SOURCE và chọn ký hiệu 0 

 

- Việc vẽ mạch bằng Capture để phục vụ cho trình mô phỏng Pspice phải tuyệt đối chính xác từ 

việc chọn linh kiện đến nói dây và các thông số linh kiện, như vậy việc mô phỏng mới đảm bảo 

được 

- Với các mạch dao động bạn phải đặt vào mạch một điều kiện khởi đầu ( lênh IC: Initial 

Condition). Hãy mở của sổ Place Part và chọn thư viện Special rồi chọn tên linh kiện là IC1. Bạn 

hãy nhấp chuột lên chữ “ IC” để ghi vào mức volr khởi đầu ( vd : 0V ). 

4.3.2 Hoàn thiện bản vẽ 

Sau khi hoàn tất việc lấy linh kiện và đi dây, cần phải gán tên và giá trị cho các phần tử 
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Các nút lưới: Danh sách các nút lưới bao gồm toàn bộ các phần tử của mạch được liệt kê theo cấu trúc 

đã được quy định. Để tạo ra các nút lưới từ sơ đồ mạch nguyên lý, ta dùng lệnh Pspice -> Create netlist    

từ thực đơn của chương trình. Danh sách này được lưu trong tệp tin có đuôi .net và được quản lý bằng 

trình trình quản lý dự án, ta có thể chọn vào tệp tin này để xem nội dung bên trong của nó. Và đây là nội 

dung của tệp tin ứng với mạch đang xét:  

nếu có thông báo lỗi , bạn hãy kiểm tra lại sơ đồ mạch cho đến khi nào không xuất hiện lỗi nữa thì chúng 

ta tiến hành xác định kiểu phân tích và mô phỏng 

4.4 Phân  tích và mô phỏng 

4.4.1 Xác định kiểu phân tích và mô phỏng 

Trước hết hãy nhập chuột vào biểu tượng  để mở trang phân tích mạch. Cửa sổ 

New Simulation xuất hiện: 

gõ vào ô Name tên của trang phân tích. Nhấn phím Create để mở cửa sổ chọn kiểu dạng phân tích. Giao 

diện như sau: 
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Trong thẻ Analysis, mục Analysis type có 4 lựa chọn kiểu phân tích chính: 

- Bias poit: dùng xác đinhj điều kiện phân cực DC của một mạch điện. Tính toán xong,  ta sẽ có các 

mức áp DC trên các đường mạch và có dòng điện chảy qua các nhánh của mạch 

- DC Sweep: dùng quét thông số DC để phân tích các đặc tính của các linh kiện điện tử. Như vẽ 

các đường cong đặc tính của diode, transistor, scr, triac, các cổng logic,..Khảo sát mạch với các 

mức nguồn nuôi DC khác nhau... 

- Time Domain ( Transient ): dùng phân tích các mức áp trên các điểm của mạch điện lấy theo 

biến thời gian ( ở đây trục X lấy theo biến thời gian ). Nó có công dụng như bạn đang dùng một 

máy hiện sóng nhiều tia để xem các tín hiệu trên các điểm nối của mạch điện. 

- AC Sweep/Noise: dùng phân tích các mức áp trên các đường nối của mạch điện thoe biến tần số 

và góc pha ( trục X lấy theo biến tần số hay biến góc pha ). Nó dùng để vẽ ra đường cong đáp 

ứng biên tần, pha tần của mạch. 

4.4.2 Thực hiện mô phỏng 

Trong ví dụ trên, ban đầu bạn hãy chọn cách phân tích là Bias Point và nhấn OK để đồng ý 

Chọn Pspice -> Run ( hoặc biểu tượng  trên thanh công cụ ) 

Để quan sát kết quả của quá trình mô phỏng phân tích 1 chiều, ta có thể mở tệp đầu ra hoặc quay trở lại 

sơ đồ mạch và kích vào biểu tượng  ( cho phép hiển thị điện áp dịch )hoặc ( dòng điện dịch ) 

hoặc  ( công suất tiêu tán trên các phần tử ) 
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Kết quả của quá trình phân tích: 

  

 

Tiếp theo chúng ta chọn cách phân tích Transient ( Trục X lấy theo biến thời gian ). ở dạng phân tích này 

bạn chỉ cần gõ số vào các ô trống ( xem hình ): 

 

Điện áp định thiên 
Dòng điện định thiên 

Công suất tiêu tán 
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Trong ô Run to time : gõ vào khoảng thời gian phân tích 

Ô Start saving data after:  xác định thời điểm bắt đầu cho hệ tín hiệu 

Ô Maximum step size: chọn bước in ( bước in càng nhỏ thì tín hiệu in ra sẽ càng net, hình càng đẹp 

nhưng tập tin dữ liệu ghi lại trên đĩa sẽ lớn và thời gian phân tích sẽ kéo dài hơn ). 

Sau khi đã chọn xong thì nhấn phím OK để trở lại trang vẽ. Chọn đầu dò Volt  và gắn vào vị trí của 

chân ra OUTPUT số 3 của IC 555. Nhấn chọn Run để xem kết quả phân tích: 

 

Trong trang đồ thị này, chúng ta thấy tín hiệu ra trên chân số 3 của IC555 có dạng xung vuông. Lúc này 

muốn xem tín hiệu trên điểm nào của mạch điện thì đặt ống dò ngay trên điểm đó. 

Nếu như cùng lúc bạn đặt ống dò trên 2 chân số 6 và số 3. Chúng ta sẽ thấy tín hiệu trên chân 3 là dạng 

xung vuông, còn trên chân 2,6 là dạng tín hiệu răng cưa, cả hai cùng hiện trên 1 đồ thị 
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Kết quả mô phỏng:  
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Bạn có thể thay đổi trị số của các linh kiện trên mạch điện rồi cho phân tích bạn sẽ thấy kết quả khác. 

Trên vùng làm việc của Pspice, bạn nhấp chuột vào 2 trục của đồ thị để thay đổi tọa độ và lưới hiển thị 

sao cho phù hợp với nhu cầu của bạn 

Bạn cũng có thể xem các đường biễu diên khác. Mở của sổ add trace bằng lệnh Trace -> add trace... 

hoặc biểu tượng  trên thanh công cụ. Trong cửa sổ Function or Macro, bạn chọn hàm cần xem, 

trong thanh Trace Expression chọn biến cần quan sát, nhấn OK để xem: 
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Ngoài ra bạn có thể chọn chế độ quét DC_Sweep để phân tích các đặc tính của linh kiện. 

 

 

trong thẻ Name chọn nguồn 

cần đo ( ở đây là nguồn V1) 

Start Value: giá trị khởi đầu 

End value: giá trị kết thúc 
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Đây là phần mềm mô phỏng mạnh và được dùng rất phổ biến. Và để sử dụng được phần mềm này một 

cách thấu đáo đòi hỏi các bạn phải có một kiến thức chuyên sâu về kỹ thuật điện tử. Trong phần này tôi 

chỉ giới thiệu khái quát về công cụ mô phỏng Pspice để các bạn có thể biết cách mô phỏng một số mạch 

điện tử phục vụ cho việc học tập của mình.  Việc dùng Pspice để phân tích độ nhạy, phân tích nhiễu, 

phân tích Fourier, phân tích tham số, phân tích nhiệt độ, mô phỏng số,...và nhiều vấn đề khác tôi sẽ 

không đề cập đến trong tài liệu này. Nó sẽ được hướng dẫn chi tiết, thấu đáo trong một tài liệu khác 

chuyên biệt để có thể giúp bạn có thể đi sâu vào khai thác phần mềm mô phỏng Pspice. 
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Chương 5: Một số bài tập ví dụ 

Phần này sẽ giới thiệu các bạn một số mạch tham khảo vẽ bằng OrCAD 9.2 

5.1 Mạch nguồn 

5.1.1 Sơ đồ nguyên lý: 

 

Để cho mạch được gọn khi đi dây các bạn sử dụng chức năng “ đặt  nhãn đường mạch “ bằng cách nhấp 

chuột vào biểu tượng Place net alias  bên thanh công cụ phải 
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Đặt tên cho nhãn trong khung Alias, màu chữ trong khung Color, và muốn thay đổi định dạng chữ thì 

nhấp vào nút Change... trong khung Font  

Đặt nhãn vào vị trí đi dây phù hợp, làm tương tự cho đầu dây còn lại, các đường mạch có chung nhãn sẽ 

được tự động nối với nhau khi chuyên qua Layout Plus 

Chức năng này rất hữu dụng, nhất là khi thiết kế mạch phức tạp, sử dụng nhiều IC,... Tạo nhãn đường 

mạch sẽ cho mạch nguyên lý gọn hơn và thẩm mý hơn 

5.1.2 Sơ đồ mạch in 

5.1.2.1 Sắp xếp linh kiện 

Các bạn có thể sắp xếp linh kiện theo hình dưới 

  

5.1.2.2 Vẽ mạch ( ở đây sử dụng chế độ Autoroute ) 

Các thông số  về độ rộng đường mạch của mạch trên được cho như hình: 
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Chọn chế độ chạy mạch in một lớp ( BOTTOM ) 

vào Auto – Autoroute, ta được như hình dưới 

 

 

 

 

 

 

 

 

 

Kiểm tra các đường mạch và chỉnh sữa lại 

nếu muốn. Sau đó chèn Text và phủ mass 

cho mạch 

Sơ đồ mạch hoàn chỉnh 
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5.2 Mạch nạp STK200/300 

5.2.1 Giới thiệu 

Mạch nạp loại này sử dụng cho các board STK200/300 của Atmel nên thường được gọi là STK200/300. 

Mạch này giao tiếp với máy tính qua cổng LPT (cổng song song). Có 2 phiên bản phổ biến của mạch 

STK200/300 đó là phiên bản thu gọn và phiên bản sử dụng IC đệm dòng 74xxx. Ở đây sử dung mạch có 

IC đệm 74HC245, mạch này nạp rất ổn định và an toàn. Mạch này được hỗ trợ bởi rất nhiều chương 

trình nạp và sử dụng được cho hầu hết các loại chip AVR. Mạch này có các linh kiện rất dễ kiếm và chi 

phí rẻ nên được dùng nhiều trong giói SV 

5.2.2 Sơ đồ nguyên lý 

Mạch có sơ đồ nguyên lý như hình: 

 



Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 5. Bà i tà  p 
 

Nguyễn Ngọc Hà. Email: hanguyen92205@gmail.com 
Lớp D10CQDT01_N – Học viện Công nghệ Bưu chính Viễn thông Tp. HCM  95 

Sử dung chức năng place no connect  để đánh dấu vào các chân không đi dây. Chức 

năng  để tạo đường bus 

5.2.3 Sơ đồ mạch in 

5.2.3.1 Sắp xếp linh kiện 

Linh kiện trong mạch có thể được sắp xếp như hình dưới 

 

5.2.3.2 Vẽ mạch  

Các thông số độ rộng đường mạch tham khảo 
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Chạy dây lớp BOTTOM 

 

Kiểm tra mạch, chèn Text và phủ mass cho mạch 
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Mạch hoàn chỉnh: 

 

5.3 Mạch nạp AVR USB 910 

5.3.1 Giới thiệu 

 Nạp được hầu hết các dòng AVR và một số chíp 89S của Atmel  bằng cổng USB tiện lợi 

 Kiểm tra lỗi sau khi nạp 

 Hỗ trợ khóa chíp và lập trình fuse bit 

 Header chuẩn ISP cho kết nối thuận tiện 

 Tốc độ nạp cao, sử dụng được với hầu hết các trình biên dịch 

 Mạch siêu nhỏ gọn, bọc cách điện thuận tiện cho di chuyển, sử dụng  

 Cực kì đơn giản trong kết nối, cài đặt và sử dụng. 

 Tương thích với  Windows XP, Vista, Windows7. 

5.3.2 Sơ đồ nguyên lý 

Mạch có sơ đồ nguyên lý như hình 
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5.3.3 Sơ đồ mạch in 

5.3.3.1 Sắp xếp linh kiện 

Có thể sắp xếp linh kiện như hình: 

 

5.3.3.2 Vẽ mạch  

Bảng thông số độ rộng đường mạch tham khảo 
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Chạy dây và hoàn thiện 

 

Kiểm tra mạch và phủ mass, ta có mạch hoàn chỉnh như sau: 
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5.4 Mạch đèn LED rượt đuổi 

5.4.1 Giới thiệu 

Đây là mạch đèn trang trí ứng dụng IC 555 và 4017 rất đơn giản nhưng hiệu ứng khá đẹp mắt. 
IC 555 đóng vai trò làm xung kích cho 4017 thực hiện đếm. Tốc độ chuyển động của đèn được quyết 
định dựa vào tần số của 555  
5.4.2 Sơ đồ nguyên lý 

Mạch có sơ đồ nguyên lý như hình dưới 

 

5.4.3 Sơ đồ mạch in 

5.4.3.1 Sắp xếp linh kiện 

Sơ đồ bố trí linh kiện 
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5.4.3.2 vẽ mạch 

Chọn lớp BOTTOM, thay đổi độ rộng đường mạch phù hợp rùi chọn chế độ chạy dây tự đông 

 

Sau khi chạy dây tự động, vẫn còn một số đường mạch chưa chạy được, ta phải tiến hành vẽ bằng tay , 

tạo jumper cho đường mạch còn lại 

Chọn chế độ vẽ tay Edit Segmaent Mode  , nhấp chuột vào đường mạch cần vẽ, di 

chuyển đến vị trí phù hợp, chạy hết các đường mạch còn lại nhớ là các đường mạch không cắt nhau 

Trở về chế độ  Component Tool  , nhấp chuột phải, chọn thẻ New... Xuất hiện hộp 

thoại sau 



Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 5. Bà i tà  p 
 

Nguyễn Ngọc Hà. Email: hanguyen92205@gmail.com 
Lớp D10CQDT01_N – Học viện Công nghệ Bưu chính Viễn thông Tp. HCM  102 

 

Nhấp chuột vào khung Footprint... để tìm chân linh kiện cho via 
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Nhấp chọn OK 

Đặt vào vị trí cần tạo VIA, các jumper này khi làm mạch chúng ta phải tiến hành hàn dây 

Mạch sau khi tạo các jumper, và chỉnh sửa phù hợp như hình dưới 

 

Tiến hành phủ mass cho mạch để tạo bản mạch hoàn chỉnh, chèn text nếu muốn 
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5.5 Mạch đồng hồ số đơn giản 

5.5.1 Giới thiệu 

Mạch đồng hồ số dùng Led 7 đoạn để hiển thị giờ phút giây, sử dụng VDK AT89C52 để lập trình điều 

khiển và IC thời gian thực DS1307. Thích hợp cho những ai muốn tự làm mạch cho riêng mình hoặc tặng 

bạn bè 

5.5.2 Sơ đồ nguyên lý 

Mạch có sơ đồ nguyên lý như hình dưới 

 

5.5.3 Sơ đồ mạch in 

5.5.3.1 Sắp xếp linh kiện 

Sơ đồ bố trí linh kiện 
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5.5.3.2 Vẽ mạch 

Chọn vẽ mạch 1 lớp ( BOTTOM ), chỉnh kích thước độ rộng đường mạch phù hợp 

Autoroute mạch điện ta có kết quả như hình 
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Kiểm tra mạch, tạo via cho các jumper, phủ mass và ta có mạch hoàn chỉnh như sau 

 

 bố trí linh kiện trên board 
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5.6 Một số mạch điện tử hay 

Ở phần này sẽ giới thiệu cho các bạn một số mạch điện lý thú ( sưu tầm ) để các bạn có thể nghiên cứu 

vẽ và làm board thật. 

5.6.1 Mạch điều khiển tải bằng âm thanh 

 

5.6.2 Mạch đèn giáng sinh 
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5.6.3 Mạch tạo xung 1kHz 

 

5.6.4 Mạch bảo vệ quá áp 

 

5.6.5 Mạch khóa số 
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5.6.6 Mạch relay bảo vệ dòng 1 pha 

 

5.6.7 Mạch relay bảo vệ dòng 3 pha 

 

 

5.6.8 Mạch đồng hồ vạn niên 

Mạch này để gọn và thẩm mỹ thì các bạn nên thiết kế board 2 lớp ( TOP, BOTTOM ). 
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Khối điều khiển 

 

Khối hiển thị 
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Đây là sơ đồ mạch in tham khảo 

Khối hiển thị 

 

Các jumper 
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Khối điều khiển 

 

Các jumper 
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Chương 6: Làm mạch in thủ công 

Phần này sẽ giới thiệu các bạn cách làm board 1 lớp thủ công tại nhà từ các sơ đồ mạch in đã vẽ trên 

OrCAD Layout Plus 

6.1 Dụng cụ cần thiết 

- Panel: tấm đồng , tùy theo board để xác định kích thước ( mua ở chợ Nhật Tảo ). 

- Dung dịch ăn mòn: FeCL3 mua ở chợ, hoặc HCL, H2O2. 

- Phụ kiện: Kìm, khoan (các mui thường dùng 0.6mm 0.8mm 1mm 3mm), giấy ráp hoặc rẻ rửa bát hoặc 

cọ xoong 

6.2 Chuẩn bị bản in 

Sau khi thiết kế bạn chuẩn bị in, nếu nhà có máy in thì tốt, không có thì phiền đấy ! Nếu bạn cài Adobe 

Acrobat, MS Office 2003 hay FinePrint thì có một tiện ích máy in ảo, bạn sẽ in ra máy in ảo này rồi đem 

ra ngoài in vì tập tin được các máy in tạo ra là pdf hoặc file ảnh. Như thế cửa hàng bạn đem in không có 

OrCAD cũng không sao. Vấn đề ở đây là bạn phải thuyết phục chủ tiệm cho bạn in thôi. 

Hiện nay có một số cửa tiệm cho phép bạn in mạch file .MAX, nhưng hơi mắc. Không thì các bạn chép cái 

OrCAD protable trong USB và đem ra tiệm mở cái OrCAD chọn mở  file cần in lên và in thôi. 

Nếu bạn dùng giấy đề can thì in lên mặt bóng (mặt bóng của nó giống như mặt sau của cái nhãn vở dính 

(phần bỏ đi)). Loại này dc đánh giá cao nhất, nó đi được những đường mạch 10mil. Còn giấy hồng hà 

cũng được, nhưng bạn nên để đường mạch phải cỡ 15mil trở nên. 

Đối với những máy in mới HP1100 hay Canon LBP 800 trở nên, bạn phải chọn kiểu giấy nhẹ nhất nếu 

không mất giấy ráng chịu. Khi chọn giấy nên chọn loại giấy màu vàng, như vậy khi ủi thì sẽ thấy rõ hơn 

6.3 Ủi mạch 

Trước tiên bạn đánh sạch bề mặt tấm đồng, càng sạch càng tốt, đem rửa sạch rồi lau khô, bạn cắt tấm 

đồng thành tấm có kích thước bằng với board bạn thiết kế. Còn giấy bạn phải cắt to hơn khung để là 

xong có chỗ mà bóc. 

Để nhiệt độ bàn là ở chế độ max. Sau khi đặt bản in lên bo đồng bạn đặt bàn là, là trong khoảng 5-10 

phút, chú ý là kĩ phần mép. Để nguội. Nếu là giấy đề can thì có thể bóc, còn giấy hồng hà thì phải đem 

ngâm nước cho giấy mục ra rồi bóc đi. 

Không nên ủi lâu vì như vậy sẽ làm nhòe đường mạch, làm cong board,... 

Làm càng nhiều thì bạn sẽ tự rút ra kinh ngiệm cho riêng mình 

6.4 Ngâm mạch 

Bạn lấy một ít FeCL3  pha với nước tốt nhất là nước sôi. Pha đến khi nó bão hòa. cho vào một cái đĩa. Đặt 

tấm đồng vào đĩa, nghiêng đĩa như người ta đãi vàng nếu bạn pha với nước sôi thì khoảng 1 phút là 
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xong. Còn nước nguội thì khoảng 5 phút. Bạn thấy đồng ở phần không có đường mạch bong hết ra là 

được. Sau đó dùng cọ xoong đánh sạch. 

6.5 Khoan board 

Mũi 0.6 đề khoan chân có chân nhỏ như diode zener, mũi 0.8 là trở, 1 là diode chỉnh lưu. 3 là khoan lỗ 

bắt vít. 

Bạn đặt mũi khoan vuông góc với board, bấm công tác, cho khoan qua thì tắt, tiếp tục chuyển sang lỗ 

khác. 

6.6 Bảo vệ mạch 

Để tránh cho mạch khỏi bị oxi hóa bạn phải quét lên mạch một lớp bảo vệ. Sau khi hàn xong, bạn phủ 

lớp bảo vệ. Dung dịch bảo vệ: RP7 (hàng sửa xe máy, chợ trời cũng có), Sơn bóng , nhựa thông (có bán ở 

chợ Nhật Tảo). 

Với RP7 hoặc sơn bóng bạn phun trực tiếp vào phần có đường mạch. 

Còn với nhựa thông bạn đem đập nhỏ, đem hòa tan bằng xăng hoặc axeton (hiệu thuốc hoặc hàng 

mành), được một dung dịch dạng keo, sau đó lấy bút lông quét lên. Khi axeton hoặc xăng bay hơi thì lớp 

nhựa thông sẽ bảo vệ mạch. 
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Mở đầu
ORCAD là một công cụ thiết kế mạch điện tử đơn giản và phổ biến. Cũng có rất nhiều phần mềm thiết kế
mạch điện tử khác, tuy nhiên, tôi chọn sử dụng phần mềm này, vì bộ công cụ này được đánh giá là khá
mạnh.
Các thư viện linh kiện của ORCAD có thể coi là mạnh nhất cho đến nay, và hầu hết các nhà sản xuất linh
kiện điện tử đều cung cấp các add-in thư viện linh kiện cho ORCAD.

Đã có rất nhiều sách hướng dẫn sử dụng ORCAD bằng hình, tuy nhiên giá sách khá cao và thực chất
ORCAD không có gì là phức tạp, vì vậy, tôi muốn thực hiện tài liệu hướng dẫn này một cách đơn giản, để
cung cấp miễn phí cho sinh viên. Thành thực mà nói, các sách dù có hướng dẫn tỉ mỉ tới đâu, thì cũng
không thể giúp các bạn sinh viên nắm bắt toàn bộ các chức năng của ORCAD, mà chủ yếu, các bạn thực
hành nhiều, mày mò nhiều, và hỏi han nhiều, các bạn sẽ tìm hiểu và nắm bắt về ORCAD rất dễ dàng.

Trong tài liệu hướng dẫn này, chúng tôi sẽ đi từng bước đơn giản, để các bạn có thể thực hiện một mạch
nguyên lý bằng ORCAD, sau đó hướng dẫn các bạn từng bước để xuất ra thành mạch in, chạy mạch in,
điều chỉnh mạch in, cuối cùng là việc làm một mạch in điện tử tại nhà như thế nào.

Tài liệu này được chia làm 5 phần:
-Phần 1. Cài đặt OrCAD 9.2
-Phần 2. Một số thao tác để vẽ một mạch nguyên lý với ORCAD dùng CAPTURE
-Phần 3. Cách chuyển từ mạch nguyên lý sang mạch in và các thao tác trên LAYOUT PLUS
-Phần 4. Sử dung công cụ Pspice A/D tích hợp trong OrCAD để mô phỏng mạch điện

-Phần5. Một số mạch điện tử lý thú để các bạn nâng cao khả năng vẽ mạch của mình
-Phần 5. Làm mạch in 1 lớp thủ công

Ở đây tôi chọn sử dụng OrCAD 9.2 vì tính phổ biến của nó, thư viện khá đây đủ, chiếm ít tài nguyên, ít lỗi,
sử dụng rất ổn định. Hiện tại đã có bản 16.5 nhưng rất nặng (10G tất cả sau khi cài đặt ), với lại việc cài
đặt cũng rất khó khăn. Kể từ bản 16.3 trở đi Cadene đã bỏ phần Layout mà thay vào đó là PCB Editor, vì
vậy tài liệu của phần này rất ít chủ yếu là tài liệu tiếng anh. Nhưng nếu muốn trở thành nhà Design
PCB chuyên nghiệp thì nên sử dụng cái này.

Cũng phải nói thêm rằng đây là tài liệu tôi biện soạn dựa trên những kiến thức của mình và trích dẫn
tham khảo thêm một số tài liệu trên mạng nên có một số đoạn có thể trùng với tài liệu của các tác giả
khác, tôi đã cố gắng hướng dẫn rất chi tiết và tổng hợp một số tài liệu để các bạn có thể tiếp cận với
phần mềm OrCAD một cách nhanh chóng.

Các bạn đọc tham khảo và cho ý kiến để cuốn ebook này được hoàn thiện hơn.Xin chân thành cám ơn!
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Chương 1: Cài đặt phần mềm OrCAD 9.2

Để cài đặt OrCAD 9.2 bạn thực hiện các bước sau:

- Cho đĩa CD cài đặt OrCAD vào máy hoặc có thể chạy trực tiếp trên ổ cứng:
- Nhấp chuột phải vào file setup.exe , chọn Run as administrator như hình dưới

http://codientu.org


Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 1. Cài đàt OrCAD

http://codientu.org 11

- Đợi vài giây chúng ta sẽ thấy hộp thoại xuất hiện như hình dưới và yêu cầu chúng ta nên tắt hết
các chương trình diệt virut , nếu không thì trong quá trình cài đặt có thể xãy ra vài lỗi không
mong muốn. Click vào OK để tiếp tục thực hiện công việc cài đặt.

- Một hộp thoại mới hiện ra, chọn Next để tiếp tục:
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- Chọn Yes trong hộp thoại Software License Agreement:

- Chọn Next để tiếp tục trong hộp thoại tiếp theo:

- ở hộp thoại tiếp theo yêu bạn nhập key codec là A B E F G H I J K ( Enter xuống dòng sau mỗi kí
tự) chọn Next và nhập 17 chữ số 1 ở hộp thoại tiếp theo như hình dưới. Next để tiếp tục
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- Nhập thông tin của bạn vào phần Name và Company. Next để tiếp tục. Chọn Yes ở cửa sổ tiếp
theo:

- ở hộp thoại tiếp theo, có 2 tùy chọn: Typical nếu cài đặt các thành phần chung của OrCAD,
Custom để setup các ứng dụng cần dùng. Chọn Next để tiếp tục

http://codientu.org
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- Quá trình cài đặt bắt đầu,

- Chọn Yes ở 2 hộp thoại tiếp theo

- Và cuối cùng nhấn Finish để hoàn
tất .

http://codientu.org
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Quá trình cài đặt phần mềm OrCAD 9.2 đã
xong. Nhưng đừng vội mở phần mềm lên, nó
vãn chưa chạy được, ta phải tiến hành Crack
đã:

- Tìm đến file PDXOrCAD.exe trong thư
mục Crack của CD

- Click chuột phải và chọn thẻ Properties,
chuyển qua Tab Compatibility và chọn
như hình dưới ( nếu là win 7, còn
win XP thì bỏ qua bước này ). Click
Appy để hoàn xác nhận

- Xuất hiện hộp thoại của phần mềm Crack PDXOrCAD
- Chọn đường dẫn đến thư mục đã cài đặt OrCAD , ở đây tôi cài lên ổ C có đường dẫn là

C:\Programm Files\Orcad\. Nhấp chọn Apply để thực hiện. Nếu xuất hiện dòng thông báo “
Fixed Patch – Success: All patches applied “ như hình thì quá trình cài Crack đã thành công, nếu
xuất hiện thông báo lỗi thì hãy kiểm tra lại các bước trên xem đã đúng chưa.

http://codientu.org
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Vậy là đã cài hoàn tất cài đặt phần mềm OrCAD 9.2 ( Lưu ý: Mỗi phiên bản có một cách cài đặt và Crack
khác nhau ). Khởi động chương trình OrCAD lên và khám phá.

http://codientu.org
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Chương 2: Vẽ mạch nguyên lý bằng OrCAD Capture

2.1 Tổng quan về OrCAD Capture

OrCAD Capture là phần mềm vẽ mạch nguyên lý rất mạnh , với thư viện phong phú, thao tác đơn giản,
dễ chỉnh sữa và tìm kiếm.

Trong phần này tôi sẽ hướng dẫn khái quát để mọi người có thể tiếp cận và sử dụng phần mềm này. Từ
khởi động , tạo một bản thiết kế, lấy linh kiện, thay đổi thông số linh kiện, đi dây, hoàn thành mạch
nguyên lí đến việc tạo thư viện linh kiện cá nhân để tiện cho việc sử dụng về sau.

2.2 Vẽ mạch nguyên lý bằng OrCAD Capture

2.2.1 Khởi động OrCAD Capture

Khởi động OrCAD với chương trình Capture( hoặc Capture Cis ):

C1. Start -> AllPrograms-> Orcad Family Release 9.2 -> Capture ( Capture Cis )

C2. Click vào biểu tượng trên màn hình Desktop

Màn hình làm việc của Capture như sau:
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2.2.2 Tạo một Project mới

2.2.2.1 Tạo Project mới:

Để tạo một project bạn có thể làm như sau:

• Chọn menu File -> New -> Project.

• Hoặc chọn nút lệnh Create document

Hộp thoại New project hiện ra, nhập tên project trong phần Name ( Theo tôi mỗi 1 Project bạn nên lưu
vào 1 thư mục riêng vì trong orcad 1 project có thể tạo ra rất nhiều file )và đường dẫn đến vị trí lưu
project trong phần Location
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Click vào nút Browse để chọn đường dẫn cho project

Nếu muốn tạo một thư mục con để chứa các file trong project của bạn, nhấp chuột vào Create Dir...

Nhập tên thư mục muốn tạo vào phần Name trong hộp thoại Create Directory. OK để xác nhận

Màn hình của OrCAD Capture như sau:
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2.2.2.2 Thiết lập kích thước và cài đặt ban đầu cho bản vẽ:

Khi bắt đầu vẽ một Schematic chúng ta
nên chọn menu Options -> Preference
đặt các thuộc tính tùy chọn riêng chi
người thiết kế về màu sắc hiển thị của
Wire, Pin …tọa độ lưới vẽ trong trang
thiết kế. Hộp thoại Preferences như
sau:

-Chọn lớp Color/Print: hiện các gam
màu để gán cho từng đối tượng trong
trang sơ đồ mạch nguyên lí như: màu
nền của background, pin linh kiện, tên
linh kiện, bus, đường kết nối các thành
phần, lưới vẽ, giá trị linh kiện, text, …
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-Chọn lớp Grid Display: Hiện/
không hiện ô lưới được thể
hiện bằng những dấu chấm
trong các trang thiết kế hoặc
sửa đổi linh kiện. Mục đích
của lưới là giúp chúng ta đặt
linh kiện & sắp xếp so cho hợp
lí & chính xác nhất

-Chọn lớp Pan and Zoom:
hiện khung thoại chứa các giá
trị để thay đổi tỉ lệ thu phóng
hay thu nhỏ các đối tượng
trong trang thiết kế sơ đồ
mạch.
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-Chọn lớp Select: hiển thị khung
thoại liên quan đến việc lựa chọn
các thành phần trong trang sơ đồ
nguyên lý.

-Lớp Miscellaneous: chứa những
thành phần hỗ trợ cho việc gán các
thuộc tính các đối tượng trong trang
thiết kế. Ngoài ra nó còn có chức
năng rất quan trọng là tự động hiển
thị số thứ tự của loại linh kiện được
lấy ra ( Automatic reference placed
part ) & bắt tay chéo với Layout ( thẻ
Intertool Communication ) rất hữu
dụng trong việc sắp đặt các footprint
linh kiện tùy thích của người thiết kế
nhằm tránh trường hợp các linh kiện
sắp xếp không theo ý muốn. Chức
năng này chỉ có tác dụng khi mở cả
Capture & Layout và xử lý cùng chung
thiết kế.
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Chọn menu Options > Design Templace… để gán các tham số mặc định cho bản
thiết kế & các trang sơ đồ nguyên lí mới. Những giá trị được gán theo khung
tham số này không ảnh hưởng đến những thiết kế của mạch điện cũ. Tại hộp
thoại Design Template ta có thể tùy chỉnh thiển thị kiểu kí tự, size của các kí tự
hiển thị tên, giá trị , … của linh kiện. Ngoài ra chúng ta có thể đặt têncủa
thiết kế, size của thiết kế, đơn vị đo,…

Chọn font hiển thị kiểu ký tự thiết lập kích thước bản vẽ
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2.2.2.3 Các đối tượng làm việc

Thanh công cụ

Chọn đối tượng

Thư viện linh kiện

Chạy dây

Đặt nhãn đường mạch

Vẽ đường nối bus

Đặt điểm nối

Nối với đường bus

Nguồn

Mass

Điểm không nối

2.2.3 Các phím tắt và từ khóa trong OrCAD Capture

2.2.3.1 Phím tắt:

Việc sử dụng các phím tắt sẽ giúp cho thao tác của chúng ta được nhanh hơn, và trong tài liệu này tôi
chủ yếu hướng dẫn bằng các phím tắt

Phím Chức năng Phím Chức năng
R Xoay linh kiện W Nối các đương mạch
I Phóng to màn hình O Thu nhỏ màn hình
P Lấy linh kiện N Đánh nhãn
J Tạo điểm nối B Vẽ đường bus
T Thêm văn bản cho bản vẽ X Đánh dấu chân linh kiện ko sử dụng
F Lấy các khối nguồn G Lấy các khối mass, nối đất
Y Vẽ khối chữ nhật ESC Thoát chế độ đang chọn
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2.2.3.2 Từ khóa tìm kiếm nhanh linh kiện

Để thao tác được nhanh và lấy linh kiện chính xác thì bạn phải nhớ tên của các linh kiện, ở đây tôi chỉ
nêu một số từ khóa được sử dụng nhiều

Kí hiệu Tên gọi Kí hiệu Tên gọi Kí hiệu Tên gọi
R Điện trở RESISTOR VAR Biến trở CAP Tụ điện
CAP NP Tụ không phân cực RELAY Rơ le LED Đèn led
FUSE Cầu chì DIODE Đi ốt DIODE ZENER Đi ốt ổn áp
NPN Transistor ngược PNP Transistor thuận CRYSTAL Thạch anh
BRIDGE Cầu diode SW Nút nhấn HEADR Chân cắm
Khi làm việc với OrCAD các bạn chú ý là phải tắt các trình gõ tiếng việt đi thì mới sử dụng được các phím
tắt , và tránh lỗi khi sử dụng các phím tắt, đơn giản là phần mềm nó không biết tiếng Việt.

2.2.4 Vẽ sơ đồ nguyên lý

Muốn vẽ được mạch nguyên lý thì các bạn phải có sơ đồ nguyên l{ đó ở 1 tờ giấy hay ở trong đầu bạn
rồi. Bạn phải biết là sử dụng những linh kiện nào.

2.2.4.1 Tìm kiếm và chọn linh kiện

Để lấy linh kiện ra bạn nhấn phím P ( hoặc Shift + P hoặc chọn Place Part ). 1 cửa sổ hiện ra như sau :
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Ở khung Part cho phép chúng ta gọi ra các linh kiện, vậy linh kiện được lấy ở đâu? linh kiện được lấy ở
Libraries. Nhưng chúng ta đang thấy Libraries trống trơn thế kia thì lấy làm sao được linh kiện? Vậy ta
phải Add library sẽ hiện ra 1 cửa sổ như sau :

Theo tôi thì nên Add tất cả các thư viện vào. Vì mỗi 1 thư viện chứa các linh kiện khác nhau mà ta không

thể nhớ được linh kiện nào nằm trong thư viện nào. Thế là Add thư viện xong
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Từ hộp thoại Libraries, các bạn chỉ chuột vào bất kz một trong các thư viện được add ( hoặc Ctrl + A để
chọn tất cả thư viện ) thì danh sách các linh kiện trên cửa sổ Part List sẽ xuất hiện

Bạn đánh tên linh kiện vào khung Part để chọn linh kiện phù hợp với mạch nguyên lý

Nhấp OK để chọn linh kiện, lúc đó cửa sổ này sẽ mất đi và linh kiện dính vào chuột của bạn

Chọn vị trí thích hợp và nhấp chuột trái để đặt linh kiện
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Nhấp chuột trái để tiếp tục đặt linh kiện vào các vị trí khác, nhấn ESC trên bàn phím để ngưng việc đặt
linh kiện

Chọn và đặt đầy đủ linh kiện vào trang vẽ trước rồi tiến hành đi dây nối mạch

Để nối dây bạn nhấp vào bên thanh công cụ phải hoặc sử dụng phím W

Nhấp chuột vào linh kiện và kéo đến vị trí khác nếu muốn di chuyên chúng

Các thao tác Rotate ( R ) để xoay linh kiện, Vertical ( V ) để lật linh kiện theo chiều dọc hoặc Horizontal (
H ) để lật theo chiều ngang

2.2.4.2 Vẽ mạch cụ thể

Để các bạn dễ hiểu thí chúng ta sẽ đi vào vẽ mạch cụ thể, ở đây tôi chọn mạch điều chỉnh và ổn định tốc
độ động cơ. Mach nguyên l{ như hình dưới:

Nguyên lý hoạt động của mạch: Khi động cơ được nối đến J1 quay sẽ cho ra điện áp cảm ứng đặt vào chân số
1 của Triac. Nếu động cở bị giảm tốc độ ( có thể do tải tăng lên) làm V1 giảm, D2 sẽ dẫn điện tạo dòng kích
cho Triac. Dòng điện qua triac tăng lên sẽ làm tăng tốc độ động cơ tăng lên như cũ. Nếu động cơ bị tăng tốc
độ ( có thể do tải giảm xuống ) làm V1 tăng, D2 bị phân cực ngược sẽ ngưng dẫn, giảm dòng điện cấp cho
động cơ, tốc độ động cơ giảm xuông như cũ.
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Các linh kiện trong mạch: 5 điện trở, 1 biến trở, 2 tụ không phân cực, 3 diode chỉnh lưu, 2 transistor
ngược , 1 triac, 2 chân cắm, công tắc 3 cực 1

Bây giờ quay trở lại cửa sổ Place Part (
Shift + P hoặc P ). Lấy ra 1 con trở nào
ở khung Part ta gõ vào R sẽ có hình
ảnh như sau

Enter để lấy R. sau đó R sẽ đi theo chuột của ta, nhấp chuột vào 5 vị trí để lấy 5 điện trở. Muốn thoát để

lấy linh kiện khác thì ấn ESC,hoặc nhấp chuột vào biểu tượng Select trên thanh công cụ để kết thúc.

Để chọn chân cắm cho linh kiện ta
cũng làm tương tự, ở khung Part các
bạn gõ CON2, sau đó nhấp OK để trở
về màn hình làm việc.
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bạn gõ CON2, sau đó nhấp OK để trở
về màn hình làm việc.
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Gõ RESISTOR VAR ở khung
Part để lấy biến trở:

Để lấy tụ điện không phân
cực chọn CAP NP tại
khung Part của thư viện
sau đó OK để trở về màn
hình làm việc
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Tiếp theo, bạn chọn DIODE
tại khung Part để lấy đi ốt,
nhấp OK để trở về màn
hình làm việc. Nhấp chuột
trái vào 3 vị trí khác nhau
để lấy 3 diode

Chọn công tắc 3 chấu bằng
cách gõ SW MAG-SPDT
trong khung Part, sau đó
nhấp OK để trở về màn
hình làm việc. Tại trang vẽ
nhấp chuột trái vào một vị
trí bất kì để chọn công tắc

Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 2. OrCAD Capture

31

Tiếp theo, bạn chọn DIODE
tại khung Part để lấy đi ốt,
nhấp OK để trở về màn
hình làm việc. Nhấp chuột
trái vào 3 vị trí khác nhau
để lấy 3 diode

Chọn công tắc 3 chấu bằng
cách gõ SW MAG-SPDT
trong khung Part, sau đó
nhấp OK để trở về màn
hình làm việc. Tại trang vẽ
nhấp chuột trái vào một vị
trí bất kì để chọn công tắc

Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 2. OrCAD Capture

31
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Để lấy Triac, tại khung Part
của hộp thoại Place Part
gõ TRIAC, sau đó nhấp OK
và nhấp chuột trái vào vị
trí bâts kì để chọn Triac

Chọn cuộn dây bằng cách
tại khung Part gõ
INDUCTOR FERITE. OK để
trở về màn hình làm việc
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Tiếp theo chọn transistor
NPN bằng cách gõ NPN
vào khung Part. OK

Cuối cùng, chọn chân Mass
bằng cách nhấp vào biểu

tượng Place Ground
bên thanh công cụ. Tại
khung Libraries chon
SOURCE, tại khung Symbol
chọn 0, sau đó nhấp OK để
trở về màn hình làm việc
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Kết thúc việc lấy linh kiện, ta có hình sau :

2.2.4.3 Sắp xếp linh kiện
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Các linh kiện vẫn nằm ngổn ngang thế, để có thể xoay được các linh kiện dọc, ngang, quay ngược xuôi
các bạn chọn vào linh kiện cần xoay rồi ấn phím R, hoặc phím H, hoặc V( có thể chọn vào linh kiện kích
phải chuột chọn Rotate = R, Mirror Horizontally = H, Mirror Vertically = V )… và sắp xếp linh kiện sao
cho gọn để chuẩn bị nối dây.

Để nối dây các bạn ấn phím W ( Place Wire ), con trỏ chuột sẽ thành dấu cộng và chúng ta bắt đầu nối
dây. Xong ta được hình sau:
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Muốn thay đổi giá trị cho linh kiện, hãy nhấp đúp chuột
vào linh kiện, khi đó hộp thoại Display Properties xuất
hiện. Tại khung Value của hộp thoại nhập vào giá trị của
linh kiện muốn thay đổi, sau đó nhấn OK để hoàn tất thay
đổi.
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Đây là mạch hoàn chỉnh

2.2.5 Kiểm tra lỗi sơ đồ nguyên lý

Nhấp vào biểu tượng minimize trên góc phải hoặc biểu tượng , xuất hiện màn hình như sau. Chọn
page 1
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Nhấp vào biểu tượng design rules

check

Hộp thoại Design Rules Check xuất
hiện, check vào Scope, Action &
Report như hình bên và nhấp Ok để
kiểm tra.

Nếu có thông báo lỗi bạn hãy kiểm
tra vị trí có khoanh tròn nhỏ màu
xanh và tiến hành sửa lỗi rồi tiếp
tục.
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2.2.6 Tạo file netlist

Sau khi kiểm tra không thấy lỗi , chúng ta tiến hành tạo file .mnl để chuyển

sang Layout , chọn trên thanh công cụ, hoặc chọn Tool=> Create
Netlist

Cửa sổ Create Netlist xuất hiện, chọn Layout, trong thẻ Options chọn User Properties are in inchers để
tự chọn chân linh kiện footprint, Browse để duyệt đến nơi chứa file, nhấp chọn OK

Chon OK trong hộp thoại xuất hiện tiếp theo để hoàn tất quá trình tạo file netlist
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Vậy là đã hoàn tất quá trình vẽ mạch bằng Capture, bạn hãy dùng file .MNL vừa tạo để vẽ mạch in bằng
OrCAD Layout Plus

2.3 Tạo thư viện linh kiện mới trong OrCAD Capture

2.3.1 Giới thiệu

Việc tạo ra linh kiện mới trrong Capture rất quan trọng, các linh kiện điện tử đều được sản xuất theo
một số tiêu chuẩn nhất định. Trong Layout thì một số chân linh kiện nếu không biết thì có thể tìm một
linh kiện khác có chân tương tự, còn trong Capture thì công việc đó không thể thực hiện được. Hơn nữa
việc tạo ra một thư viện mới của riêng bạn sẽ giúp bạn quản l{, cũng như thao tác nhanh hơn trong việc
tìm kiếm linh kiện

2.3.2 Các bước tạo linh kiện mới

Một project bao gồm việc tạo ra linh kiện mới , tạo ra bản vẽ nguyên lý hoặc xuất ra mạch in,...Khi đó
việc tạo ra linh kiện mới là việc làm để phục vụ cho schematic nào đó.

Để tạo thêm linh kiện mới, các bạn phải nhận diện được linh kiên đó là gì, hoạt động như thế nào. Phải
tra datasheet của linh kiện đó. Sau khi đã biết rõ về linh kiện, hãy hình dung trong đầu sơ đồ bố trí các
chân linh kiện sao cho việc vẽ mạch nguyên lí được dễ dàng và đẹp nhất.

Tiếp theo là tạo ra một thư viện linh kiện để chứa linh kiện mà các bạn sẽ tạo ra. Vì đặc tính các đề tài là
khác nhau và những người làm việc với mạch điện tử cũng khác nhau nên việc đặt tên cũng có những
đạc thù khác nhau. Cuối cùng là việc tạo ra linh kiện bạn, đặt vào các thư viện phù hợp. Cụ thể tôi sẽ
hướng dẫn các bạn tạo ra con MAX232.

2.3.2.1 Tìm datasheet

Việc đầu tiên là phải tra cứu datasheet của con MAX232. Để tra datasheet bạn có thể search trên mạng
http://google.com hoặc tìm trực tiếp từ các trang web về datasheet:

www.alldatasheet.com

www.datasheetcatalog.com

http://google.com
www.alldatasheet.com
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Đây là hình ảnh của con MAX232 trong datasheet

2.3.2.2 Tiến hành tạo linh kiện

Trong màn hình làm việc của Capture.

Chọn File > New > Library

T rong cửa sổ quản lí, nhấp chuột phải
vào library.olb tại thư mục Library, chọn
New Part để tạo linh kiện mới

Nhập tên linh kiện vào
khung Name ( tên này sẽ
được hiển thị khi bạn chọn
linh kiện). Chọn kiểu linh
kiện trong ô Part
Reference Prefix.

Ở đây chọn là U

Nhấp OK để vào trang
thiết kế

www.datasheetcatalog.com
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Cửa sổ làm việc như sau:

Trước hết chúng ta cần tạo ra nhóm chân, sau đó sửa chữa thông số, những nhóm chân có cùng chức
năng ta ta thiết kế chung.

Chọn Place Pin Array trên
thanh công cụ để tạo nhóm chân cho
linh kiện

Ô Starting Name ( tên chân) : 1

Starting Number ( Chân bắt đầu): 1

Number of Pins ( số chân được tạo ra
trong cùng nhóm chân): 8

Increment ( số đơn vị tăng lên) : 1

OrCAD hỗ trợ việc tạo ra các nhóm
chân bằng cách tự động tăng thứ tự
tên chân Starting Name, Starting
Number lên Incrment đơn vị, nếu như
chân đó tận cùng là 1 số.
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Khi nhấn OK, con chuột sẽ tạo thành 1 dãy 8 chân linh kiện. Trên khối U
vuông, các bạn đặt nó cạnh nào, nó sẽ nằm ở cạnh đó.Nhấp chuột để hoàn
tất.

T iếp tục tạo các chân còn lại. Chọn Place pin array

Ô Starting Name : 16

Starting Number: 16

Number of Pins : 8

Increment: -1

OK và chọn vị trí đặt chân

Nhấp đúp chuột vào chân linh kiện để sửa đổi các thông số: tên,
số chân linh kiện

Tiếp tục cho các chân còn lại. Nhấp chuột trái và kéo giữ chuột để sắp xếp
lại vị trí các chân linh kiện cho hợp lí & thẩm mỹ.

2.3.3 Vẽ đường bao và lưu linh kiện

Chọn Place rectangle trên thanh công cụ để tạo đường
bao, vẽ hình vuông vừa khít trên hình.Chọn Place Text để nhập tên
cho linh kiện.Như vậy là đã làm xong 1 linh kiện mới, nhấn Save để
lưu lại linh kiện.

2.4 Chỉnh sửa linh kiện

2.4.1 Đặt vấn đề
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Khi lấy linh kiện trong thư viện, có một vấn đề là đa số với con IC thì bị ẩn chân VCC và GND, nhưng các
bạn yên tâm khi xuất ra mạch in chân VCC mặc nhiên nối với Power và chân GND thì nối đất. Tôi sẽ chỉ
cho cách làm cho nó hiện lên

2.4.2 Tiến hành chỉnh sửa

Ở đây tôi chọn con IC định thời 555

Bạn nhấp phải chuột vào linh kiện, chọn Edit Part

Xuất hiện cửa sổ làm việc mới giúp bạn chỉnh sửa các thông số của linh kiện:

Phần 2 dấu cộng trong vòng tròn màu đỏ là 2 chân VCC và GND, bạn nhấp đúp chuột vào nó để chỉnh
kiểu chân
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Hình dạng chân của nó trong cửa sổ Shape, trong cửa sổ này chân được lựa chọn là zero length chính vì
vậy mà bạn không nhìn thấy nó, bạn có thể chọn Line hoặc Short để hiển thị chân. Tick vào Pin Visible
để hiển thị tên của chân linh kiện

Tương tự như trên để hiển thị chân GND. Bố trí lại sơ đồ chân cho
hợp lý và thẩm mỹ, Sau khi chỉnh sửa ta được hình bên

Trong cửa sổ này bạn cũng có thể thực hiện chỉnh sửa, thêm bớt chân, thay đổi kích thước hình dáng
của linh kiện.

2.4.3 Lưu linh kiện vừa chỉnh sửa

Nhấp chuột vào nút Close trong cửa sổ làm việc hoặc nhấn Ctrl + W, xuất hiện hộp thoại

Chọn Update
Current để lưu

thay đổi, Update All để thay đổi tất cả linh kiện đó có trong Project, Discard để hủy bỏ thay đổi, Cancel
để quay lại hủy bỏ thao tác, Help để được trợ giúp.
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Vậy là đã hoàn tất cơ bản phần Capture, tiếp theo ta chuyển sang phần Layout để thiết kế mạch in.

( luôn Ctrl + S để lưu bản project , phòng sự cố xảy ra ngoài ý muốn )
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Chương 3: Vẽ mạch in với OrCAD Layout

3.1 Tổng quan về phần mêm vẽ mạch in OrCAD Layout

Để thi công board mạch thực tế cần phải xuất mạch nguyên lý trong Capture sang file mạch in được hỗ
trợ bởi Layout. Phần này sẽ hướng dẫn các bạn xuất file .mnl trong mạch nguyên lý sang Layout để vẽ
mạch in hoàn chỉnh, cách chọn chân linh kiện footprint, tạo thư viện chân linh kiện mới,...

3.2 Vẽ mạch in với OrCAD Layout

3.2.1 Khởi động OrCAD Layout

Khởi động OrCAD với chương trình Layout Plus

- Start -> AllPrograms-> Orcad Family Release 9.2 -> Layout
- Click vào biểu tượng trên màn hình Desktop

Màn hình làm việc của Layout Plus như sau
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3.2.2 Một số lệnh cơ bản

3.2.2.1 File

Chứa các lệnh liên quan đến việc tạo mới, mở, nhập và xuất ra các tập tin đối tượng vòa Layout hay sang
các thành phần khác ( để sử dụng trong một số phần mềm thiết kế mạch khác như Protel, PCAD PCB, ...)

3.2.2.1.1 Open

Liệt kê tất cả các tập tin .MAX đang nằm trong thư mục hiện hành.

3.2.2.1.2 Import

Cho phép mở hay nhận một file đã được tạo từ các phần mềm khác như Protel PCB, CadStar PCB,...

3.2.2.1.3 Export

Cho phép xuất file .MAX đã được tạo từ OrCAD Layout sang các phần mềm thiết kế mạch in khác như
Protel PCB, CadStar PCB,...

3.2.2.2 Tools

3.2.2.2.1 Library Manager

Cho phép bạn chỉnh sữa hay tạo mới một footprint của linh kiện nào đó. Từ đây bạn có thể tạo hay sưu
tập một thư viện footprint linh kiện mà bạn hay sử dụng cho các thiết kế về sau.

3.2.2.2.2 OrCAD Capture

Cho phép mở chương trình thiết kế mạch nguyên lý OrCAD Capture từ chương trình vẽ board mạch
OrCAD Layout

Ngoài ra trong Tools còn các chức năng khác như SmartRout cho phép bạn vẽ mạch thông minh, Edit
App Settings, Reload App Settings,...

3.2.3 Tạo bản thiết kế mới

Để tạo một bản thiết kế mới, vào menu File -> New hoặc từ biểu tượng trên thanh công cụ. Xuất
hiện hộp thoại Load Template File, ta nhập vào file Template theo đường dẫn mặc định:

C:\Program Files\Orcad\Layout_Plus\Data

File template là file định dạng một số thông số mặc định cho board mạch, như số lớp board mạch,
khoảng cách đi dây, kích thước đường mạch, quy định thiết kế,... được sử dụng xuyên suốt trong quá
trình vữ mạch với Layout. Nếu là một board bình thường thì bạn chọn file default.tch ( hoặc
jump6238.tch sẽ giúp quá trình chạy mạch hiệu quả hơn , các jumper sẽ không cắt ngang IC,…). Còn nếu
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bạn muốn thiết kế board mạch riêng theo hình dạng cụ thể, như Sound Card, Lan card,... thì load các file
template khác. Nhấn Open để thực hiện load file .TCH

Xuất hiện hộp thoại Load Netlist Source yêu cầu bạn chọn file netlist có đuôi .MNL đã được tạo trong
OrCAD Capture. Nhấp Open để chọn mở file Netlist
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Tại hộp thoại Save File As bạn nhập vào đường dẫn và tên file mà bạn muốn lưu thiết kế của mình. Mặc
định Layout Plus sẽ đặt tên file mặc định trùng với file netlist và lưu trong thư mục chứa project đó.

Nhấp Save để tiến hành lưu.
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Nếu các linh kiện trong mạch thiết kế là các linh kiện mới và chưa từng có liên kết đến thư viện footprint
của Layout Plus lần nào thì sẽ xuất hiện hộp thoại yêu cầu bạn phải liên kết đến footprint. Đây là bước
khó khăn đòi hỏi bạn phải cẩn thận, nếu như chọn sai chân thì mạch coi như bỏ đi, ttos nhất bạn hãy
xem kỹ hình ảnh thực tế của linh kiện để việc chọn hình dạng và kích thước của footprint được chính
xác. Kinh nghiệm cho thấy sẽ tốt hơn nếu bạn tực hiện việc gắn footprint cho tất cả các linh kiện trong
suốt quá trinh vẽ mạch bằng Capture.

3.2.3.1 Liên kết Footprint

Để làm tốt phần này bạn phải thường xuyên làm mạch, có kinh nghiệm thì việc tìm kiếm các footprint
được nhanh hơn.

3.2.3.1.1 Một số footprint thông dụng

- Thư viện TO : TO92 ( transistor: C828, C1815, C535,...), TO202 ( Transistor: H1061, IC ổn áp họ 78xxx,
79xxx,... )

- Thư viện DIP100T: /W.300 ( các IC cắm từ 14-20 chân ) /W.600 ( các IC cắm từ 24-40 chân )

- Thư viện TM_CAP_P là footprint của các loại tụ điện

- Thư viện JUMPER là footprint của các loại điện trở, quang trở, biến trở,..

- Thư viện TM_DIODE là footprint của các loại diode hay led

3.2.3.1.2 Liên kết đến footprint

Quay lại màn hình làm việc của Layout sẽ xuất hiện hộp thoại sau:

Trong hộp thoại Link Footprint to Component có thông báo là không tìm thấy chân của D1 có tên là
DIODE. Vì thế nên tìm chân cho linh kiện này bằng cách nhấp chuột vào liên kết Link existing fooprint to
component...
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Hộp thoại Footprint for DIODE xuất hiện , nếu là lần đầu tiên sử dụng thì bạn phải add thư viện vào
bằng cách nhấp chuột trái vào nút Add...

Bạn chọn đường dẫn đến thư viện Layout mặc định là C:\Program Files\Orcad\Layout_Plus\Library.
Bạn nên add tất cả vào để tiện cho quá trình sử dụng
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Tại khung Libraries nhấp chọn mục JUMPER. Tại khung Footprints nhấp chọn mục JUMPER200 ( khoảng
cách giữa 2 chân là 200 mils = 5 mm ) để chọn chân diode. OK để thực hiện

Tiếp theo trong hộp thoại Link Footprint to Component có thông báo là không thể tìm thấy chân của
chân cắm J1 có tên CON2. Nhấp chuột vào Link existing fooprint to component...

Trong hộp thoại Footprint for CON2, tại khung Libraries chọn JUMPER, tại khung Footprints chọn
JUMPER100. Xong nhấp chọn OK.

Trong hộp thoại Link Footprint to Component có thông báo là không thể tìm thấy chân linh kiện Q3 có
tên T2801
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Nhấp vào Link existing fooprint to component...Trong hộp thoại Footprint for T2801, tại khung
Libraries chọn TO, khung Footprints chọn TO202AB để chọn chân cho Triac

Tiếp tục chọn liên kết chân linh kiện cho các chân còn lại ( transistor Q1, Q2 tương ướng là TO - > TO126,
cuộn dây L1 là thư viện JUMPER chọn JUMPER100, công tắc 3 chấu và biến trở chọn lần lượt là TO->
TO202AB và TO-> T126, tụ điện chọn JUMPER - > JUMPER100,...) cho đến khi nào không còn xuất hiện
hộp thoại Link Footprint to Component nữa. Khi hoàn thành liên kết đến các footprint với linh kiện,
OrCAD Layout tự động load các footprint như hình vẽ:

3.2.4 Footprint trên board mạch

Khi các fooprint được load, nếu không đúng với yêu cầu thiết kế thì phải chỉnh sửa hoặc tạo mới chân
linh kiện cho phù hợp

3.2.4.1 Chỉnh sửa fooprint

Chọn linh kiện cần thay đổi trên board mạch vừa load, sau đó nhấp chuột phải chọn Properties hoặc
nhấp đôi chuột vào linh kiện

Hộp thoại Edit Component xuất hiện, ở đây bạn có thể sửa lại tên và giá trị linh kiện, Nhấp chuột vào
Footprint... để thay đổi footprint
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Từ hộp thoại Select Footprint ta có thể lựa chọn các footprint thích hợp. Tuy nhiên nếu không tìm thấy
footprint phù hợp thì ta phải tạo mới fooprint cho phù giợp với linh kiện
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3.2.4.2 Tạo mới chân linh kiện

Ta có thể tạo mới chân linh kiện bằng cách trong chương trình Layout Plus, vào menu Tools -> Library
menager

Để tạo một footprint mới hoàn toàn bạn bấm Create New Footprint …

Ví dụ:

Tạo footprint cho một pushbutton (Panasonic part EVQ-PAG04M) bạn cần một số thông tin về kích
thước của nó:
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Ở hộp thoại Create New Footprint

Nhập tên linh kiện mới ở mục Name of
footprint, ví dụ là PB
Bấm chọn English. Mặc dù kích cỡ các bộ
phận của linh kiện được cho ở hệ mét nhưng
hầu hết kích thước chế tạo PCB vẫn bằng đơn
vị inches ( hay mils = 1/1000 inch).

Để dùng theo hệ mét bạn phải thay đổi systems settings. (vào Options -> System Settings) xuất hiện
hộp thoại bên.
Nhấp OK. Bây giờ bạn đang làm việc theo hệ mét.

Switch có tất cả 4 chân nhưng ta chỉ cần định dạng cho 1 padstack vì các chân dều có đặc điểm giống
nhau.

Đầu tiên vào View -> Spreadsheet ->Padstacks. Ta thấy xuất hiện hộp thoại padstacks, ta double click
vào padstack có tên T1 sẽ xuất hiện hộp thoại Edit Padstack cho tất cả các lớp của T1.
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Bạn thay đổi tên của padstack này, thường thì
đặt tên theo tên footprint. Điều này làm cho
việc tìm kiếm nó dễ dàng hơn trong Layout khi
có nhiều padstack. Tiếp đó nhấp chọn
Undefined trong mục Pad Shape

Nhấp OK. Xuất hiện hộp thoại padstacks. Bạn
thấy padstack tên PB với tất cả các lớp của nó
không được định dạng

Dựa vào Datasheet bạn định dạng cho các lớp của padstack PB. Nếu chọn nhiều lớp cùng một lúc thì
nhấn chọn tên các lớp đồng thời giữ phím Ctrl. Bạn chỉ cần định dạng cho những lớp cần thiết .

Đầu tiên bạn cần định dạng kích thước cho chân lỗ khoan, theo datasheet đường kính chân lỗ khoan là 1
mm.
Ta chọn 2 lớp DRLDWG, DRILL.
Click phải chuột chọn Properties , xuất hiện hộp thoại Edit Padstack Layer , nhấp chọn Round, sau đó
nhập giá trị 1(=40 mils) vào Height và Width.
Nhấp OK
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Bạn thấy trong hộp thoại padstacks lớp DRLDWG, DRILL đã được định dạng:

Tương tự bạn định dạng cho các lớp TOP, BOTTOM, INNER. Thường thì kích thước của vòng xuyến bao
quanh lỗ chân khoan lớn hơn lỗ khoan khoảng 20 mils(=0.5 mm). Do đó nhập giá trị 1.5mm vào Height
và Width.

Vì lớp giữa của mạch là miếng đồng dành cho power và ground, để tránh hiện tượng ngắn mạch người
ta thường tạo ra xung quanh các lỗ khoan một khoảng trống, lớn hơn kích thước lỗ khoan là 35
mils(=1.75 mm). Bạn nhập giá trị 2 mm vào Height và Width và chọn pad dạng round cho lớp PLANE.

Cuối cùng bạn cần định dạng cho mặt để hàn chân linh kiện, thường thì nó lớn hơn vòng xuyến bao
quanh chân lỗ khoan khoảng 5 mils(=0.125 mm). Do đó bạn chọn pad hình round và nhập giá trị
1.625mm vào Height và Width cho lớp SMTOP and SMBOT.
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Sau khi định dạng xong cho các lớp của padstack này, ta sẽ lưu tên của footprint mới tạo vào thư viện, ta
nên tạo thư viện mới để dễ dàng tìm kiếm sau này.

Bằng cách click Save As trong hộp thoại Library manager.
Điền tên footprint mới tạo, sau đó click vào Create New Library để tạo thư viện mới.

Nhấp OK thì footprint mới tạo sẽ được lưu vào thư viện.
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Sau đó chọn Text tool để xóa bớt
các chữ không cần thiết đi, chỉ để lại
&Comp và &Value. Nhấp vào text cần
xóa và bấm phím Delete (trên bàn
phím).

Thêm các chân linh kiện vào bằng cách

chọn công cụ Pin Tool .

Click chuột phải vào nền đen, chọn
New…

Đặt chân mới ở vị trí thích hợp

Chọn thuộc tính cho 2 text còn lại bằng kéo chuột để bôi nó, xong click chuột phải, chọn Properties
(phím tắt Ctrl+E).

Chọn Layer là SSTOP.
Chọn OK.
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Sau đó bạn sắp xếp lại vị trí cho các chân, bạn luôn luôn đặt vị trí của pad1 tại

(x,y) = (0, 0) > double click vào pad1 xuất hiện hộp thoại EDIT PAD.

Bạn dựa vào Datasheet biết khoảng cách giữa các chân để xác định vị trí cho các chân còn lại. Pad2 = (0,
6.5)
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Các chân khác tương tự: Pad4 = (4.5, 0), Pad3 = (6.5, 4.5)

Bạn có thể dùng các công cụ đo đạc như: Dimension, Measurement trong menu Tool để có thể tạo
khoảng cách chính xác giữa các chân.
Ngoài ra bạn còn có thể vẽ thêm các đường bao (Obstacle) cho linh kiện, đây là đường ranh giới giữa các
footprint để khi sắp xếp chúng không bị chồng chéo nhau.

Để vẽ đường bao bạn click vào biểu tượng Obstacle Tool , sau đó click phải chuột chọn New, giữ
chuột trái đồng thời kéo đến các góc chân pad, đường bao bao quanh các chân pad.



Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 3. OrCAD Layout

64

Đầu tiên bạn đặt tên cho đường bao, sau đó chọn Place Outline tại ô Obstacle Type. Độ dày width tùy
ý.

Thường bạn chọn đường bao này nằm ở lớp Global Layer, tức thuộc tính Obstacle Layer là Global Layer.

Cuối cùng click OK để lưu lại các định dạng cho footprint mới tạo.

Bạn đã hoàn thành việc tạo 1 footprint mới không có sẵn trong thư viện của layout.

Để nhanh hơn bạn có thể lướt qua thư viện của layout tìm những footprint tương tự footprint mà bạn
cần tạo để sửa chữa cho phù hợp với thực tế rồi Save As nó lại, lưu lại trong thư viện mới mà bạn tạo
cho dễ tìm kiếm.

3.2.4.3 Những chú ý khi tạo mới chân linh kiện

Khi thiết kế footprint, ngoài việc bạn cần biết chính xác kích thước thực giữa các chân linh kiện để thiết
kế kế đúng, còn phải biết kích thước của cả linh kiện để có thể bố trí khoảng cách giữa các linh kiện cho
hợp lý.

Một số kinh nghiệm chọn kích thước cho chân linh kiện:
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- Với các linh kiện thường như điện trở, tụ, diode … bạn chọn chân hình tròn (Round), đường kính
là 1.8 đến 2.1, tùy loại linh kiện

- Chân 1 của IC hay các linh kiện có cực tính như tụ hoặc diode bạn nên chọn kiểu chân là hình
vuông hoặc hình chữ nhật

- Với IC ta nên chọn chân hình Oval (với các chân 2 trở lên) và hình chữ nhật (đối với chân 1). Kích
thước thường là 1.7mm Width và 2.2 mm Height.

- Với các chân linh kiện to như chân của các JACK cắm, chân của đế IC có cần thì nên chọn bề
Width(bề ngang) to ra một tí, cỡ 1.8mm.

Thực tế việc tạo ra linh kiện trong Capture quan trọng hơn rất nhiều lần so
với việc tạo ra linh kiện trong Layout (hay Layout Plus). bạn chỉ cần sử dụng các chân layout có định
dạng giống vậy đểsử dụng, không nhất thiết phải tạo ra các định dạng chân cho từng linh kiện riêng biệt.

3.2.5 Một số thao tác cần thiết trước khi vẽ Layout

Đầu tiên, bạn sẽ tắt DRC (Design Rule Check), bạn sẽ cần dùng chúng sau, nhưng không phải bây giờ.
Sau khi tắt, khung chữ nhật nét đứt sẽ biến mất.
Những ký hiệu xuất hiện bên cạnh các linh kiện có thể không cần thiết nhưng chúng sẽ làm cho màn
hình của chúng ta rối hơn. Có 2 cách để xóa chúng đi:

- Chọn Text Tool trên thanh công cụ, click chuột vào đoạn ký hiệu mà bạn muốn xóa đi, sau
đó click chuột phải và chọn delete.

- Hoặc nếu bạn muốn xóa hoàn toàn các ký hiệu đi kèm, bạn làm như sau: Chọn lớp 23 AST như
hình vẽ, sau đó tắt nó đi.(sử dụng phím “-”)

3.2.6 Thiết lập môi trường thiết kế
3.2.6.1 Thiết lập đơn vị đo và hiển
thị. Đây cũng là đơn vị thể hiện độ
rộng của đường mạch in trong board
mạch. Mục đích của vấn đề này là giúp
cho người thiết kế quản lý được kích
thước của các nets trong board mạch
cũng như kích thước của board
outline. Cách làm như sau: Vào
Options -> System settings. Bạn sẽ
thấy hộp thoại sau xuất hiện: Ở đây
bạn nên chọn đơn vị là
Millimeters(mm). Ngoài ra ta còn có
thể thiết lập lưới vẽ, đặt lưới nếu cần
thiết ở khung Grids.
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3.2.6.2. Đo kích thước board mạch

Vào Tool -> Dimension -> Select Tool.

Sau đó đo độ dài và độ rộng của đường bao. Mục đích của cách làm này là cho người thiết kế biết được
board mạch mình thiết kế có kích thước thật bao nhiêu, để từ đó có những điều chỉnh hợp lý trong việc
sắp xếp các linh kiện trong đường bao cho phù hợp với board mạch in mà mình đang có.

3.2.6.3 Layer Stack

Để định nghĩa Layer Stack, bạn chọn View Spreedsheet từ Toolbar
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Nhấp Layers để chọn lớp vẽ, ở đây bạn chọn lớp BOTTOM, click chuột phải chọn Properties.

Chọn như sau và OK

3.2.6.4. Thiết lập khoảng cách giữa các đường mạch

Để thiết lập những luật về khoảng cách cho pads, tracks và vias. Bạn chọn View Spreedsheet từ Toolbar.
Chọn Strategy -> Route Spacing.
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Từ menu pop up chọn Properties:

Xuất hiện hộp thoại: Edit Spacing

Ở đây bạn có thể điều chỉnh các thông số cho phù
hợp. Cần chú ý đơn vị đo mà bạn đã thiết lập ở trên.
Chọn OK.

3.2.6.5 Thiết lập độ rộng đường mạch in

Bạn làm điều này để điều chỉnh độ rộng của các nets trong mạch khác nhau tùy theo chức năng của
chúng. Thường thì: các đường nguồn, mass phải lớn hơn các nguồn tín hiệu, hay các đường ứng với
mạch công suất thì bề rộng cũng phải lớn hơn bình thường…Muốn điều chỉnh các thông số này bạn có
thể làm như sau: Vào View Spreedsheet → Nets. Bôi đen tất cả, chọn Properties



Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 3. OrCAD Layout

69

Hộp thoại Edit Net cho phép ta chỉnh các thông số của Nets

Min Width, Conn Width, Max Width là độ rộng của nets mạch in. Không nên để 3 giá trị này bằng nhau,
vì khi đi mạch máy sẽ tự động điều chỉnh độ rộng của nets. Khi ít đất thì nó chọn Min, khi nhiều sẽ chọn
Max, như vậy sẽ linh hoạt hơn.

3.2.6.6 Vẽ đường bao

là đường bao ngoài cho tất cả các linh kiện và các đường mạch trong mạch in. Để vẽ bạn tiến hành như
sau:

Click chuột vào Obstacle Tool, sau đó click vào một góc mà bạn muốn vẽ Outline, con chuột chuyển
thành dấu cộng nhỏ, click phải, chọn Properties sẽ hiện ra hộp thoại sau:
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Bạn chọn như hình vẽ. Sau đó chọn OK.
Click vào 4 góc của khung mà bạn muốn vẽ, sau đó nhấn ESC.
3.2.7. Sắp xếp linh kiện lên board mạch

Việc bố trí linh kiện lên board mạch là một trong những yếu tố quan trọng quyết định
đến độ ổn định, dễ vẽ và thẩm mĩ,v.v…của board mạch.

Bạn có thể sắp xếp linh kiện bằng tay hoặc sử dụng chức năng tự động sắp xếp của
Layout Plus.

3.2.7.1. Sắp xếp linh kiện bằng tay

Nhấp chuột vào biểu tượng Component Tool trên thanh công cụ.Để di chuyển linh kiện nào ta nhấp
chuột vào linh kiện đó, sau đó, khi nhả chuột ra và di chuyển thì linh kiện cũng sẽ di chuyển theo. Đến vị
trí cần đặt linh kiện thì nhấp chuột một lần nữa, và linh kiện sẽ được cố đinh.
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Sau khi sắp xếp một lúc ta được như sau: nhấp chuột vào Reconnect Mode để ẩn /hiện dây nối

3.2.7.2. Sắp xếp linh kiện tự động

Đầu tiên bạn cần phải cố định một số linh kiện mà bạn muốn nó được đặt ở một vị trí xác định, tránh bị
thay đổi vị trí trong quá trình auto. Di chuyển linh kiện đến vị trí xác định, nhấp chuột phải chọn Lock.
Sau khi đã cố định được các linh kiện theo yêu cầu, chọn Auto -> Place -> Board.

3.2.8 Vẽ mạch

Layout Plus hỗ trợ cả 2 chức năng vẽ tự động và vẽ bằng tay. Thông thường nên kết hợp cả 2 chức năng
này, vì khi vẽ tự động đôi khi sẽ có những đường mạch rất phức tạp, lúc đó ta nên điều chỉnh lại bằng
tay.
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3.2.8.1. Vẽ tự động

Vào Auto -> Auto Route -> Board, Layout Plus sẽ tự động vẽ mạch.

3.2.8.2. Vẽ bằng tay

Chọn Edit Segment Mode . Kích vào dây muốn vẽ, lúc đó dây sẽ gắn với con trỏ, rê
chuột để tạo đường mạch, kích trái chuột để cố định đường mạch.

Để đổi hướng đường đi của mạch: kích vào cuối đoạn dây, sau đó đổi theo hướng mà bạn muốn vẽ.

Sau khi vẽ xong, nhấn ESC để kết thúc.

Nhấp F5 để refresh bản mạch.

Sau khi vẽ, bạn sẽ được như sau:
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3.2.9. Hoàn thiện bản mạch

Về cơ bản, chúng ta đã hoàn thành việc vẽ mạch in. Trong phần này bạn sẽ tiến hành một số thao tác
cuối cùng trước khi xuất mạch in

3.2.9.1. Chèn một đoạn text vào mạch in

Chọn Text Tool từ thanh công cụ. Click phải vào màn hình chọn
New.

Hộp thoại Text Edit hiện ra, trong khung Text String gõ nội dung cần chèn.

Lưu ý: nếu bạn làm mạch in thủ công thì click chọn Mirrored để khi ủi không bị ngược. Chọn lớp hiển thị
trong khung Layer ( thường thị chọnTOP và BOTTOM ), và kích thước chữ . chọn OK để hoàn tất

Di chuyển đoạn text đến vị trí cần chèn, click chuột.
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3.2.9.2. Phủ mass cho mạch in

Mục đích của vấn đề này là để chống nhiễu cho mạch điện.

Cách làm như sau:

Chọn Obstacle Tool. Nhấp chuột vào khung mạch, con chuột co
thành dấu cộng nhỏ thì click phải, chọn Property.
Màn hình sẽ xuất hiện hộp thoại Edit Obstacle.

- Trong khung Obstacle Type chọn: Copper Pour.
- Trong khung Obstacle Layer chọn lớp cần phủ Copper Pour: có thể là TOP hay BOTTOM.
- Trong khung Net Attachment thì chọn là GND hoặc POWER, tùy theo bạn muốn phủ theo GND

hay POWER. Nếu không thì ta để dấu “ – “
- Nhấn OK.
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Bản mạch hoàn chỉnh:

Nếu vẽ mạch nhiều lớp thì trong lúc vẽ, nhấn phím Backspace và các phím số để hiển thị một số lớp
nhất định,1: TOP, 2:
BOTTOM, ...

3.2.10. In mạch Layout

Để in mạch vừa vẽ, bạn
thực hiện các bước sau:

- Chọn Option ->
Post Process
Settings

- Nhấp chuột phải
vào lớp muốn in
(vd: lớp
BOTTOM), chọn
Preview
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- Vào menu File, chọn Print/Plot ( Ctrl + P )
- Chọn như hình dưới rồi nhấp OK

Kết quả:

Vậy là đã hoàn chỉnh 1 board PCB , tôi sẽ hướng dẫn các bạn làm mạch in thủ công tại nhà ở phần sau.
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Chương 4: Mô phỏng bằng PSPICE

4.1 Tổng quan về phần mêm mô phỏng Pspice

4.1.1 Giới thiệu về Pspice

Kỹ thuật điện là ngành khoa học nghiên cứu những ứng dụng của các hiện tượng điện, từ nhằm biến đổi
năng lượng và tín hiệu, bao gồm việc thu hập , gia công, xử lý, truyền tải tín hiệu

Để thuận tiện cho việc tính toán, thiết kế các thiết bị điện tử, người ta thường thay thế các mạch điện
thực tế bằng các mô hình thay thế và các sơ đồ mạch điện tương đương. Việc phân tích các mạch điện
nhằm dự đoán và kiểm tra khả năng làm việc của các thiết bị điện tử hoặc nhằm đưa ra các sản phẩm
phù hợp với yêu cầu đặt ra.

Phương pháp thực tế để kiểm tra một mạch điện là xây dựng chúng. Tuy nhiên hiện nay, khi mà các
thành phần của một mạch tích hợp có kích thước ngày càng nhỏ bé thì việc xây dựng các vi mạch này trở
nên rất khó khăn, Bên cạnh đó, những tác động vật lý, âm thanh, ánh sáng,...không ảnh hưởng đến
mạch điện thông thường nhưng lại gây nhiễu rất lớn đối với các vi mạch. Vì vậy, việc lắp ráp các vi mạch
từ các thành phần trong phòng thí nghiệm đòi hỏi nhiều thời gian, công sức và tiền bạc

Sự phát triển của công nghệ thông tin cho phép xây dựng các phần mềm mô phỏng và phân tích quá
trình làm việc của mạch điện tử. Khi đó ta có thể xây dựng, thử nghiệm, khảo sát hoạt động của mạch
ứng với các trường hợp cũng như việc thay đổi các thông số kỹ thuaaj cũng như khảo sát ảnh hưởng của
chúng đến quá trình làm việc của mạch. Do đó tăng tính mềm dẻo và khả năng khảo sát nhiều trường
hợp, tình huống khác nhau

Vấn đề khó khăn khi sử dụng các phần mềm là tính chính xác của mô hình. Nếu các mô hình không có
các đặc tính giống như các phần tử thực thì việc mô phỏng là vô nghĩa

Spice ( Simulation Program with Integrated Circuit Emphasis ) là một chương trình tính toán mô phỏng
và mô hình hóa các mạch điện tử tương tự được phát triển từ những năm 1970 tại đại học California ở
Berkeley

Pspice ( Power Simulation Program with Integrated Circuit Emphasis ) được phát triển bởi hãng
MicroSim, là một trong những phiên bản thương mại được phát triển từ Spicevaf trở thành phần mềm
mô phỏng phổ biến nhất trên thế giới. Pspice cho hép chúng ta mô phỏng các thiết kế trước khi di vào
xây dựng phần cứng. CHương trình mô phỏng cho phép chúng ta quan sát họa động của mạch cũng như
những thay đổi của các tín hiệu đầu vào hoặc các giá trị của các thành phần trong mạch điện. Do đó có
thể kiểm tra lại các thiết kế để xem chúng có chạy đúng trong thực tế hay không. Pspice chỉ mô phỏng và
tiền hành các phép đo kiểm tra chứ không phải là phần thiết kế của mạch điện

4.1.2 Các tính năng của Pspice

Pspice được đưa ra thị trường nhiều phiên bản khác nhau, mỗi phiên bản cung cấp các tính năng khác
nhau tùy thuộc vào yêu cầu khách hàng.



Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 4. Mô phông PSPICE

78

Trong phần này, tôi sẽ hướng dẫn dùng phần mềm Pspice A/D đi kèm trong bộ phần mềm OrCAD

Pspice A/D là chương trình dùng để mô phỏng các mạch điện tương tự và số. Các tính năng chính của
Pspice A/D:

- Phân tích xoay chiều, một chiều, quá độ : Tính năng này cho phép chúng ta kiểm tra các đáp
ứng cảu mạch điện khi được cung cấp đầu vào khác nhau. Cụ thể :
+ Phân tích một chiều ( DC Analysis ): Cho phép xác định điện áp định mức và trị số dòng điện
cho tất cả các nút của mạch bằng cách quét toàn bộ giá trị của điện áp trong một khoảng do
người dùng định nghĩa. Điều này có ý nghĩa khi muốn xác định đường đặc tính của các mạch
điện có chứa các phần tử phi tuyến như: diode, transistor,.. hoặc muốn xác định điện thế định
mức của các mạch khuếch đại
+ Phân tích quá độ ( Transient Analysis ) : nhằm dự đoán các trạng thái của mạch khi có các sự
kiện quá độ xảy ra
+ Phân tích xoay chiều ( AC Analysis ) : mô phỏng hồi đáp tần số của mạch điện, tức là ta có thể
quan sát được các trạng thái của mạch điện khi tần số của nguồn điện thay đổi trong một dãy
cho trước. Dựa vào đó đó ta có thể tìm thấy tần số cộng hưởng của mạch

- Phân tích tham số, độ nhạy, giá trị giới hạn : với những tính năng này chúng ta có thể quan sát
những biến đổi của mạch điện khi thay đổi các giá trị của các thành phần của nó

- Phân tích thời gian của các mạch số cho phép tìm ra sự cố về thời gian xuất hiện khi kết nối các
tín hiệu có tần số thấp trong quá trình truyền dẫn tín hiệu

Pspice A/D cũng cung cấp các mô hình hóa về các ứng xử của các thiết bị tương tự và số, vì vậy chúng ta
có thể mô tả các hàm chức năng của mạch điện sử dụng các biểu thức và hàm toán học. Do đó có thể
xây dựng và phân tích các đặc tính phức tạp của thiết bị thông qua mô hình toán học. Các mô hình hóa
được xây dựng trong Pspice A/D không chỉ là các điện trở, điện cảm, điện dung mà còn có các mô hình
sau :

- Mô hình dây dẫn, bao gồm độ trễ, độ dội, tổn hao, tán xạ và tạp âm
- Mô hình của cuộn dây từ phi tuyến, bao gồm độ bão hòa và từ trễ
- Mô hình của MOSFET
- Mô hình của transisitor trường có cực điều khiển cách ly IGBT MOSFET
- Mô hình của các phần số với vào ra tương tự

4.2 Các bước tiến hành mô phỏng và phân tích mạch điện

Để khảo sát một mạch điện nói chung cũng như một mạch điện tử công suất nói riêng ta tiến hành theo
các bước sau:

- Xác định mô hình các phần tử cần thiết để xây dựng mạch điện. Đa số các phần tử này đều có
trong thư viện mô hình của chương trình, tuy nhiên trong một số trường hợp ta phải xây dựng
thư viện mới. Việc xây dựng mô hình mới đòi hỏi am hiểu sâu sắc về kỹ thuật điện- điện tử bởi vì
mô hình phải phản ánh đúng đặc điểm và tính chất vật lý của thiết bị thực. Mô hình càng gần với
thực tế thì kết quả phân tích càng đáng tin cậy. Mặc dù vậy, trong một số trường hợp, khi khảo
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sát một số đặc tính nào đó thì ta chỉ cần mô hình hóa các tham số, thông số liên quan đến đặc
tính đó, tránh gây ra những phức tạp không cần thiết

- Thiết lập sơ đồ nguyên lý của mạch điện cần nghiên cứu. Cần phải đảm bảo chắc chắn rằng sơ
dồ nguyên lý được xây dựng là đúng đắn

- Chuyển đổi từ chương trình nguyên lý sang chương trình mô hình hóa theo ngôn ngữ chuyên
dụng của phần mềm ( đối với phiên bản hiện tại của Pspice thì việc này là hoàn toàn tự động ).

- Thiết lập các thông số của sơ đồ và các tham số khảo sát
- Tiến hành khảo sát:

+ Chạy thử chương trình với chế độ quen thuộc mà kết quả đã biết trước để kiểm tra độ chính
xác của mô hình

+ Khi mô hình hoạt động đạt độ tin cậy thì ta tiến hành nghiên cứu vói các chế độ cần khảo sát
theo yêu cầu đặt ra

Cụ thể với Pspice A/D trong OrCAD ta tiến hành theo 3 bước:

- B1: Thiết kế mạch bằng CAPTURE

+ Tạo một dự án Analog Or Mixed A/D

+ Đưa vào các phần tử

+ Nối dây và hoàn chỉnh sơ đồ mạch

- B2: Xác định kiểu mô phỏng
+ Tạo tệp tin mô tả
+ Xác định kiểu phân tích: 1 chiều, xoay chiều, quá độ, thời gian, tần số
+ Chạy PSPICE

- B3: Quan sát kết quả:
+ Thêm các đường đồ thị
+ Phân tích dạng sóng
Kiểm tra tệp tin đầu ra nếu cần
+ Lưu và in kết quả

4.3 Thiết kế mạch bằng CAPTURE

Về phần Capture tôi đã hướng dẫn cụ thể cho các bạn ở phần trên, nên phần này tôi chỉ hướng dẫn
những gì liên quan tới Pspice.

4.3.1 Tạo 1 project mới

Khởi động cửa sổ làm việc của Capture. Chọn File -> New -> Project để tạo project mới

Cửa sổ New project xuất hiện
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Trong cửa sổ này, bạn gõ vào tên tập tin trong phần Name, chọn thư mục để lưu trữ tập tin trong phần
Location. Trong thẻ Create a New Project Using bạn đánh dấu vào ô tròn thứ nhất : Analog or Mixed
A/D. Nhấn Ok để đồng ý tạo Project mới

Lúc này trình Capture mở ra một cửa sổ Create Pspice Project, bạn hãy chọn mục Create a blank
Project để trình Capture mở ra trang vẽ trắng

OK để hoàn tất và vào vùng làm việc chính của Capture
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Với việc liên thông với trình Pspice A/D thì thanh Capture có thêm thanh công cụ để hỗ trợ cho việc liên
thông với Pspice

Ở đây tôi sẽ mô phỏng mạch dao động sử dung IC định thời 555, loại IC này được dùng rộng rãi trong
mạch điện tử tương tự. Sơ đồ nguyên lý của 1 mạch tạo xung dùng 555 như sau:

Các linh kiện có trong mạch:

IC 555/ ANL-MISC.OLB

R/analog

C/analog

VDC/source

GND

Các bạn thực hiện việc lấy linh kiện và đi dây để hoàn thiện mạch như hình trên

Lưu ý:

- Thư viện để sử dụng cho trình mô phỏng Pspice được lấy trong thư viện pspice theo đường dẫn
mặc định là: \capture\library\pspice

Một số thư viện thông dụng dùng trong mô phỏng Pspice bao gồm:
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Analog: chứa các phần  tử thụ động ( R,L,C ), hỗ cảm, đường truyền và các nguồn dòng, nguồn áp phụ
thuộc( nguồn áp phụ thuộc điện áp E, nguồn dòng phụ thuộc dòng điện F, nguồn dòng phụ thuộc dòng
điện G và nguồn áp phụ thuộc dòng điện H )

Source: bao gồm các loại nguồn dòng và nguồn áp độc lập như VDC, IDC, VAC , IAC , VSIN ,VEXP, xung,...

Và nhiều thư viện khác chứa các thành phần của mạch điện như các linh kiện điện tử công suất: diode,
transistor, thyristor, mosfet, các cổng logic, các thiết bị giao tiếp

- Các điểm nối của mạch được đánh dấu bằng các số nguyên dương, trong đó bắt buộc phải có
nút số 0 và luôn được hiểu là điểm đất ( Ground ). Điểm 0 này rất quan trọng vì khi chạy chương
trình máy sẽ tính toán điện áp giữa mỗi nút trong mạch điện với điểm đất này trong từng bước
tính

Để lấy điểm 0 ta kích chuột vào biểu tượng bên thanh công cụ hoặc nhấn phím G. Hộp thoại Place
Groud hiện ra, ta chọn thư viện SOURCE và chọn ký hiệu 0

- Việc vẽ mạch bằng Capture để phục vụ cho trình mô phỏng Pspice phải tuyệt đối chính xác từ
việc chọn linh kiện đến nói dây và các thông số linh kiện, như vậy việc mô phỏng mới đảm bảo
được

- Với các mạch dao động bạn phải đặt vào mạch một điều kiện khởi đầu ( lênh IC: Initial
Condition). Hãy mở của sổ Place Part và chọn thư viện Special rồi chọn tên linh kiện là IC1. Bạn
hãy nhấp chuột lên chữ “ IC” để ghi vào mức volr khởi đầu ( vd : 0V ).

4.3.2 Hoàn thiện bản vẽ

Sau khi hoàn tất việc lấy linh kiện và đi dây, cần phải gán tên và giá trị cho các phần tử
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Các nút lưới: Danh sách các nút lưới bao gồm toàn bộ các phần tử của mạch được liệt kê theo cấu trúc
đã được quy định. Để tạo ra các nút lưới từ sơ đồ mạch nguyên lý, ta dùng lệnh Pspice -> Create netlist

từ thực đơn của chương trình. Danh sách này được lưu trong tệp tin có đuôi .net và được quản lý bằng
trình trình quản lý dự án, ta có thể chọn vào tệp tin này để xem nội dung bên trong của nó. Và đây là nội
dung của tệp tin ứng với mạch đang xét:

nếu có thông báo lỗi , bạn hãy kiểm tra lại sơ đồ mạch cho đến khi nào không xuất hiện lỗi nữa thì chúng
ta tiến hành xác định kiểu phân tích và mô phỏng

4.4 Phân tích và mô phỏng
4.4.1 Xác định kiểu phân tích và mô phỏng

Trước hết hãy nhập chuột vào biểu tượng để mở trang phân tích mạch. Cửa sổ
New Simulation xuất hiện:

gõ vào ô Name tên của trang phân tích. Nhấn phím Create để mở cửa sổ chọn kiểu dạng phân tích. Giao
diện như sau:
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Trong thẻ Analysis, mục Analysis type có 4 lựa chọn kiểu phân tích chính:

- Bias poit: dùng xác đinhj điều kiện phân cực DC của một mạch điện. Tính toán xong, ta sẽ có các
mức áp DC trên các đường mạch và có dòng điện chảy qua các nhánh của mạch

- DC Sweep: dùng quét thông số DC để phân tích các đặc tính của các linh kiện điện tử. Như vẽ
các đường cong đặc tính của diode, transistor, scr, triac, các cổng logic,..Khảo sát mạch với các
mức nguồn nuôi DC khác nhau...

- Time Domain ( Transient ): dùng phân tích các mức áp trên các điểm của mạch điện lấy theo
biến thời gian ( ở đây trục X lấy theo biến thời gian ). Nó có công dụng như bạn đang dùng một
máy hiện sóng nhiều tia để xem các tín hiệu trên các điểm nối của mạch điện.

- AC Sweep/Noise: dùng phân tích các mức áp trên các đường nối của mạch điện thoe biến tần số
và góc pha ( trục X lấy theo biến tần số hay biến góc pha ). Nó dùng để vẽ ra đường cong đáp
ứng biên tần, pha tần của mạch.

4.4.2 Thực hiện mô phỏng

Trong ví dụ trên, ban đầu bạn hãy chọn cách phân tích là Bias Point và nhấn OK để đồng ý

Chọn Pspice -> Run ( hoặc biểu tượng trên thanh công cụ )

Để quan sát kết quả của quá trình mô phỏng phân tích 1 chiều, ta có thể mở tệp đầu ra hoặc quay trở lại

sơ đồ mạch và kích vào biểu tượng ( cho phép hiển thị điện áp dịch )hoặc ( dòng điện dịch )

hoặc ( công suất tiêu tán trên các phần tử )
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Kết quả của quá trình phân tích:

Điện áp định thiên Dòng điện định thiên

Công suất tiêu tán
Tiếp theo chúng ta chọn cách phân tích Transient ( Trục X lấy theo biến thời gian ). ở dạng phân tích này
bạn chỉ cần gõ số vào các ô trống ( xem hình ):
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Trong ô Run to time : gõ vào khoảng thời gian phân tích

Ô Start saving data after:  xác định thời điểm bắt đầu cho hệ tín hiệu

Ô Maximum step size: chọn bước in ( bước in càng nhỏ thì tín hiệu in ra sẽ càng net, hình càng đẹp
nhưng tập tin dữ liệu ghi lại trên đĩa sẽ lớn và thời gian phân tích sẽ kéo dài hơn ).

Sau khi đã chọn xong thì nhấn phím OK để trở lại trang vẽ. Chọn đầu dò Volt và gắn vào vị trí của
chân ra OUTPUT số 3 của IC 555. Nhấn chọn Run để xem kết quả phân tích:

Trong trang đồ thị này, chúng ta thấy tín hiệu ra trên chân số 3 của IC555 có dạng xung vuông. Lúc này
muốn xem tín hiệu trên điểm nào của mạch điện thì đặt ống dò ngay trên điểm đó.

Nếu như cùng lúc bạn đặt ống dò trên 2 chân số 6 và số 3. Chúng ta sẽ thấy tín hiệu trên chân 3 là dạng
xung vuông, còn trên chân 2,6 là dạng tín hiệu răng cưa, cả hai cùng hiện trên 1 đồ thị
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Kết quả mô phỏng:
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Bạn có thể thay đổi trị số của các linh kiện trên mạch điện rồi cho phân tích bạn sẽ thấy kết quả khác.

Trên vùng làm việc của Pspice, bạn nhấp chuột vào 2 trục của đồ thị để thay đổi tọa độ và lưới hiển thị
sao cho phù hợp với nhu cầu của bạn

Bạn cũng có thể xem các đường biễu diên khác. Mở của sổ add trace bằng lệnh Trace -> add trace...

hoặc biểu tượng trên thanh công cụ. Trong cửa sổ Function or Macro, bạn chọn hàm cần xem,
trong thanh Trace Expression chọn biến cần quan sát, nhấn OK để xem:
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Ngoài ra bạn có thể chọn chế độ quét DC_Sweep để phân tích các đặc tính của linh kiện.

trong thẻ Name chọn nguồn
cần đo ( ở đây là nguồn V1)

Start Value: giá trị khởi đầu

End value: giá trị kết thúc
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Ngoài ra bạn có thể chọn chế độ quét DC_Sweep để phân tích các đặc tính của linh kiện.
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Ngoài ra bạn có thể chọn chế độ quét DC_Sweep để phân tích các đặc tính của linh kiện.

trong thẻ Name chọn nguồn
cần đo ( ở đây là nguồn V1)
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Đây là phần mềm mô phỏng mạnh và được dùng rất phổ biến. Và để sử dụng được phần mềm này một
cách thấu đáo đòi hỏi các bạn phải có một kiến thức chuyên sâu về kỹ thuật điện tử. Trong phần này tôi
chỉ giới thiệu khái quát về công cụ mô phỏng Pspice để các bạn có thể biết cách mô phỏng một số mạch
điện tử phục vụ cho việc học tập của mình. Việc dùng Pspice để phân tích độ nhạy, phân tích nhiễu,
phân tích Fourier, phân tích tham số, phân tích nhiệt độ, mô phỏng số,...và nhiều vấn đề khác tôi sẽ
không đề cập đến trong tài liệu này. Nó sẽ được hướng dẫn chi tiết, thấu đáo trong một tài liệu khác
chuyên biệt để có thể giúp bạn có thể đi sâu vào khai thác phần mềm mô phỏng Pspice.
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Chương 5: Một số bài tập ví dụ

Phần này sẽ giới thiệu các bạn một số mạch tham khảo vẽ bằng OrCAD 9.2

5.1 Mạch nguồn

5.1.1 Sơ đồ nguyên lý:

Để cho mạch được gọn khi đi dây các bạn sử dụng chức năng “ đặt nhãn đường mạch “ bằng cách nhấp

chuột vào biểu tượng Place net alias bên thanh công cụ phải
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Đặt tên cho nhãn trong khung Alias, màu chữ trong khung Color, và muốn thay đổi định dạng chữ thì
nhấp vào nút Change... trong khung Font

Đặt nhãn vào vị trí đi dây phù hợp, làm tương tự cho đầu dây còn lại, các đường mạch có chung nhãn sẽ
được tự động nối với nhau khi chuyên qua Layout Plus

Chức năng này rất hữu dụng, nhất là khi thiết kế mạch phức tạp, sử dụng nhiều IC,... Tạo nhãn đường
mạch sẽ cho mạch nguyên lý gọn hơn và thẩm mý hơn

5.1.2 Sơ đồ mạch in

5.1.2.1 Sắp xếp linh kiện

Các bạn có thể sắp xếp linh kiện theo hình dưới

5.1.2.2 Vẽ mạch ( ở đây sử dụng chế độ Autoroute )

Các thông số về độ rộng đường mạch của mạch trên được cho như hình:
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Chọn chế độ chạy mạch in một lớp ( BOTTOM )
vào Auto – Autoroute, ta được như hình dưới

Kiểm tra các đường mạch và chỉnh sữa lại
nếu muốn. Sau đó chèn Text và phủ mass
cho mạch

Sơ đồ mạch hoàn chỉnh
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5.2 Mạch nạp STK200/300

5.2.1 Giới thiệu

Mạch nạp loại này sử dụng cho các board STK200/300 của Atmel nên thường được gọi là STK200/300.
Mạch này giao tiếp với máy tính qua cổng LPT (cổng song song). Có 2 phiên bản phổ biến của mạch
STK200/300 đó là phiên bản thu gọn và phiên bản sử dụng IC đệm dòng 74xxx. Ở đây sử dung mạch có
IC đệm 74HC245, mạch này nạp rất ổn định và an toàn. Mạch này được hỗ trợ bởi rất nhiều chương
trình nạp và sử dụng được cho hầu hết các loại chip AVR. Mạch này có các linh kiện rất dễ kiếm và chi
phí rẻ nên được dùng nhiều trong giói SV

5.2.2 Sơ đồ nguyên lý

Mạch có sơ đồ nguyên lý như hình:
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Sử dung chức năng place no connect để đánh dấu vào các chân không đi dây. Chức

năng để tạo đường bus

5.2.3 Sơ đồ mạch in

5.2.3.1 Sắp xếp linh kiện

Linh kiện trong mạch có thể được sắp xếp như hình dưới

5.2.3.2 Vẽ mạch

Các thông số độ rộng đường mạch tham khảo
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Chạy dây lớp BOTTOM

Kiểm tra mạch, chèn Text và phủ mass cho mạch
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Mạch hoàn chỉnh:

5.3 Mạch nạp AVR USB 910

5.3.1 Giới thiệu

• Nạp được hầu hết các dòng AVR và một số chíp 89S của Atmel bằng cổng USB tiện lợi
• Kiểm tra lỗi sau khi nạp
• Hỗ trợ khóa chíp và lập trình fuse bit
• Header chuẩn ISP cho kết nối thuận tiện
• Tốc độ nạp cao, sử dụng được với hầu hết các trình biên dịch
• Mạch siêu nhỏ gọn, bọc cách điện thuận tiện cho di chuyển, sử dụng
• Cực kì đơn giản trong kết nối, cài đặt và sử dụng.
• Tương thích với Windows XP, Vista, Windows7.

5.3.2 Sơ đồ nguyên lý

Mạch có sơ đồ nguyên lý như hình
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5.3.3 Sơ đồ mạch in

5.3.3.1 Sắp xếp linh kiện

Có thể sắp xếp linh kiện như hình:

5.3.3.2 Vẽ mạch

Bảng thông số độ rộng đường mạch tham khảo
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Chạy dây và hoàn thiện

Kiểm tra mạch và phủ mass, ta có mạch hoàn chỉnh như sau:
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5.4 Mạch đèn LED rượt đuổi

5.4.1 Giới thiệu

Đây là mạch đèn trang trí ứng dụng IC 555 và 4017 rất đơn giản nhưng hiệu ứng khá đẹp mắt.
IC 555 đóng vai trò làm xung kích cho 4017 thực hiện đếm. Tốc độ chuyển động của đèn được quyết
định dựa vào tần số của 555
5.4.2 Sơ đồ nguyên lý

Mạch có sơ đồ nguyên lý như hình dưới

5.4.3 Sơ đồ mạch in

5.4.3.1 Sắp xếp linh kiện

Sơ đồ bố trí linh kiện
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5.4.3.2 vẽ mạch

Chọn lớp BOTTOM, thay đổi độ rộng đường mạch phù hợp rùi chọn chế độ chạy dây tự đông

Sau khi chạy dây tự động, vẫn còn một số đường mạch chưa chạy được, ta phải tiến hành vẽ bằng tay ,
tạo jumper cho đường mạch còn lại

Chọn chế độ vẽ tay Edit Segmaent Mode , nhấp chuột vào đường mạch cần vẽ, di
chuyển đến vị trí phù hợp, chạy hết các đường mạch còn lại nhớ là các đường mạch không cắt nhau

Trở về chế độ Component Tool , nhấp chuột phải, chọn thẻ New... Xuất hiện hộp
thoại sau



Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 5. Bài tàp

102

Nhấp chuột vào khung Footprint... để tìm chân linh kiện cho via
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Nhấp chọn OK

Đặt vào vị trí cần tạo VIA, các jumper này khi làm mạch chúng ta phải tiến hành hàn dây

Mạch sau khi tạo các jumper, và chỉnh sửa phù hợp như hình dưới

Tiến hành phủ mass cho mạch để tạo bản mạch hoàn chỉnh, chèn text nếu muốn
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5.5 Mạch đồng hồ số đơn giản

5.5.1 Giới thiệu

Mạch đồng hồ số dùng Led 7 đoạn để hiển thị giờ phút giây, sử dụng VDK AT89C52 để lập trình điều
khiển và IC thời gian thực DS1307. Thích hợp cho những ai muốn tự làm mạch cho riêng mình hoặc tặng
bạn bè

5.5.2 Sơ đồ nguyên lý

Mạch có sơ đồ nguyên lý như hình dưới

5.5.3 Sơ đồ mạch in

5.5.3.1 Sắp xếp linh kiện

Sơ đồ bố trí linh kiện
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5.5.3.2 Vẽ mạch

Chọn vẽ mạch 1 lớp ( BOTTOM ), chỉnh kích thước độ rộng đường mạch phù hợp

Autoroute mạch điện ta có kết quả như hình
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Kiểm tra mạch, tạo via cho các jumper, phủ mass và ta có mạch hoàn chỉnh như sau

bố trí linh kiện trên board
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5.6 Một số mạch điện tử hay

Ở phần này sẽ giới thiệu cho các bạn một số mạch điện lý thú ( sưu tầm ) để các bạn có thể nghiên cứu
vẽ và làm board thật.

5.6.1 Mạch điều khiển tải bằng âm thanh

5.6.2 Mạch đèn giáng sinh
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5.6.3 Mạch tạo xung 1kHz

5.6.4 Mạch bảo vệ quá áp

5.6.5 Mạch khóa số
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5.6.6 Mạch relay bảo vệ dòng 1 pha

5.6.7 Mạch relay bảo vệ dòng 3 pha

5.6.8 Mạch đồng hồ vạn niên

Mạch này để gọn và thẩm mỹ thì các bạn nên thiết kế board 2 lớp ( TOP, BOTTOM ).
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Khối điều khiển

Khối hiển thị
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Đây là sơ đồ mạch in tham khảo

Khối hiển thị

Các jumper
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Khối điều khiển

Các jumper
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Chương 6: Làm mạch in thủ công

Phần này sẽ giới thiệu các bạn cách làm board 1 lớp thủ công tại nhà từ các sơ đồ mạch in đã vẽ trên
OrCAD Layout Plus

6.1 Dụng cụ cần thiết

- Panel: tấm đồng , tùy theo board để xác định kích thước ( mua ở chợ Nhật Tảo ).
- Dung dịch ăn mòn: FeCL3 mua ở chợ, hoặc HCL, H2O2.
- Phụ kiện: Kìm, khoan (các mui thường dùng 0.6mm 0.8mm 1mm 3mm), giấy ráp hoặc rẻ rửa bát hoặc
cọ xoong

6.2 Chuẩn bị bản in

Sau khi thiết kế bạn chuẩn bị in, nếu nhà có máy in thì tốt, không có thì phiền đấy ! Nếu bạn cài Adobe
Acrobat, MS Office 2003 hay FinePrint thì có một tiện ích máy in ảo, bạn sẽ in ra máy in ảo này rồi đem
ra ngoài in vì tập tin được các máy in tạo ra là pdf hoặc file ảnh. Như thế cửa hàng bạn đem in không có
OrCAD cũng không sao. Vấn đề ở đây là bạn phải thuyết phục chủ tiệm cho bạn in thôi.

Hiện nay có một số cửa tiệm cho phép bạn in mạch file .MAX, nhưng hơi mắc. Không thì các bạn chép cái
OrCAD protable trong USB và đem ra tiệm mở cái OrCAD chọn mở file cần in lên và in thôi.

Nếu bạn dùng giấy đề can thì in lên mặt bóng (mặt bóng của nó giống như mặt sau của cái nhãn vở dính
(phần bỏ đi)). Loại này dc đánh giá cao nhất, nó đi được những đường mạch 10mil. Còn giấy hồng hà
cũng được, nhưng bạn nên để đường mạch phải cỡ 15mil trở nên.
Đối với những máy in mới HP1100 hay Canon LBP 800 trở nên, bạn phải chọn kiểu giấy nhẹ nhất nếu
không mất giấy ráng chịu. Khi chọn giấy nên chọn loại giấy màu vàng, như vậy khi ủi thì sẽ thấy rõ hơn

6.3 Ủi mạch

Trước tiên bạn đánh sạch bề mặt tấm đồng, càng sạch càng tốt, đem rửa sạch rồi lau khô, bạn cắt tấm
đồng thành tấm có kích thước bằng với board bạn thiết kế. Còn giấy bạn phải cắt to hơn khung để là
xong có chỗ mà bóc.
Để nhiệt độ bàn là ở chế độ max. Sau khi đặt bản in lên bo đồng bạn đặt bàn là, là trong khoảng 5-10
phút, chú ý là kĩ phần mép. Để nguội. Nếu là giấy đề can thì có thể bóc, còn giấy hồng hà thì phải đem
ngâm nước cho giấy mục ra rồi bóc đi.

Không nên ủi lâu vì như vậy sẽ làm nhòe đường mạch, làm cong board,...

Làm càng nhiều thì bạn sẽ tự rút ra kinh ngiệm cho riêng mình

6.4 Ngâm mạch

Bạn lấy một ít FeCL3 pha với nước tốt nhất là nước sôi. Pha đến khi nó bão hòa. cho vào một cái đĩa. Đặt
tấm đồng vào đĩa, nghiêng đĩa như người ta đãi vàng nếu bạn pha với nước sôi thì khoảng 1 phút là
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xong. Còn nước nguội thì khoảng 5 phút. Bạn thấy đồng ở phần không có đường mạch bong hết ra là
được. Sau đó dùng cọ xoong đánh sạch.

6.5 Khoan board

Mũi 0.6 đề khoan chân có chân nhỏ như diode zener, mũi 0.8 là trở, 1 là diode chỉnh lưu. 3 là khoan lỗ
bắt vít.
Bạn đặt mũi khoan vuông góc với board, bấm công tác, cho khoan qua thì tắt, tiếp tục chuyển sang lỗ
khác.

6.6 Bảo vệ mạch

Để tránh cho mạch khỏi bị oxi hóa bạn phải quét lên mạch một lớp bảo vệ. Sau khi hàn xong, bạn phủ
lớp bảo vệ. Dung dịch bảo vệ: RP7 (hàng sửa xe máy, chợ trời cũng có), Sơn bóng , nhựa thông (có bán ở
chợ Nhật Tảo).
Với RP7 hoặc sơn bóng bạn phun trực tiếp vào phần có đường mạch.
Còn với nhựa thông bạn đem đập nhỏ, đem hòa tan bằng xăng hoặc axeton (hiệu thuốc hoặc hàng
mành), được một dung dịch dạng keo, sau đó lấy bút lông quét lên. Khi axeton hoặc xăng bay hơi thì lớp
nhựa thông sẽ bảo vệ mạch.


